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Conventions Used
in This Book
Text that you are instructed to type appears in a special typeface.
Text that appears on-screen, such as messages and menu commands, appear
in bold.
Keystroke combinations are indicated as in the following example: "Press
Command-P to print." This means that you press and hold the Command
key (the key at the bottom of your keyboard with a picture of an apple and
a cloverleaf on it), and then press the key labeled P. Release both keys
simultaneously.
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Introduction
After a quick scan, many people are reluctant to ever pick up a program
manual again. After breezing through the tutorial, they simply start worki ng.
Time-and labor-saving features of programs go unused because you didn't
notice them, the manual did a poor job of explaining them, or you didn't
want to take the time to learn how they worked. Even if you didn 't realize
that your word processing program had a table feature , you could still make
tables with tab stops. The job gees done, but not as efficiently as it might have
been. Many people use computers as if they were plumbing-with a hammer.
A hammer may not be the best tool for fixing the pipes, but if you bang long
enough, something is sure to happen ...

What This Book Will
Do for You
lthough the Mac and its software are easy to use,
regardless of how long you have had a Mac on your
desk, rest assured there are often easier ways of doing
things and better cools for the job. This is what The
9-to-5 Mac is about.

A

Real business productivity on the Mac requires the following:
The 9-to-5 Mac

•

Exposure to the right resource materials.

• Awillingness to learn and try new things.
• Time to practice.
This book and the accompanying disk are resource materials. Even if you
have the inclination, you probably d on' t have the time to read dozens of
books. magazi nes, and trade newspapers to keep u p with happenings in the
Mac world . Instead, this book foc uses on over o ne hundred of the most
po pular Macintosh programs, describes their capabilities, and shows you
how they work. Examples and templates are provided fo r many of these
programs so that you can put them to use in your business immediately.
Advanced features often are illustrated in the templates so that you readily
can see how to use them in your own documents and files.
It is assumed that you understand the Macintosh bas ics: using the mouse,
selecting menu options, working with dialog boxes, opening desk accessories, and copyi ng and saving files. If not, you should start by working through
the tuto rial material that came with your Mac. Otherwise, whether you are a
new user or a seasoned Macintosh veteran, you wo n't feel out of place.
The 9-to-5 Mac will show you dozens of ways to improve your computing
productivity-better tools for the jo b at han d and more efficient ways to use
your programs.

How the Book Is Organized
ach chapter d iscusses a particular type of program. Sectio ns within chapters are always o ne of cwo types: templates or program reviews. Related
tools and utili ty programs are discussed at the end of each chapter.

E

The append ices provide additio nal information abou t the Macintosh, System
software, and safe computing practices you may find helpfu l. If you wa nt
mo re informatio n abo ut a particular program, the Appendix E, "Product
Index," contains an alphabetical list of all programs d iscussed in the book
o r used in the templates, and provides manufacturer names and phone
numbers.

About the Templates
ou will find many task templates in the book. Each template shows you
how to do something practical and useful with a popular Macintosh
program. Examples of templates include ready-to-use databases and
spreadsheets; word processing stationery documents for memos, faxes,
envelopes, and labels; and connectivity tasks such as using Publish and Subscribe and moving files between different types of computers.

Y

The start of each template section in the book is marked by a
template icon.
In most cases, templates are accompanied by one or more files on the disk
that enable you to put them to use in your business instantly. Step-by-step
instructions are provided for using each template (how to enter your own
data, create reports, view help screens, and so o n) and customizi ng the template, such as adding your logo and company name, and using different
fonts.
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Read This First!
7be 9-to-5 Mac provides an introduction to !.he major business uses of !.he Macintosh. Each chapter is devoted to one category of business software. For each
area, a general introduction is supplemented wic.h specific software reviews and
actual working templates that illustrate practical business functions. The goal is
to provide an overview of !.he software, not in-depc.h training. When you are
ready to make a commitment to a particular application, you will need c.he full
documentation, and in some cases, a supplemental guide for that program.
This chapter provides d1e background information necessary for getting the
most out of 7be9-to-5 Mac. You could just jump to the topics that interest
you; however, we suggest you read this chapter first because it provides
information on where to look for answers when you have questions or run
into problems. The following topics are covered in this chapter:
• Macintosh Basics-What you need to know to use this book.
• The "Right" Software-In many cases, the version of the program is
as important as the name of the actual application.
• The Templates-How to work with the ready-to-use
templates o n the enclosed disk and how to create your
own templates.
• The Truth about the Macintosh-It's not perfect!
This book reviews many of the most popular Mac
software programs. The point of this book, however,
is to show you how to use the Mac in conjunction
with software to accomplish various business tasks,
making the process simpler, smoother, and more
e njoyable. This chapter focuses on the information
you will need before you begin.

l::::::::::J

J

Macintosh Basics
n this book, very few assumptions are made about your knowledge of the
Mac. If you want to experiment with any of the topics discussed, you will
need a Mac, and for convenience, a hard disk drive. For specific templates,
you will need the software in which the template was created.
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The Macintosh-user interface is designed to make learning to use new software an e nj oyable exploration rather than a tedious task. Knowing a few
basics, however, is critical to being able to find your way around the system.
If you are an experienced Macintosh user, this section reviews the things you
first learned about using your system. For the novice, the following informatio n is important.

T
Starting Up the Mac
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There is only one correct way to start up and shut down your Mac. Before
you turn on the Mac, turn on all the devices connected to the SCSI port.
Typically, these include external hard disk drives and tape drives, but also
may include a scanner or other high-speed input or output devices.
Next, locate the power switch on the Mac and turn it on. Depending on your
equipment, the switch typically is located on back of the Mac; or if you have
an Apple extended keyboard, you may be able to use the power switch located on the keyboard. An icon of a Mac with a smiley face then appears
o n-screen. Other icons may appear in the lower-left corner of the screen, and
then a screen similar to the o ne in figure 1.1 appears. (This may take a few
seconds.)
This screen is referred to as the Desktop, and it is the screen from which you
can locate the files contained on your hard drive. The white bar across the
top of the screen that contains an Apple in the upper left corner is called the
menu bar.
If no symbols appear o n the far right end of the menu bar, you are running
the Finder under System 6. (System 6 is a versio n of the Mac operating system software.) If you see only one symbol on the far right of the menu bar,
you are probably running under System 6 with Multifinder. Ifa ballooned
question mark and a miniature Mac appear on the right end of the menu bar,
you are running under System 7. (System 7 is a recently released enhanced

version o f the Mac operating system.) You can use either operating system
version with the programs discussed herein; however, System 7 is recommended. For a complete discussion of the advantages of Syste m 7, see
Appe ndix A"The System 7 Advantage."

Figure 1.1 The Syste m 7 Desktop.
Unlike a text-based e nvironme nt where you must memorize a series of commands, the Mac is action-oriented. You must maste r four basic actio ns in
o rder to successfully use the Mac. Read on to find out more about the
mouse!

Mousing Around
The mouse is a peripheral that e nables you to move around o n the Mac
screen quickly. You can perform many functions with the mouse, but first
you need to learn how to use it.

Pointing is the process of moving the mouse pointer to the position
you want. By itself, pointing usually doesn' t accomplish anything. It is
often used as the first step in a series of actions.

Read This First!

Clicking consists of pressing and releasing the mouse button. It is
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important to hold the mouse firmly so that it doesn't wiggle when you
press the butto n. You click to select an object, insert the cursor in a
particular place in a document, close windows, turn dialog boxes
settings on and off, o r to position the cursor for further action.
Dragging involves positioning the mouse pointer, pressing and holding
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down the mouse button, moving the pointer, and then releasing the
mouse button. To drag an object, position the mouse pointer on the
object you want to move. Press and hold down the mouse button. At
this point, the object is selected. While holding down the mouse
button, move the mouse. The o bject o n which the pointer is positio ned
moves as well. After you move the object to the location you want,
release the mouse button. You can drag to move objects, highlight text,
and select menu items.
Double-clicking consists of clicking the mouse button twice in quick
succession. The second click must occur within a predefined time
period, or the system recognizes the clicks as two separate clicks rather
than a double-click. You can double-click to open documents, launch
programs, and select text.

Collectively, these mouse actions enable you to perform most of the necessary tasks within the Mac environment. To launch a program or open a
document, for example, simply positio n the mouse pointer on the icon that
represents the program or document you want to open, and double-click the
mouse. To move a window o n the Desktop, position the mouse pointer on
the bar that appears at the top of a window, and then drag the window to a
new locatio n.

Dealing with Disks and Files
Hard disk drives and floppy diskettes are the primary media used for storing
Macintosh data files and applications. After your Mac starts up, a column of
icons appears on the right side of the Deskto p-one for each attached hard
d isk volume. As additional disks are inserted or mounted on the Desktop,
each o ne is represented by an icon (see figure 1.2). Aselected disk (the disk
on which you single-clicked) is represented by an icon filled with a solid
color. Adisk that currently is open (a disk with an open window on the Desktop) is represented by an icon fi lled with a pattern . Floppy disk icons always
look the same; they resemble a miniature floppy diskette. On the other hand,
there is no standard icon for hard disks. The appearance of a hard disk icon
depends o n the software used to initialize the disk.
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Figure 1.2 As they are mounted or inserted, each disk or volu me is
represented on the Deskcop by a named icon.
There are cwo ways co remove a floppy disk from the Desktop. First, you can
eject it. To do this, you select the disk by clicking on it once, and then press
Command-Shift-1. If you are at the Finder (the Desktop) , you also can eject
the disk by selecting it, and then pressing Command-E o r selecting Eject ...
from the File menu in System 6 or the Special menu in System 7. Because
ejecting a disk still leaves an image of it o n the Desktop, you should use chis
procedure only when you need to insert a flop py diskette o cher than the
diskette currently in the drive, or are attempting to copy files from one
floppy to another on a Mac that has only o ne flopp y drive.
The second method of removing a disk from the Desktop is to drag its icon to
the Trash. Unlike using the Eject command to remove a disk from the Desktop, dragging an icon co the Trash also removes the disk (and its icon) from
the Desktop. In addition co using chis procedure with floppy diskettes, chis
also is the correccway to unmount hard disks. (Under no rmal circumstances,
there are few reasons foreve r unmo un cing hard disks. If you have a Bernou lli, SyQuesc, or ano ther type of removable hard disk, dragging its icon to
the Trash enables you to safely remove the disk from its drive and replace it
with a different one.)
Disks are for storing data-any type of computer d ata, such as programs,
documents, and program preferences. Unlike RAM (RandomAccessMemory)
installed in your computer, data scored on a hard disk remains afcer you shut

Read This First!

off the machine . RAM is used to temporarily store a program and its data files
only while you are running that particular program. The contents of RAM
disappear when you turn off the Mac.
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NOTE: Do not confuse hard disk space with memory (RAM) .
When you are asked about the storage capacity of your Mac, you
are being asked about the capacity of your hard disk drives(s)20, 40, 80, and 100 megabytes (M) are common sizes for hard
disk drives. When you are asked about the memory of your Mac,
RAM is being referred to rather than the size of the hard disk.
Common memory amounts are 1, 2, 2.5, 4, and 8M. To de termine the amount of RAM installed in your Mac, return to the
Desktop, and selectAbout the Finder .. . (System 6) orAbout
This Macintosh ... (System 7) from theApple menu.
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Although you can store many types of files on disk, the ones most frequently
discussed are applications, documents, INITs, and Control Panel devices
(CDEVs). Applications orprograms, such as PageMaker, Excel, and FileMaker
Pro, are elaborate sets of computer instructions that enable you to perform a
particular task, such as database manage ment or desktop publishing. You run
a pplications to create new documents or to read existing do'cume nts or data
files . A memo designed in your word processing program or printer fonts are
examples of documents. Not all documents are created by you; some are
created by programs automatically. Setting preferences in a program often
resu lts in the creation of such a file. Other d ocuments are sometimes included with the programs you purchase. Printers from companies other than
Apple, and fax-modems usually are accompanied by special Choo~er docume nts that enable you to select the device from the Chooser d esk accessory.

IN/Ts (called extensions in System 7) and CDEVs are ever-prese nt software.
Both types of documents are copied to the System folder, and load automatically when you turn on the Mac; they remain in memory throughout the
computing session. INITs are well-suited for performing background tasks,
such as checking the Mac's serial port for incoming faxes. INITs also are used
to control special hardware, such as CD-ROM drives. The other major use of
INITs is to enhance the System software by providing new functions. Adobe
Type Reunion and Suitcase II are examples ofINITs. IflNIT functions need
co be changed or accessed frequently, the INITs often are paired with a desk
accessory or CD EV. To change the INIT's operation, you simply open its desk

accessory or Control Panel document, and then set the new options. CDEVs
perform similar functions to INITs, but options for each CDEV are set by
selecting the appropriate icon in the Control Panel desk accessory.
To see the different rypes of files on your disks, return to the Desktop, open
a window by double-clicking on a disk or folder icon, and then select By
Kind from the View menu .

Shutting Down the Mac
When you finish working with the Mac, close all programs (usually by selecting Quit from the File menu of each program), and then select Shut Down
from the Special menu. Because the Mac performs clean-up work whe n you
select Shut Down, do no t turn off the power without first selecting Shut
Down. The Mac notes window positio ns, for example, and saves this information to disk.
If you turn off the Mac without selecting the Shut Down command, the desktop may need to reconstruct the next time you restart or boot the Mac. This
frequently is the cause oflo ng delays when you reboot after a crash . Worse
still, one of your programs or lNITs may be trying to write information to the
hard drive when you switch off the Mac. You may end up with an incomplete
or corrupted data file.
After you select Shut Down, wait until the message box appears before you
turn off the Mac's power switch. (Newer Macs may not display a message.
Instead, they turn off automatically when you select Shut Down.) Turn off
external drives and other SCSI devices after you turn off the Mac.

Macintosh Software: The
Numbering Scheme
he price paid for the continual improvement of Mac software is
that products are continually being updated. New features are introduced, and the way in which a program works may change. It is not always
enough to own just any copy of the programs being discussed in this book,
magazine articles, and elsewhere. The version of the software you own can
be important.

T

Read This First!

Microsoft Word 5, fo r example, introduces a grammar checker as part of its
standard features. Earlier versio ns simply d o not have this feature. So, ifyou
are trying to follow instructio ns in a magazine article for using the grammar
checker, yo u need Word 5.

The 9-to-5 Mac

What do the numbers mean? Fortunately, there is a wid ely accepted scheme
for numbering software versions. Although develo pers aren't required to use
it, many d o. Here is how it works:

T
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• Changes in ve rsion numbers (the digit o r digits to the left of the
d ecimal), such as from 1. 1 to 2.0 , indicate a major revision of the
program, o ne t hat contains many new features. Achange o f this natu re
often requires that you learn new ways of performing certain tasks. Old
procedures may no longer work and there may be new features you
d id no t anticipate. If the version number ends with a zero, such as 5.0,
it is the first release of that version. A .0 or .00 number sometimes
indicates that the p rogram has been written or rewritten fro m the
ground up.
•

A change in the first decimal place ofa versio n number, such as 3.1 to

3.2, indicates minor revisions, typically accompanied by a few new
features. Most of the procedures you learned in using the original
version are the same, bu t there may be some new fea tu res. Bugfixes
(correctio ns to programming errors) and revisions to ensure compatibility w ith o ther software or new Mac models often are introd uced.
• Achange in the second d ecimal place of the vers ion number, such as
3.02 to 3.03, usually is reserved for bug fixes or maintenance releases.
You should not experience any fu nctional di ffere nce between t his
release and the previous release. This level of change also is sometimes
indicated wi th a letter rather than a number, such as 4.0B.
In general, you want to p urchase the most rece nt release of each p rogram.
There is little reason, for example, to b uy versio n 1.0 of a program if version
2.0 has already been released. Make su re that other applicatio ns you want to
use with the new product are compatible .

Locating Software Version Numbers
If you ever need to call a software manufactu rer's technical support li ne, you
will need to know the versio n of software you are using. The most reliable
place to find a version number is within the program itself.

There are two places to look. First, if you are already in the program (a good
idea when you call tech support), pull down the Apple menu and select
About (program-name). A dialog box appears and often includes the ve rsion number of the software you are using. You can use this same method
from the Desktop to find ou t the version number of the System software.
Figure 1.3 shows the About This Macintosh ... dialog box in System 7.
ii
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Figure 1 .3 The version of the System appears in the box.

NOTE: If you are running System 6, the equivalen t men u option
is also located in the Apple menu but is called About the
Finder... . The d ialog box displays information about the version
of the Finder that is bei ng used, as well as the System version.
You can also check the Get Info dialog box of most programs to find the
version number of the program. Return to the Find er; click o n the program
icon; and select Get Info from the File me nu ; or press Command-I. Starting
with System 6, Apple provided a place in the Get Info box for software
manufacturers to record the version number.
Many programs display their version number in the splash screen that is
presented when you first start the program . You need to be quick to see it,
though, because most splash screens disappear automatically after the
program has loaded .

Read This First!

Most files within the System folder-including desk accessories (DAs) , Control Panel devices (C DEVs), and extensions (INITs)-also contain version
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numbers. OAs freque ntly display th e numbe r when you launch them or in an
About ... menu command. Extensions generally display the version numbe r
in the Get Info dialog box. Some Co ntro l Pane l documents show the version
numbe r on the ir screen in the Control Screen.
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Deciding When To Upgrade Programs
Besides making it easie r to work with technical support, there is a practical
reason for checking ve rsio n numbers and making a note of th em as they are
announced in ads and magazine articl es. Ve rsion numbers let you know
when it is time to upgrade your software.

T
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If you aren' t havi ng problems with a program-such as features that do n 't
work, incompatibility with essential desk accessories o r INITs, or unexplained crashes-you safely can ignore a change in the second decimal place
o f a version numbe r. Because new features often are not added in such versions, you will not need to buy or request the update. However, if you are
experiencing trouble with the software, it's worth calling the software manufacturer. The new vers ion may solve your problem. Many softwa re companies
are happy to send you a copy of"fixes," and ofte n they a re free.
Do you need a new version if the number has changed in the first decimal
place? Maybe. Such a change (3. 0 to 3. 1) indicates a minor revision and may
contain some useful new features. Check with the company, read reviews, or
watch for magazine ads and direct mail pieces th at describe the new features.
If they sound u seful, it may be worth the price of the upgrade. Keep in mind,
however, that this is an interim version ; something to tide users over until
the next big upgrade is re leased. If you wait long enough after 2.2 has been
announced before buying or upgrading to it, for example, it's distinctly possible that you will get hit with another upgrade fee when 3.0 rolls aro und .
Some companies give you the next upgrade for free if you have purchased
the product or upgraded within 30 days o f a new re lease of a ve rsion . It is a
good idea to check the company policy before o rdering a n update. Howeve r,
do n 't expect the manufacturer to te ll you that a new version will ship next
week. Few companies pre-announce release dates.
If you are part of a larger organization, the decision to upgrade may be out of
your hands. Large companies seldom can affo rd to support five versio ns ofa
product, sou pgrade decisions may be made o n a company-wide basis. Still,
the above discussion may give you an idea of whether you are missing something whe n a new version of a program is a nnounced.

Selecting System Software
When you purchase a new Mac, it is bundled with appropriate System software. Time marches on, however, and it may no t always be clear which new
versions of System software are compatible with your machine or which
version is best co use.
While you are determini ng whether you are running the most up-to-date
version of the System software your Mac can support, you also may be interested in where your Maci ntosh falls in the grand scheme of things. The
models that are still being shipped by Apple-as of this writing-are the Ilci,
Ilsi, IIfx, LC, Classic, Classic II, Quadra 700 and 900, and the three
PowerBook models (100, 140, and 170).
For those ofyou who own older Macintosh models, your biggest decision
will be determining if-or when-you need to move from System 6 to
System 7.
System 7 offers a host of new features, such as file and program aliases
(stand-ins for folders, disks, files, and programs), virtual memory (using your
hard disk to supplement your Mac's RAM), file and program sharing over an
AppleTalk network, improved font and desk accessory manage ment, balloon
help (pop-up help balloons in the Finderand programs), publish-andsubscribe (automatic u pdating of documents whenever a supporting document changes) , and TrueType fonts for che screen and printing.
The biggest consideration when deciding whether to install System 7 is the
availability of system memory. For System 7, you need a minimum of2M of
RAM for it to run. Because MultiFinder is on permanently in System 7 (allowing you to run several programs at the same time), you will be happier if you
have at least 4M of RAM. On older systems, you may need to install more
memory.
On the down side, not all programs are currently compatible with System 7.
As is the case with any new System software for che Mac, you w ill need to
upgrade many ofyour current programs, or discard them if the manu facturer
d oes not intend to provide a System 7-compacible version. However, u pdates
often are evolutionary. Some initial updates will simply make the program
compatible with System 7. Later updates will go farther and actually take
advantage of the special features of System 7. To determine whether your
favorite programs w ill have problems, the System 7 software includes a
HyperCard stack called Com patibility Checker that you can use to check your
programs for basic comparability problems.

Read This First!

Yo u can obtain new versions of System software- withoutdocumentationfree fro m user groups, computer bulletin boards, and information services. If
you have a friendly Apple-authorized dealer, he may be willing to let you
copy the necessary disks. If you feel more comfortable with a manual in
hand, you can purchase System software-along with the supporting documentatio n-from any Apple dealer.
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If you upgrade to a new System version, be sure to use the Installer program
to change all th e system compo nents. The System and Finder files now are
always upgraded togethe r. Printer drivers (such as LaserWriterand
LaserPrep) and other sys tem components (such as t he extensions or
AppleTalk drivers) may change with a system upgrade.
Since the introduction o f System 7, Apple has released several Tune-Upsminor bug fixes-and maintenance releases for the System software. When
run, a Tune-Up upgrades your System software automatically.

T
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Templates
any-perhaps most-computer users have no interest in becoming
computer experts. Acomputer is simply another tool for getting a job
do ne. Unfortunately, doing computer tasks often means that you will need to
lea rn how your programs work in-depth-learning what each feature does,
how to set configuration options, and so o n. For those of you who are more
interested in getti ng the job clone rather than getting intimately involved with
your software, dozens of templates are included with this book. Each template enables you to accomplish a useful busi ness task by simply plugging in
your own text or d ata.

M

Atemplate file is a master file used for its o rganization or structure, but not
for the information it contains. To actually use a template file , a copy of the
template is made and that is what you modify. Templates are tightly tied to
th e program in which they are created. In some cases, however, you may be
able to open a template file in a similar package (many word processing
programs read Microsoft Word documents, for example). lfyou decide to use
the template, make sure you save a version of the template in its o riginal
format.
The disk included with this book contains many templates designed to
supplement the text. As each template is introduced in the book, you will be
given instructions for using and customizing the template. Of course, you are

not required to open o r use the templates. But doing so will give you a better
understanding of h ow you r programs work, as well as presenting you with a
finished business task-one that you can immediate ly put to work for you.
The organization of the template files and instructio ns for accessing them are
contained in Append ix E, "Using the Enclosed Disk." After you copy the files
to your hard d isk drive or co a different floppy diskette, feel free to experiment. The o riginal masters remain safe on the distribution disk.
As you become more famil iar with the products you want to use, you may
want to develop templates of you r own. For many, the tem plates that come
with this book will serve as a launching pad for designing your own personal
products. The most im portant rule when you use a template is to avoid accidental changes to the original file.
You can protect templates in severa l ways. The goal is to strike a balance
between making the template easy to access and difficult to change. The
approach you use depends on the System version you are using and how
comfortable you are in worki ng on the Desktop.
The least effective approach co protecting your Template is to include it
(or some other recognizable te rm) as part of the file name and try to train
you rself to always u se Save As ... to create a new version of the file. Th e p roblem you run into is that it taki;s only one mistake to save a new fik: uvc::r the::
original and overwrite the template file. The advantage to this method is that
u sing a template can be accomplished entirely from within that particular
program. There is no need to ever work with the file on the Desktop.
Some programs offer commands that he lp you manage te mplates.
PageMaker, for example , contains a special Template o ptio n when saving a
file. If you save the file as a template, when you reopen that particular template, a copy of the original file opens automatically. Microsoft Word 5 and
many other new programs provide an option tO save documents as stationery files. Whenever you ope n s uch a file, Word generates a new copy of it
named Untitle d chat you can ed it as needed.
In all versions of the System, you can lock a file tO prevent changes. You can
do this by selecting the Get Info command from the File menu on the Desktop. To lock a file , follow these steps:
l. Save the file in wh ic h you are working and quit from the program.

2. Return to the Finder.

3. Click o n the icon of the document that you want to protect from
c hanges or the document you want to make a template.

Read This First!
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4. Select Get Info from the File menu or press Command-I. The Get Info
dialog box appears.
5. Click on the Locked check box in the Get Info dialog box.
The file is now marked by the system as t·ead-only. When you open the file,
you may be advised that no changes can be made. When you attempt to save
the file using the Save command, the program acts as if you selected the
Save As ... command and prompts you auto matically for a new file name. To
make changes to the locked template, you must unlock that particular file
from the Desktop. Simply follow the preceding steps, and click on the
Locked check box to toggle off the protection.
System 7 offers another o ption. You can use the Get Info command to
change the file to a stationery pad. lf you open the file you will either be
prompted to give the file a new name immediately, or the program will create a new document called Untitled that you can edit as you wish.

NOTE: In programs that do not support stationery pads, opening a statio nery pad from within the program will open the
original document, rather than a copy. If you do not want to
change the original file, be sure to save it under a new name.
It is a good idea to make a backup copy of all of your templates. The simplest
approach is to use a floppy diskette to hold a copy of the files . Drag a copy of
the template file onto the diskette and you have a spare copy. If you need to
restore the template, you can copy it back o nto your hard disk from the
floppy diskette. For mo re information on file backups, seeAppendix B,
"BackUp Basics."

Macintosh ••Truths••
ust as you don't need to know how to build a toaster in order to make
breakfast, you should n't need to become a programmer or engineer to
accomplish tasks with a computer. \Vhen compared to the older DOS environment, the Macintosh is a user-friendly computer. The desktop metaphor
with its file folders and trash can is very inviting, particularly when compared
to a text-based operating system.
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Perhaps nothing speaks so strongly of the success of the Macintosh approach
as the success of .Microsoft Windows, which brings a similar graphical interface to IBM-compatible computers. Almost everything said about the
Macintosh is now true about Windows. Fortunately for those who made a
commitment to "the computer for the rest of us," Apple has stayed one step
ahead and continues to add features not yet available in Windows.
Consistency between programs is a Mac hallmark and a key element in the
ease-of-learning and ease-of-use associated with the Macintosh environment.
Apple designed stringent guidelines for software developers to ensure that
Macintosh programs act in a predictable fash io n. Common menu items are
always present and consistent from one program to the next. As an example ,
most Mac programs contain an Edit menu that includes Cut, Copy, and
Paste options. After you know how to use the Cut command in one program,
you know how to use Cut in all programs. Similarly, clicking, double-clicking, and dragging with the mouse work the same across programs.
Text-based applications for the IBM PC, o n the o ther hand, present a variety
ofuser interfaces. Within the DOS environment, learning how to use one PC
program may teach you virtually nothing about how other programs work.
Even an operation as basic as saving a data file to disk varies widely among
IBM programs.
After you cross the hurdle of mastering the basic mouse actions, the Mac
approach provides immediate benefits for new users. Because of the consistent interface, subsequent training time is reduced considerably. When faced
with a new program-regardless of its type-you find that you can perform
basic operations witho ut opening the manual. Unfortunately, these face ts of
the Mac and Mac programs lure many users into a false sense of security.
After all, how could anything go wrong with such a su perbly designed machine and easy-to-use software?
To avoid disappointment and disastrous data loss, it's important to learn a
few awful truths about the machine and the software you have chosen to use.
Armed with this information, you will be in a better position to understand
and deal with the problems that can arise.

Truth # 1: The Mac Is Not An Appliance
Yes, you were able to make toast the first time you plugged in the toasterand you d id n' t even open the instruction booklet. Friendly or not, you will
not get along well with the Mac unless you learn the basics. You need to
master mouse operations, learn how to create folders and new fil es, use

Read This First!
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disks, operate your printer, and more before you can be productive. No, you
do not need to learn how to program or dismantle the machi ne with your
eyes closed, but you do need to acquire some basic knowledge about the Mac
and its operating system. If you don 't, you will be on the phone to your
dealer or the software manufacturer every time you buy a new program o r
something minor goes wrong. The advantage co the Macintosh way of handling things is that after you master these skills, you can use them in each
and every program .

Truth #2: Developer Guidelines Are Not
Laws

T

Nothing is cast in scone. Even though guidelines exist, Apple does not certify
new programs nor does it insist that developers adhere to the guideli nes.
After you run a handful of popular Mac programs, you will quickly recognize
those programs that offer "a better way of doing things"; that is, those programs in which parts of the developer guidelines have been ignored.
Many developers think they can improve the Mac interface. They may be
right; they may be wrong. On the plus side, when developers create new
ways of doing things, new standards evolve-benefitting all users.
Each user needs tO determine whether the usefulness of the program out·
weighs the hassles of the inconsistencies . Some changes are additions tO the
inte rface . Many Microsoft programs, for example, close a dialog box auto·
marically when you double-click on a radio button. Because you don'thave
rouse such features, they shouldn't interfere in your normal way of doing
things. Other changes can be shocking when first encountered. Although the
Command-S keyboard shortcut is usually reserved for saving the current daca
file, for example, some programs are configured so chat Command·S im plements a Sort procedure. The learning curve is steeper for mastering those
programs that do nor follow Apple's guidelines.

Truth #3: All Software Has Bugs
Bugs are programming errors made by the creators of a program. In many

cases, they're trivial. Such bugs may be a nuisance and an inconvenience, but
they are easily overcome after you identify chem. If you find that a particular
command does n't work, fo r example, find another way within the program
tO accomplish the same task. This strategy is called a work-around and is an
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importanc survival skill when facing a critical deadline. Some bugs, however,
can be disastrous. The cursor may freeze, o r a system bomb o r crash may
occur, forcing you to restart your computer. In the worst case scenario, precious data files may be damaged or destroyed.
Bugs are unintencio nal. No developer wants unhappy customers. Unfortunately, no matter how long and hard a developer tests a program before
releasing it, some bugs will remain. In general, the less ambitious the program, the fewer bugs you are likely to encou ncer. From a programming
standpoint, some bugs simply aren 't worth eliminating. Some bugs arc; extremely rare, exhibiting themselves only when a specific, unusual combination of keys is pressed. Correcting such a bug can cause another part of
the product to "break. " For a developer, ridding a program of such a bug can
present a greater risk to the product than simply leaving it alo ne.
Another type of problem that can have the same impact as a serious bug is an
incompatibility. An incompatiblity results when two programs (or a program
and a System file, such as a DA o r an !NIT) are not able to co-exist o n the
same machine. Occasionally, an incompatiblity appears because no one
thought to develop a standard before the problem arose (or they chose to
ignore standards that already exist within the developer guidelines). Often
times, the more sophisticated and up-to-date your system is, the more likely
you are to encounter incompatiblity problems with older utilities and applications.
Not to be confused with bugs and inco mpatibilities are design decisions.
Design decisions are specific decisio ns made by the software manufacturer
about what a program will do and how. In creating a program, the developer
also must decide what features not to include . Simply put, the absence ofa
feature is not a bug. It's just a disagreement between developer and customer about what is important. On an o ptimistic note, if enough customers
address the issue, the feature is very likely to show up in a later ve rsio n of the
program.
Similarly, typos in the manu al o r errors in describing how a feature works are
no t bugs. They're just mistakes, frequently caused by last minute changes to a
program. When discrepancies like this occur, most manufacturers make a
point to include an errata sheet with the manual or a READ ME text file that
explains the last minute changes, additio ns, and deletions.
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So what do you do about software bugs and incompatibilities-now that you
know they occur?
•

If the problem is repeated consistently, most manufacturers wane to
hear about it. When reporting a bug, know the version of the software
you are running, the version of the operating system, and the type of
hardware you use. Until someone lets the manufacturer know about
the problem, they will not know that they need to fix it. Developers
may not be able to offer an immediate solution, but they generally
make an honest effort co ensure that the problem is corrected in the
next release.

•

If the problem comes and goes, experiment to see if you ca n figure out
what seems to be causing it. Technical support can help o nly if you can
describe the problem well enough for them to identify it.

•

If the bug is serious eno ugh co cause data loss, b ring ic to the
developer's attention immediately. Ifie really is a bug, chances are
good that they are aware of it and are working on a solutio n. If it isn' t a
bug, the developer will probably be able to tell you what you are doing
wrong.

•

lfyou have an incompatibility problem (and you are able co pinpoint
the two conflicting programs, DAs, or IN!Ts), one of the manufacturers
involved may have a revised version that corrects the problem. If they
cannot fix it, you may need to stop using one of the programs or use it
under restricted circumstances.

T
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You can minimize the number of incompatibilities in your system by
following a simple rule: Install slowly. Most users begin using just a
few programs and utilities. Use the software for awhile and keep track
of the problems you experience . Ifeverything is running smooth ly, feel
free to add another new program, DA, or !NIT.
•

For things in a program that you simply don't like, try writing a letter
to the customer service department in care of the manufacturer. At
worst, you r suggestions will be ignored. However, you may end up on
the beta list as a test site for the next version.

Unfortunately, software follows its own versio n of Murphy's Law. You may go
mo nths without a problem then suddenlyencountera whole rash of irritating mishaps. When this happens, try to identify what yo u are doing d ifferen tly. If you just installed new software, try removing it and see if the
problems stop. Jfso, you probably have an incompatibility problem and

should contact the developer of that particular software for suggestions or a
revision.
If you are trying a new procedure within a program and experience problems
in getting the program to function, contact the technical support staff for that
program. Keep in mind that most technical support people are trying to help
you, but they need you to provide the necessary information. If at all possible, when you make the call, be at your Mac with the problematic program
on-screen. You must be willing to be the support person's eyes, ears, and
hands when experimenting with the system and tracking down the problem.

Truth #4: Hardware Can And Will Fail
As expensive and elegant as your Mac and peripherals are, they are really just
electronic devices. Even ifyou clean them faithfully and protect them with
surge protectors, they will eventually break down. If you are lucky, the part
that fails will be inexpensive to replace, and its loss will not be accompanied
by a loss of data, too.

Think of your Mac as you think about any other electronic office device, such
as a photocopier. Plan for breakdowns rather than an uninterrupted string of
luck and you will be happier in the long run. For suggestions on how to
protect your equipment, see Appendix C, "Protecting Your Investment."

Truth #5: There Are Some Bad People
Out There
But you undoubtedly know this. Unfortunately, in the computer arena, the
actions of a few people can have far-reaching consequences for computer
users everywhere. Those with the most far- reaching negative impact are those
who create viruses. Avirus is a piece of computer code that, like a bacterial
virus, invades the body ofa computer and infects various parts of its software-damaging the System file or altering programs you run. Minutes, days,
or months later, you may find th at your Mac is bombing frequently or that
data files are being destroyed.
The sole purpose of a traditional virus is to infect and spread. After a program is infected, running that program activates the virus. Any other
programs run during the same computing session also can be infected. Insert
a floppy diskette in the drive, store data on it for a friend , and that floppy can
become infected as well. Pop it into another Mac, and the infection continues
to spread . Now your problem is your friend 's problem, too.

, ... -
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Read This First!

Like it or not, it's smarter to be concerned about virus protection and detection than to assume you will be lucky and unaffected. Although it may sound
li ke a joke, you need to practice safe computi ng. Buy an anti-virus program
and use it religiously: (a) to scan every floppy diskette before you copy its
con tents to your hard disk drive ; and (b) to periodically check you r hard disk
drive, System file, a nd Desktop to ensure they are not infected. Fortunately,
you can eliminate many viruses even after your computer is infected. See
Appendix C, "Protecting your Investment" for more information about virus
protection software.

NOTE: Frequent system crashes and bombs are not necessarily
the result of a virus. Having and using an anti-virus program,
however, will enable you to determine those rare instances in
which a virus really is the cause of your problems.

T
Q

Summary
ow th at you know th e basics, feel free to skip directly to any chapter
that captures your interest. Each chapter is self-contained; everything
you need to know about the topic is presented within the chapter. Be certain
to take a peek at the Appendices, too. You'll find helpfu l information concerni ng hardware and software troubleshooting, a discussion of software a nd
hardware add-ons that can help protect your equipme nt and darn, instructions for connecting SCSI devices to the Mac, and a table of co ntents for the
template disk.
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Working with
Words
Who needs a word processing program? Everyone. Word processing programs are the computer applications that bind us all together. Everyone
writes. Regardless of what business and department you are in, letters,
memos, notes, faxes, and reports must be written. Although word processing
programs cannot write for you, the programs ensure that what you write has
a professio nal appearance-free from spelling errors and white-out.
This chapter examines the basics of word processing. Beginning with comparing the advantages of word processing programs versus the typewriter, it
discusses using standard template documents for business correspondence
and tools you can use to add power to your current word processing software. This chapter also discusses the following items:
• Advantages that make word processing programs critical fo r
business.
• Style sheets that can improve the appearance of your
documents.

T

• Standardized templates that can simplify the
production of business correspondence.
• Various word processing tools that can help
you improve your writing.
This and the following chapter ("Getting the Mail
Out") show you how to make short work of several
routine word processing tasks. Routine, however,

/

does not imply that the tasks are trivial or immediately obvious co everyone
who sits down in front of the computer. Instead, they are tasks that you probably want to perform with a word processing program but may not know
how. The following templates are included in chis chapter:
• An awards certificate template
•

Two fax form templates

• Two letterhead templates
Instructions are provided for using the cemplaces and for modifying them
to meet your needs. Although the templates were created with Microsoft
Word 4 and MacWrite II, don't feel left out if you currently own or use a
different word processing program. You can recreate the templates with most
major Macintosh word processing programs, including Microsoft Word 5,
WordPerfect, Nisus, WriteNow, and Taste.
The chapter concludes with mini reviews of che following useful word
processing cools:

'Sl

•
•
•
•

•
•
•
•
•
•

LetterWorks
QuickLetcer
Letter Writer Plus
RighcWriter
Sensible Grammar
Gram •mac •ikMac
Acta 7
DocuComp
Thunder 7
Instant Update

Word Processing Programs
Versus Typewriters
efore you bought your shiny new computer, you probably used a typewriter for writing tasks-especially for business correspondence and
addressing envelopes. Although crude in comparison, the typewriter has a

B

few advantages over a computer program. First, the typewriter is immediately
accessible. Turn it o n, insert a piece of paper, and you are ready to go. Unlike
th e Mac, you don 't need to wait for a typewriter to complete its boot
sequence and then launch a word processing program. Depending on the
speed of you r Mac, this can take from o ne to several minutes. Printed output
from most typewriters is immedi ate. You already are working on th e final
output medi um-a piece of paper. You perform computer work o nscreen,
and then you must print the document as a separate step. Un less you buy a
printer that can print e nvelopes, addressing envelopes also is easier on a
typewriter. Finally, completing forms can be quite a challenge using a word
processing program. However, as discussed be low, the advantages of a typewriter are mo re imagined than real.
Most busi ness users turn o n their Mac in the morning and leave it on until
it's time to quit for the day.Just as you don't turn on a photocopier each
time you want to make a copy, you don' t turn on your Mac every time you
want to use it and then turn it off the moment you are finished. Although
printed output is not instantaneous when you use the Mac, it is close
enough. Most laser p rinters, for example, can print between four and eight
pages per minute. Even an ImageWriter dot-matrix printer can print a page in
less than a minute. That's not too long to wait for a perfectly printed page! If
you buy a printer that can print envelopes (most laser printers and inkjet
printers can do this), you can address e nvelopes using the Mac as easily as
you can using a typewriter.
Learning to use a word processing program (even o n a Mac) takes longer
than learning to use a typewriter. However, the payoffs are well worth the
investment of time. In fact, the advantages of using a word processing program are so numerous and substantial that it's hard to imagi ne doing without
once you've used one .
Some of the advantages are the results o f using the computer rather than
paper and pencil. Because you can save documents o n disk, for example,
you can print as many copies of the original document as you need, and if
necessary, you can reprint the document six months or six years later.
Also, electronic storage takes up significantly less space in your office than
the equivalent informatio n o n paper.
You have eve n more advantages because you are using a standardized
Macintosh program. Like other Macintosh applications, word processing
programs enable you to cut and paste text and graphics to your heart's
conte nt. Moving a paragraph, sentence, or an entire section to a different
locatio n is a simple matter. You can rearrange words to say exactly what
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you mean. Furchermore, because ic's so easy to move informacion becween
different Macintosh programs, your documencs also can contain data
from spreadsheet programs (such as a quarterly budgec reporr) , bar or pie
charts from business graphics programs, and illustrations from drawing or
painting programs.
Because word processing applications allow you to manipulate text, it's easy
to improve your document. Making a minor revision is no longer a major
headache. When you use a typewriter, deleting a paragraph from che middle
of a report may force you to retype the last half of the report. When you use a
word processing program co delece cext, the program closes u p che space
automacicallyand then repaginates the document. Un like using a typewriter,
you never need to retype after you move cext.
The strength of cechnology provides even more ad van cages. When you use a
laser printer, for example, you have almost to cal control over the appearance
of you r document. Even without the added powerofdeskcop publishing (see
Chapter5, "Making a Point"), Macintosh word processing programs provide
great flexibility. Typewriters often are limited to a single character style-the
typeface that is etched in the key tops. When you use a word processing
program, changi ng a fo nt (the electronic version ofa typeface) within a document is as easy as highlighting text, and then selecting an option from a
program menu. Coupled with a laser printer, your documents can appear
as polished as typeset material.
In additio n to the preceding features, most word processing applicati ons
include a variety of wricing tools. You will have a hard time finding a commercial word processing program that does not concain a built-in spell checker.
Running a spell check before printing assures you of catching all typos and
misspellings. (No more white-our!) Some word processing programs also
concain special-purpose dictionaries that enable you co check the spelling of
medical cerms, legal terms, or foreign languages. Afew programs even include thesaurus o r grammar-checking functions. Jfyou need a litcle help wich
yo ur writing style, choice of words, formatcing, o r punctuation, many programs and utilities are available chat make these tasks easier. Refer to che end
of this chapter to read about some of the most useful word processing tools.
All these advantages are standard wich any Macintosh word processing program. You easily can master many tasks wich just a little experimentacion and
an occasional reference to the manual. However, remember that getting the
most o ut of a word processing program involves learning how to use the
program properly.

Word Processing Templates
s you use your word processing program , you probably will no tice that
you create certain documents over and over. More than likely, you develop-or must conform to-a particular style and design for business
letters, memos, and fax transmittals. Company standards dictate some formats, and other formats reflect personal style. After you settle on a particular
design and set of fo nts, you do not need to recreate the basic structure of a
document for each new letter, memo, o r fax you write. Because the computer allows you to create and store data, designing templates fo r
frequently-used documents makes good sense.

A

Most offices have a few basic formats that are used for all correspo nde nce.
These formats often contain elements that never change from one document
to ano ther. When you store these commo n elements on disk and use them as
a starting point for each new docume nt, you can save time and ensu re a
consistent appearance for your documents. The disk included with th is book
contains templates for several of the most commonly used business-correspondence formats. After you see the ease with which you can create and use
templates, you may come up with some ideas of your own.

Creating an Award Certificate
Everyone likes to be appreciated. Providing official certificates or awards is a
great way to reward outstanding contributio ns. Although not a part of everyday business, certificates can provide real mo rale boosts and are sim ple
enough to demonstrate the bas ic ideas for customiz ing templates.
The Award template is a MacWrite Il document. If you use a different word processing program, you still may be able to o pen the file.
Even if you have difficulty reading the file inyourword processing
program, you should easily be able to recreate the template. Note the margins that appear in figures 2.1and2.2 below, and that the template is
designed to print in landscape (wide) mode.
As you can see in figu re 2. 1, the template contains placeholders for each line
of text. You obviouslydon't wa nt to produce an award for "Award Title."
Instead, replace the placeho lders with the appropriate text. The replacement
text will automatically take on the font, style, and size that was originally
assigned to the placeholders.
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Figure 2.1 The Award template.
The steps you take to create the actual certificate are quite simple.
1. Determine what you wane the template to say. The example ce1tificate

simply says "Award Title." You may want to change this, for example, to
Employee or Managerof the Mont11.
2. InMacWrite 11, open the Award template (see figure 2.1).
3. Now you are ready to replace the placeholder text with your information. Simply highlight each placeholder and type the information you
want on that line. If the cexc spills to the next line, press Shift+ Return
to enter a new Line mark where yo u want the Line to break, or change
the te.>..1: in the line to a smaller point size so it will fit on one line.
Figure 2.2 shows t11e certificate with the new text.
Even though you use a template to provide a standardized format, ifyou are
creating a certificate, you may want to change its appearance to match the
personal style of the individual or the purpose of the certificate. To customize the certificate template, highlight text and select a new option from t11e
Font, Size, Style, or Fo rmat menu. If you are recreating the template in Word,
you may want to modify the style associated with that text. (Style sheets are
discussed in the "AWord About Styles" section of this chapter.) Figure 2.3

shows the certificate with a slightly more ornate look. This was acco mplished
by selecting the entire docume nt, and the n selecting Zap f Chancery fro m the
Font menu.
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Figure 2.2 The Manager of the Momh certificate.
Most word processing programs enable you to preview a docume nt before
you print it. Although MacWrite Il does not have a command specifically fo r
performing a print preview, you can select the Reduced Size command fro m
the View me nu to make the e ntire certificate fit onscree n. If you are using
Word 5, select Print Preview from the File me nu, or press Command-Optio n-I. Because the document appears o nscreen as it will appear when you
print it, this useful feature helps you avoid paper waste.

NOTE: Regardless of the word p rocessing program that you are
using, before you print the certificate, select Page Setup ... from
the File menu. Make sure the orientation is set to landscape
mo de (also referred to as "wide" or "horizontal") by clicking o n
the sideways Orie ntatio n icon, a nd the n select OK Finally, ma ke
sure you have p ape r in your printer, and then select Print from
the File menu.
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Figure 2.3 A more ornate award.
Besides owning a Macintosh word processing program, you need a laser
printer or a high quality ink-jet printer for churning out your certificates. (An
award printed o n a dot-matrix printer is not very impressive.) If you don't
o wn a suitable printer, look for a Mac-equipped copy shop where you can
have the certificate printed.
You also will need a supply ofcertificate paper. Certificates and awards usually are printed o n a heavy paper d1at is framed by a decorative color border.
(If the border on the certificate pape r you are using is larger man 1 inch,
make sure you increase all margins in the certificate proportionately.) Certificate paper is inexpensive, usually costing between 9 and 17 cents per sheet.
If you are unable to locate a box of certificate paper at your local computer
o r paper supply score, you can purchase it by mail from Intergraph ix Corporation (1-800-451-2515) o r Paper Direct (1-800-272-7377). To make the
award mo re official-looking, add a stick-on gold certificate seal in the space
above the date or signature. (You a.I so can purchase seals from Paper Direct.)

Creating Business Memos
Interoffice memos are o ne of the most commo n forms of business communication. Altho ugh business memos are in danger of be ing replaced by yellow

sticky notes attached to documents, a properly formatted memo conveys a
strong and professional image.
Figure 2.4 displays the Memo template that is on the disk. This template was created in Microsoft Word 4 and contains three sections: a
header, an address, and an area for body text. Like the Award template, you can simply load this document (or the tab-formatted version) into
your word processing program and add the information you want.
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Figure 2.4 The Memo template.
The address portion of the memo (To, From, Subject, and Date) is laid out
in two columns using Word's table feature. The column on the left contains
the address headings. You enter the address information in the right-hand
column. The template is designed so that the address headings in the left
column are bold and the address information in the right column is plain
text. This adds to the formal look of the document. The general heading of
the memo ("Memo") never changes. After you complete the address, click on
the lower portion of the memo and type the body text.
Nothing is sacred about the template. You can change any and all parts to
suit your needs. The easiest way to alter the formatting or font choices is
to change the Header, Header Info, and Normal styles. The Header style
controls the information that appears at the top of the form (the doubleunderlined "Memo") , and Header Info controls the address information.
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The standard address headers are bo ld (To:, From:, and so on) and the actual
address text is plain. Use Normal to format the body text (in this case, 12
point Times with one blank line following each paragraph). Basing your
tem plates on Normal style provides a method to ensure a consistent look
amo ng your documents.

TECHNICAL NOTE: If the program you use does
not provide a table feature, such as the table in which
the address section of the Memo template was laid out,
you can use tab stops to set the starting po int of the To:, From:,
Subject:, and Date: informatio n. (A template that uses tab stop
formatting also is contained o n the disk as "Memo template
(Tabs).") If you are unable to load the o riginal memo template,
try the Tab version instead.

Date Stamping a Document in Word 4
When you write a letter, trying to remember o r find the current
date can be frustrating. Many word processing programs insert
the current date in a docume nt automatically. lfyou use Word 4,
you can add a Date command to the Work menu to perfo rm this
task in a single action.
To add a Date command to the Work menu , follow these steps:
1. Press Command-K to access the Glossary dialog box.

2. Click o n the Date format you want to add to the Work menu. An
example of the date appears below the Name box.
3. Press Option +Command+= to activate the Add Command feature.
The cursor turns to a bold plus (+)symbol.
Note: You cannot use the symbols on the numeric keypad of the
extended keyboard to access the Add Command feature. You must
use the= (equal) symbol that is on the main part of the keyboard.
4. With the bold plus pointer, click o n the Date format you want. The
glossary definition you selected is added to the Work menu. Click on
Close to close the dialog box.
To date stamp a document, position the cursor where you want
the date to appear, and then select the Date format from the
Work menu (see figu re 2.5).

file Cdll r ormat ron t Document Utilities Window
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Figure 2.5 Date stamping a Word 4 document.
NOTE: If you have Word 5, it is not necessary to add the Date
command to the Work menu. It is already available to you in
Word 5's Insert menu. Any date you add with this command will
be updated automatically to the current d ate each time you open
the document. Dates you enter in Word 4 must be manually
updated wheneveryou o pen the document.
For date stamping to work correctly in any word processing
program, you must have the correct d ate set on your Mac. (If the
date is wrong, you can correct it in the General sectio n of the
Control Panel.)

Creating Fax Transmittal Templates
Many of us use a fax machine fo r business commu nications. Standard p reprinted transmittal fo rms, however, require that you type the informatio n
o nto the form or complete the form by hand. If the fo rm is in your comp u te r,
you can handle fax info rmatio n the same way you deal with other business
correspo ndence and writing-using your Mac!
Figure 2.6 shows how the template appears when you first open it.
The upper portio n of the template is composed of two tables. (If
the cell gridlines d o not appear when you open the d ocument in
Word 4, select Preferences from the Edit menu, and click on the Show
table gridlines check box. lfyou are using Word 5, select Preferences from
the Tools menu, click on the View icon, and then click on the Table
gridlines check box.) Because each cell in a Word table can contain a separate alignment (left, right, centered, o r justified), tables make it easy to align
text the way you want.
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Figure 2 .6 The Fax Form template before customizing.
The Fax Form template combines features from the Award template and the
Memo template. Placeholders ind icate the company address. The recipient
address and body text of the transmission are blank and will be replaced
by the actual information. After replacing the placeholders with your logo,
company name, and address, you need only fill in the recipient's address
information and insert new body text each time you want to send a fax.
To personalize the template, replace d1e d ummy company address with your
address. Place your company logo o r another suitable graphic, such aspicture of a telephone or fax machine in the le ft side of the top table. (If you
have a company logo but it is not saved as a graphic, see Chapter 5, "Making
a Point" for help.)
After you replace the placeholders and make any desired formatting changes,
save the file using a new name. There are two main ways to prevent your new
version ofthe template from being altered inadvertently.
1. Lock the file.
Return to the Finder desktop, use the Get Info command (discussed in
Chapter 1, "Read This First!"), and click on the Locked check box. To
save edited versions of a locked file, you must use the Save As ...
command to save the file under a new name.
2. Make the template into a stationery document.

If you are using Syste m 7, you can make a stationery file o ut of any
document by clicking o n the Stationery Pad check box in the Get Info
box; System 7 w ill t he n prompt you for a new file name, o r create a
name for you, whenever you ope n the docume nt. lfyou are using
Word 5 o r ano the r word processing program that supports its own
version of statio nery docume nts, you can select Save As ... from the
File menu and choose Station ery as the file type.

If you use a fa,x machine, using a standard fax fo rm is a real time-saver. lfyou
use a fax modem, this has even more advantages. Similar to a data communicatio ns mode m, you use a fax modem to send documents stored on your
Mac, such as a fax form, only the d ocuments are sent to a fax machine just
like a regular fax. You d o not need to print out the form, and then carry it to
your fax machine. You can complete the e ntire process o n the Mac.

Font Selection for Fax Modems
To e nsure that your fax transmissio ns are legible , you must use
care when assigni ng fonts to the Fax Form te mplate and to o the r
d ocuments you wa nt to transmit. Unlike a printer, a fax mode m
normally uses screen fonts to produce the output. Whe n translating your docume nt into fax format, the fax software tries to
compe nsate for the d iffere nce in resolution between the screen
and the receiving fax machine. Each fo nt tha t appears o n the fax
is created by taking a fo nt that is precisely th ree times the size of
the font that appears o nscreen, and then scali ng it back down . If
you format the e n tire docume nt in 12 poin t Times, fo r example,
the fax software replaces the 12 point Times in the transmissio n
with 36 p oint Times. If the software d oes no t find 36 p oint
Times, it creates t he fon t size by rescaling the bitmapped 12
point Times screen fo nt. Un fortunately, whe n a bitmapped font
is rescaled this way, it can appear jaggy a nd distorted .
To avoid this proble m and e nsure crystal-clear transmissio ns, use
True Typ e fo n ts, Ad obe Type Man ager (ATM) fo nts, o r select o nly
fonts fo r which you also have a trip le-sized screen fo n t.
Finally, if you are using Word 4 o r 5, click on the Fractional
Widths check box in the Page Setu p .. . d ialog box. Although the
onscreen text may look a little o dd , using th e fractional widthsoption improves the spacing between le tters and words in fax
transmissions.
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To use the existing template with a fax modem, you need the 12and 36- point size fonts ofTimes, Helvetica, Helvetica Oblique,
and Helvetica Bold. lfyou have a different font in the proper
sizes, you can change the styles in the Fax Form template.

NOTE: If you intend to use the template with a standard fax
machine rather than a fax modem, the prior font restrictions do
not apply. Because everything o n the page is treated as a graphic,
you can use any fonts that look good when printed on paper.

Creating Custom Letterhead
If you don't have company letterhead, you can inexpensively create
your letterhead on the Mac and save it as a template. When you
print o n high-quality bond paper using a laser printer, you r letterhead can look as good as custom printed letterhead.

00

There are many possible styles for company letterhead. The arrangement of
company name, address, pho ne number, and logo ranges widely. An easy
way to choose an attractive, suitable layout for letterhead is to save incoming
business letters. Find an arrangement you like and replicate it. This section
provides two samples created in Microsoft Word to get you started. Each
template uses date stamping and places the return address information in the
header and/or footer so that it remains out of the way. Each template also
includes placeholders fo r the customer/client address and salutation.
In the firs t example, the header contains your name, title, and
the current date (see figure 2.7). The footer contains the company
name, address, and phone numbers for voice mail and fax transmissions. If you are using Word 4, select Open Header ... or Open Footer...
from the Document menu. If you are using Word 5, select Header or Footer
from the View menu to access the information in the headers and footers.
To customize the template, enter yourown name and title in the ''Your Name
Here" and "Title" lines. You also should insert your own company and address informatio n in the foo ter. The footer is centered on the page, and each
bullet is separated from the surrounding text by two spaces. You may want to
change the bullet spacing depending on the length ofyour company name
and address. You also can use the menu commands to change the font characteristics of the header and footer, as well as the body text.111e body text of

Letterhead 1 uses the Normal style (12 point Times, in this instance). The
h eader and foo ter use Helvetica and Helvetica Bold.
i

Frid•y. Hov.mbet 1S, 1991
Cu.st>mer Ne.me
Company

re"

Add

City, S1a10 Zip

o..r Home:

COWl'>Nf • ADDRESS · CllY,STATE ZIP ·

TB.EPHOHE:(SSS)~~

· FAX: ($SS)5S$.SSSS

• • Normal Para.

Figure 2 .7 The Letterhead 1 template in Word's Page View.
After you complete the template, select Page Viewfrom the Document
menu (Word 4) or Page Layoutfrom the View menu (\Vorel 5) to see the
e ntire page. When you are satisfied with the appearance o f the page, save the
template using a new name. Again, it's a good idea to protect the template by
using one o f the options suggested above for the Fax Form te mplate.
: he Letter~ead 2 ~Vo rd) template ~dds a to uch ofclass by includmg a graphic gradient bar (created m MacDraw Pro) beneath the
company name. This template does not use a footer-all the company address information appears in the header. To make it easy to align the
address sections (co mpany name, address, and pho ne numbers) in the
header, a Word table was used (see figure 2.8).
As with the Letterhead 1 template, to customize the template, you must open
the header and replace the dummy address informatio n with your address
informatio n. Then save the document using a new name and select a protection method.

Working with Words

~ File

Edit Formot

Font

Document

Utllltfes Window

lUork

Letterhead 2 (Word)

O

't

:1

'"

Company Name 1 ~. . . z•1

I Ttl(SSS}~ 1

1-

~""(m)m<S5'5

Pnte.y. November 15. 1991
p u:iotMrName

COmpMy
Add=

c uy, s..~z1p
Dear Harm.

k!}f{i}! Normnl+ ...

TJ

Figure 2.8 The Letterhead 2 template in Word's Page View.

That Extra Touch
Here's a trick that enables you to produce a letterhead with a
custom-printed appearance and still make changes to the letterhead as often as you want.
1. Buy a colored toner cartridge for your laser printer. (Many companies

that advertise laser-cartridge refilling services sell colored toner.)
2. Purchase a ream of quality laser-compatible bond paper that is a
lighter, complimentary shade of the toner.
3. Create a new version of the letterhead template and eliminate the date
stamp from the header, as well as the customer address and salutation
in the body.
4. Print several copies of the revised template onto the bond paper.
5. Remove the colored toner cartridge and replace it with a normal black
toner cartridge.
To use this letterhead, create your letter in a new blank document (rather than using the template) , and be sure to leave
enough room at the top or bottom of the first page to avoid
printing over the address information. Load the colored paper
that you printed in step 4 into the printer and print the document. If needed, you can use blank sheets of the colored paper
for additional pages of the document.

The Letterhead 2 template uses Normal style (12 point Times) for all body
text-including the date and customer address. The company name uses
36 point Helvetica Bold, and the return address uses 10 point Times.
Graphics can go a long way toward dressing up letterhead. You can use a
paint or draw program to create a graphic and add it to the header (li ke the
gradient bar in figure 2.7) . Your company logo is another item you probably
will want to add. See Chapter 5, "Making a Point" for more informatio n on
graphics. For add itional ideas o n graphics, look at the HyperCard art stacks
that came with your Macintosh, or browse through commercially available
clip art.

Using Boilerplate Text
Because many documents incorporate standard or boilerplate text that varies
little fro m one use to the next, you can use a variation of the template approach to obtain tremendo us reward s for very little initial investment. Wills
and other legal contracts are examples of do cuments almost entirely made
u p of boilerplate text. Inserting boilerplate text in documents makes it easy
to piece together the appropriate components for a tailor-mad e document.
Usi ng boilerplate text involves creating a series of individual documents that
contain text you are going to use repeatedly. It is a good idea to sto re t hese
d ocuments in an individual folder to keep them separate from actual correspondence. To create a boilerplate d ocument, ope n a new document, enter
cexc and format it the way you wane, and then save the documen t to the
folder that contains your boilerplates.
Copying and pasting boilerplate text relies on the capability of the Mac to
open mo re than one document at a time. When you reach a point in a document where you want to insert stored text, o pen the document that contains
the boilerplate text (leaving ope n the document in which you are working)
and highlight the text you want to insert. Select Copy from the Edit menu
and close the boilerplate document without saving the changes. In the current document, position the cursor where you want to insert the boilerplate
text and select Paste from the Edit menu. The boilerplate ttxt appears in chc
document in which you are working. You now can reformat or edit the
text as necessary. (Some word processing programs, such as Word 5 and
MacWrite 11 , contain an Insert File ... command that e nables you to achieve
the same effect without having to reso rt to cutting-and-pasting. Simply positi o n the cursor at the spot in the current document where you want to add
the bo ilerplate text, select the Insert File ... command, and then choose the
boilerplate file to be inserted.)
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Styles and Style Sheets
One of the most convenient features in word processing programs is the
capability to create and use styles and style sheets. In Microsoft Word and
most other word processing programs, styles normally apply to paragraphs
rather than individual words, and record Ruler settings (tab stops, indents,
margins, justification, and line spacing), as well as font options (items from
the Font and Format menus). Using styles ensures that similar paragraphs
within a document use the same format. For example, applying the same
style to each section heading enables you to make changes to all section
headings in a single step.
Suppose, for example, that you assign all section headings the Head 1 style
that is 24 point Times and flush left. As usual, headings are scattered
throughout the report. If you redefine the Head 1 style as 36 point Helvetica
and centered, all the Head 1 section headings will conform instantly to the
new definition. This single step certainly beats looking for and reformatting
each section heading individually!
Styles help maintain consistency in a document. If you formatted all the section heads as Head 1, the section heads will reflect any changes you make to
that style. If you apply styles to each paragraph and heading, you never need
to worry about odd formats creeping into your document. You can create
and modify styles in Word 5 using the Format Style ... dialog box (see figure
2.9). In Word 4, the command is Define Style ... .

Style sheets are a collection of styles you can transfer from one document to
another. Style sheets provide an electronic method for distributing suggested
formats and a way to maintain consistency in all correspondence.

TECHNICAL NOTE: As in most word processing programs,
Word 4 and 5 allow you to create a default style sheet that is used
to format new documents. However, only certain style names
(such as Normal, Heading 1, Footnote, and so on) are copied
automatically to a document from the default style sheet. After
you create a document, the style sheet in that particular document is independent from all other documents. Rather than
creating and redefining styles in each document you create, you
can import a style sheet from another document. 'l: o do this,
follow these steps.

Style: Citadel

n OK

•footer

J)

(Cancel)
( Apply )
normal-indent
Show: @Document Styles
Style:

O

INormal Para~

( HMirH1)
All Styles (Delete J

I( Use As Default J

Normal + Font: , Indent: Left 0. 13 in Right -0.63 in, Space
After 12 pt, Tab stops: 0 .38 in; 2 in Number Aligned; 4.5 in;
6.62 in

Based On:
NeHt Style:

18
18

INormal
~~~~~~~~~~~
INormal Para.

Figure 2.9 Word 5's Format Style .. . dialog box.
1. Open the document to which you want to import a style sheet.

2. Select Style ... from the Format menu or press Command-T. The Style
dialog box appears.
3. Select Open from the File menu or press Command-0. The Select a
Document dialog box appears.
4. Double-click on the document that contains the style sheet you want to
import. The style sheet imports into the document in which you are
working. (This may take a few seconds.)
5. Select OK to close the Style dialog box.
You can still apply character formatting (font characteristics, such as size and
type) to individual characters, words, or phrases within paragraphs. For example, you can make a word Helvetica Italic in a paragraph that has Palatino
in its style definition.
One of the wonderful things styles let you do is decide and use conventions
consiste ndywithout memorizing a series ofrules. Like many tasks you
perform with a computer, investing the time to create styles pays off by
simplifying a variety of tasks, such as making global changes and creating a
Table of Contents. Most major word processing programs for the Mac
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support styles. Learning how your word processing program handles styles is
a wise investment.

Word Processing Tools
he final section of chis cha peer reviews a variety of cools that can make
the word processing program you use more powerful. You can use most
of the tools discussed in chis section in combination with each ocher and with
most major Macintosh word processing programs.

T

For those situations where you need to use a simple word processing program in a hurry while working in another program, the QuickLeccer and
Letter Writer Plus desk accessories can handle the task without interrupting
the application in which you are working.
Whipping out coherent and to-the-point business letters is no t everyone's
forte. In special cases, such as legal letters, it's a waste of time to "reinvent
the wheel" because much of the language in th e document may be standard.
For co ncrete exa mples of business, sales, and legal letters, Round Lake Publishing offers three products in its LeccerWorks series: LetterWorks, Sales
LetterWorks, and Legal LetterWorks. LeccerWorks contains over 400 business
leccers. Sales and Legal LecterWorks p rovide 300 and 160 letters, respectively.
Most word processing programs enable you to check spelling, and some
programs even include a thesaurus that suggests alternate words. However ,
few programs go beyond this. If you need help with punctuatio!l and grammar, you may be a cand idate for one of the grammar checkers reviewed in
this sectio n (RightWriter, Sensible Grammar, or Gram• mat• ik). Other programs discussed in this sectio n provide o utlining tools, advanced spell
checking, and work-group word processing.

Word Processing With Quickletter and
Letter Writer Plus
QuickLetter is a full-blown word processing application that is written as a
desk accessory. To open QuickLetter, you can select it from the Apple menu
or double-click on the special QuickLetter icon. QuickLetter contains its
own menus, a ruler bar, and supports multiple fo nts and multiple open
documents. You can copy any graphic image into a QuickLetter document to
serve as a page header-enabling you to create your own letterhead o r fax

forms, for example. QuickLener also supports multiple address books and
can print envelopes and labels.
Unlike most DAs, Quick Letter does nor disappear when you close the document in which you are working. The Title window (see figure 2.10) remains
onscreen until you quit QuickLetter. The Title window is used to create new
documents, open files (supported file types include QuickLetter, QuickLener
stationery, MacWrite 11, Microsoft Word, and plain text) , print envelopes, o r
ope n a QuickLener address d atabase.

4311 East Sohan.. Las v eg.., IN 70213
fax • 70l ·U l ·S0'1 Phone .. 703·ZZ t ·S01D
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Version I 5 C> CopyrfQhl 1988- 91 Worki119Soflvare, Inc,
Thf.s ~tUtr ts JV"chut-d

tor uu on Ont M1eintosh.
Coc>ln must bt l>'O"ch....S f or
tKh MK~t01h on Yhich
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Figure 2 . 10 A Quickletter stationery document and the Title window.
Address databases in Quickletterare like those in most Rolodex-style DAs.
You can paste any address into a letter or use the address as a basis for an
envelope or label. Any address you copy to the Clipboard (in any application) can be printed as a Quickletterenvelope.
Quickleu er also allows you to:
• Add or change keyboard equivalents for menu options.
•

Center text vertically when printing.

•

Seta stationery document as the default document that opens automatically when you select New from the File menu.
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•

Specify the part of the program you want to o pen each time the DA is
invoked, such as a new document, an envelope, the Open ... dialog
box, or an address book.

•

Use date and time stamping capabilities.

•

Use "Smart Quotes" (curly quotes).
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While QuickLetter is good for letters, memos, and other short documents,
you probably will not want to use it as a permanen t replacement for your
regul ar word processing program. Features that are not offered include paragraph styles, tables, multiple ruler settings, and spell checki ng. However, fo r
those times when you can do without these feat ures, QuickLetter is a winner.
Letter Writer Plus is another word processing DA. Rather than using a menu
bar, Letter Writer Plus uses icons. When you click on an icon, Letter Writer
Plus performs a specific action o r displays a pop-up menu that lists menu
options. If you click on the Magnifying Glass icon, for example, the Search
and Replace menu appears. You can see a document created using Letter
Writer Plus in figure 2. 11.
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Figure 2.11 A Letter Writer Plus document.
Letter Writer Plus supports multiple fonts, sizes, and styles; provides a stationery feature that enables you to save documents as reusable templates; and
can print envelopes. Two features that set this program apart from other

word processing DAs are boilerplate text and mail merges. You can save to
disk phrases and paragraphs you use frequently as "standard paragraphs"
(boilerplate text) . When you want to insert a standard paragraph in a document, just click on the paragraph icon (11) and select the file name of the
paragraph from the File dialog box. Letter Writer Plus inserts the paragraph
in the document al the current cursor position.
Mail merges usuallyare possible onlyin full-featured word processing programs, but Letter Writer Plus offers a mail merge feature and the capability to
manage the associated data (see figure 2. 12) . Using the menus and merge
data document forms, n1rning an existing memo or letter into a merge letter
is a simple matter. After you select or create a data file, Letter Writer Plus
automatically lists the field names in the Merge menu . To insert field names
in a document, simply select field names from the menu or type the field
names surrounding them with standard delimiters (••»).You even can specify
a default entry for each data field.
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Figure 2.12 The merge feature in Letter Writer Plus.
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The Merge Preview option enables you to view a document that has actual
field data in place of the placeho lders. You also can use the merge featu re to
generate a series ofaddressed envelop es. You should note, however, that a
merge can concain a maximum of30 records. You must handle larger me rges
in multiple passes.
Letter Write r Plus is an extremely functional word processing DA; however, it
allows only o ne set of margins and tab settings per document, supports o nly
one open document at a time, and does no t include "Smart Quotes" (curly
quotes).

Creating Business Letters with
LetterWorks
Le n e rWorks, and its companion products Sales Le tte rWorks and Legal
Le tte rWorks, p rovides hundred s ofletters that cover typical business situations. Whe ther you a re responding to a customer inqui ry, no tifyi ng an
employee ofa promo tio n, creating a resume, or wri ting a letter to the zoning
commission, you will p robably fi nd a pro fessionally-written le tter o n the
topic.
You use all LetterWorks products the same way. The letters are provided o n
disk in a Text-o nly fo rmat that you can edit using any word processing program. Each Lette rWorks product comes wi th an exte nsive manual that shows
fo rmatted ve rsio ns of all t he le tte rs. After you locate the le tter you want in
the manual, you load the document into a wo rd processing progra m, change
the language as needed, add fo rmatting and fo nts, and the n print the lette r .
Some le tte rs, such as the contracts, will need little editing. The gen eral le tte rs, however, are more useful for their ideas and to ne rather tha n fo r the
actual words with which they are writte n. These letters show you how to
write a p articular letter ra the r than providing you with specific text.

Improve Your Writing with
Grammar Checkers
RightWrite r is a grammar-checki ng progra m that examines documents in
batch mode . After establish ing grammar-checking rules and selecting a docume nt, RightWrite r analyzes the docume nt. Whe n finished , the comme nts are
writte n directly into a ne w copy of the file . To finish the sessio n, you o pe n
the marked file in your word process ing program and make the changes you

want. Because RightWriter strips ou t the comments when you are ready, it
is not necessary to remove the comme nts manually while editing (see
figure2 .13).
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Figure 2.13 A document grammar-checked with RightWriter.
RightWriter appendsstatistics and a summary of its recommendations to the
e nd ofthe edited document. Scores for readability, strength, jargon, and use
ofadjectives and adverbs are included, as well as a frequency list of every
word used in the document. Docume nt types supported are MacWrite 2.2
through 5.0; MacWrite II l.Oand 1.1; Microsoft Word 3.0and 4.0; WordPerfect 1.0.0 through1.0.4; WriteNow 1.0, 2.0, and 2.2; and text files.
Sensible Grammar is another grammar-checking program. Acheck window
appears after you open the document you want to check. As Sensible Grammar scans the docume nt, potential grammatical and punctuation errors
appear in context. For each error Sensible Grammar points o ut, you can
correct the error by hand, accept one of the suggestions provided by the
program, mark the spot in the document, or ignore the recommendation.
Figure 2.14 displays the Sensible Grammar control screen.
When Sensible Grammar suspects a punctuation error, the program states
which grammatical rule is broken. You can correct the error simply by clicking on the Fix button. For grammatical or mechanical errors, the program
suggests o ne or more phrases to improve the sentence. To cycle through the
suggestions, click on the Suggest button. To replace a phrase, click on the
Replace button. If you want to make a change bu tare not enthralled by the
suggestions, just click on the Document icon and you can perform a standard editon che current sentence.
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Figure 2.14 The Sensible Grammar Checking Document dialog box.
As Sensible Grammar processes a document, you can edit the suggested
phrase groups, mark certain phrases as temporary exceptions (phrases you
wane Sensible Grammar co ignore), and add names co che Capitalized Exceptions group. Prior to beginning an analysis, you also can change the list of
grammatical and punctuation rules you want examined (see figure 2.15).
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Figure 2.15 The grammar and punctuation rules in Sensible Grammar.

Excessives are words, sentences, and paragraph lengths that exceed maximums you have set. Sensible Grammar tracks excessives in a separate window.
Readability and difficulty statistics also are provided for each document.

Supported file formats include MacWrite 4.5 and later; MacWrite II; Microsoft
Word 1, 3, and 4; Microsoft Works 1and2; Microsoft Write; PageMaker 1;
WordPerfect 1; WriteNow 1 and2; and text files.
Gram• mat• ik Mac combines elements ofRightWriter and Sensible Grammar.
You can check documents interactively or in a batch mode (see figure 2.16).
In interactive mode, as Gram• mat • ik Mac brings each potential error to your
attention, you can click on a b utton to re place the possible error with the
suggested correction, mark the problem, ignore it, or view additional help
about the violated rule. You also can click in the text window and edit the
document directly. Because the text shown is cumulative, you can clearly see
each phrase and sentence in con tex t.
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Figure 2.16 Interactive mode in Gram• mat • ik Mac enables you to deal with
each problem as it appears.
In batch mode, Gram• mac• ik Mac creates a new copy of the document that
displays the problems it marks. You can specify whether you wan t the marks
accompanied by comments and suggestions. Gram• mat• ik, like RightWriter,
provides an option that enables you to remove the marks fro m th e file.
After Gram• mac• ik analyzes a file, the usual array of scatiscics appears. The
program displays a series of bar charts that com pares your file to the
Gettysburg Address, a Hemingway short story, and an insurance policy. A
separate word profiler utility provides a list of words used in che document
and the frequ ency with which they were used.
Of the three grammar-checking programs, Gram • mat • ik is the o nly program
chat includes a spell checker. If you want to change the program to meet your

Working with Words

The 9-to-5 Mac

particular needs, you can edit the help screens and create your own grammar
rules. File formats that Gram• mat• ikMac supports include MacWrite;
MacWrite II; Microsoft Word 3 .0 and 4.0; Microsoft Works 1.1and2.0;
WordPerfect 1.0.1through1.0.3; WriteNow2.0 and 2.2 ; Rich Text Format
(RTF) ; and text files.

Outlining with Acta 7
Acta 7 is a System 7-savvy outliner program and desk accessory. You remember outlines, don'tyou? They were-for me, at least-an annoying tool that
high school teachers insisted you use to organize your thoughts for major
papers and projects. Surprisingly, as I have grown older (and have more
thoughts to organize), I have come to rely more on outlines and outline
programs. As outliner programs go, Acta is one of the oldest and best.
Outline topics are arranged using a family tree approach. "Sisters" are topics
at the same level as the current topic; "Daughters" are topics subordinate to
the current topic; and "Aunts" are topics of greater importance than the
current topic. A fully expanded Acta 7 outline of a draft of the contents of this
book appears in figure 2.17. See the figure for examples of the different levels.
Creating a new topic is as simple as pressing Command-W, D, or A- for a
new sister, daughter, or aunt. To collapse or expand a topic, double-click on
the hollow triangle that precedes the topic. (A hollow triangle indicates subsidiary points below the topic. A dark triangle indicates no further topics.)
Besides text, Acta topics also can contain graphics and sound. You can rearrange points by dragging them to a new location in the outline or by shifting
topics to the left or right.
You can assign numeric labels, Roman numerals, user-designated bullet characters, or no labels to topics. Acta 7 contains the standard Macintosh Font,
Size, and Style menus so that you can apply different fonts to particular
parts ofthe outline. In addition, the program contains a search-and-replace
feature that enables you to make changes throughout an outline. You can
print outlines that contain a border, page numbers, and a date stamp. System
7 features include Balloon Help, Publish and Subscribe, and support for
Apple events and TrueType fonts. Otheruseful features include Smart
Quotes, the capability to specify a default outline, and phone dialing through
the Mac's speaker or a modem.
Although you can perform most actions using the pull-down menus, you will
quickly memorize tl1e important Command-key equivalents. For example,
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Figure 2 . 17 An Acta 7 o ulline.
both the Acta 7 desk accessory and program allow you to open multiple
outlines simultaneously. Each outline is assigned a numbe r according to the
order in which it was opened . You can switch among outlines by pressing the
Command key and the o utline numbe r.

If you want to use an Acta 7 outline as che basis for a word processing document, or you want to provide a copyofche outline to someone who doesn 't
own Acta, you will appreciate the program's many Save As ... options: Textonly, mail merge fo rmat, Acta 2.0, MacWrite, ThinkTank, MacDraw 11, MORE,
WriteNow, Microsoft Works, and Microsoft Word (RTF). You also can save
each page as a PICT file which preserves the original formatting and enables
the file to be read by most graphics programs.

Comparing Documents with
DocuComp 1 .54
While DOS use rs have the COMP command and public domain utilities for
comparing different versions of docume nts, Macintosh users had nothing
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similar until the release ofDocuComp. Eve n something as simple as determining if two files are identical could only be done by examining the
information in the Get Info boxes of the files. What happens when you want
to get to the heart of the matter and determine what the specific differences
are between two documents?
DocuComp can compare any two word processing documents, text files, or
program listings and show you the d iffere nces. It is not even essential that
the files be created in the same program. DocuComp can read files created by
Microsoft Word 3 and 4, WordPerfect 1, WriteNow 1and2, MacWrite II 1.0
and 1.1, MORE II, and MORE 3. It also can handle program listings and ASC II
text files. When comparing documents, DocuComp ignores differences in
fo nts and style (bo ld, italic, and so on) ; it o nly compares differences in text.
To analyze docume nts from unsuppo rted word processing programs and
files generated in newer versions ofsu pported programs, you can save them
as Text-only files.
After you specify the two versions ofa file you wa nt to compare, DocuComp
displays the files in the Comparison Window (see figure 2.18). Insertions,
deletions, and moved text are indicated by special markings, font styles, and/
o r colors. Deletions appear as strike-thru text, insertions appear with underlining, and text you moved appears boldfaced. You can change the indicators
as you want. Saving and printing options include line numbers, revision bars
in the margins, font styles, and color.
As you move th rough the documents, they scroll in unison. You can move
manually or jump from one modification to the next by clicking on the Next
Change and Previous Change buttons at the bottom of the window. When
you finish examining the files, you can create a composite document that
shows all the changes, and then save the composite document in a particular
word processing file format or print it. The composite also can include comments you attach to the ftle and a revision list that explains each of the
changes. Figure 2.19 displays a revision list.

DocuComp is an excellent tool for documenting differences between successive versions of a fi le. Whether you are a writer working on a manuscript, a
lawyer who wan ts to illustrate recent changes to a con tract, or a programmer
comparing code segments, DocuComp is the program to use.

Ii File Edit Customize Search Help
Newer file line no.. 11
Ol der file line no.: 11
Test Sampl e - New
m

Stetus: Repl oced

This~ will demonstrate how DocuComp works. This

0;
page

IQ

is the sesond of two drafts. which will be compared by DocuComp to
highligit the changes between them.
By reading ~ two drafts. and then the DocuComp comporison. you
will be exoosecl to some of the editing marks and format choices
ovoiloole. Thi~ i~gmli should f2[QVide Y.Ql.! with Q!:! iQiQ Qf l!t:OOI IQ
.i_~t wheny~Ql.!r Qwn files.
Ycu should pay particular attention to the way DocuComp handles
text that is moved. In this simple example, this paragraph ~
moved Jllfil: two paragraphs up in the page. Although finding where
the text was moved should be no problem for DocuComp, ii is more
complicated if changes are made to this paragraph before .2LQf!fil it
is moved. The second draft of this example in fact mode changes ta
this paragraph and then moved it IQ 2 Q!!W IQS;gtiQ!!. If will be
inlercsfi1!9._to see how DocuCom_.2.hondled it.
Test Somple - Old
This ~will demonstrate how DocuComp works. This page
FBflFeseAls !Re first of two drafts, which will be compared leief. by
DocuComp to highligit the changes between them.

......,
I-'

:~=

:0
Q

By reading~ two drafts. and then the DocuComp comparison. you
will §SI a fla•,•er of the editing marks and same ef :Re format
choices available. Gf eetirse. IRis is a slfllflle enamfile. aAel It mav ee
Rarel le BflJlreEiale Oeet!CefA!l fulll•f tlA~il yeti tise ii eA eAe ef ·1•etir
evlA elerumeAls.
By now most of the ~ feolures of DocuComp's comparison
abilities will hove been demonstrated. We suggest that yoo make a
few test n..ns on simple files or the DocuComp test files before
beginning to use this program ~ By chonging program
parameters and testing the different options you will become
familiar with the variety of uses and results DocuComp con provide.
_!'..reu ...!JLD.!l.!L!l..

!.!l.l!J !;fl.ii ll!l._e

J91J

~

lo

]2121

Figure 2.18 Two versio ns of the same document compared with DocuComp.

Powerful Spell Checking with Thunder 7
Most current word processing and page-layout programs include a spell
checker. However, as word processing programs proliferate on your hard
drive, you will notice that each program requires its own massive dictionary.
Some spell checkers are easier to use, have better dictionaries, or more useful options than others. Spell checkers allow you to add new, specialized
words to adjunct dictionaries- legal, com puter, or medical terms, and so on.
Unfortu nately, whenever you add a new word to a dictionary in one program, there is no simple way to add it to the dictionaries associated with all
the other programs. Jf you use Thunder 7, that problem is eliminated.
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A
7
8
9
12
13
IA
1<1

20
21
22
2.1

25
25
26
27
30

33

Replace "EXAMPLE" by '1EST SAMPLE"
Replace "example" by " test sample"
Replace "represents the first" by '1s the second"
'1oter"
Delete
Replace "the" by " these"
Replace "get a flavor" by 'be exposed to some"
Delete
"some of the"
Replace "Of course, this is a ... " by '1his example should ..."
"You should pay particular attention to the way.. ."
Move
from page 1 line A 2
Replace "wiD be" by "wa s"
"iust"
Insert
"or ofter"
Insert
"wiH"
Delete
Replace "make" by "mode"
Replace "move it." by "moved it to a new location."
Replace "handles it." by "handled it."
Replace "main" by 'basic "
Replace "routinely." by "on a routine basis."

Figure 2.19 A DocuComp revision list.
Thunder 7 is a Control Panel device that lees you spell check almost any
program or desk accessory in which you use text, such as word processing
programs, a Note Pad DA, or telecommunica tion programs. When you set up
Thunder 7, just specify the programs and DAs in which you want to activate
Thunde r 7. When you launch one of the programs or DAs, Thunder7 is
loaded automatically and adds a new menu option to the application menu.
Using Thunder 7 has several benefits.
• You ca n add spell checking, thesaurus, and glossary functions to
programs tha t don't typically o ffe r them-including DAs.
•

You avoid the redundant creation of pe rsonal dictionaries in other
programs that already include a spell checker. You can use Thunde r 7
co check all you r documents, regardless of the program o r DA in which
they are c reated .

•

You may be able to elim inate extra dictionaries from other programs to
save disk space.

NOTE: Some programs may not load o r run properly if the
included d ictio nary can not be found.
Thunder 7 can check text as you type or examine selected text in batch mode
(see figure 2.20) . In either case, whe n Thunde r 7 detects an error, you are

presented with a list of possible spellings for the word you typed . To select a
replacement, double-click on the replacement word, o r press the number
assigned to the suggestion (1 th rough9). Changes you make in Thunder 7
are pasted automatically into the document in which you are working.

Clipboard format : MacVr iteFormatting vill be maintained .
Misspelling in context :
Ouickletter File Menu. An Open dialog box af ears asking you to NChoon
stationery you want to open with the 'New ' -~,,\,,fj,f. M Choose the
Ouickle tter s tationery document which you want to use as your Default
Stationery .
Type of error : Punctuation
Misspelling : command•.
Sugges tions for : command•.

IQj

1 command. •
2 command•
3
4
5

~

Show

((

NeHt

]J

(

Fl<!itl<t< •~

)

(I: hlll\ll!'

;...~-==~r.=======IQJ==, [

( ·r.~s1

10090

(

IHI J

090

I 9nore

) [ Stats

[Add to Gloss.] ( Options

J ( Done

J~

( Add to Diet . J

Figure 2.20 Batch-checking with Thunder 7.
Check out the other features Thunder 7 includes:
•

Punctuation and duplicate-word checking, such as "the the."

•

A thesaurus that suggests alternate word choices.

•

User-definable glossaries in which you define abbreviatio ns you want to
replace auto matically with a word or phrase.

• A batch search/replace functio n.
•

Reconfigurable Command-key equivalents for Thunder 7 menu items.

• A utility that enables you to add personal dictionaries you create in
o ther programs, such as Microsoft Word, to the spelling dictionaries
contained in Thunder7.
•

Several specialized dictionaries, such as contractions, abbreviations,
computer terms, commo n names, and so on.
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As networks proliferate, work group software is beginning to make an appearance on the Mac. Although our computers are "personal," many tasks are
a group effort. Instant Update is one of a handful of programs that enables a
gro up of people to work simultaneous ly on a single document, such as a
team-written product manual or a departmental procedure handbook.
As with many network products, each person who uses the product is classified as the administrator or a user. The administrator is responsible for
creating and managing work groups. Users create and edit documents. Instant Update suppo rts multiple servers and work groups.

The heart oflnstant Update is the document window in which users create
and edit documents (see figure 2.21). In addition to traditional word processing features, such as justification, tabs, multiple fo nts, and a ruler, the
program supports paragraph styles and tables, such as those in Microsoft
Word. Instant Update also can import documents in a variety of word processing formats.
As you work with the documents, Instant Update notifies you of new versions
immediately as they are written. After the creator of the document distributes
a copy to you, select any changed or new part of the document and Instant
Update informs you who last created and modified the document. When you
and anotheruser both modify a section of the file, Instant Update provides a
specific method to resolve the conflict. You can select and move either of the
two changes to the master docume nt o r leave both versions in the d ocument.

TIP: Because every user has the right to update the master copy
of any document distributed to her or him, it is a good idea to
name a project leader for each document-someone who is in
charge of resolving conflicts.
Ifyou write collaboratively and work o n a network, Instant Update helps you
eliminate the tedious and time-consuming procedures of passing around
disks and tracking down the author every time you have a change .
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Figure 2.21 Changes you make in Instant Update are indicated by gray
revision bars.

Summary
This chapter discussed the different types of tasks you can perform using
word processing programs. Specifically, you learned how to:
• Create and modify templates.
• Use and customize award certificates, business correspo ndence, and
facsimile transmittal forms.
• Date-stamp documents.
• Use boilerplate text in standard d ocuments.
• Create and modify styles and style sheets, and impo rt style sheets.

Working with Words

•

Use QuickLecter and Letter Writer Plus DAs to assist in creating
business letters, legal documents, and sales reports, and manage data.

•

Check grammar in documents using grammar-checking programs, such
as RightWriter, Sensible Grammar, and Gram• mat• ikMac.

•

Create outlines with Acta 7.

•

Compare different versio ns of the same document with DocuComp.

•

Use Thunder 7 as your primary spell checker and dictio nary for all the
word processing programs you use.

•

Edit documents on networks w ith Instant Update.

The 9-Lo-5 Mac

In Chapter 3 , "Getting the Mail Out," you will learn how to perform merges
using several different word processing programs.

Getting the
Mail Out
The process of writing a business letter includes more than just typing the
document in your word processing program. Making sure that the content of
the letter matches the specific situation, addressing the envelope, and-in
the case of bulk mailings-organizing the mailing, are all important parts of
the process. Not every business situation calls for a unique letter. The ability
to produce a series of personalized form letters is a significant time-saver in
most offices. Ironically, one of the greatest challenges that faces the computerized office is the simple task of addressing an envelope. This chapter
discusses several approaches to these challenges. The topics covered in this
chapter include the following:
•

Personalizing a form letter with the recipient's name and add ress.

•

Using advanced mail merge features to design letters based o n
information about the recipient.

•

Printing envelopes in Word.

•

Creating a series of envelopes as a mail merge.

•

Producing mailing labels.

In this chapter, Microsoft Word is used to provide an
overview of the production of form letters, but many
other word processing programs also are discussed.
Microsoft Word templates are included for the following word processing tasks:

/

----

•
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Basic letters that contain simple merged address blocks and prompts
for the current date.

• A merge document that prompts for information as the letter is being
produced (including codes for selecting the text for the body of d1e
letter) .
•

An advanced example of mail merge that uses conditional statements to

create the letter based on information about the recipient.
Templates for these tasks are provided on disk for WordPerfect (WordPerfect
Corporation), WriteNow (T/Maker Company) , MacWrite II (Claris Corporation) , Taste (DeltaPoint), and Nisus (Paragon Concepts). Each program's
differences in performing a merge relative to Word are discussed later in the
chapter.
In addition to these mail merge templates, there are several templates devoted to the envelope. These include the following:
• A Word template for addressing individual envelopes.
•

An address merge template for creating a series of envelopes from data

documents.
•

A template for merging addresses to a roll of Avery 4146 labels.

• A MacLabelPro template for producing shipping labels.
The capability of word processing programs to produce form letters by combining information from a data document with a template letter is one of the
most mixed blessings of the computer industry today. While form letters may
communicate more efficiently with your customers, they are also responsible
for the personalized junk mail you receive every day. Still, mail merge is one
the most important business tools available and, combined with the tools
necessary for preparing envelopes or labels, a critical part of any business.

The Magic of Mail Merge
ost companies use form letters to respond to recurring customer complaints, to inquire about unpaid account balances, and to do mass
mailings to promote new products and announce sales. The only thing "personal" about the mailings of many companies, however, is the name and
address on the envelope. When consumers receive letters in which they are

M

addressed as "Dear Customer," they know they are just another face in the
crowd. Using the mail merge feature included in most word processing programs enables you to personalize this type of letter with very little effort.
It's likely that your company already has a customer o r client database.
Chances are excellent that the data you need for a mail merge is already in
the database. In addition to making form letters more personal, thinking in
terms of mail merges encourages you to make better use of the data. Rather
than stuffing a photocopied form letter into a hand-addressed envelope
when a customer contacts you, you can enter the customer information into
the database, create a form letter using the customer's name and address,
and print a customized letter and envelope. In addition to producing a more
personal letter, by entering the customer information into a database, you
now have a permanent record of one more customer or client that is immediately available for future mailings.
Because setting up a mail merge looks so much like programming, many
users ignore the mail merge feature in their word processing program. When
you compare the steps needed to create and execute a mail merge to simply
typing a letter, the task of performing a mail merge may seem a little daunting. Because most people have never performed a merge or seldom use the
feature, they are forced to crack open the word processing manual every time
they need a new form letter. This section reveals the secrets of creating successful form letters.

Merging with the Data Document
Every mail merge consists of two components: a merge form (a letter, invoice, statement, dunning notice, and so on) and a data document (a file
that contains the names, addresses, and other information you want to
merge). You create merge forms using a word processing program.
Data documents are organized infields. Each field represents one category
of information that you want to insert in the final letter. Examples of fields
include: First Name, Last Name, Street Address, City, State, and ZIP code. The
names of the fields appear in the first row of data. Markers relating to these
field names are placed in the merge form to indicate where the information
should be inserted. The rows of the data document are organized as records.
A record consists of an entry in each field organized on a single row-one
person (customer, client, patient, or sales rep) per row.
You can generate data documents from a number of different Mac applications, including spreadsheets, databases, HyperCard stacks, and even word
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processing programs. In fact, the only criteria that dictate where you create
the data document are the file formats that your word processing program
will accept for merge data.
The two applications most frequently used to manage the information for a
data document are spreadsheets and databases. These programs are discussed in detail in separate chapters, but the commands for getting the
information ready for a mail merge are explained in this section.
As mentioned in Chapter 7, "Number Crunching," there are a number of
advantages to using a spreadsheet program to manage data. The foremost
advantage is that you don 't need to invest in a separate database. You can
manage data, for example, using a small Microsoft Excel customer data file
(see figure 3.1). Each row in tl1e spreadsheet represents one customer
record. Each column is a data field. Note the row of headi ngs at the top of
the spreadsheet. The headings are an essential part of the data file because
they name the variables that Word or other word processing programs use to
ide ntify field information.

Figure 3.1 An Excel data file.
Mosr word processing programs use one of two formats to identify the fields
in the data document-tab-delimited or comma-delimited. Altl1ough these
terms may seem complicated, they simply mean fields separated by tabs or
separated by commas. Virtually every Macintosh database and spreadsheet

can produce data in o ne of these formats through a Save or an Export
command.
To use the informatio n stored in the Excel document that appears in the
preceding figure, select the Save as ... command, click on the Options button, and then select Text as the format. When the Excel text file is opened in
Microsoft Word, you can see that it was saved in a tab-delimited format (see
figure 3.2). A comma-delimited file contains the same information, but fields
are separate~ by commas rather than tabs .
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Figure 3.2 A tab-delimited Excel text file opened in Word.
To provide even mo re flexibility than a spreadsheet program offers, you can
use a database program to generate data documents. Although each database
program works differently, after the data is prepared in the database (entered, selected, and sorted) , most database programs generate a merge file
using a Save As, Export, o r similar command . To generate a merge file in
FileMaker Pro, for example, follow these steps:
1. Open the FileMaker Pro database.

2. Select the records you want using one or more Find commands to
limit the merge to a subset of tl1e data file. (You can skip this step if
you want to include the entire data file.)
3. Select Export ... from the File menu. The FileMaker Pro Export ...
dialog box appears (see figure 3.3).
4. To make a Microsoft Word-compatible data file, select Merge from the
File Type: pop-up menu at the bottom of the dialog box.
To create the same data file for other word processing programs, you
can select the options for tab- or comma-delimited formats.
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Figure 3.3 The FileMaker Pro Export.. . dialog box.
5. Enter a name for the new file and click on the New button.
6. You are then prompted to select the fields you want to export from the
Specify field order for export dialog box (see figure 3.4). Click once
on each desired field so that a check mark appears in front of the name.

Specif y fiel d order for eHport
./ S aluhtton N4'm•
./ Ffrst Nam•
./Last No1me

~
H

. / Cowipanv

./ S tr . . t Addru s
./ City
./ S bte

..

Ar•• Cede
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Focus

Htddle Name/ ln itfa1
S uffix

rm.

Su lte/Unlt/f1Hr

~

® Don' t formo1 outpu1
O Forma1 output using curre n1 loyout

Figure 3.4 The Specify field order for export dialog box.
You also can set the order of the fields by dragging them to any
position in the field list. However, it isn't necessary to do this when
you want to perform a merge with the resulti ng data unless the word
processing program you are using requires it. Most word processing
programs identify fields by the field names rather than by the order of
the fields in the data document.
7. Click on the OK button and the merge file will be created.
Most word processing programs accept extra fields in the merge daca file. As
long as the data file contains the particular fields specified in the merge

document, the merge will run as expected. However, with a large database,
exporting all the fields creates a data file that is much larger than needed
and can slow up the merge process.
Normally you should use a word processing program to create the data file
only in those rare instances when: (a) you don't intend to modify the data, or
(b) you don't have a suitable spreadsheet or database program. For small
merges, on the other hand, it is often easier and more convenient to work
entirely in your word processing program. Word 5 provides a new featurethe Print Merge Helper-that makes it easy to create a data document. To
activate the Helper, select Print Merge Helper from the View menu. The
Print Merge Helper File dialog box appears for you to select your data
document (see figure 3.5) .
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Figure 3.5 The Choose or Create a Data Docume nt dialogue box.
Clicking on the New button accesses the Data Document Builder dialog
box (see figure 3.6). You use the Data Document Builder dialog box to
create the fields within a data document.
You enter a field name and click on the Add button. Each name that you add
creates a new field in the data table. When you finish adding fields, click o n
the OK button; a dialog box appears and prompts you fo r a file name for the
data document. After you enter a file name and click on the OK button, a
new Word document is created and the fields are organized as a Word table
(see figure 3.7). The Helper moves to the merge form immediately and begins to insert the necessary codes.
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To add client o r custo mer info rmation to d1e data document, select me file
name fro m me Window menu. Click on me first empty cell (under the first
field name) and enter the information. Yo u can press me Tab key to move
from one column to me next. When you reach the end of the record, you can
press me Tab key to create a new record (row).
Word 4 also supports the table fo rmat, but you must create me
table on your own. Because me table layout is me best approach for
managing data in the word processing program, you can use the
Data Doc. template (\'f ord) enclosed o n the disk. Using d1is template, designing a data document table is fairly simple.
You enter new information the same way as you do in Word 5. Click o n me
first field and then press d1e Tab key to move from field to field. To add extra
rows to the end of me table, position me cursor in me righ tmost cell of the
last row in me table and press the Tab key. To remove unnecessary rows or
columns, highlight me rows or columns, select Table ... fro m the Edit menu,
click on the Row or Column butto n, and click the Delete button.
You can format a table using any of the formatting commands. You add
character formatting, such as bold or italics, d irectly in me merge fom1. Be
sure to use proper capitalizatio n and punctuation. You must include

punctuation in the data document that is part of the actual data, such as a
period that follows abbreviations. Other punctuation, such as the comma
between cicy and state, is inserced into the merge form.

Performing an Elementary Merge
At a minimum, a Microsoft Word merge form contains text, format·
ting information, and merge fields. Merge fields are placeholders.
After you merge the data document with the form letter, each
merge field is replaced with real data. More advanced merge forms also may
contain programming instructions, such as conditional statements and
prompts for data. To give you an idea of how the address block for a letter
should be set up, see the Basic Merge template on the disk included with this
book. You can use the Basic Merge as a starting point for any form letcer (see
figure 3.8) .
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Figure 3.8 A Microsoft Word merge form .
Every field, instruction, and statement on the merge form must be enclosed
in a pair of special angle bracket symbols(«»). When Word encounters these
symbols, it identifies the information inside as a field or instruction. lfyou
are using Word 5, select the merge field names from the drop-down list from
Print Merger Helper. Both the codes and the field names are inserted for
you. In Word 4, you can enter the symbols in the following ways:
• Type Option · \ for ''<<'' and Option · Shift ·\ for ",,", or
• Select the Print Merge item from Word's glossary.
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Selecting the Print Merge glossary item inserts a pair of brackets at the
current cursor position. You just fill in the field name or instruction. Be careful how you spell the field names. Every field name must match a field in the
header record (the first line of the data document). If you misspell a field
name, Word is unable to complete the merge.
The DATA statement must be the first line of the merge form document. The
DATA statement informs Word of the name of the data document that will be
used in the merge. If you are using Word 5, the DATA statement is created
when you first activate the Print Merge Helper and specify a file name. In
this example, the data document is called Basic Merge Data. The data document and merge form must be in the same folder when you perform the
merge.
Notice that the field markers are formatted as though they are the actual
words they represent. The City and State fields, for example, are separated by
a comma and a space. Date is aligned with the right margin. Any spaces or
punctuatio n you want to be part of the final letter must appear in the merge
form (except for punctuation already contained in the data document). In
addition, any formatting you apply to the fields is applied automatically to
the data when you perform the merge. You even can change the font type,
style, or size of merged data by formatting the fields in the merge form.
The second line contains the only advanced feature in this template. The Set
command instmcts Word to prompt once at the start of the merge process
fo r a value to be inserted into every one of the letters. The Ask command,
discussed later in this chapter, prompts you for a different value for each
letter individually. In this example, when the merge is performed, the command «SET Date=?Enter a date for the letter:» displays a prompt for you
to enter the date you want to place on each letter. The information you enter, for example Sept. 10, 1992, 9/10/92, 10-Sept-92, or 9-10-92, replaces the
Date field in the top right corner of each letter automatically.
The Set command can be used two ways. First, you can use it to enter a specific piece of information into each letter without being prompted for the
information during the merge. «SET Date ="9/10/92",,, for example, replaces
the Date field in each form letter with the date that is surrounded by quotation marks. The command is interpreted by Word to mean that it should
replace the merge field (Date) with the informatio n inside the quotation
marks (9/10/92) . This is the least flexible versio n of the Set command. Every
time you perform a new merge with this merge form, you need to change the
date or other information inside the quotes.

The second variation of the Set command-the one used in Basic Merg~
prompts you for the data when you perform the merge. «SET Date= ?Enter a
date for the letter:» instructs Word to display a dialog box that prompts you
to "Enter a date for the letter:". The? means that a dialog box should appear;
the text following the question mark is the prompt used within that dialog
box. This version of the Set command is the more flexible than the previous
o ne because never need to modify (or remember to modify) the actual merge
document. Each time you perform a merge, Word prompts you fo r the necessary Set information-in this case, a date for the letter.
In Word 4, you must create Set commands by entering the appropriate text
from the keyboard. If you are using Word 5, you can use the Print Merge
Helper to help you construct a Set command (see pages 609-611 of
Microsoft Word User's Guide).

Merging with the Print Merge Command
The Basic Merge form lacks a body. There is nothing in it but a name, address, and salutatio n. Although this is enough for you to try out the print
merge p rocess and see how it works, you would normally finish the letter by
adding a couple of body paragraphs and a closing.
To perform a merge, the merge form must be lo aded into Word and onscreen. The data document does not need to be open when you select the
Print Merge command, but Word must be able to locate it (placing it in the
same folder as the merge form will take care of this). To perform a merge in
Word 4 or 5, follow these steps:
1. Open the Basic Merge file from within Word.

2. Select Print Merge ... from the File menu. The Print Merge dialog box
appears (see figure 3.9). The dialog box is slightly different in the two
versions of Word.

NOTE: Jn Word 5, you also can use the Print Merge Help command
and select the second icon to create a new file that contains the letters,
or the third icon to send the letters directly to the printer.
3. Select All records by clicking on the All butto n, or click on the From
button and specify a subset by entering data record numbers (10
through 20, for example).
4. It is generally best to send the letters to a new file so that you can make
sure they are what you want. In Word 5, select the Merge and Save
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Results in a New File radio button and the click on the OK button to
send the information to a new document. In Word 4, click on the New
Document button to accomplish the same thing.
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Figure 3.9 The Word 5 Print Merge dialog box.
5. A dialog box appears and prompts you to enter a date. The prompt is
based on the information specified in the Set command in the merge
form (see figure 3.10) .
Print Merge
Enter o clote for t he letter:

ISeptember 10, 1992
(\::;
[ ____
o_K___;t,1J) (St op Merge J

Figure 3 .10 The date prompt in the Print Merge dialog box.
6. A new document appears and contains a copy of the merge form for
each of the records you selected from the data document (see figure
3.11). Each form letter appears on a separate page. If necessary, you
can edit the new document.
Other than adding a body to the Basic Merge form, there is very little customization required. When you begin to create your own merges, be sure

to change the DATA line in the merge form to reflect the name of your data
file. If you want to use this lener with an existing database, you also must
change the field names to match the fields in you r database.
it
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Figure 3.11 The results of a merge can be directed to a new document.
If first and last name are a single field in your d ata base Oames Green, for
example), you can change the salutation to "Dear «Name»:", or return to the
database or spreadsheet and split the name into two fields-a fi rst name and
a last name. If your database does not contain a salutation field (Mr., Ms., Dr.,
and so o n), you can address the people as "Dear •First Nam e»:"-if you
don 't mind a slightly informal form letter.

Form Letters without a Data Document
You may not want to keep a record of every customer address, but
you still need a way to respond to leners and warranty card comments. The Intermediate Merge template is an example of a
"one-at-a-time" merge form (see figure 3.12). Rather than taking information
from a data document, you are prompted for all customer data. The lfi'Else/
Endif and Include statements enable you to select one of two different sectio ns of body text to include in the letter.
For example, suppose that your Customer Service Department has prepared
a series of letters it uses to respond to customer inquiries and complaints.

Getting the Mail Out

----The 9·to·5 Mac

T

The two letters sent most often deal with an o mitted line of text on the
company's Ball Bearing Polisher box and a potentially dangero us use of a
Bagel Toaster.

a

f ile

Edit

Form at

Font

Document

Utiliti es

Window

Work

Interm ediat e M erge

\Nor mol

fl

<SET 0..10•?En10r a dale ror oll Jeners:>
<ASK Nameg?Enter cuswomer's run nome:>
<ASK Addreoo=?Enter cusworner'• street address:>
<ASK City-?Enter cuswomer's City, State, and Zip:>
cASK Letter-?Enter A for polloher; B tor 108.Ster:>

<Dalt>

<Name>
<Address>
<City>
Dearc Name>:

<IP Letter-•A•xlNCLUDE A><ELS E><lNCLUDE B><ENDI!'>
Sincerely,
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Figure 3.12 A merge fo rm without a data document.
Each week, you receive a handful of letters and warranty cards that co ncern
problems with these products. After you gather the letters and cards and sort
them by product, a customer service person, receptionist, or secretary can
readily respond to customers by answering a series of onscreen prompts for
custo mer info rmation and selecting the body text document to use.
The Intermediate Merge template pro mpts the user for data. Unlike Basic
Merge, there is no associated data document. You provide all the necessary
information by entering it in dialog boxes when you perform the Print Merge.
The Intermediate Merge template uses both Set and Ask statements. As pre·
vio usly explained, Set prompts are only presented once during a merge. You
use Set statements for data that remains constant for all letters in the merge.
In this example, a Set pro mpt is used to request a date for all letters. Ask
prompts, on the other hand, are repeated for every letter in the merge and
are used when you need different information for each letter. Intermediate
Merge uses three Ask commands to prompt for the customer's name, street
address, and City/State/ZIP code.

Two sections of body text were created for the body of the letter. The Ball
Bearing Polisher section is named A, and the Bagel Toaster section is named
B. During the merge process, you select which of the two sections you want
to insert in the letter. These two documents are shown in figure 3.13.

m

]O

::I

R
2

..J.l

llfil

INormel

D

·t

~
;J

t.

~ 1~11211i:ii]

I

IS-

4

lliill l==J

,_,

01
J[6

::I
i a C:::I

•

W.l

Thank you for bu)'i:nc GQR's Ball Bearln& Poll>her. Wbtn the pofuher.....,. slupped, Ille
folloviJli line .,.. mislal<enly omined from the side of t>ie box: "The Ball Bearinl: Pofuhor
"'deslined "''Wrk only with boll bearln&s thelOre at least 112 inch;,, aurm~,., or
lar,ger.• U•ine smaller sizes causes the boll beortni:s 10 foll in10 the cem inside the
pofuhor and frequently results in• jam.

I··
l'J!!:
::

IC your pofuhor becomes jammed in this way, it can easily be disassemble<! with a Philhps
screwrM>r and the offend in&: ball bearln&s remov.d. We apoJoiize for any Inconvenience
this may have caused you.

-

m
:Io
~

1.4..

0E

B

]1

llQI

INor mel

~

D

t

_j.4

]:!:

Gl911zll• I

(;;)Fl l::J

~
;J

t.

I

Thank you for bu)'i:nc GQR's Bogel Toas10r. When the

]6

::I
e c:::i

"°"''".....,.

d"ij;ned, ,,. assumed
that consume"' 'Wuld use only fresh begels from their local delica10s!en or bakery. We
didn't realize that the uni1 Jlliiht also be used forfroren begels.

Frozen baieb, likt any other frozen object contain a certain amoW\t of va.iter. If a. frozen
ba&'.el 13 insened int> the .,,.,.,,, there Is at least a small ch4nce that you may be
electtocu.,d. To avoid this h4%anl, ve •tron&IYrecommend the< you lhav your beg els
before lnsenini them in10 the .,.,,,r j
1

-

"'"'
,1,1::

,,
'.fil.

Figure 3.13 Body text documents A and B.
To perform the print merge, follow these steps.
1. Launch Microsoft Word and load the Intermediate Merge document.
2. Select Print Merge ... from the File menu. The Print Merge dialog box
appears.

3. In Word 4, click on the Print button to route the letters to the printer.
In Word 5, click on the Merge and Print Results button, and then
click on the OK button to accomplish the same thing.

4. Respond

to

the date prompt.

You are prompted for the date only once. The date is stored in memory
and inserted automatically in all the letters in the merge.

5. Respond

to the prompts for each customer and enter the full name of
the customer, the street address, and customer's city/state/ZIP code.
Click on the OK button to complete each item. Enter this information
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exactly as you want it to appear in the letter. Spelling, spacing, capitalization, and the presence or absence of commas are reproduced just as
you enter them.
6. Indicate the body text document you want to use by typing A for the
Ball Bearing Polisher or B for the Bagel Toaster. (The test is casesensitive. If you type anything other than a capital A, the Bagel Toaster
text is used.)
7. Click o n OK in the Print dialog box and the letter prints.
8. After you complete the first letter, you are prompted for information
for the next customer. If you want to generate additional letters, repeat
steps 5 tl1fough 7 until you enter all the customer information. After
you enter all the customer information, select Stop Merge. You also
can stop the merge at any time by clicking on Stop Merge or Cancel in
any of the dialog boxes.

NOTE: As with Basic Merge, you can direct the form letters to a new
document ratl1er than to the printer by clicking on the appropriate
option in the intial Print Merge dialog box.
The Intermediate Merge 2 template is modified to create a more
flexible and powerful template. It is designed to prompt you for the
name of the document you want to include as the body of the letter
(see figure 3.14). You can create several dozen body text documents, for
example, and then merge them into this form . To prepare for the merge,
keep a list of the body text document names for your data entry personnel.

NOTE: Keep the document names short. The shorter the name,
the less chance they will be entered incorrectly.
Two lines are changed in the Intermediate Merge 2 template: the prompt for
the name of the body text document, and the Include statement tl1at embeds
the body text in the merge form. Rather than asking you to enter A or B to
designate which body text to use, the new prompt asks for the name of the
body text document (the variable called "Letter"). The Include statement
«INCLUDE «Letter»» instructs Word to use the data document you named in
response to the prompt.
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Figure 3 .14 A merge form can prompt you for the file name you want to
include.

Using Conditional Statements
The Advanced Merge template is a commission letter for sales
representatives that extracts annual commission figures from a
worksheet and embeds them in the body of the form letter (see
figure 3.15). Depending on the percentage of improvement shown over the
sales of the previous year, different messages are used.
This template uses the If, Else, and End.if conditional statements to customize individual letters so that addressees receive different messages depending
on their individual circumstances. In addition tO stating the earned commission, the letter rewards excellent performance and issues a warning for a
poor showing. If the sales of an individual increased more than fifty percent
over last year's sales, a bonus is added to the base commission. If sales improved by less than fifty percent, the normal commission is given. If sales
decreased or were unchanged, a warning is given.
Although the data document could have been created in Microsoft Word or
in a database program, the more typical place to track sales figures is in a
worksheet. The Advanced Merge Data template was created in Excel 3.0 and
was saved in Text format. Because it is a text file, you can open it in Word,
Excel, or almost any other word processing or spreadsheet program.
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cDale>
c Title> c Pir31> cL..1>
cComp&iY>
c Addre">
cCity>, c Stole> cZ1p>
Dear cPir31>:
l!nciosed you Vlll fllld your 8l\lluol commission for represen~ Kenco, Inc. in 1992. On
sales of $<Sales 92>, 1he commission b $cPo.)'>.
c.IP changeo•O">We recognize 1hat Ille current busine" cllm4le makes it difficult t>
contlllue to mcrease sales, but-ove..U-our sales representouveo showd 8II increase or
almost 4()91; owr wt )'OM. If your lacklustor pelforniance contlllues into 1he next q uaner,
w vill be folCOd to 1tnni:na10 our releoonshlp villi you.cl!NDIP
clP Change>• .50'>Since your sales h4w increued so mw:h owr lest year's r;cures, I am
pleased to include a bonus of $cbonus> for a to10l payment of S<Tollll>. Keep up Ille
good w rk lcl!LSl!>c!P Change >·O'>ThAnk you for representiJli our
Une.cl!NDIP>el!HDIP>
Sincerely,

I<

John Wllalen, Preslden!
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Figure 3.15 The Advanced Merge template form letter.
In the merge form (Advanced Merge), the second sentence of the first paragraph states che annual sales of each sales representative and his or her
commission. Because all calculacio ns were perfom1ed in Excel, the data is
taken straight from the worksheet
The next two paragraphs in the template use conditional rests co attach one
or C\vo special messages to the letter. The first paragraph is the negative condition. If che representative's sales were unchanged or decreased from the
previous year, a warning is given. Note that the Change figure is surro unded
by quotation marks. This is necessary because after you save it in Text format, all data in an Excel worksheet is considered text. The End.if statement at
the end of the paragraph is not followed by a d osing delimiter. Leaving off
the delimiter stops Word from inserting an extra blank line. If the condition
is nor met, chis paragraph is skipped.
The next body paragraph use an If and an Else statement to respond to two
conditions: exemplary sales (an increase of 50 percent o r mo re) and acceptable sales (an increase, but less than 50 percent). In the former case, a line

that awards a bonus is added to the letter, and it closes with a congratulatory
message ("Keep up the good work!"). Otherwise, if results were positive, but
not high enough to warrant a bonus, a "thank you" is used to close the letter.
A second If statement is nested within the first If statement. If an Else statement was used alone, everyone, other than the top sales people, would
receive the "thank you" message. The presence o f the additional If statement
stops that message from being added to the letters for those who will receive
a warning. Clearly, a "thank you" may create a mixed message for them. Because the paragraph uses two nested If statements, it requires two Endif
statements to finish the paragraph.
Figures 3.16a, 3.16b, and 3.16c show examples of the three letters that you
can generate.
The letter is fairly simple. If you want to dress it up and increase the amount
of information presented, you may want to include an Excel bar o r column
graph that compares total sales by quarter for the last two years, or a pie
chart that shows the contributions of each sales rep to the total sales for the
year. The version sent is based on the information contained in the data
document. The decision-making is part of the merge process rather than your
responsibility.

Pebnwy l , 1993
Ms. Man;la G~

Hockmlnoier Tool & Die
23 Suron Stteet

.Jame.awn, NY 3220
DearMan;la:

l!nclosed you Vil! find your annual commmion for ropruenung Kenco, Inc. m 1992. On

.W or $ 102,500, Ole commission is $5,125.
Thank you for roprosonting our line.

Si:nceroly,
John Wbalen, President

Figure 3.1 Ga A normal commission letcer with no bonus.
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February l , 1993
Mr. Sal Martm
Rockpon Tools
1843 Jol\03 High1.1ly, Suile 15
Rockpon, CT 1234
Deer Sal:
l!nclo3ed you viii find ;our annual commission for representing Kenco, Inc. in I 992. On
salts of $I 96,700, 1he commi3sion is $9 ,835.
Since your oales have incre""ed so much over lb31year's figures, I am ple,,.ed
bonus of $4,918 for a b:>tal paymentof $14,753 . Keep up Ule eood wrk!

v include a

Sincerely,
Jolin Whalen, President

Figure 3.1 Gb A positive commissio n lette r with a bonus.

February l , 1993
Sir Gabri.el Smith
JoMS Research
17 I!. Paddineb:>n
London, Ontor1o H94 K8A
Dear Gabri.el:
Enclosed ;ou VIII find ;our annual commisoion for representing Kenco, Inc. in 1992. On
sales of $162,000, tile commission is $8,100.
We recoenize that tile current business clima1e mekes it diffic uit v continue ro incre""e
sales, but-ovenill-our salts representatives sho-.red an incre""e of almost 409!0 over lb3t
year. If ;our Iacltlus1er performance continues inv tile next quaner, -.re viii be forced ro
1ermina1e our relationship vitll ;ou.
Sincerely,
Jolin Whalen, President

Figure 3.1 Gc A negative commission letter with a warning.

Merge Features of Other
Word Processing Programs
f you are an owner of another word processing program, you are not left
to fe nd for yourself. You will find revised merge and data documents o n
the disk for performing the three merges in MacWrite Il, WordPerfect,

I

WriteNow, Nisus, and Taste. The following sections describe the differences
in the way you perform a mail merge, as compared to using Word's mail
merge feature.

Merging in MacWrite II
MacWrite II performs merges in a similar manner to d1at of Microsoft Word.
The following differences are imponant:
•

MacWrite II cannot prompt fo r data; that is, there are no Set or Ask
instructions.

•

The merge data file is selected from the Open Merge Data File ...
command in the File menu rather than embedded in the merge
document as an instruction.

•

Operators in conditional statements must be surrounded by spaces.

I.!fl

To pe&"m the Bask Merge in MacW<ite 11, follow these steps

l. Launch MacWrite II, and then open the Basic Merge-MW merge

template.
2. Select Open Merge Data File ... from the File menu. Select the Basic
Merge Excel Text file.
Because MacWrite is unable to interpret Word tables, you must use a
tab-delimited o r comma-delimited document, such as Basic Merge
Excel Text.
3. The template contains all the necessary merge fields. Just click on the
Close box in the Insert Merge Field dialog box that next appears.
4. Select Merge ... from the File menu. The Merge dialog box appears
(see figure 3.17).
5. In the Merge dialog box, select the records you want to merge, or
select All . As in Word, you can merge to the printer or create a new
document from the merge data (one page per record) .
Almough MacWrite does not prompt you for information during a merge, a
date in the merge document can be updated automatically when you open
the file. Select Preferences from d1e Edit menu, and then select the format
you want from me Date Format box (see figure 3.18) . Be sure to click on the
Always Update butto n in the Date & Time box. Then position the cursor
where you want me date to appear and select Insert Date from d1e Edit menu.
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Figure 3 . 17 MacWrite ll's Merge dialog box.
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Figure 3 .18 You can specify date-handling preferences in MacWrite II.
Because MacWrite II cannot prompt you for information during a merge, the
Intermediate Merge cannot be performed-at least, not easily. You need to
restructure the task as a standard batch merge and create a separate merge
form and data file for each intended customer letter.
The next template discussed is the Advanced Merge.

MacWrite uses the same delimiters and conditional statements as
Word, but operators in conditional statements must be surrounded
by spaces in d1e Advanced Merge-MW template. To ensure dle
spacing between paragraphs would be correct, it was necessary to rewrite the
conditionals as a series of nested If statements (see figure 3.19). The data
document is Advanced Merge Data.
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Figure 3.19 The Advanced Merge-MW document with nested If statements.
This organization of If statements is a bit more difficult to understand, but
produces the same letters as the If series described for Word.

Merging in WriteNow
WriteNow's mail merge features are almost identical to those of Microsoft
Word. WriteNow uses the same delimiters and supports dle same statements
and conditionals. In fact, the only significant d iffe rence is that conditional
tests must be surrounded by straight quotes when comparing text strings («IF
Letter="A"») , and no quotes can be used when comparing numbers («IF
change < = O»). Curly quotes("") are not interpreted correctly.
Also, like many other word processing programs, WriteNow cannot interpret
Word tables. For dlese reasons, separate WriteNow merge and data documents (Basic Merge-WN and Basic Merge Excel Text) are provided o n the
enclosed disk.
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NOTE: As long as you keep these two limitations in mind, you
can load Word merge forms directly in WriteNow by specifying
Word format in WriteNow's Open dialog box.

~

~

To perform the Basic Merge in WriteNow using the Basic Merge-WN
and Basic Merge Excel Text templates, follow these steps:

l. Open Basic Merge-WN in WriteNow.

2. Select Merge ... from the File menu. A dialog box appears.
3. In the dialog box, select All for the range of records to merge, and click
on the New Document or Printer button, depending where you want
the output to go.
The Intermediate Merge template uses conditional tests to determine which body text is embedded in the letter. WriteNow requires
that all conditional tests be surrounded by straight quotes rather
than curly quotes («IF Letter = "A",, , not «IF Letter = "A" »).
Note that, as in Word, conditional tests are case-sensitive. If you want the
Ball Bearing Polisher body text, you must type a capital letter A when
prompted to choose a form letter. Using a lower-case a results in it failing the
first test (" IF Letter = "A" ,,), and the Bagel Toaster letter (the B option)
will be printed instead.
A copy of the Intermediate Merge 2 Word document is included on disk in
the WriteNow folder. To load it (or any other Word document) into
WriteNow, select Open from the File menu, select Microsoft Word/Write as
the Type of document to open:, and then select the file from the file list.
Intermediate Merge 2 will run unaltered.
To convert the Word Advanced Merge template to a WriteNow document,
load the template into WriteNow and remove the quotation marks from inside the three IF Change conditionals.

Merging in Taste
Although Taste merge documents closely resemble those of Word, there are
several important differences. Like MacWrite II, Taste does not prompt you
for data during a merge, and the data document is selected via a menu option rather than embedding a DATA statement in the merge form. Although
the field names and commands in a Taste merge form look like the field

names and commands in Word, you must e nter the m in Taste dialog boxes
(see figure 3.20). You cannot ente r the m by hand.
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Figure 3.20 The Insert Merge Fields ... dialog box enables you to insert fields
into the merge form.
On the positive side, you can merge a Taste form with its own Address Book
files or using tab-delimited text files. However, there is one important difference. You must not use quotation marks co surround field s that contain
commas. For example, Mark Jones, Ph.D. appears in an Excel text file as
"Mark Jones, Ph.D." You must remove the quotation marks before you use
the data file for a Taste merge.

[.I.]

To ped'orm lhe B'5;c Me<ge ;n T'5te, follow lhese steps.

1. Open the Basic Merge-Taste te mplate within Taste, and then select
Merge Setup-Choose Database ... from the File menu. Select Taste
Data 1, a revised text-only Excel data file, from the file list that appears.
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2. Select Merge ... from the File menu or press Command·M. The Taste
Merge... dialog box appears. Click on the New Document button.
Keep the other options the same.
3. When prompted for the file name to which you want to save the new
merge document, accept the suggested default.
Like MacWrite IL, Taste canno t prompt for data during a merge. Because of
th is, the best way to perform a merge, such as Intermediate Merge, is to ere·
ate separate secs o f form lercers and data files and merge them normally.
Taste co.mains a conditional test to establish field criteria and an·
other conditional test to select specific records to include in a
merge. The field criteria tests are more restrictive than those offered by Microsoft Word-at least when applied to this task.
In Taste, a field conditional test to insert a text string into the merge docu·
ment (such as the warning notice for inadequate sales used in the Advanced
Merge) requires that the string be in evelJ' record in the data document.
Rather than rewrite the data document fo r the Advanced Merge, it is easier to
make separate letters for each of the three possible conditions: greatly im·
proved sales, above average sales, and poor sales. You select groups of
records from the data d ocument based o n the contents of the Change field.
The groups do not overlap because the change for each sales representative
must be either negative, positive, or neutral.
To perform the Advanced Merge in Taste, follow these steps.
1. Launch Taste and load tl1e Advanced Taste 1, Advanced Taste 2, or
Advanced Taste 3 templates.

2. Select Merge Setup-Choose Database ... from the File menu.
3. Select Advanced Merge Data 2 as the data file.
4. Select Merge ... from the File menu or press Command-M .
5. When the Merge dialog box appears, click on the All button for the
Record Range, and select Printer or New Document for the Merge
To section.
6. In the same dialog box, click on the Use Record Criteria check box,
and then click on the Set Criteria butto n. The Record Selection
Criteria dialog box appears (see figure 3.21) .
7. Sec the rules for selecting the records. (In the case of the three Ad·
vanced Taste merge forms. the rules already arc entered for you.) Click

on the OK button to exit from the Record Selection Criteria dialog
box, and then click the OK button in the Merge dialog box to perform
the merge.

Record Selection Criterlo

Figure 3.21 The test for the positive letter in the Record Selectio n Criteria
d ialog box.
8. If you instructed the merge to create a New Document, you will be

prompted to save the current document and then asked for a file name
for the merge output. If you did not instruct the merge to create a new
document, the merged letters are routed to the printer.

9. Load the other two form letters-one at a time-and repeat steps 2
through 8 to complete the merge process.

Merging in WordPerfect 2.0
WordPerfect merges are nothing like merges in other word processing programs. Merge forms and data files must use WordPerfect's special field and
record markers. You cannot use normal tab- or comma-delimited data files
without first converting them to WordPerfect's format. Fields are normally
referred to by number, but you can optionally assign names lO Lht:m.
There are no provisions for performing conditional tests-at least not those
based on field contents. The lack of support for conditional tests makes
some complex merges extremely difficult to perform. On the positive side,
however, WordPerfect merge documents can contain macros and pop-up
messages.
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Merges in Wo rdPerfect, like the other word processing programs, usually
consists of two files: a primaty file (the merge document) and a secondary
f ile (the data document). The secondary file must be in the format shown in
figu re 3.22. Each field must be followed by an <End of Field> delimiter
and a hard Return. Each record must be followed by an <End of Record>
delimiter and a hard Return. Because fields are referred to by number, the
file does not contain a header record that displays the field names.

[D

Do c 2: Basic M erge Da t a-WP
E!t
Mr.<End of Field>
Sal<End of Field>
Merg e limi~!ill!
Marlin<End of Fi eld >
Rockport Tools< End of Field>
Date
1843 Jones Highway, Suite IS<End of Fiel d> Define Namu
Rockporl<End of Field >
CT<End of Field>
11
1
01234<End of Record>
Message...
Ms.<End of Fi eld>
Next Record
Marcia<End of Field >
PrimarlJ Flle...
Quit
Graham<End of Field >
Run Macro
Hockminster Tool & Die<E nd of Field>
Secondary File ...
23 Sutton Streel<End of Field>
To Printer
Transff'r
Jamestown<End of Field >
NV<End of Field>
03220< End of Record>

:urn

lmmammsl c
!~·!~::E:d •m , !

Pg 1

Ln 1

l

Figure 3.22 The first two records of a Wo rdPerfect data document (secondary file) .
If you are creating the secondary file fro m scratch, you type the contents fo r
each field, and then insert an <End of Field> marker from the Merge
tools palette. After the last field in each record, insert an <End of Record>
marker. While this is fine for small merges, you o ften will want to use existing
data stored in a database or spreadsheet. Although WordPerfect cannot use
external database- or spreadsheet-generated files in its merges, you can convert those files to WordPerfect format. A macro has been created for you for
just this task, as described later in this section.

NOTE: When executing a Word Perfect merge, you should always create a new document first. Unless the primary fi le
contains a To Printer command, the merge information is always
written into the active document. It's also a good idea to close
the primary and secondary merge files to avoid accidentally embedding a merge in the files.

[.ljj

When you are •eady to execute the Basic Me•ge, fullow thm steps,

1. Launch WordPerfect. If either the primary or secondary files (Basic
Merge-WP and Basic Merge Data-WP) are open, close them.

2. Select New from the File menu. This creates a new document to
receive the merge results.
3. Select Merge ... from the Tools menu to display the Merge tools
palette (if it is not already on-screen).
4. Double-click on Start Merge ... at the cop of the Merge tools palette.
5. Select the Basic Merge-WP template as the primary file and the Basic
Merge Data-WP template as the secondary file. The two files will merge
into the new document-one page for each record.
Included within the Library attached to Basic Merge Data-WP is the Data File
Conversion macro. When you run the macro with an Excel tab-delimited Text
file loaded in WordPerfect, this macro performs the following actions:
•

Strips off the header record.

•

Deletes any embedded quotation marks(").

•

Places each data field on a separate line and adds an <End of
Field> marker after each one.

•

Marks the last field of each record with an <End of Record > marker.

To use this macro to convert your own data files, you need to be aware of the
following things:
• Turn off Smart Quotes in the File Preferences Environment Format
menu before you execute the macro. You can turn the option back on
after the macro has played.
• Begin the data file with a header record. If you do not, the macro will
delete the first record by mistake.
•

Excel text files do not end with a final Return. The macro takes this into
account and adds a final <End of Record > marker at the end of the
file. If your particular file does end with a Return, the macro will add an
extra <End of Re cord> marker at the end of the file. If this happens,
delete the extra marker before you save the converted data file.
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TIP: If you find this macro useful, you can transfer it to your
Private Library so that you can use it with any document. Refer to
the Librarian ... "Copy from a Document" procedure in the
WordPerfect Reference manual.
After you install the macro in your Private Library, follow these steps to try it
out:
1. Launch WordPerfect.
2. Open the tab-delimited text file you want to convert to WordPerfect
secondary (data) file format. (The Basic Merge Excel Text is used for
this example.)
Because this file is not in WordPerfect format, select All from the Show
pop-up menu in the Open dialog box. You will find a copy of Basic
Merge Excel Text in d1e MacWrite II folder. Select the Basic Merge
Excel Text file and click o n the Open button. The Import Conversion
Format dialog box appears.
3. Select Text Import and click o n the OK button. The file is imported
and appears onscreen.
4. Select Data File Conversion from the Macro menu (see figure 3.23).
As you watch, the macro will reformat the data file, breaking it into
individual fields, inserting field and end of record markers, and so on .
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Figure 3.23 Running the Data File Conversion macro.

TIP: If you decide to save the converted data file, be sure to give
it a new name to avoid overwriting the original file.
Because WordPerfect doesn't support conditionals, the easiest way
to create a series of customer service letters, as was done in the
Intermediate Merge template, is to develop separate merge forms
and configure each one to prompt you for keyboard input. The Intermediate
Merge-\VP merge template (see figure 3.24), is the merge form for the Ball
Bearing Polisher letter. This template contains a date stamp in the u pper
right corner and several prompts fo r user input-each accompanied by a
message that indicates the type of data expected.
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Figure 3.24 The Intermediate Merge-\VP merge form .
To use the Intermediate Merge-WP template, follow these steps.
1. Launch WordPerfect. (Do not o pen the merge document before

performing the merge.)
2. Select New from the File menu. This creates a new document that will
receive the merge results.
3. Select Merge ... from the Tools menu to display the Merge tools
palette (if it does not already appear onscreen) .
4. Double-click on Start Merge .. . at the top of the Merge tools palette.
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5. Select the Intermediate Merge-WP template as the primary ftle and click
on the Merge button. Click on the No File button in response to the
Open Secondary dialog box.
This indicates that any required input will come from the keyboard.
The merge file will be loaded into the blank document you just
created.
6. Message boxes appear at the bottom of the screen that prompt you for
each line of data. The cursor is positioned for you and the data is
entered direccly into the form letter. After you enter a response to each
prompt, select End of Field from the Merge tools palette. Do not
press the Return key unless you want to add a blank line to the text. rf
you have an extended keyboard, you can press the F12 key rather than
select End of Field from the palette.
When the merge is complete, you can print the resulting document or edit
the document. If you always want to send the resulting letters directly to the
printer, you can modify the Intermediate Merge-WP template by inserting a
To Printer instruction as the last Line of the document.
Because WordPerfect lacks conditional tests, it is necessary to create three separate merge forms and three data documents for the
Advanced Merge. The three merge forms are stored on disk as Adv.
Merge 1-WP, Adv. Merge 2-WP, and Adv. Merge 3-WP. WordPerfect provides a
tool for record selection that can break the data file (Advanced Merge DataWP) into three groups based on sales results: Negative, Positive, and Neutral.
These three data files have already been created for you and are on the enclosed disk. To see how the data files were created, follow these steps:
1. Launch WordPerfect and create a new document.

2. Select the Sort ... command from the Tools menu.
3. Select the Advanced Merge Data-WP file and click on the Sort butto n.
The Sort dialog box appears (see figure 3.25).
4. Change the settings to match those shown in figure 3.25 for the
negative group. The various check boxes, pop-up menus, and keyboard
entries instruct WordPerfect to select only those merge records where
the contents of Field 11 (Change) is less than o r equal to zero, and
then redirect the output to a new file.
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Key
1811

02
ltems:I Merge

03

04

os
06
0 7
08

09

IRlphonumer!c
Ifllph cmurneii <

Order:j Ascending

IRl1>ho11umer!c

181 Redirect Output

Ifllpl1<1nurneii1

Il\lphonumL' ric
Ifll11 t1<1n um mi 1

n

Begin

D

Figure 3.25 Creating the "Negative" group in the Sort dialog box.
S. When prompted for a file name, e nter Negative.
6. Repeat steps 2 through 4 to create the Positive and Neutral data files.
Only the Filter Acceptance Criteria at the bottom of the dialog box will
change in each case. Use KEY 1 >=50 for the Positive file. Enter
KEY1 >0 * KEY1 <50 for the Neutral file. (fhe asterisk (*) represents
"AND.")
There now are three data files and three merge documents. To complete the
process, merge each of the pairs: Adv. Merge 1-WP and Negative, Adv. Merge
2-WP and Positive, and Adv. Merge 3-WP and Neutral.

TIP: Remember to close any open merge forms or data documents, and create a new blank document before you perform
each merge.

Merging in Nisus
Merges in Nisus are identical to those in Microsoft Word. Nisus
supports the same delimiters, conditionals, and merge types. Although Nisus also can read Microsoft Word documents, Nisus
files-Basic Merge-N and Basic Merge Data-N; Intermediate Merge-N, AN, and
BN; and Advanced Merge-N and Advanced Merge Data-N-are included on
the disk. To perform either the Basic, Intermediate, or Advanced merge in
Nisus, follow these steps:
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1. Launch Nisus and o pen the merge document (Basic Merge-N, Intermediate Merge-N, or Advanced Merge-N).

2. Select Merge .. . from the File menu. The merge dialog box appears.
3. Select Printer or New Document.
Note that the Intermediate Merge-N template is modified slightly. During a
prompted merge, Nisus creates only a single merge document. If you need
additional form letters, you must repeat the merge process for each one.

Envelopes and Labels
ddressing envelopes may be the last legitimate use of the typewriter. But
with a template and printer, you will find that envelope printing easily is
handled right in your word processing program. The trick is simply to format
the document properly and choose the correct Page Setup ... options. The
envelope template saves you from going through the trial-and-error required
to create your own envelope document.

A

The Envelope (\Vord) template is used for creating and printing
business size (#10) envelopes. To print envelopes using this template, you need a laser or an ink-jet printer. Although it's possible
to print envelopes using a dot-matrix printer, the time it takes to position the
envelope and the misfeeds that often occur make it a less than fruitful task.
To use the template, just follow these steps:
1. Launch Word and open Envelope (Word) (see figure 3.26).

2. Replace the dummy return address with the address of your company.
lf you are using preprinted envelopes that already contain a return
address, remove the return address and replace it with blank lines.
3. Change the dummy address to the address of your customer or client.
4. Select Page Setup .. . from the File menu. Select landscape mode (the
sideways page icon), Envelope - Center Feed, and Fractional Widths
(see figure 3.27). (Different printers may require different settings.)
5. Insert an envelope into the manual feed tray of your printer. For an
Apple LaserWriter IINT or JINTX, place the envelope face up, left edge
in and push the guides toward tl1e center until it just fits the envelope.
If you have a different printer, check the manual that came with your
printer for envelope adjustment instructions.
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Figure 3.27 The Page Setup ... dialog box enables you to set o ptions for
printing envelopes.

6. Select Print from the File menu, and then select OK The address
prints on the envelope.
7. Close the document without saving it.

Using other Printers
The instructions in steps 4 and 5 are correct for an Apple
LaserWriter IINT and IINTX. The paper tray for those printers
contains a pair of movable guides you use to center each handfed piece of paper, or in this case, an envelope. If you have a
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different printer, the options in step 4 and the envelope placement in step 5 may be different. Many printers, such as the older
LaserWriter LI, do not have an option for centering envelopes.
For these printers, align the envelope wi th the right edge of the
guides (as you look cowards the printer). Some printers may
require that you insert the e nvelope face down rather than face
up. Try inserting a regular sheet of paper and printing with the
template to gee an idea of how the envelope should be inserted.
A little experimentation may be necessary for perfect results.
As with the other word processing templates, you can use clip arc o r a
scanned version of your company logo co dress up the e nvelope, placing it in
the return address section. You also may wane co add a message line that
prints across the bottom left edge of the envelope, such as Attn: Accounting,
Happy Holidays!, and so on.
The disk also contains envelope templates for MacWrice 11, WriceNow, and
WordPerfect. The templates for MacWrite II and WordPerfect are saved as
stationery documents rather than normal files. Taste and Nisus include envelope stationery files on their program disks. WordPerfect 2.0 contains an
Envelopes macro that e nables you to print a currently highlighted address on
an envelope. If you wane co perform an envelope merge with any of these
word processing programs, you can modify the envelope templates using the
procedures outlined in the preceding section of this chapter.

Printing a Series of Envelopes
with an Envelope Merge
You can give the Envelope (\Vord) template a real workout by
changing it into a merge document. If you have a database of addresses for which you wane co send a mailing, simply change the
customer address section co a series of merge fields. The modifications have
been done for you in the Envelope Merge (\Vorel) file o n the e nclosed disk
(see figure 3.28).
The first line of the cemplace is a DATA statement that cells Word the name of
the merge data file. So chat you will have a data file with which co cry it out,
the template uses the file created for the Basic Merge example in the preceding section of chis chapter (Basic Me rge Data). To mark the locations where
you want co insert data, the customer address now contains merge fields that
are surrounded by t11e familiar "" delimiters.
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Figure 3.28 A Word document for envelope merges.
The dummy return address (Company) from the original envelope template
is replaced with a real address-that of the Jones Construction Company. If
you want to put Envelope Merge (Word) to work for you, change this address
to the return address of your company. If you use preprinted envelopes that
already contain a return address, eliminate the Jones Construction Company
address and replace it with blank lines.
To perform a sample envelo pe merge, follow these steps.
1. Launch Microsoft Word and open Envelope Merge (Word).

2. Select Page Setup .. . from the File menu, and make sure the settings
are correct for printing envelopes on your printer.
3. Select Print Merge ... from the File menu . The Print Merge dialog
appears.
4. Select Print (Word 4) or Merge and Print Results (Word 5) so that
the envelope information is sent directly to the printer.
5. Insert an envelope in the manual feed tray of the printer, click on the
Manual Feed option, and then select OK in the Print dialog box.
6. As each envelope feeds through, add another envelope to the tray.

NOTE: lfyou would rather not waste envelopes, you can click
on the appropriate button in step 4 to route the output to a new
document rather than to the printer.
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You will wane co make a few basic changes co the Envelope Merge (Word)
template. Begin by changing the return address to your address (or if you
have preprinted envelopes, replace it with blank lines) . Change the file name
in the DATA statement to the name of your address file. Finally, change the
field names in the main address to the names in your data document.

Producing Mailing Labels
with Microsoft Word
Generally speaking, a word processing program isn't the best program for
generating labels because of the difficulties inherent in lining up data on the
label. Arriving at the correct spacing for each label and between labels, selecting the correct Page Setup ... options (a custom page size is often required),
dealing with multiple columns, and determining the correct use of conditionals is a time- and paper-consuming process. Unless your word processing
program includes label templates, you may find that it is not worth the aggravation to print labels with it.
If you anticipate a regular need for labels, you may be happier with a dedicated label program. However, before you rush out to buy one, check the
programs you already own. Many database programs and word processing
programs contain label templates. Microsoft Word comes with a Mailing
Labels folder that contains several ImageWriter and LaserWriter label templates.
One of the biggest problems you will run into is d1at addresses contain varying numbers of lines. For example, some addresses may have a company
name and some may not. If you decide to use a label template in your word
processing program, labels are best printed as a merge document because
you can use conditional tests to handle the varying numbers of address lines,
closing up the space between lines for records that don't have a company
name.
The Avery 4146 (Word) template prints a continuous string of 1-up
labels on an ImageWriter printer (see fig ure 3.29). Addresses may
contain four or three lines (four lines with a company name and
duee Lines witho ut). It is designed to print on Avery 4146 labels- pin-fed, 1up address labels (intended for dot-matrix printers) that are 4-inches wide
and 1 7/16-inches high with a 1/16-inch gap between labels.
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Figure 3.29 The Avery 4146 (Word) template for 1-up lmageWritcr labels.
The first line of the merge document names the data file and prints the first
line of each record (in this case, the name of the person). The IF statement
checks for a company name in the second field of the record. If a company
name is found, it is printed. If not, the Address line of the record is printed in
its place. This is how you close up the space if there isn't a company name in
the record.
The merge template assumes you have set the page size to match the height
of a single label, making each label the equivalent of a new page. To set page
size to match label height, you must establish a new custom paper size that is
1 1/2-inches high (corresponding to the distance from the top of one label to
d1e next). To define a new paper size, follow d1ese steps.
1. Launch Microsoft Word and open the Avery 4146 (Word) template.
2. Select Chooser from the Apple menu, and then select the printer you

use from the list of printers.
(Remember, this template is fo r dot-matrix printers, such as the
ImageWriter. The template is not appropriate for laser printers.)
3. If you are using Word 4, select Preferences from the Edit menu (see
figure 3.30). If you arc using Word 5, select Preferences from the
Tools menu. Enter the dimensions for the label: Width = 4 in ;
Height = 1. 5 in.
1. Select Page Setup ... from the File menu, and click on the button for
the custom paper size you defined.

Getting the Mail Out

Preferences

lo...I

Oefoult Meosure: ._li_nc_h_ _ _

181 Show Hidden Te11t

O Use Picture Placeholders
181 Show Tobie Grldllnes
O Show Te11t Boundaries

in Poge Uiew

O Open Documents in Poge Uiew
181 Bockground Repoginotlon
181 " Smort" Quotes
Keep Program in Memory:
Keep File in Memory:
Custom Paper Size:

O Now O Always
O Now 0 Always

Wldth:~llelg ht: ~

Figure 3.30 Creating custom paper sizes in Word 4.
When printing, the printer feeds to the top of each label automatically. To
modify the Avery 4146 (\Vord) template for other 1-up label sizes, just change
the custom paper size. When you are ready to try the label merge, insert the
labels into your printer and follow these steps:
1. Select Print Merge ... from the File menu.

2. In Word 4, select Print from the File menu to send the labels to the
printer, or select New Document to display the merged labels onscreen. The equivalent options in Word 5 are Merge and Print Results
and Merge and Save Results in New File.
3. If you are printing now, click on the No gaps between pages check
box in the ImageWriter Print dialog box, and then click on the Best
button or Faster button to set the print quality.
When performing a merge, it is best to try a test run first using just a few
records. This is particularly important when merging labels-unless the first
label is positioned correctly, the rest of the labels also will be misaligned.
Because the lmageWriter begins by feeding the label about 1/2-inch, position
the print head in the middle of the label for the test run. After you find the
correct position for the print head and can print three consecutive labels
perfectly, rerun tlle merge using all records. If your printer tends to slip or
jam when printing labels (many do), run the merge in several passes, for
example, 30 to 50 records in each pass.
All label lines in the Avery 4146 (Word) template are printed in 12 point New
York. You can experiment with other fonts and sizes. The only restrictions
are that the font must not cause an address line to exceed the label width

(4-inches) and that the total height of all address lines is no more than 11/2·
inches.
You may want to include an additio nal address line. Currently, the entire
address must fit on a single line. lfyou decide to add an extra line, you also
must test for the existence of a second address line in the same manner in
which the template checked for Company.
After you set the options you want, you may want to change Avery 4146
(Word) to print on a different size of 1-up label. To do this, just create a new
custom paper size as previously explained.

Envelope and Label
Programs
rinting envelopes and labels are such common business tasks that several software publishers now offer programs or desk accessories specifically for these functions. There are many reasons why you should consider a
dedicated program rather than using a word processing template. When
printing envelopes, most dedicated programs enable you to add message
lines, store frequently used addresses, and print postal bar codes on the
envelopes. The programs frequently support a variety of envelope sizes.

P

Label programs enable you to choose from dozens of popular label types and
sizes. Rather than designing complex 3- or 4-up layouts in your word processing program, label programs enable you to quickly print almost any label
format on most printers. If you are just starting a small business or work out
of your home, you may not be ready for the expense of custom-designed and
printed shipping labels. With a laser printer and laser-compatible labels,
however, you can inexpensively produce polished labels that can enhance
your company's image. If your address, phone number, or logo changes, you
can instantly update the information without worrying about what to do with
dozens of rolls of preprinted labels.
What follows are capsule descriptions of several envelope and label programs. Although there are many more, these descriptions will give you an
idea of what to expect in a labeling program.
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Creating Envelopes and Labels
with INtouch
INtouch is an all-in-one address book DA from Advanced Software. Jn addition to storing addresses, phone numbers, and notes, it works as a telephone
dialer (dialing through your modem or the Mac's speaker) and can print
labels and envelopes. Figu re 3.31 shows the lNtouch main screen.
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Figure 3 .31 The !Ntouch main scree n.
You can define up to 15 styles o f envelopes and labels. JNtouch provides ten
predefined styles for you: a # 10 envelope for a L1serWriter, DeskWriter,
Personal LaserWriter, ImageWriter, and StyleWriter; a #9 envelope for a
LaserWriter and ImageWriter; and three labels. You also can define a series o f
pictures or logos to add to each envelope, a series of message lines, and the
type style for the address and the return address. You optionally can add
postal bar codes to each envelope. Figure 3.32 shows a print preview of a
typical INtouch envelope.
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Figure 3.32 A print preview of an INtouch envelope.
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One of INtouch's newest features is an INIT called Snap* that enables you to
access the INtouch DA without using the Apple menu. j ust press a special
keyboard combination and you can send any currently highligh ted address in
your word processing program, for example, straight to the printer to create
an envelope. You also can add tl1e address to your !Ntouch database at the
same time.
Like most DA address programs, INtouch is not designed fo r mass mailings.
You can print o nly one envelope or label at a time. Export options, however,
enable you to export an entire INtouch database as a tab-delimited text file,
suitable for use as a mail merge data file with o ne of the envelope templates
provided on the enclosed disk.

Creating Labels with MaclabelPro
When you think of labels, Avery often springs to mind. So it's hardly a surprise that a label company has created software that makes it easy to design
and print attractive labels.
MacLabelPro 1.03 provides over 60 templates for address, disk, video cassette, name badge, price marking, and file folder labels; index and post cards;
transparencies; index tabs; and envelopes. Each blank template is the same
shape and dimensions as the actual label or envelope. To use a template, just
add the appropriate text (all fo nt combinations, sizes, and styles a.re supported) and any graphics you want.
Tools are provided co rotate objects; import PICT or EPS graphics; use
Macintosh icons; draw lines, squares, and other shapes; and resize and crop
graphics. You also can specify fill patterns, add serial numbers, and perform
mail merges with the program. The only impo rtant feature that the program
lacks is the capability to print bar codes.
The Shipping 5164 (Avery) label template is designed co produce
high-quality shipping labels on laser printers. The template contains areas for a company logo, your address, a message line, and
merge fields for the custo mer or client's address (see figure 3.33). The merge
procedures used by MacLabelPro are very similar to those of Microsoft Word
and many o ther popular word processing programs. Missing information
(company name, title, or first name) is handled auto matically by
MacLabelPro's "autoslide" and "slide object left" functions.
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Figure 3 .33 The MacLabelPro Avery 5164 shipping label template.
To prepare the Shipping 5164 (Avery) template for general use, replace the
dummy company address and phone number with your own. Next, add your
company logo into the graphic placeholder in the upper left corner of the
label. You can do this by copying the graphic to the Clipboard while in a
graphics program or a graphic viewer DA, or use the Import Graphic ...
command from MacLabelPro's Special menu (you can do this only if the
graphic is a PICT or EPS file).
After you place the graphic, use the graphic tools in MacLabelPro's palette to
shift the position of the graphic, change the size, or crop it, as necessary. If
you have a standard message line you want to use, such as "First Class" or
"Urgent", add that now by selecting the text "Optional message line here"
at the bottom of the label and typing your new message over it. If you do not
want a message line, select the pointer tool from the tool palette, click on
the message box, and press the Delete or Backspace key to eliminate it. You
also may need to change the fonts if the fonts used in the template are not
available on your system. From top to bottom, the fonts are Umbra (your
company address) , Helvetica Bold (customer address), and Helvetica Bold
Oblique (message line).
·
After you set the options the way you want, save the template under a new
name and run a test merge. Rather than waste a sheet of labels, you can run
the test with normal letter-size paper. To perform a merge, follow these
steps.

1. Launch MacLabelPro and load Shipping 5164 (Avery).

2. Select Print Merge ... from the File menu.
3. Select the merge data file from the file list that appears in the dialog
box. For this test, use Basic Merge Excel Text. (lf the merge data file is
already on-screen in a window and was opened using the Edit Merge
File ... command from the Special menu, you can click on the Merge
Window button in the dialog box rather than selecting a file .)
4. In the layout dialog box that appears next, select the correct paper feed
option, and then click on the Continue button. (Optionally, you also
can specify a starting label and a range of records. Just clicking Continue will print all records beginning with the upper left label on the
page.)
5. In the LaserWriter Print dialog box, click on OK and the test merge will
print.
All your mailings will not be appropriate for a merge. Sometimes you may
want to print o nly one label. For this reason, you may want co save two versions of the template: a copy for merges and a copy for short nms. To create
the short run template (not provided on the disk), simply delete the merge
fields and save the template with a new name using the Save As ... command
in the File menu. When you are ready to print a label, open the short run
template and type the customer's address directly inco the address area.

NOTE: When you issue the Print ... command for a single label
or the Print Merge .. . command for a label merge, you can select
the starting label position on the form. This enables you to use
the same sheet of labels several times. Just peel off the labels with
addresses and print only where a label still remains. (Be sure to
read the instructions that come with the labels. You can safely
feed sheets of laser-printer labels through the printer o nly a
limited number of times.)

Creating Envelopes and Labels
with MacEnvelope
If you are looking for an all-purpose envelope and label program, you also
may want to take a look at MacEnvelope from Synex. The program disk
contains two versions-an application and a DA. Templates are included for
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13 common envelope sizes and 65 label layouts (for both Avery and Nebs
labels).
Each label or envelope can include the following print areas: an address, a
return address, a message, and up to two graphics. You can create as many
new templates as you like, but they are all saved as part of the main template
list. (Because of this, we could not include a MacEnvelope template on the
enclosed disk. However, as you can see in figure 3.34, it is simple to design a
shipping label template similar to the one created for MacLabelPro.)

s
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Figure 3.34 A shipping label template in MacEnvelope.
MacEnvelope does not include any graphics, editing, or line/shape-drawing
tools. If you want to add graphics to an envelope or label, you must import
or copy them from another program. However, the program does have a
graphics library that contains clip art samples and serves as a repository for
new graphics you add.
Return addresses and customer/client addresses are maintained in Lists.
Rather than dealing with merge fields, you simply choose the address or
addresses you want to print and they are placed automatically in the proper
spot on the envelope or label. MacEnvelope also supports bar codes, which is
an increasingly important feature .

Summary
n this chapter, we explored mail-related casks that are an important part of
any business. If you wane to gee your personal, departmental, or company
mailings under control, the templates and special-purpose programs discussed above will make the cask easy. Specifically you learned how co
perform the following casks:

I

• How co me rge using a Data Document, Merge Form, the Print Merge
commands, and conditional statements.
• How co perform merges with MacWrice 11, WriteNow, Taste,
WordPerfect, and Nisus.
•

How co create e nvelope and label templates, print a series o f envelopes, and produce mailing labels using INtouch, MacLabelPro, and
MacEnvelope.

In Chapter 4, "The Paper Chase," you will learn how to produce professionallooking documents using form generation programs.
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1fyou take a quick glance around, you will notice that we are still a long way
from the "paperless office." In fact, the advent of the personal computer has
made it easier than ever to create mounds of paper- in the form of statistical
and accounting reports, mass mailings, and other computer-generated reports. Sure, you can read information and reports onscreen, but you don 't
normally send floppies to customers; you send form letters and catalogs.
When you file a claim with your health insurance company, you fill out the
same form- with essentiaJly the same information that you have already
provided a dozen times during the year- again and again. Worse still, you
must fill out the forms by hand.
Although forms design and management programs do little to e liminate
unnecessary paper, they do enable you to automate the process of filling out
forms. (In reality, the forms design and management programs make you
more efficient at generating paper.) This chapter discusses the following
advantages that form programs have over the pa perversions:
• Produce perfect forms without filling them o ut by
hand or using white-out.
• Make computerized versions of existing paper
forms or custom design new forms.
• Increase your accuracy by making the form
automatically calculate statistics, such as subtotals and totals.

•
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Make unlimited perfect copies of forms.

This chapter explores creating forms using three popular programs:
SmartForm Designe r and Assistant (Claris Corporation), Fast forms (Power
Up Software Corporation) , and Informed Designer and Manager (S hana
Corporation). Although each program comes with sample forms, the following custom templates show you how to construct different, useful business
fo rms in each program:
•

AStatement ofAccount form (SmartForm Designer a nd Assistant)

•

AShippi ng Re q uest form (Fast Forms)

•

AWork Order form ( Informed Designer and Manager)

You can use form generatio n programs three different ways. You can create
original forms or buy templates and then complete the forms on your Mac.
Use the forms program for the sole purpose of creati ng master fo rms that you
have printed and then manually fill out the copies. Finally, you can duplicate
existing forms, replacing the origin als with compute r-generated versio ns of
the forms.

The Advantages of Form
Programs

Y

ou have a number ofaclvantages when you re p lace current paper forms
with a computerized forms syste m. The sig nificant advantages are improved accuracy, efficiency, and storage. (Unfortunate ly, saving pape r is not
one of the advantages. You probably will fi nd that you create as many, if not
more, paper copies of forms using form programs than when you completed
the forms manually.)
When you use an electronic form, the compu ter handles all calculations. T his
e liminates the possib il ity of human error and simplifies the process offill ing
in the form. You initially may invest a la rge amount of time whe n you des ign
a form , but after you are finished, you can use it over and over, and easily
change it if the need arises. In addition to simple calculations, you can design
forms that check the completeness of information you enter by requ iring you
to fill in certain fie lds before you can print. For example , if you e nte r a payme nt as a charge, you can specify that a charge account numbe r also be
e ntered. Electronic forms also can check against a list or a set o f rules to
determine whether you have entered appropriate values.

Because you can design electronic forms for easy completion, they are more
efficient to use than paper forms.Just enter the information and press the
Tab key to move from o ne field to another in a logical order. Because you
e nter all the info rmatio n into the computer, you do not need to read another
person's handwriting. You also can set default settings for fields in a fo rm. A
default is a value that is inserted automatically. Many forms contain default
values for the local area code, city, state, and ZIP code.
Forms can be used by more than one individual. When two or more people
must handle a form, you have several o ptio ns fo r filling in the form.
• You can use the e lectronic version of the form and share a floppy disk
copy of the fo rm file with another person, or use the file on a network.
• You can work with a paper copy and have a data-entry person enter the
information on the form into the computer.
• You can work strictly with paper copies of the form.
Unfortunately, if you complete forms o n paper, you begin to lose the built-in
conveniences of the forms program, such as date stamping and calculatio ns.
Experi ment with the d ifferent procedures and choose the one that works
best for you.
The greatest advantages of a forms program are storage and retrieval. You no
lo nger need to keep paper copies of all your printed forms. You can store all
the information in the computer. If you need a new copy of the original
form, you just print one.

TIP: Remember, when you store printed forms on your computer rather than in a fili ng cabinet, it is just as important to
organize your hard disk as it is to organize your filing cabinets.
The templates in this chapter are designed to give you an idea of the forms
you can create and use fo r general busi ness purposes. These forms may no t
meet your needs exactly, but they show you how electronic forms can replace
their paper-and-pencil equivalents. Forms programs, such as the three discussed in this chapter, provide you with the tools you need to create and use
forms. Whether you design o r purchase forms templates, investing the time it
takes to make sure the form meets your needs pays off in ease-of-use and
functionality.

-
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Using Flexform Business Templates
Although designing forms is fun , it is also time-co nsuming. The tinkering
requ ired to produce a perfectly arranged form with a ppropriate calculations
can go o n a nd on. Rather than caking the "d o-it-yourself ' a pproach, you may
fi nd that someone else has created a form that meets your need o r the fo rm
is close e nough you can easily alte r it to suit your need . Antic Software makes
ready-co-use form templates. Flexform Business Templates: Gene ral Business-Volume I contains d ozens of fo rms for the SmartFo rm program, a nd
includes a copy of SmarcForm Assistant that e nables you to fill out the forms.
Picture fields are included in each form showing you where to paste your
company name and/o r logo. Figure 4. 1 shows a sample form from th is
collection.
ll rile (dll U1ew w1noow'

PAYMENT PAST DUE

-- - - - -- - - - - - - - - - - - - - - - - - - - - - - - -- - - - --- - - - - - - - -- - - - - - -- - - - ~1'!.'!.

Figure 4 .1 A set of Past Due Notices are included in Flex.Form Business
Templates.
Forms in Volume I are divided intO the following seven categories:
•

Billing-credit/debit memo , invoice, and raincheck.

• Selling-estimate, proposal, proposal lead card, sales-call report, sales
order, sales receipt, and shelf talker.
• Stock-keeping-inventory count ticket, inventory record, material
return request, material transfer ticket, material withdrawal request,
picking list, and shipping & receiving log.
•

Collecting-cash receipt, credit application, deposit slip, past due
notice, and statement.

•

Delivery-bill oflading, bill oflad ing (short), delivery receipt, mailing
label, packing list, and shipping label.

•

Productio n-change order, daily production report, labor/material cost
report, production change order, production o rder, repair o rder, and
work order.

•

Miscellaneous-#10 regular business envelope, #6114 business reply
envelope (FIM B without bar code) , #61/4 business reply envelope
(FlM C with bar code), #6 1/4 courtesy reply envelope (FIMA with bar
code) , and #6 3/4 regular window envelo pe (for use by professionals,
such as CPAs and attorneys).

Ifyou are interested primarily in producing good-looking forms on demand
or you intend to have a pri nter reproduce the forms , you also sho uld check
out FlexForm Business Templates: Inventory/Stock-Keeping Edition-Volume
II. It is a two-disk set of PageMaker 3 form layouts. The files can be read and
used by PageMaker 4 as well as PageMaker 3. Like the forms in Vo lume I, the
24 forms in Volume II are professionally designed and attractive. Figure 4.2
displays a typical form from the set.
Forms in Volume II are divided into the following categories:
•

Production-daily production report, labor/material cost record,
production change order, production order, repair order, and work
o rder.

•

Purchasing-purchase order, purchase requisition, purchasing change
order, and request for quotation.

•

Delivery-bill oflading (short and long forms) , delivery receipt,
packing list, and shipping labels.

•

Receiving-receiving report and returned goods report.

• Stock-keeping-inventory count ticket, inventory record, material
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Figure 4.2 The Purchase Order template from Flexform Business Templates:
Volume IL
return request, material transfer ticket, material withdrawal request,
picking list, and shipping/receiving log.
Because the forms are PageMaker files, you easily can customize them by
adding your company name and logo. Volume Ualso includes eight gradient
fills you can place in forms to add emphasis to particular sections.
Working in PageMaker presents some drawbacks, however. You cannot fill
out the forms on-screen.You must complete the forms manually-or place
the forms into a standard form program as a graphic image-and then

overlay the form with fields. (For more details on how to perform this task,
see the following section, "Working with Pre-printed Forms.")
Using form templates is an attractive alternative to designing your own forms.
However, you may fi nd yourself adapting you r procedures to match the form
rather than designing a form for the way you do business. With SmartFo rm
Designer (Volume I) o r PageMaker (Volume II) , you can mo dify the forms so
that they match your needs more closely. When possible, before making your
purchase, preview the forms included in the template package to determine
how well they meet your needs.

Working with Pre-printed Forms
Many companies have a sizable investment in preprinted fo rms. Government
offices, insurance companies, and many other institutions often do not accept form facsi miles and insist you fill o ut informatio n o n their forms. Even
though you may be prevented from fully compute rizing these types of forms,
with a little work using a fo rm program, you can fill out the d ata and print
the informatio n onto the o riginal prepri nted fo rms.
Regardless of the form program you use, the process of comp uterizing a preprinted form is essentially the same. First, scan your form with a full-page
scanner and save it as PICT file. (If you do not own a scanner, you can have
this d o ne at a local service bureau. See Chapter 5, "Making a Po int" fo r information.) Then import or paste the graphic image of the form into the form
progra m. Because you use the image of the form only as a guideline for placing field s, the clarity of the scan is not critical. However, the scanned image
must be exactly the same size and in the same position o n the page as the
original form. Finally, following the directions included with your particular
form program, you add fields and calculations to the form.
The most critical part of producing a computerized form is aligning the fields
correctly with the preprinted form. After you have added a few fields, be sure
to check the placement of those fields by entering some sample data and
then attempting to print it onto the origi nal preprinted form. Few things are
more frustrating than add ing all the fields to a form only to discover that the
field placement is off.
Because you will be printing onto the original p reprinted fo rm, you want to
print only the information you add to the computerized template, not the
template itself. The process for printing o nly the data differs slightly between
programs.
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In Fast Forms, form layouts are divided into two layers-a printing layer and
a non-printing layer. This approach makes it much easier to create forms that
co main a combination of priming and non-printing parts. You simply place
the graphic image of the form (and anything else you don 'twant to print) o n
the non-priming layer. When you use SmartForm, to prevent the scanned
image from printing, click on the Print form data o nly check box after you
fill out the form using SmartForm Assistant. The procedure in Informed Designer and Manager is similar to the procedure you use in Fast Forms. To
prevent the scanned image from printing, place the graphic image of the
form (and anything else you don'twant to print) on the non-printing layer,
and then click on the Hide Layout check box in the Print dialog box.

TIP:When you use Informed Designer and Manager, be sure
not to set any objects on the form to "Print always." You do not
want anything other than data to print.

Computerizing Existing Preprinted Forms
After obtaining a form package, many users immediately attempt to make
a detailed copy of all their existing forms. As mentioned earlier, some
forms may not be acceptable in an electronic version, such as insurance
claim forms or government forms. In addition, the time you spend duplicating an existing form may be better spent designing a new form. In most
cases, if a particular form design already exists and must remain unchanged, it is better to treat it as a preprinted form using the previously
discussed techniques. Before you invest too much time in duplicating
forms on the computer, consider the following:
• Plan to spend at least one full work day re-creating the design and
matching the fonts on the form. Factor in even more time if you want
to add calculations and validation, such as range and data type checking.
• When re-creating government or insurance forms, just because the recreated forms look like the original forms does not mean that the
intended recipient will accept them.
• Duplicating an existing form is pointless unless you intend to replace
the paper form with the form you create. Before you begin the project,

make sure that you have the cooperatio n of the managers who are
responsible for determining what forms will be used in the company
or department.
Although you can impress your friends and associates by getting that company fo rm o nto the Mac's screen, your boss may wonder why you have so
much free time to devote to such a dubious task. A bette r approach is to
design new forms that are easy to use o n the computer and meet your business needs. The following sectio ns discuss the three major Mac fo rms
programs and present several fo rm templates for you to use.

The Statement of Account
Form in SmartForm

T

he Statement of Account template is a simple example of the types of
forms you can create using a forms program. Altho ugh you can use
any of the three programs reviewed to create the template, Smartform was
selected because it is well-suited for creating a form that will be used by mo re
than one person.

Smartform is a two-part program. You use Desig ner to create and modify the
form , and then use Assistant to fill out the form . \\7hen you purchas e
SmartForm Designer, you receive o ne copy ofSmartForm Assistant. Only the
person that designs new forms needs a copy of Designer. Yo u can purchase
additional co pies of SmartForm Assistant for the users who will fill out the
various forms. Because you only use Assistant to fill in the blanks o n forms,
you do no t need to worry about someone inadvertently modi fying the master
form.

Completing the Statement of
Account Form
The Statement ofAccount fo rm is a ready-to-use form that generates statements ofaccounts for customers and clients. Figure 4.3 displays a completed
Statement of Account form.
You can complete the fo rm by pressing the Tab key to move fro m
field to field, o r you can move directly to any field by clicking o n it
with the mouse. As you tab through the form, you canno t enter
data or tab to the top Date field, the Balance column, o r the Total field:
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information is entered automatically into these fields by the program. The
Customer field is centered vertically and horizontally, and has room for five
address lines.
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Figure 4 .3 A completed Statement of Account form.
SmartForm Assistanc enables you to store the forms for a single customer as a
forms set. A forms set consists of multiple copies of the same form in a single
file. To create a new blank copy of a form, select Add Blank Form from the
Edit menu. As long as you want the forms saved in the same file, you can add
blank forms as needed. To use your own data with the Statement of Account
template, follow these steps:

1. Double-click the Smartform Assistant program icon to launch the

program.
2. From the File menu, select the New... command. Locate the
Statement file in the File dialog box.
3. To create a copy of the Statement form, select Statem ent from the File
dialog box. This creates a copy of Statement and assigns the name
Statement- I.
4. Enter the data you want. Press the Tab key to move from field to field
in the form.
5. To create another statement for th e same client, select Add Blank
Fonn from the Edit menu. A new form appears.
6. When you complete the forms you want, select the Print... command
from the File menu to print the form.
You can use this form as is; however, you may want to make a few simple
changes to enhance the form, such as adding your business name and logo.
The next section discusses how to cuscomize the Statement form.

Customizing the Statement of
Account Form
You must use Smartform Designer to customize your forms. To finish customizing the form , all you need to do is insert the name and address of your
company in the upper left corner of the form. To perform this task, follow
these steps:
1. Double-click on the Statement file to launch SmartForm Designer.

SmartForm Designer runs and the Statement form appears on-screen.
You also can run SmartForm Designer and use the Open command to
load the Statement form.
2. Select the text tool (the capital letter Afrom the Tool palette) and
highlight the sample company name.
3. Type the name of your firm . The text you type replaces the sample
company name.
4. Repeat steps 2 and 3 to replace the sample address with the address of
your company.
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5. Select the Save command from the File menu to save the modified
form.
The name and address of the company name appears in Helvecica Bold. The
company name is 14 poincs and the address is 12 points. The "Thank You"
char appears on the bonom of che form is Brush Script. lf you don't have Brush
Scripc, you can replace ic wich a font you do have, such as Zapf Chancery.
The final modificacion you may want to make is to che phrasing of che form.
The headers for the body of the form (Date, Invoice # /Credit Memo#, and
so o n), for example, may not contain the phrasing you want. To edit the
head ers, click on the text tool in the Tool Palette, select the words you want
to change, and type a\vay.

The Shipping Request Form
in Fast Forms
f your company sells produces rather than services, most ofyour shipping
charges are probably billed to customers. Alchough the cost of se nd ing out
replacement items for lose and damaged goods and shipping evaluation units
is often treated as a business expense, these costs can ad d up. The Shipping
Request form is designed to help your shi pping department get a handle on
these types of expenses and track special shipping requests. The Shipping
Request form calculates total charges. Ifemployees make personal shipments, such as packages to relatives or friends, you can bill the charges back
to the employee sending the package.

I

Completing the Shipping Request Form
The Shipping Request form is d ivided into two parts. The individual who makes the shipping request compieces the first half of
the form. The shipping department completes the second half of
the form (the section of the form with the gray background). Figure 4.4 displays a completed Shipping Request form created in Fast Forms 2.0.
Following is a lisc of the form parts the person who fills ou t the shipping
request completes:
• The requesc date (the program enters the current date for you).
• The name and depa rtmentofthe requester.

•

The reason fo r the shipment and preferred method of shipping.

•

The "ship to" address and the date the shipment must be received.

•

A list of the items included in the shipment.

The shipping department completes the following sections :
•

The quantity of each item shipped and back-ordered.

•

The date of the shipment and number of cartons included in the
shipment.

•

The carrier and special delivery requests (ifany).

•

The weight, amount of insurance, and charge for each carton.

To create new copies of a fo rm, use the Fast Forms o r Fast Fo rms Filler program and select New Form from the Form menu. Press the Tab key to move
from field to field. You can press Command-Tab at any point to move directly
to the next major section. (This skip-ahead option was created with Fast
Form ·s Quick Tab feature.) After you click o n a check box or enter the items
you want to ship, for example, you can use the Quick Tab feature to jump to
the next sectio n rather than tabbing through several empty fields.
The Preferred Shipping and Carrier check box sections at the top and
bottom of the form include an Other option that you can use to enter a
different response. After you click o n the Other check box, press the Tab key
o nce to move to the text field, and then type your response. For "Preferred
S'1ipping," for example, you might enter "Courier" or "Cab." Note that Fast
Forms check boxes ar e not exclusive-you can click on several check boxes
in the same group; however, when working in this form, you should click o n
o nly o ne check box in each section. Fast Forms does not prevent you from
clicking on mo re than o ne check box.
Rath er than the Total Charges field recalculating every time you make an
entry, it calculates only o n command . In other words, Fast Forms does not
calculate the Total Charges field automatically as you fill o ut the form; the
field calculates only when you complete the form, print the form, or when
you request a calculatio n. To force a calculation, press Command-=, or select
Calculate from the Form menu.
Fast Forms provides only simple data screening capabilities; it checks for
numeric entries in number fields and performs range checks. The Shipping
Request form is designed basically as a fill-in-the-blan ks fo rm. You must validate all data. For example, this form contains three fields in which you enter
dates; 1: Request Date , 23: Needed By, and 79: DateShipped. Only the

'
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first field (Request Date) is a "crue" dace field ; the program ente rs the date
aucomacically. Because Fast Formssupporcs o nly dace fields chac receive a
dace scamp, che ocher two fields are just ordinary cexc. Because che Needed
By field and the Da te Shipped field accept any cexr you type, be su re co
enter che real d aces.
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Figure 4 .4 A copy of a completed Shipping Request form.

NOTE: Although fields in Fasc Forms forms a re normally filled
in one row aca cime, from left to righc, and chen from top co
boccom, chey have been reordered co follow the natural flow of
che form. To see che order , just cab through the form. Figure 4.5
shows the field names and numbers ofrhe Shipping Request
form.

Customizing the Shipping Request Form
You will no t need to make ma ny changes ro the Shipping Request form. In
addition to replacing the company logo a nd name, you may want to change
the text for some of the headings or check box options.
C
ID

ril e

Edil

Tc.ct

l

rt= •

~

T,

c..-~.-.a.mMy~

i
,..__ i
,,,._,,,

SUPPLY
COMPANY

~

L..

In-!?•.. ""

~
H

I• .._.'-',
O;!!m·l!•fi!!!µp!Ui•

Elm.I

fiJo.nerged-.trMU:

(j]UNl:NPwt .. S.Wt

17.rtc-.

{A3eust-

~MtomeE)Vtu

Ltfr!!ii·l·l ·i!·ilifil
3

WDUUUl!li®iii41'®

ACME

, • i
'o
i
'O !

-

-

,...................................................................... .................................................................

~

Q

loyaut Form

Field

Sh ip neq ue st

~

~

Ornw

ra::J0tteot1vie~s•

[liF~e.-ss

t >ChtroDt

I::(~:..

1=.:...

fig ,..,...IW•-l

""'"-

I,

~l-1

!S· Co.pariv

~·

c~ ~=-=-

$1//~(10

rn=- cu-~

iH
•
!:!=:.

0£PAR'/1JElfT
01/l.Y

M ·lif.Chli4TM

?.-

''I
~Q1i,i2

'2? : PCll"'l2

28 : Duc2

2Q·Qt.y3

-XI Parl3

3 1: 0..cJ

13":oty0
38 0\.1,16

~_:Port>
~Pcrl6

4

I Qli,,17

-'2 Pcrl7

"

Ql!J9

4,· Pcrl8

.5J .Oli.111

~~1:
I~ 1718081
~ 173 9091 i
~ l?S.801J :
~ 177 8011 i

l

46 ·0.:SCB

~

:

~~1;
~~!
66 ~ 67 906 l

~fo._.c10

"4 · Pcrtlt

l

t'I

~~...,,lj

W°Dffcll

47 Ql!J)

;

,' 6 Stu p p7:80 1 1
58 Stup 59:802, j

Duc: 11

~==================~
~
1

'----' i

~"'~:~0a~~~·1~~:1~' ~~!!!!!!:~:~··.
.... !;!~~i·~;:+!!!!!!~ ~·:~n~~~J!,.~1l~~j
! l;I·lJ~1!i lf~j!i 1il~ ~M~·:~:i~M~:~,~~r~•:~:~·:~:i~
/~·M1:~..~H~~j.j~rl~i
· .:',·:
•• ...

19

~~~·
HoCc:r tonsj

[§jusrs

(B Othff(tped'f1

li}SKoricl4iv

~Grownd

3

4

95; Ll t;1_c;l6

93'.l-ll~[99

lns~9?_:__
~
rns 100 _Chtr1

~ i0f"'Uj!02·-lns 103_~~

i

1~--

:

t "·1 "' 1 3"mrl+i ~J !

.....................................................................................................................................!Q
I~

Figure 4.5 Fields in the Shipping Request form.
The Shipping Request form uses onJy Helvetica and Helvetica Bold in 6, 8, 9,
and 10 points. Ifyou do not have these fonts in your system, you can substitute other fonts.
You wiU want to replace the sample logo and company name in the upper
left corner of the form with your own logo and company name. To replace
the logo graphic, follow these steps:

The Paper Chase

1. ln a graphics program, select Open fro m the File menu co open a copy
ofyour company logo.
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2. Select the graphic, and then select Copy from the Edit menu . Select
the Quit command to exit from the graphics program.
T

3. Launch Fast Forms and select Open from the File menu co open the
Ship Request template.
4. Click on the current logo. The logo is selected.

5. SelectPaste from the Edit menu. Your logo replaces the sample logo.
After you place the graphic, you can resize it, if necessary. Lf yourcompany
name is part of your logo, you should delete the sample company name. To
delete the sample company name, select the text tool from the Fast Forms
palette, highlight the "Acme Supply Company" text, and then press the Delete key or Backspace key. If your company name is not part of your logo,
you will need to add your company name to the form. Select the text tool
from the Fast Forms palette, select the sample company name, and replace it
by typing your company name.
Ifyou want to add advanced checking capabilities, consider recreating the
form in SmartForm or Informed Designer. The following features are available when you create forms in SmartForm or Informed Designer:
•

Multi-part forms that enable you to generate two copies of the form ;
one for the requester and o ne fo r the shipping department.

•

Clustered check boxes that prevent you from clicking o n more than
one check box in a section.

•

Lookup functions that enable you to link part numbers to item
descriptions and shipping charges co rate tables.

•

Formulas that enable you to ensure the quantity shipped plus the
numberofback-ordered items for each line equals the number you
request.

TIP: Because Informed Designer can read and convert Fast
Forms documents, you do not need to redesign the forms fro m
scratch.

The Work Order Form in
Informed Designer
fyou work for a company that performs repairs or provides a service, you
probably use a standard work order form. Replacing the work order form
with a computerized equivalent can increase the accuracy ofyour calculations, reduce customer disputes (they won't need to decipher cryptic
handwriting) , and replace paper records with an efficient electronic database.

I

Work Order is an Informed Designer form you can use in the office or in the
field to write up and tally service and repair bills. Although the Work Order
form is designed for an auto repair shop, you easily can adapt it to any kind
of service organization-plumbers, electricians, carpenters, computer dealers, consultants, and so o n.

Completing the Work Order Form
The Work Order form is a landscape, or wide form. If you are
using a standard Mac monitor, you will need to scroll back and
forth across the form as you enter data. After you load the form
into Informed Designer or Manager, press the Tab key to move from field to
field through the form. (The order in which you tab appears in figure 4.6.)
Informed Designer supports the same Quick-Tab feature as does Fast Forms.
To move directly to the next major section of the form, press Command-Tab.
In addition to pressing the Tab key to move from field to field , you can move
directly to the field you want to edit by clicking on it.
Many items contain default entries that you can tab past or edit as necessary.
Fields that contain defaults are the first three date fields (Date , Date
Ordered, and Date Scheduled); the City, State , and ZIP Code fields ; the
area code in the Phone field ; the hourly labor rate; the Sales Tax percent;
and the filled check box that indicates that travel time will be charged to the
customer. Informed Designer also automatically fills in the form number in
the upper- right corner of each form.
The Work Order form contains check boxes in Area 3 and in Area 6. The
check boxes in Area 3 are clustered; that is, they work as a group-you can
select only one check box at a time. When you select o ne check box, the
other check boxes turn off. To place a check in any of these fields, click o n a
check box using the mouse, or press the Tab key to move to the box you
want, and then press any key on the keyboard.
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Seve ral fields in the Word Orde r fo rm are display-only fields. You cannot edit
d isplay-only fields. These particular fields contain calculation results, such as
subtotals and totals, and the form number. You can set fields to d isplay-only
to protect en tries from inadve rte nt editing.
Whe n you test the Work Order form, you should know about the fo llowing tricky sections:

Section

£'(p/anation

Year, Make, Model,
Serial Numbe r (Area 3)

You can use the second unlabeled row of
fields to record informatio n about
another vehicle.

Service Work (Area 4) and
Hourly Charges (Area 7)

If you enter labor charges directly into
Area 4 ("Replaced muffler-$43.50," for
example) , the Work Order form igno res
any hou rly labor charges entered in Area
7 whe n calculating th e total labor
charges. Thus, if you charge every
customer the same hourly rate for every
service you perform, fill out Area 7 ("3
hours @ $36/hour," for example), and
d1en enter only me description of the
work in Area 4. On the other hand, if you
charge d ifferent races for different types
of work, enter each item separately in
Area 4, include the separate p rices in the
Service column, and then leave Area 7
blank.

Travel Time (Area 6)

Enter the Time Left and Arrived in hour
and minute format, such as 2 : 45. If the
time between the two entries moves from
AM to PM or vice versa, add the appropriate su ffix to each time, such as 2 : 45 PM.
When you add the appropriate suffix to
the time, d1e Work Ord er fo rm converts
me time to a 24-hour format-2:45 PM
becomes 14:45. The results appear as
hours and fractio ns of an hour, rather
than hours and minutes. The time fields
also contain help messages. To access
time field help messages, move to a time
field and select Help from th e Fonn
menu.
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Figure 4.6 The tab o rder in the Work Order form.
The Work Order form also contains fields for three signatures.
• A field for the signanire of the person who authorizes work.
• Another field for the signature of the technician who completes the
job.
• And lastly, a field for the signature of the custo mer when he or she
receives the repaired vehicle.
To test the form, enter sample data, and then print die form. Before printing,
however, select Page Setup ... from the File menu and make sure that you
have selected landscape mode. Because d1is fo rm is designated as a multipart form, two copies print automatically-a copy fo r the customer and a
copy for the company. The completed form appears in figure 4.7.

Customizing the Work Order Form
Now it is time to take a look at how the Work Order form actually works. The
Work Order form contains many features the other two templates do not.
This section discusses the form in the order in which you fill it out. The Work
Order form uses Helvetica lnserat fo r the name and address of the auto body
shop because it resembles a rubber stamp. All other text is Helvetica or
Helvetica Bold and ranges in size from 6 to 12 points.
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Figure 4.7 A completed Work Order form.
Field 34: RecNum is an auto-incrementing field you can initialize in the
Value dialog box. This field is set to start at 001000 and increases by l each

time you create a new form. To speed record searches, the fo rm is indexed
on this fie ld and the name of the customer (field 4).
If you plan to fill o ut forms someplace other than the workplace, change the
form number field (34: RecNum) so that it is no lo nger a display-o nly field.
This enables you to edit the form number as needed so that you can match
the number issued tO the custome r in the field.
To turn off the display-o nly default, following these steps:
1. Select the pointer tool from the Tools palette and click on d1e
RecNum field .

2. Press Command-K. The Value dialog box appears (see figure 4 .8) .
3. Click on the Display-only check box to turn off display-only. (The
check mark should disappear.)
4. Click on the OK button to close the dialog box.

Ualue for RecNum
Functions

Cells

~-------~

Ce116
Ce117
Ce118

0
,.::.
H

g~t::elime
0

Calculation

Operators

Abs()
ACos ()
AddDays ()

0
,.-

+

b

*

IA:
~

~ '" ';"'~" ~ -"~" ~ .: . :~e y('"'"~)-----'-~"--':;i: ~l~D

@ Default Q None

181 Display only

181 Auto-increment

Get next value from I.__F_o_r_m
_ _ _ _ _ _,,..._.I
Nexl value
Increment by

I ·~!lli~•~•!liliiJliiJlii]lii]lii]liill]
~

LJ

Ca n ce l

J

n

OK
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Figure 4.8 The Value dialog box.
The Today func tion displays the current system date as the default in the
three date fields (fields 1 through 3-Date, Date Ordered, and Date Scheduled).
Field 8: Zip is a character field that uses a##### format. This fo rmat enables leading zeros to appear rather than be omirced as they would be in a
normal number format.
Field 9: Phone is a character field that contains d1e default format (4 16) 0000000. When you enter a seven digit phone number, for example 5238865,
the character substitutions are made from the right side and the default area
code is retained. lf you enter a ten-digit phone number (which includes the
area code), Informed Designer replaces the defau lt area code (416) with the
area code you enter.
Fields 10 and 18 (Yearl and Year2) are for recording the year of manufacture of each vehicle (that is, the year each one was made). Both fields use a
special date format-19YY. You can enter a complete year (such as 1985), o r
enter just the last two digits of the year (85), and the entry converts to the
complete year. (These fields may be irrelevant to your business and can be
eliminated.)
Fields 14 through 17 are clustered check boxes, and are defined as Boolean
fields. (Boolean means that you can o nly set the check box to two different
settings: On/Off o r True/False). Because the fields are clustered, if you check
one box, the other boxes turn off (become unchecked) automatically (see
figure 4.9) .
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Figure 4.9 A clustered group of check boxes.
Field 22 is a table in which you record service labor. You enter customer
descriptions of suspected problems and write-ups of the worked performed
in the Description of Work column. You optionally can enter prices for
labor performed in the Service column. (If you perform all work for a fixed
ho urly fee, you can enter the total hou rs of labor and the charge per hour in
the line beneath the table (Area 7) rather than enter the individual price for
each service in the Service column.)

NOTE: If you enter any fees in the Service column, the hourly
charges in the line below (Area 7) are ignored in the labor calculations. Field 32: ServTotal contains the sum of all labor
charges.
Field 23 is a special field (referred to as a table) in which you enter product
parts and is located on the left side of the form. You must enter three entries
in each line: the quantity, a part number and/or name, and the total price for
that number of parts. Field 28: Parts displays the to tal dollar amount for all
parts. Because the amounts to be totaled come from a table rather than a set
of individual fields, you cannot simply instruct Informed Designer to use a
formula such as Sum ( Price) to calculate the Parts to tal (field 28). When
summing a column of a table, the correct form ula is Sum ( EachValueOf
(Price)) .

Field 22 (Labor) in Area 4 is a table in which you use a formula similar to the
Sum formula is used to sum service charges (field 32: ServTotal). Informed

Designer copies the Parts total (field 28) to the totals section on the far right
side of the form, and places it in field 33: PartsTotal.
Field 24: Location refers to the location in which you perform the work. If
you use only one work site, you can ignore this field. If you perform work at
multiple work sites, or at a customer's house or company, enter the address
information in this field.

You use fields 25 through 27 to charge for ti-ave! time to a job site. In the first
field, enter the time you left your office, and in the second field, enter the
time you arrive at the customer's location. Enter AM or PM after each entry so
that the time converts to a 24-hour format. The calculation field 39:
TravelTime computes the difference in seconds between the two times. The
formula (TimeAr r i ved -Time l ef t ) / 3600 converts the time difference to
hours and fractions of an hour (1.3, for example, represents one and threetenths of an hour). If you check the check box in field 27 (Charge for travel
time?), the travel time in field 39 is multiplied by the hourly rate in field 30:
PerHr to arrive at the trip charge (calculatio n field 36). If you do not check
field 27, Informed Designer does not calculate or assess a trip charge.
\Vhen your company uses a fixed hourly rate for all service work, enter labor
charges in fields 29 through 31. Enter the number of hours worked in field
29: Hrs, and the hourly rate in field 30: PerHr (the current default for field
30 is S36). To change the defa ult hourly rate, select field 30: PerHr, press
Comrnand-K, and then type a new value in the Value dialog box. field 31
(the labor to tal) is the product of fields 29 and 30 and calculates automatically. lf you do not enter any dollar amo unts in the Service column,
Informed Designer uses the amount in field 31: HrRate for the Service Total
amount (32: ServTotal) .
Field 35: SubTotal is the sum of the Service and Parts totals (fields 32 and
33). Informed Designer calculates sales tax in field 37: Tax and uses the
formula 0 . 07 * Pa r tsTotal. This means that the hypothetical state sales
tax of seven percent is levied on parts o nly and does not include service.
Field 38: GrandTotal is the sum of fields 35, 36, and 37 (the Subtotal, Trip
Charge, and Sales Tax) .
Regardless of the type of service your corn pany performs, you can use variations of the Work Order form . Following are a few suggestions for some of
the areas you may want to change:
• The font for the company name and address is Helvetica Inserat
(chosen because it looks like a rubber stamp). If you do not have this
font, you can change it to a similar font, such as Helvetica Bold. Of
course, you will also want to change the company name, address, and
pho ne number to that of your own company.
• The default values for fields 6 through 9 (City, State, ZIP, and Phone).
• The labels above fields 10 through 13 (Year, Make, Mode~ and Serial
Number) may need to be changed to names appropriate for your
business.
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If you perform all your work at the same hourly rate, eliminate the
Service column of the Labor table (field 22) and widen the Descrip·
tion of Work column to the full table width. You can even replace the
table with one- or two-line fields titled "Customer Comments" and
"Description of Work." (Note: If you eliminate the Service column, be
sure to change the formula for field 32: Serv'fotal to read HrRate.)

•

Set the default value offield 30: PerHr to your standard hourly rate.

•

If your company performs work at several different sites, you can
change field 24: Location to a pop-up list of different work locations.

•

True is the default for field 27: Charge for travel time?. If you do not
normally charge for travel time, click on the Charge for travel time?
field, select Value from the Settings menu, and then change the
default response to False.

•

You can alter the sales tax formula in field 37 (fax) to match the sales
tax formula for your city and state. The current formula calculates tax
for parts only and does not calculate tax for labor. If your city and/or
state taxes both parts and labor, you can change the formula to . 07 *
SubTotal. If you also should tax the trip charge, the formula becomes
. 07 * (Sub Total + TripC hg) . In either case, you should substi·
tute your local tax rate for the default setting of .07.
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Summary

I

I
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n this chapter you learned how to create and use various form templates
on the Mac. Specifically, you learned the following:
•

The advantages of form programs.

•

How to use FlexForm business templates, pre-printed forms, and how
to computerize existing preprinted forms.

•

How to customize and complete the Statement of Account form
(SmartForm) .

•

How to customize and complete the Shipping Request form
(Fast Forms).

•

How to customize and complete the Work Order form
(Informed Designer).

In Chapter 5, "Making a Point," you will learn how to create professionallooking documents, brochures, and presentations using desktop publishing
techniques.

Making a Point
Even the strongest critics of the Mac agree that it started the desktop publishing revolution. The introduction of a machine that actually displayed an
image similar to the final output was groundbreaking. Today, WYSIWYG
(What You See Is What Yo u Get) displays are a standard part of most computer environments.
The Mac continues to be a strong leader in the desktop publishing industry.
This chapter reviews some of the basic publishing arenas and provides guidelines for selecting tools appropriate fo r creating you r own designs. The topics
covered include:
• Graphics programs for working with images.
• Techniques that enable you to incorporate your company logo into
word processing documents.
• Desktop publishing and desktop presentation software.
• Using fonts and special text effects.
• Creating business charts and graphs.
• Capturing images from the Macintosh screen.
The Mac retains its lead in providing powerfu l and flexible tools for design and production. Al though no t for
everyone, it is a good bet that-even in a small company-at least o ne person will need these programs.

/
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This chapter provides a broad overview of the options available within
Macintosh desktop technology.

Graphics Programs: Working
with Images
dmittedly, not everyone in business needs a graphics program; but fo r
many users, the ability to manip ulate an image is an important part of
their jobs. Even simple illustrations and grids are easier co create with a dedicated graphics program than by using the meager graphic tools provided
with most database, spreadsheet, and word processing programs.

A

There are several types of graphics programs and corresponding file formats.
Paint programs, such as MacPaint from Claris Corporation and Studio/ 1,
Studio/8 , and Stud io/32 from Electronic Arts are the s implest co use. Paint
programs enable you to design and edit bitmapped images-grap hics composed of dots. Black-and-white paint images ge nerally are sto red in the
original MacPaint format. Paint images that involve color or shades of gray are
stored as TIFF (Tag Image File Format) files.
Paint programs- even powerhouse programs such as Studio/32-seem more
natural co many users: artists and no n-artists alike. The sophistication of paint
programs is determined by the resolutio n of the image (the numbe r of dots
per inch) and the number of colors in the image. Regardless of whether the
p rogram supports only 1-bic images (black-and-white) or handles 32-biccolo r
or gray-scale eye-poppers (over fo ur million colors) , the tools and techniques
usually are easy to master.
At the next level are draw programs. Draw programs work with objects,
rather than individual dots. The image is stored as a collection of instructio ns
for drawing the image. You can create a rectangle as an actual shape. Because
the rectangle is an object rather than merely a collectio n of d ocs, you can
resize it, move it, rotate it, change its fill pattern, o r place it behind another
o bject. Claris Corporation's MacDraw Pro is a typ ical d raw program. The files
for these p rograms are generally saved in the PICT o r PIC12 fo rmat.
The highest level graphi cs application is chat of PostScript drawing programs.
Like standard drawi ng programs, these applications enable you co create
images out ofindividual objects. The programs, however, create instructions
that are designed especially for PostScri pc printers. As a result, the resolu tion
and special effects of these programs are unequaled. If you are a freehand

illustracor, choosing one o '." these programs is the closest you can come to
transferring the normal graphi cs cools and techniques co a computer screen.
The two major competicors in this field are Adobe Illustracor and Aldus Freehand. Bear in mind that these programs are for experts. These programs
often create two files-an EPS file for printing and a TIFF file for on-screen
display. EPS is an acronym for Encapsulated PostScript and refers co a file that
contains actual instructions fora Postscript printer.

Paint. Draw. or Postscript
Different jobs require different tools. If you intend to create your own images, make sure that you are comfortable with the way the program actually
works. If you need to use images created by o ther people, make sure the
program you select ca n import the proper file formats. You should base the
type of program you choose on the following criteria:
• Your level ofartistic expertise.
• The types of images you intend to create and edit.
• The types offiles your deskcop publishing or presentation software
accepts.
• Your budget.

If you are an inexperienced artist, your best bet is to begin with a simple
paint program. Everything is drawn o n a single flat surface and the cools you
use, such as the erase r and paint bucket, are derived from real life cools and
analogies. Because of their limited capabilities, paint programs tend to be
less expensive. You should expect to pay mo re for a program t hat is capable
of creating and editing 32-bit color images than fora 1-bit (black-and-white)
program. When-or if-you decide to move up to a more complex program ,
you will not have wasted a substantial amount of money.
More experienced or adventurous users may be better off with a draw program, such as MacDraw Pro. Being able co produce resizable PICT/PICT2
(draw) files is a big plus if you intend co do desktop p ublishing.
If you already are an accomp lished artist and want to take full advantage of
the capabilities of modern PostScript printers, such as those in the Apple
LaserWriter series, Illustrator or Freehand are the programs of choice.
For those of you th at are unable to decide between painting or drawing (or
need the power of both), SuperPaint 3 is a good cho ice (see figure 5.1) .
SuperPaint enables you to work with dmw and paint gmphics simultaneously,

Making a Point
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switching between modes as needed . You can take a graphic object, change it
temporarily to a bitmap, do some mino r editing, and then change it back into
an object again which is extremely ha ndy.

Figure 5 .1 This SuperPaint 3 sample image is a combination of Paint artistry
(the graphics) and Draw objects (the text) .
Don't be surprised ifa single graphics package isn't enough. When performing heavy-duty image editing, it is often convenient to switch from one
program to another throughout the process in order to take advantage of
special editing features that exist in one program but not in others.

Image Processing
A special class of graphics programs is available for working with
high resolution images, such as scanned photographs or televisio n screens. These programs e nable you to actually edit the
scanned or captured image. You also can use the programs to
add special effects, such as blur o r distortion, o r to colorize
black-and-white images. The most no table of these programs are
Digital Darkroom from Ald us Corporation and Adobe Photoshop.
If you routinely need to clean up scans or images captured from
television or video tape (typically in TIFF fo rmat) , you will need
an image editing program .

Graphics programs can open up an entirely new horizon for the computer
user. Most people think of the computer as a tool for working with words o r
numbers. With the additio n of a good graphics package, you can use the
computer to work with images as well. Although the programs are not substitutes for talent, they do o ffer another avenue for creative expression. And for
those o f you who aren't artists, graphics programs offer a way of modifying
existing images to meetyourcurrent needs.

Aldus Gallery Effects
Gallery Effects are "plug-in" filters you use with SuperPaint 3 to create special
effects in bitmapped images. You also can use Gallery Effects with Adobe
Photoshop and Digital Darkroom, as well as within the special stand-alo ne
application and a desk accessory that are included with the package.
After you install a plug-in into o ne of the programs, it is selected and acts just
as any other tool. You can apply Gallery Effects to the entire image o r to a
selected area. Several of the effects are usefu 1for creating interesting backgrounds that are particularly useful in presentations (see figure 5.2). In
less than five minutes, fo r example, you can use SuperPaint 3 to create a
presentation-quality text chart o n a Gallery Effect backgrou nd.

Figure 5 .2 A text chart on a gradient-filled backgrou nd with a Craquelu re
effect.
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When selected, each effect has one or more controls you can use to alter its
intensity, the amount of detail, and so on. You can use the preview window
to see what a small selection of the graphic will look like when you apply the
current effect settings. Gallery Effects can be used on both color and grayscale images.

Clip Art with ClickArt Image Portfolios
Everyone occasionally needs some artwork to dress up presentations, n ewsletters, or reports. Unfortunately, not everyone is an artist; however, there is
a solution. Traditional clip art consists of books of images you can copy and
physically paste onto the page. Electmnic clip art consists of disks of images
you copy and paste into documents using the standard Macintosh editing
commands. These images may be used without a graphics program.
Thousands of canned images exist as public do main, shareware, or commercial products. Images are stored in one of th e standard graphic formats to
make them easy to access. You use the image as is or load it into a graphics
program to edit. Clip art images can be detailed drawings or simple line arc.
Some newer collections offer scanned images and color images. A leading
source of commercial clip art is the ClickArt Image Portfolios from T/Maker
Company. The two products discussed he re, ClickArt Color Graphics for
Presentations and ClickArt EPS Business Art, are high-end images. T/Maker
also has bitmapped versions of much of its ClickArc.
ClickArt EPS Business Art consists offour disks of detailed black-and-white
EPS business images. Like other T/Maker ClickArt sets, a visual index of the
images is presented in the User's Manual. Figure 5.3 shows several of the
images placed in a PageMaker document.
Because the files are PostScript, you can do amazing tricks to the images if
you have the right graphics program. The ma nu al offers tips on altering image size, cropping, adding text, combining images, adding a background or
box, and filling and stroking the image with gray.
ClickArt Color Graphics for Presentations consists of a set of over 250 color
PICI2 or EPS images (depending on which version you order) suitable for
use by most presentation and desktop publishing programs. PICT2 is a color
format for use with most graphics programs. EPS (Enca psulated PostScript)
files are designed for use with only the most sophisticated graphics programs
and are generally more difficult to modify. Some programs that can read EPS

files include Aldus PageMake r, QuarkXPress, Ready,Set,Go!,Ad obe Illustrator ,
and Aldus Freehand . Figure 5.4 shows two sample images loaded into
MacDraw Pro.

Figure 5.3 Here are a few of the many graphics included in EPS Business Art.

Figure 5.4 Two ClickArt Color Graphics images for presentations.
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To save disks pace, the graphics are compressed. Rather than copying all the
files to your hard disk, a special Extractor program enables you to decompress just the files you need for your presentation. Image categories include
arrows, awards, backgrounds, borders, business, communications, computers, flags, hands, logos, maps, money, office, people, politics, retail, stamps,
time, and transportation. To find specific files, a printed guide to the disks is
included that displays the name and a picture of every image.
Whether you choose the PICT2 or the EPS version of this package depends
on how you want to use the images. PICT2 files are more compact and display quickly. EPS is the better choice when you need very high resolu tio n
images (for printed o r slide output, for example) and when screen display
time is not an issue.

Using Your Logo
he most commo nly used image in any business is the company logo.
There are dozens of Mac-related uses for a logo. You can add it to documents to generate your own letterhead and custom envelopes, include it o n
screens created in a presentatio n program or business charts made in a
spreadsheet, and use it to identify database records as those of your firm. The
trick, however, is getting it into the Mac.

T

You have two options:
•

Re-create the logo in a graphics program.

• Scan the logo using a scanner, and then sto re it on disk as a graphic.
The first o ption is fine if you are designing a new logo from scratch or have
an extremely simple logo, such as a logo that consists only of text and solid
shapes. In most cases, however , the second optio n makes more sense. The
process consists of scanning the logo and th en using a graphics program to
clean up the image.

Scanning the Logo
The purpose of scanning is only to get your logo into the Mac. Although
almost any scanner can do a good job, d o n't expect it to be perfect. You can
achieve perfection- or something close to it- in the clean-up process.

If you don't have the equipment (or the desire) to do the scanning yourself,
check w ith local "quick copy" or print shops to see what they charge for
doing it. They eve n may be willing to do the clean-up work. Be sure to mention that it mu st be saved in an appropriate Macintosh format. Ask the m for
PICT, TIFF, and EPS formats. Different programs in which you want to use
your logo may have diffe rent restrictions fo r the type of files they can and
cannot read.
The type of scanner required varies w ith clarity of the logo, the background
in w hich it is embedded, and whether it is stra ight black-and-white or needs
to display gray tones or color. The following factors are impo rtant to consider whe n scanning a logo:
•

Clarity of the original- If your original image is fuzzy o r has other
imperfections, they can only get worse in the scanning process. Start
with the cleanest reproduction you have.

•

Background-The greate r the contrast between your logo a nd the
paper on which it is printed , the better the scan will be. The best case
is a logo printed on untextured wh ite paper. Scanning a logo on
tex tured letterhead, for example, may make it difficult to get a good
image.

•

Black-and-white vs. gray-scale-If your logo is black-and-white only (no
shades of gray), you will have the easiest time getting it into the Mac.
Virtually any scanne r can do a re asonable job of capturing a black-andwhite image. If your logo is gray-scale or colo r, you need to worry
about accurate reproduction of the shades- something that isn 't an
issue with a black-and-wh ite logo. The scanner selected must be able to
capture gray-scale o r color images, as appropriate fo r the logo.

After you have a clean copy of your logo and access to a scanner, you are
ready to go. Because scanners routi ne ly have multiple settings for dots per
inch (dpi) and data bits, try several combinatio ns to see which settings pro duce a scan closest to the original. If the original image is black-and-white,
you w ill probably do we ll sticking with the line art mode of th e scanne r. If
the logo contains grays or colo rs, use a gray-scale or colo r scanne r and scan
at the 4- a nd 8-bit settings at both 200 and 300 dpi.
Depending o n the types of files your graphics program can read , save the
scans in TIFF or PICT format. If you are borrowing a scanner for this task,
save each scan in botb fo rmats- you can throw the un needed set away later.
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After you have a reasonable scan w!th which to work, you will need a graphics program in which to edit. If the sca n is black-and-white, any paint
program will suffice if it can read the file. If th e file is in TIFF or PICT fo rmat,
you will need a more powerful program, such as Aldus SuperPaint 3,
MacDraw Pro, Studi o/8, Studio/3 2, Adobe Photoshop, or Digital Darkroom to
clean up the image.
Figure 5.5 d isplays an unedited scan of a logo saved as a 300dp i/8-bit TIFF
image.
Tent

Mask

Color Goodies

IUlndow s

300dpll0 bit lo o -Tlrr

Figure 5.5 This is the original, unedited image in Studio/8.
Editing the scan requires several steps that vary, depending o n the nature of
the logo. While editing, be sure to save the image frequen tly. Keeping multiple copies of the image enables you to repeat the process, if necessary,
without moving all the way back to square one. To clean up a scan, you can
fo llow these general steps:
1. Elimi nate the background around the logo using the

Eraser too l.

2. Remove any patterns within the logo using the Eraserand Selection
tools. After you close the bo rder, you can use the program 's Fill or
Paint Bucke t tool ro fill the area with a u nifo rm pattern.
3. Increase the magnificatio n (zoom) and remove extraneous dots in the
image. Make su re all lines are smooth and closed.

4. Optional: If you decide that you want the logo to be entirely black-andwhite (no shades of gray or colors) , you can transform any image to
black-and-white by simply using the option in your graphics program
to set the contrast to 100%.
5. The final steps of clean-up require doctoring the image to meet design
requirements-in this case, squaring up the frame of the computer
screen, cleaning u p the keyboard, and rescaling the image to an
appropriate size. Yo u can accomplish this final editing usi ng a variety of
tools, but the most useful ones often are the Pencil, Eraser, and
Selection tools. Figure 5.6 displays the finished logo, saved as a
Scrapbook image for easy access.
Scrapbook

3 / 12

PICT

Figure 5.6 From the Scrapbook, you can copy and paste your logo into any
document.
Text in a logo-even a few letters-can present a special problem. Unless you
are extremely patient and skilled as an artist, it is unlikely that edited text will
look as good as the original text. One solution is to re place all re.Kt with real

le tte rs you type while in the graphics program. As long as the text was created with a standard font you can identify, retyping is the answer. When
replacing text, ifyou are using a program, such as SuperPaint, that supports
both paint and draw modes, change to draw mode before adding the text. If
you save the finished logo in PICT format, you will be able to resize the image without distorting the text.
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If you want to have a little fun and your graphics program contains interesting fill and gradient options, you may want to create a couple of stylized
versions of your logo, such as the one shown on the splash screen of the 4th
Dimension Project Expense Tracker database in Chapter 6, "Getting Organized. "Just select areas and fill them with the patterns or gradients ofyou r
choice.

Putting It in Print: Desktop
Publishing

T

hese days, the dividing line between word processing and desktop publishing (DTP) is becoming blurred. Many of the more advanced word

processing programs now incorporate traditional desktop publishing features, such as multiple columns, paragraph styles, and text you can wrap
around graphic objects. The advantages of a true desktop publishing program are: better control over layout (the placement of items on the page),
and tighter integration of text and graphic elements.
If your layout needs are simple, you may already have all th e desktop publishing power you need in the form of your current word-processing program. If
not-or if you wou ld rather take advantage of the raw power and flexibility of
a desktop publishing program-here are several programs to consider.
The current market lead ers are Aldus PageMaker fro m Aldus, and
QuarkX.Press from Quark, Inc. Other newly released competitors include
Ventura Publisher (Ventura Software), FrameMaker (FrameTechnologyCorporation), and RagTime 3 (MacVONK USA). Ifyou are interested in getting
your feet wet in DTP, but are not ready to make the plunge with a fullfeatured program, such as the ones just mentioned , you may want to start
with a simpler, less feature-packed program, such as Aldus Personal Press.
There are also some special-purpose DTP programs that may suit your needs.
Multi-Ad Creator from Multi-Ad Services, for example, is a desktop publishing
program that is specifically designed for creating and laying out camera-ready
advertisements.
Desktop publishing can be a very expensive field. The quality ofyour output
depends up the quality of your printer. It is generally accepted that the minimum quality acceptable for DTP purposes is a 300 dpi laser printer. Even this
resolution appears grainy and irregular to someone trained as a graphic artist
o r designer. As you begin to explore DTP, there is little sense in rushing out

to beef up your equipment. As DTP

becomes a larger part of your job, you
should think about buying a larger monitor , and a faster Mac.
The built-in screens of the smaller Macs (the Mac Plus, SE, and Classic)
quickly become an impediment to accomplishing DTP tasks . Being forced to
choose between a miniature version of the page or viewing only a smidgen of
the total layout, as well as the lack of color and gray shades, slows you down
and forces you to rely heavily on your imagination (and your printer) to
determine the appearance of the final output.A full-page or two-page display
with a gray-scale display card is a good investment. You then can view and
manipulate one or two complete pages of the publication at a time, as we ll as
see how detailed graphics and scanned images appear.
DTP programs tend to be memory-intensive and slow. And although they can
do the job, working with o ne of the less expensive, less powerful Macs may
prove frustrating. Ifyou find yourself tapping your fingers while waiting for
screen redraws, it may be time to consider an accelerator board or a more
powerful Mac.

Using DTP Templates
The basic skill associated with creating a document that looks good is that of
layout design. Publication layout concerns itself with issues such as character
formatting (font selection and spacing), paragraph formatting (leading, indents, placement of tabs) , placement and sizing of graphics within the
publication, selection of the items used on the master pages (running heads,
page numbers, and rules), and the use ofcolor.
If your company does not have an in-house artist or design expert, what do
you do ifyou decide there is a need for a company newsletter, advertisement,
or brochure? You have only a few options.
• Hire an outside expert to create the design for you and possibly take
care of the printing details.
• Ask your local print shop to take care of it-many of them help with
design and layout.
•

Doityourself.

Many companies are taking the latter course. Pagelayout/desktop publishing
programs are just like other Macintosh programs- they are easy to learn and
use. Unfortunately, without a good sense of design, creating your own manuals, brochures, newsletters, or ads may lead to embarrassment in front of
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more people than you ever imagined! If you want to do some in-house desktop publishing, the easiest way to get started is by using a template package,
such as Printer's Apprentice Layouts from Postcraft International. Because
decisions concerning font selection and the placement of graphics are already made for you, there is little opportunity for things to go horribly
wrong.

Before Heading to the Printer
Do yourself and your company a favor. Before heading to the
printer with your finished publication, do two things:
• Spell check the entire document.
• Print the document using a laser printer, include crop marks,
and then read it carefully.
Perhaps these things should go without saying, but you would be
surprised at how many people pay for thousands of brochures
that contain typographical errors or the wrong company address.
Proofreading is a critical part of the publishing process. The spell
checker catches some of the errors, but a final read-through is
always a good idea. In addition to making the document easier to
proof, printing out the document assures you that there are no
last-minute glitches, such as an image that won't print. Providing
a hard copy to the printer is useful in determining if the output
was what you expected.

Printer's Apprentice Layouts: PageMakerTemplates includes over 200 templates for brochures, business cards, sales flyers, letterhead, envelopes,
business reply cards, and newsletters for use within Aldus PageMaker.
Postcraft International also has versions of the templates for Quark.XPress,
Ready,Set,Go!, and DesignStudio. Specialized layo ut packs also are available
for creating flyers or stationery only. Figure 5. 7 shows a template from the
PageMaker series.
The templates for smaller items, such as business cards and brochures, typically include many layouts in the same file. You simply select the template
you want, and then cut out the templates you do not need.

TITLE PLATE

')U,fT

cox

Figure 5.7 The Newslener 13 layout fro m the Printer's Apprentice Layouts.

Managing Publications with Checklist
PageMakerusers are already fa miliar with Checklist 1.0 because it is included
with every copy of PageMaker. Checklist 2 (ElseWare Corporation) expands
the program's original capabilities by enabling you to print any panel (links,
print options, fonts, styles, and so on), examine Postscript print-to-disk files
from other Macintosh programs, add notes to the documents, and compress
PageMaker documents and related linked files and fonts into a single compact, self-extracting file.
The Checklist 2 Quicklist option checks each PageMaker document automatically for fonts, print settings, links, and notes, and immediately notifies
you ofany errors, such as out-of-date links. Clicking o n any icon o n the left
side of the screen displays a document-specific screen, such as the style list in
figure 5.8. By selecting any style name in the style list, you can see a full description of the formatting options for that style in the text box at the bottom
of the window.
If you need to exchange PageMaker files with other users or send PageMaker
materials to a service bureau, Checklist 2 is invaluable. Rather than using
PageMaker's "Copy linked files" Save As ... option to transfer documents to
a different disk, you can use Checklist 2 to compress all the files into a selfextractingpackage-including the PageMakerdocument and, optionally, all
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linked files , external graphics, fonts, Aldus Prep, and Kern Tracks. Because
the compressed file is self-extracting, the individual who receives it does not
need a copy of Checklist 2 to extract the contents.

The 9· to·5 Mac

ffi Sched C PM

ID-

T

~

stvlt namt

Links

ACW...-12/14
AG......-12/14

S..lltt

AGM-~ 12/liUtO

C<iphon
C.llout : outtr eoMM

AG....-.ond I 0/...to
AGM-M'l'IOnd h•Uo 10/touto

121
121

...O.r...-Bold 10/MJto
AO•r•mond lt•lto IO/•uto

(::11
~

B Htlvttlo" Bold 18/•uto
B HttvtUo• Bold 14 /•uto

liEI
liEI

-tdllst

C.p tlon Ho><!
Clptton: tn-tt>Ct

Hod I

Hotn

~

HHd2

TDC

.

Bod\l ltxt • nnct · S«nt s1i.t1t + (.w: AOar#Mnd +
nu : 12 • ludT19: 14 +color : B\Kk + tuck; nont +
jlS'ttfwd + f'rst w.dtnt :0.2 • widov : 2 + Of'ph.wi . 2 +

~nm ipNm

lwjplltn•llon

tincid..trttut 1->'"t
kloloft moena al iqo.wn

I

dolonit
n,..dd.am

~myiubhGWmod
~ratwhlipat. UtwiJl

1..-1 CoUr<i br1c

Comprtss

Siu: 350K
© 1991 Elu'w'.an

l.l'I

!El
la
!El

Bod\I ttxt-1 st

[!]11,
lE

Ali91>

~

Pr'nl options

~

Font

[}. p

brk

I>

Figure 5.8 Any style that is based on anod1er style appears as indented below
that style in the list.
Ifyou have database or spreadsheet data you want to import into a
PageMaker layout, you also may be interested in Elseware's DataShaper.
DataShaper handles tab- or comma-delimited text files and enables you to
assign formatting options, such as text attributes, to the imported data

Desktop Presentations
ill ions of business presentations are given each year. Until the Mac
popularized presentation software, the normal procedure was for the
presenter to gather his or her notes and ask the company's art department to
turn them into bullet charts, graphs, and other illustrations suitable for slide
o r overhead projector displays. Those without access to such technical support were left with drawing their own transparencies.

M

Simple Mac software and ready-to-use templates now make creating an entire
presentation possible by one person. For a traditional approach, presentation
programs create images you can have made into slides by film recorders or
service bureaus. With the proper equipment, the results can appear as a slide
show on a large screen monitor or a Kodak DataShow. You can control a

presentation slide show automatically or manually. Acid music or other forms
of information and you have a complete multimedia presentation.
The most popular presentation packages are Aldus Persuasion and Microsoft
PowerPoint. Each program contains the tools and templates needed to help
you create polished transparencies, slides, and hand-outs. These packages
basically work the same as a desktop publishing program. With desktop p1'esentation programs, the emphasis is on color and single pages rather than
columns and complex multi page layouts.
To add animation to enliven on-screen presentations, consider Magic. Published by Macromedia, it is a gentle entry into the realm of animated
presentations. By drawing paths, for example, you can make your logo
smoothly slide into position or revolve around the screen, or you can make a
series of colored bars fade in gradually. Animation adds visual interest to
almost any presentation and can help retain the attention of the audience.

Using Fonts and Text Effects
hile most people select a single word processing or spreadsheet program, a graphics expert relies on a wide variety of tools. Most complex
documents are a combination of text and graphics. Novices tend to focus on
the images within a document and may neglect the text. As your design skills
develop, you will want to work with appearance of the text as well. The programs discussed previously form the basics, but are only the beginning of the
options available to you. The following tools provide a way to work with text
in much the same way that other programs enable you to manipulate images.

W

Working with Fonts
The first tool discussed actually is not an application, but rather the fonts
installed on your system. Compared to the capabilities ofa typewriter, the
eleven standard PostScript fonts may seem to provide more options than
anyone could ever desire. Compared to the arsenal of the professional typesetter, however, the standard fonts can be quite limiting.
The key is to select the appropriate fo nts for the publication-not to mix
scores of fonts within a publication. The more fonts you use, the greater
the chance your publication will look more like a ransom letter rather than
something that reflects your company image. As you begin, restrict yourself
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co rwo fonts per publication. Use one font for che headings and special text
such as captions and another font for the body text.
Fonts are divided into two main types: serifand sans serif (sans meaning
witho ut). In figure 5.9, the Ton the left (Times Rom an) contains points,
which are called se rifs . The Helve tica character is smooth and contains no
serifs.

SeOl•- CT T
Figure 5 . 9 A serif letter (on the left) compared to a sans serif letter (on the
right).
Serif fonts often are used for body copy-the text of the document. The serifs, which are the poi nty extensions at the tops and bottoms ofletters, make
the characters easie r to read whe n presented in large doses. Two of the most
popular seriffonts are Times and Garamond.
Sans seriffonts traditio nally are used for heads/headlines. Helvetica, Univers,
and Franklin Go thic are three common sans seriffonts.
Fonts are published by many differe nt companies. Two fonts that you will
hear about most frequently are Adobe and Bitstream. Be aware though, often
there are stylistic differences between fonts that have the same name but
come from diffe re nt companies. Although similar, Garamond, Adobe
Garamond, and Apple Garamond, fo r example, are considered to be three
different fonts. Also, some font names are proprietaty-other font publishers
may offer similar fonts with diffe rent names.

Adding Smart Art Text Effects
Smart Art from Adobe Systems is a DA that e nables you to use your Postscript
laser printer to help design impressive EPS text effects. Each Smart Art disk
incl udes a series of te mplates fo r creating particular text or graphic effects.

Smart Art III, for example, contains the following text effect templates:
banded, centered ellipse, college, double border, drop caps, filled, inline,
label, Neapolitan, neon, point size, slanted, split reverse, text in text, and
wrong reading text. Keep in mind that these are effects, not fonts. You can
apply these effects to any PostScript font that you have installed in your Mac.
To create an effect, follow these general steps:
1. Open the Smart Art DA.

2. Change the sample text string to say what you want.
3. Scan th rough th e installed text options and view small samples
on-screen, and then select the text option you want.
4. Change the font, point size, or any of the components of the effect,
such as text gray and shadow options.
5. Click o n the Reimage button. The Reimagecommand sends the
PostScript instructions to the printer.
Usi ng its built-in Postscript interprete r, the printer deciphers the Po stScript
code, and t hen sends the revised image back to the screen. If the result is
what you want, you can save it to disk as an EPS file or export it as a PICT file.
If not, you can always change it by repeating steps 4 and 5. Figure 5.10 shows
Smart Art in action.
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Figure 5.10 You change the options that appear in the lower window to vary
the special effects.
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The on ly drawback to designing effects chis way is chac you do noc receive
inscanc feedback on che changes yo u make. le can take che printer a minute or
more each time you click o n che Reimagebuccon. The results, however,
more chan make up for che inconvenie nce ofwaicing.

Using Effects Specialist
Although designed as a scand-alone program rather chan a DA, Effects Specialist (Postcraft Inte rnational) is very similar to Smart Art. It enables you to
create EPS special effects by applying any of 120 effects to selected text
strings. Although it produces clean PostScripc output, as well as CYMK (cyan,
yellow, magenta, black), and spoc color separations, it does not use the
printer to create or update che image on che screen.
For each effect, Effects Specialise presents a sec of pop-up menus that e nable
you co change relevant options, suc h as specifying che inside and outside
shade , setting a line screen co apply to cext, and selecting a cexc color. The
ma nual shows six different examples for each effect and lists che settings
used co create each one (see figure 5.11).

Figure 5 .11 The Executive effect works well whe n placed o n a log gradie nt
background.

In addition to text effects, you can create several types of backgrounds, including linear , radial, log, and text. The program includes a series of
templates to use as borders fo r reports, advertisements, and brochures.

Charts and Graphs
n info rmative graph or chart can go a long way toward clarifying a point.
Charts and graphs are images based on numeric info rmation. Most laser
printers can print charts directly onto a transpar ency for use with an overhead projector. For inclusion in other d ocuments, yo u can store charts as
graphic images and import them into the prese ntation or DTP program.

A

If you have a recent sp readsheet program, such as Microsoft Excel 3 or 4,
Claris Resolve, or Lotus 1-2-3 fo r the Macintosh, you already have a sophisticated tool for creating graphs and charts. If your needs are mo re extensive
than the features your spreadsheet program provides, however, you have a
numberofalternatives fro m which to choose. Like the charting capabilities
within a spreadsheet, a charting program bases the original image on a set of
data you supply. The advantage ofa dedicated program is the greater variety
of o ptio ns and the finer degree of control.

Creating Charts With Cheshire
Cheshire fro m Abbott Systems enables you to create simple charts while
working in another application. Jfyou are a PageMaker, Microsoft Word,
MacWrite II, or MacD raw II user, you can use the Cheshire CDEV/IN IT to
create bar , line, column, and surface charts and auto matically paste them into
the curre nt document. Other graph types will be made available as separate
add-in modules. As an example, a module for pie cham was released recently. Figure 5.12 shows a sample Cheshire chart created as part of a
Microsoft Word memo.
To generate a chart, you must provide Cheshire with a tab-delimited data
series. You highlight the data in the current document and activate Cheshire
by pressing a hot key, or you can enter the data directly into the text window.
In either case, clicking o n any of the chart types draws a miniatu re preview of
the chart using the currently selected options (see figure 5. 13).
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Figure 5.12 This Column/GroupedJValues chart has gray gridlines and drop
shadows.
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Figure 5 . 13 Cheshire gives you a preview of the graph based on the current
settings.
The Chesh ire pop-up display enables you to select different chart types, edit
the data, and set options. Options include white bars, a background, transposed data, and white o r blackgridlines. You can select any installed font,
size, and style for the chart text, as well as specify the number of decimal
points that are used in numbers. The bar, Line, and surface paccerns, as well
as the placement of text, are fixed.

To edit a Cheshire chart, select the chart and open C heshi~·e. Be aware, however, that you cannot change the actual organization of the chart elements.
An alternative approach is to open the chart in MacDraw II (Cheshire is incompatible with MacDraw Pro). MacDraw treats all tbe chart elements as
separate objects and you edit them independently.

Creating Graphs With DeltaGraph
Although you can use DeltaGraph from DeltaPoint, Inc. for statistical and
mathematical charts, it is mainly a package that enables you to create business graphs. Its clean images-done in fu ll color and with ho rizontal,
vertical, or radial gradient fills-are just what you need for presentations.
Figure 5.14 shows a typical DeltaGraph chart.

Figure 5 .14 Colored gradient fills and 3-D graphics combine nicely in
DeltaGraph.
You can enhance charts with DeltaGraph's drawing tools, including lines,
curves, arrows, boxes, circles, and polygons. You can acid text anywhere on a
chart. DeltaGraph creates a wide variety ofgraphs and charts, including the
following:
•

Standard charts and graphs (column, stacked column, bar, stacked bar,
line, area, pie, stacked pie, scatter, paired scatter, X-Y line, paired X-Y
line, step, table, high-low, range, contour, and polar).
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•

3-0 charts and graphs (column, area, ribbon, surface, scatter,
scatterline, and wireframe).

•

Custom charts and graphs (column /line overlay, double-Y scatter,
pastel o n black, pastel pie chart, radial pie chart, solid color area, solid
columns, vertical table, and weekly stock charts).
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Like a draw graphics package, DeltaGraph is object-oriented. The relation of
the o bjects to the top layer of the chart is controlled using Send to Front
a nd Back menu co mmands.

Creating Charts With KaleidaGraph
KaleidaGraph (Synergy Software) is the charting program of cho ice for mathematicians, statisticians, engineers, and those in similar professions. Although
it also contains standard business graphing capabilities, it is most useful for
heavy-duty number-crunching. The sample graph in figure 5.15 is enhanced
by grid lines, a drop shadow be hind the legend, valu e labels, and a text box
with an arrow.
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Figure 5.15 KaleidaGraph provides sophisticated control over the graph
image.
You enter KaleidaGraph data in a spreadsheet-like grid. After you label the
columns, define data types for the columns, and select columns, you can
create the following graph types: linear (line, scatter, double-Y, high/low),

stat (probability, X-Yprobability, stack histogram, box, percentile) , bar (horizontal bar, stack bar, column, stack column), polar, pie, or text charts.
However, no 3-D charts are available.
KaleidaGraph also provides the following features:
• Customizable help
• Macro calculator
• Plot scripts (for re-creating plots you use frequently)
• Curve fitting
• Statistical functions
• Colorsupport
After you create a plot, you can double-click on most graph elements to access a dialog box that enables you to make changes. Because KaleidaGraph is
a program that contains many options, scores of dialog boxes, and about 600
pages of documentation, you wil l need to invest a significant amo unt of time
before taking full advantage of its capabilities.
KaleidaG ra ph always has been a powerfu I graphing package, and it is becoming more powerful with each release. Although it generates a wide number of
plots appropriate for business (pies, bars, columns, lines, and high/low
charts), its advanced macro capabilities, (programmable calculator, and functio n plotting options) , are overkill in most business settings. Market
researchers, statisticians, mathematicians, and engineers, however, will be
hard-pressed to find a package that is better suited for their plotting needs.

Screen Capture Programs

S

creen capture is a special interest area, but for certain types of profes-

sionals it is an absolute necessity. If your work requires that you use what
appears o n-screen as an illustration (designing computer training manuals,
for example), you quickly will outgrow Apple's built-in screen capture command (pressing Command-Shift-3 creates a MacPaint document from the
contents of the current screen) . Screen capture utilities, such as Snap) ot,
Capture, and Image Grabber, enable you to make full-color captures of portions ofa screen- including pull-down menus and dialog boxes-and then
save them in a variety of graphic formats.
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Snapj ot, a combination INIT and DA from Wildflower Software, is o ne o f the
best screen capture utilities available. Virtually all screen shots in this book
were created using SnapJot. To capture a screen, you simply press the hotkey and then drag the mouse to select the rectangular area you want to
capture. The utility works with colo r and can create MacPaint o r PICT files
(you choose a type each tim e you save a capture) . Preference optio ns e nable
you to set the creator program for each type of image. This means that the
new image document is associated with that a pplication. Assigning Aldus
SuperPaint 3 as the creator program for all Snapj ot PICTs, for example,
means th at double-clicking on the document icon launches SuperPai nt
automatically.
Snapjot can capture almost any type of image-including most pull-down
me nus and program dialog boxes. You configure Snapjot to include o rignore the cursor. You can create black-and-white images automatically when
capturing from color screens.
Snapj ot's capture default displays an image o n-screen-each image in its own
window (see figure 5.16). This makes Snapjot an ideal tool for creating notes
during computing sessions. Suppose, fo r exa mple, that you need to call
seve ral people at specific times later in the day. To save time looking up the
numbers, you can open an address/p ho ne book DA and use Snapjo c to capture each name and number. Arrange the name and number screen captures
so chat they appear together, and the n go about your normal work. As long as
you do not click o n the close boxes, close the Snap.Jo t DA, or shut off the
Mac, you instantly can bring all of the images to the front of the screen by
clicking on any of them.
While many programs save screen captures to disk a utomatically, Snapjot
offers several approaches. You ca n configure Snapjot to copy the image to
th e Clipboard automatically, print it, o r save it following a capture. Alternatively, you can store the image in me mory. You also can use Snapjot to load
and view captures, or any other paint o r PICT files on disk.

Capturing Screens With Image Grabber
Image Grabber by Sabastian Sofrware is a DA-based capture program. To
activate it, you select the Image Grabber desk accessory, and then select the
area you want to capture by dragging the mouse. After you release th e mouse

button, a dialog box appears and presents a list of options that enable you to
deal with the new image (see figure 5.17) . Online help is available to help
eliminate any confusion.

Figure 5.16 Each new Snap)ot capture appears in its own window.
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Figure 5 . 17 Options for deali ng with a new Image Grabber image.
lfyou press and hold d own the Shift key while selecting the DA, several additional options appear. You can instruct Image Grabber to convert color
captures to black-and-white, hide the cursor, or perform a limed grab. A
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timed grab captures the entire screen automatically afte r a delay of a specified number of seconds. This enables you to capture pull-down me nus and
dialog boxes.

Capturing Screens With Capture
Flexibility is the key word when discussing the Capture CDEV from Mainstay
(see figure 5.18). A particularly useful feature enables you to capture the
sa me selectio n area repeatedly. You could captu re the contents ofa dialog
box over and over again, for example, and display diffe rent options each
time.
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Figure 5 . 18 You set all Capture optio ns from the Control Panel
Capture also enables you to:
• Capture the entire main screen, all screens attached to the Mac, or a
particular screen selection.
• Save images to the Clipboard, Sera pbook, or as MacPaint, Pl CT/PlCT2 ,
or TIFF files.
• Specify a default folder to receive the captures and a creator application for each file type.

•

Include or exclude the cursor in a capture.

•

Force black-and-white captures o n colo r or gray-scale mo nitors.

•

Name files automatically or prompt for each new file name .

•

Receive notificatio n of successful captures.

•

Perform time-delayed captures.

•

Reduce image sizes to a specified percentage.

Capture also p rovides two useful utility programs: TIFF Converter and Capture Viewer. You use TIFF Converter to convert TIFF images between IBM
and Mac formats. Capture Viewer enables you to display, examine, magnify/
zoom, and print your captures. Capture Viewer also displays a miniature
preview of any non-TIFF file in the Open ... dialog box, which assures that
you have the correct image before you open it.

Summary
n this chapter you learned about programs and techniques you can use to
produce pro fessional-looking documents with desktop publishing. In
particular, you learned abo ut the foUowing:

I

• Working with images using paint, draw, and PostScript programs.
• Scanning and polishing logos, and different ways to use a logo in
desktop publishing.
•

Desktop publishing templates and managing your publicatio ns.

•

Creating desktop presentations.

•

Using fon ts and text effects to enhance your d ocuments.

• Creating charts and graphs using desktop publishing programs.
•

Capturing screens and figures using screen-capturing programs.

In Chapter 6, "Getting Organized," you will learn how to manage and track
data using database programs.
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Getting Organized
Everyone has heard of databases. For this chapter, a database is defined as
an organized set of electronic information dealing with one central topic. The
key word is organized. A database management program enables you to
search and sort the data, and produce reports summarizing or detailing the
information.
The two general types of database programs are flat file and relational. Databases created in a flat file program are designed to stand alone. All necessary
fields must be a part of the file. Relational databases enable you to link information from multiple data files based on one or more common fields. Rather
than keep all the information in a single file, you can design several smaller
files and link them together. You can keep address information for a customer, for example, separate from the customer's orders. The advantages of
relational databases include smaller, more manageable files, and greater
flexibility in combining information from different files into reports. The
main disadvantage is that the relational concept is a difficult one to grasp.
Novices may have trouble determining the best information to be
recorded in each data file, particularly when compared with
learning to use a flat file database. This chapter presents
examples of both types of databases and examines many of
the leading database management programs. Programs
discussed in this chapter include:

J
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•
•
•
•

•
•
•
•
•
•

nuBASE for the Mac
FoxBASE+/Mac
Double Helix
HyperCard
FiJeMaker Pro
RecordHolderPlus
Panorama
4th Dimension
HyperDA II
Retriever II

Databases are used in almost all types of organizations. Many companies, for
example, use a database system to keep track of employee information (address, ID number, title, starting date, salary, and so on). Most retail
companies keep customer databases that contain addresses, phone numbers,
and records of customers' recent orders. Hospitals maintain patient information in databases. There are thousands of applications for databases. The
templates presented in this chapter cover a wide range of applications and
include:
•

Schedule C Bookkeeping (FileMaker Pro)

•

Medical Expense Tracker (RecordHolderPlus)

•

Phone Message System (Panorama)

•

Project Expense Tracker (4th Dimension)

Because the features offered by the various database programs are very similar, you should have little difficulty constructing most of the templates in
your particular program.

Introduction to Databases
very database consists of a collection of records. A record is an organized
collection of information concerning one person, one project, or one
type of item. In an employee database, for example, all of the pertinent data

E

about Hal Smith would constitute o ne record; information about Susan Reed
would be another record.
Each category of information in a database is called afield. In an employee
record, the street address may be one field, and the employee's salary could
be another. The contents of an individual field for a specific record is called
an entry. "Susan" would be the entry for the First Name field for the record
associated with Susan Reed.
Before personal computers became widely available, databases were often
stored on paper. Employee information consisted of several forms that were
filled out by hand or typed, inserted into a file folder with the employee's
name on it, and stored in a filing cabinet. Although individual employee
records were readily available (just open the correct drawer and pull out the
file) , paper-based databases were deficient in many respects, such as:

• Inflexibility-Suppose that after several years of data collection, you
decide you need new information about each employee or that you
want to organize the forms differently. ln a large company, updating or
redoing paper records would be a tremendous, time-consuming and
expensive task.
'
• Limited selection capability-The boss walks in and says, "Give me the
files for every employee that makes between $42,000 and 548,500, lives
within five miles of the office, and has been with the company for at
least three years. " With paper records, your only recourse may be to
pull every employee file and start reading.
• No sorting-Employee files are generally organized alphabetically by
last name. What if you want to sort them by start date or salary?
• No reporting-Similarly, if you want to create a graph of salary breakdowns by education level, you can look forward to several days or
weeks of work.
• No error trapping-When entering information on a paper record,
accuracy checks may be nonexistent. Typi ng or writing a person's
social security number on the Line that asks for "Starting Pay" can and
does happen. Error checking is strictly an eyeball affair.
Paper records still have their place in modern offices, but transferring the
information to an electronic database has many advantages.
Electronic databases normally support the concept offield types to restrict
the type of information you can enter in a field. Field types supported by
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different programs include text, numbers, currency, dates, logical (yes/no,
true/false), and pictures (for holding drawings, scanned photos, or other
rypes of graphics). When designing a database, you can say that Birthdate is a
date field, Salary is a numeric field , and Address is a text field. Information
you enter in th e Birthdate field would need to be in a date format (something
like 4!2160 or April 2, 1960). Any alphabetic characters typed in the Salary
field would instantly be flagged as an error by the program. Because the text
rype is the most inclusive, the Address field could contain any rype of information.
Most databases also enable you to create calculation fields. A calculatio n
field performs a mathematical, statistical, or fina ncial computation. You may
define a Grand Total field , for example, that adds tl1e contents of all Item
Cost fields, a Sales Tax field, and a Shipping field.
To speed data entry, some programs enable you to specify formatting pictures for fields. A picture is an example of what the correct formatting fo r
each field should be. The picture for a Phone Number field may be (###)
###-####.To enter a p hone number, you only need to rype the ten d igits
of which the phone number is composed. The program will insert the parentheses and the hyphen automatically. Not only does this save typing, it also
ensures that every phone number is formatted exactly the same, improving
consistency in the records.
Often, it is important to be able to view records in an orde r other than the
order in which they were entered . When determining eligibility for promotion, for example, you may want to see employees sorted in order of the year
of hire or last year's sales. Sorting is the database function you use for this
process. At a minimum, any database program should enable you to select a
single field on wh ich to sort. Generally, however, most programs can simultaneously sort on many fields. The list below is sorted first on Hiring Year and
then (within hiring year) by salary.

Hiring Year

First Name

Last Name

Salary

1982

Bob

Jones

$87,500

1982

Jane

Dow

$84,275

1982

Mark

Simmons

S62,643

1983

Susan

Hamill

S89,700

1983

John

Ke nt

$51 ,000

Indexing refe rs to an internal sorting order-a record order list based on the
contents of one or more important fields. If a database program uses indexing, you normally are prompted to select one or more key fields; fields on
which the program will order the data. The main reason to employ indexing
is to speed record searches. This is why you should always select the most
important variables as key fields. In an employee database, Name and ID
number would be good candidates.
Database programs provide ways fo r you to search and select subsets of the
records-based o n your definition. Generally, a Find or Search command is
provided for this purpose. Some searches can be very simple. To locate a
specific record, you may ask for information for all employees with the First
Name of "Susan." On the other hand, searches can be quite complex. To find
a group of records, you can create a complex search request using Boolean
logic (AND, OR, NOl). For e.xample, to ide ntify all employees with a First
Name that begins with "S" and who live in Dayton, combined with those who
started before 1986 and live anywhere except Los Angeles, you could perform the following search:

(First Name begins with 'S' AND City is Dayton)
OR (Start Date is before 1986 AND City is NOT Los Angeles)
This search request would result in the identification of all individuals who
met all the criteria for me mbership in either group. After a search is completed, you can flip through the individual records or design a report based
o n them.
The following are some of the main advantages of electronic databases:

• Flexibility-Current database programs have few limitations o n the
organ ization of d ata. If you need to add a new piece of information,
you simply create a new field for it in the database and enter the data at
your leisure. If you d ecide that some information is no longer needed ,
you just eliminate the data field and the database readjusts itself
instantly. Finally, if you don't like the way database records appear
on-screen or when printed, you easily can rearrange them by moving
r.he fields to diffe rent spots, adding graphics, o r displ ay them as a
spreadsheet-style list.
• Record checking- Most database programs enable you to specify datachecking procedures. The p rogram prompts you when you e nter a
le tte r in the middle of what sho uld be a numeric e ntry, for example.
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Sorting-You also can sort a database in any way you want and change
the sorting order as needed.
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• Selection capability-You can examine just the records you need at
the moment. Instructing a database to identify a specific set of employees based on several criteria is a piece of cake.

• Reporting-No need to pull records by hand! The organization, level
of detail, and use of totals and subtotals are all available to you as
reporting features. All you need to do is create a report template and
instruct the Mac to fill in the template with the appropriate data. You
can have as many report layouts as you want and design new ones as
needed.

• Calculations-Many databases contain built-in financial, statistical, and
mathematical functions. It's a simple matter to instruct the program
to calculate new salaries for every employee based on a percentage
increase, to determine how many days until a sales call-back is needed,
or to total a customer invoice.

• Mailing labels and mail merges-Many databases contain addressesof employees, customers, sales representatives, or public relations
people. Most database programs help you transfer those addresses to
mailing labels or export them for use in form letters.

• No duplication of information-Some advanced database programs

!)

()

enable you to link different databases so that you do not need to enter
information twice. You may, for example, have a customer file with
each customer's name, address, phone number, and a unique ID
number. Rather than tacking each customer invoice to the file, you can
start another database for invoices. Using the customer's ID number, or
last name and ZIP code, you quickly can look up his or her mailing
address and avoid retyping it.
Unless you are satisfied with the limited database capabilities of high-end
spreadsheet programs, most business users eventually find themselves hunting for a database program. For general record keeping, a database with its
many supporting features is hard to beat.

Macintosh Database
Programs
nlike other software categories in the Macintosh wo rld, there is no clear
leader in the database market. This chapter presents several working
databases you can use in your business, illustrated with many of the leading
Macintosh database manageme nt programs. The databases discussed were
selected based on their usefulness in demonstrating particular featu res. Following is some informatio n o n several important programs that were not
used to create the templates in this chapter.

U

nuBASE for the Mac
Ashton-Tate's former program dBASE Mac is now nuBASE for th e Mac (from
New Era Software Group). Altho ugh d BASE Mac was clearly not the program
that users expected (they had hoped for a database program that would be
compatible with the popular IBM version of dBASE), dBASE Mac developed a
core of faithful users who recognized it as a powerful relational database in
its own right. nuBASE for the Mac picks up whe re dBASE Mac left off.
Like many of the Macintosh relational database programs, nu BASE p rovides
several ways to create a database. The easiest is to simply create the fields,
specify their types, an d then let nuBASE generate a form for you au tomati·
cally. You can display records individually or as a columnar list. Take things a
step further, and you can create custo m forms fo r the database with the fields
attractively arranged- using multiple fonts, graphics, and color. Figure 6.1
shows a custom data-entry form included with one of the sample nu BASE
d atabases.
nuBASE d ata-entry forms can include buttons, graphics, radio buttons,
menus, and multip le pages. Check boxes and icon palettes are also supported . For demand ing applicatio ns, you can create custo m databases with
nuBASE's powerful procedural language.

FoxBASE+/Mac
FoxBASE+/Mac from Fox Software is what dBASE Mac was supposed to be:
code-compatible with programs writte n in the dBASE language for the IBM
PC. In addition, it offers full support fo r the Macintosh inte rface, enabling
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you to design d atabase applications that contain custom menus, pop-up
me nus, check boxes, buttons, and radio butto ns.
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Figure 6.1 A nu BASE custom data form.
FoxBASE+ has built its reputation on speed. According to some benchmarks,
it is reputed to be the fastest Macintosh database program around. To make it
even faster, a comp ile r is included as part of the standard package.
One important part of FoxBASE+ is the Command window. Every action you
perfo rm, such as a menu selection, is recorded in the Command window.
You can copy and use lines from the window as the basis for procedures. You
also can test commands in d1e window by typing them, or you can reexecute
commands that are already there. Operating in this mode is d1e same as
working from the dot(.) prompt in IBM dBASE.
FoxBASE+ also includes layout designers for forms (Foxform), reports
(FoxReport), and o n-line help. A program gene rator called FoxCode helps
speed development of new databases. FoxCode enables you to use generic
templates as the basis of new applications. FoxBASE fo rms can include scrolling text boxes, pop-up menus, check boxes, and radio button groups (see
figure 6.2).
Like many of d1e other high-e nd database programs, FoxBASE+ also has a
run-time version avai lable. With the purchase of the run-time system, you
can distribute copies of your stand-alone database programs royalty-free.

Figure 6.2 FoxForm makes custom screen design a snap.

NOTE: FoxBASE+/Mac is now owned by Microsoft Corporation.

Using Double Helix
For users wanting the full power of a relational database but worried about
the programming that is usually required to access that power, there is
Double Helix. Programming in Double Helix is accomplished by creating a
collection: a set of icons that represents the different dacabases, forms, fields,
calculations, and so o n, in the project on which you are working. After selecting an icon from one of the icon wells on the left side of the screen and
dragging it into the work area on the right, you define the function of the
icon and set its options (see figure 6.3).
To program a task, icon- and tile-dragging is again the approach. Figure 6.3
shows the procedure for sequentially numbering records-assigning a new
ID number to each o ne. Clicking the third icon in the top left corner of the
window displays the tile list. Each type of tile has a particular function associated with it (a mathematical operation, a text computation, o r a statistical
function, fo r example). To create a procedure, you drag the appropriate tiles
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into the open area on the right side of the screen, and link tiles by dragging a
tile's arrow to another tile. Open holes in tiles are filled with field names,
text, numbers, and so on.

Mac

UIPW font

~lyl~

NeHt fO#

Figure 6.3 A Double Helix task.
The Next ID# procedure was defined by creating a new Abacus (calculation field) called Next ID# and then performed using the following steps:
/]

l. Drag a Max tile into the layout area.

2. Drag the Lead ID# field into the hole o n the Max tile.

3. Drag an Addition ( +) tile into the layout area and connect it to the
Max tile by dragging the Max tile's arrow into the left hole of the
Addition tile.

0

4. Double-click on the right hole of the Addition tile and type 1 in the
dialog box that appears. This indicates that the plus ( +) number
should be l.
The result is that the database will create new ID# codes by adding 1 to
the current highest Lead ID#.
Supporced field types include text, number, date, flag (a radio button or
check box), and picture. You can set validation criteria for any field. You
also can create pop-up menus to speed data entry. Other special features

include custom menus, sequence icons for performing a series of commands
with a single keystroke, interfacing with no n-Helix databases on other types of
computers, and d1e capability to create databases for use with Runtinle Helix.
The current version of Double Helix includes multiuser client server software.

Using HyperCard
HyperCard is the most common Macintosh database progranJ. Starting with
System 6, a copy of HyperCard has accompanied every Macintosh sold. Based
on the analogy of a deck of cards, HyperCard stacks usually are composed of
several cards-each representing a record. HyperCard is an object-oriented
database. Objects include text fields, buttons, icons, and graphics. You can
attach HyperTalk scripts (instructions for performing a specific action when
selected) to many objects. An arrow button, for example, may contain instructions co flip to the next card. Many scripts are generic. You can copy a button in
one stack, paste it into a second stack, and it will perform the same function
automatically. The programming language, bit-mapped drawing tools, and its
object orientation make HyperCard a fairly flexible database environment.
If you are not interested in programming, you stiU can be very productive
with HyperCard . HyperCard includes many stacks you can use instantly without modifying them, such as Address and Appointment stacks, as well as
dozens of prescripted buttons, icons, art ideas, and backgrounds. There are
also many HyperCard informational stacks available that can help with business functions or teach you about the world around you. The purpose of
such stacks is solely to inform; no typing is required.

If your Mac did not come with a copy of HyperCard, you will find that you
need a copy of it sooner or later. Many companies are now creating their
program tutorials as HyperCard stacks. No I-IyperCard; no tutorial. (HyperDA
II, a HyperCard DA that can be used to read and display HyperCard stacks, is
discussed in d1e final section of mis chapter.)

Schedule C Bookkeeping
with FileMaker Pro
FileMaker Pro is Claris Corporation's popular entry into the
Macintosh database market. It is a simple flat-ftle database wim a
strong Macintosh interface. Its greatest strength is in the way it
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manages the display of information. Any database can have several layouts
that display different combinations of fields. A layout can be designed either
as a form (for display on-screen) or a report (for printing). Layout tools enable you to display or change the positio n of fields, and add colo r, li nes, and
graphics. Special layouts exist for use in printing labels.
If you are self-employed and operate your business on a cash basis, it may be
overkiU to use an accou nting program to do your bookkeeping. Unless you
are already trained as an accountant, you will find that learning to use a
double-entry accounting program is not Like learning to use other Macintosh
programs. To use accounting software correctly, you must u nderstanding
accounting.
To satisfy IRS requirements, all you really need is a simple bookkeeping
program to record and organize your expenses and income. Books is a
database template created in FileMaker Pro that enables small businesses to
track expenses and income items. Because the expense categories used
match those found on IRS Schedule C (Profit and Loss fo r Sole Proprietorships), Books makes it simple to fill o ut your tax return. Just enter
expenses as you pay them and income as you receive it.

USING THE BOOKS TEMPLATE
The Books template consists of five layouts. You use the Data Entry layout to
enter each expense and income item, review and edit previous records, and
generate reports. You use the Detail Report, Summary Report, and Detail by
Category Report layouts to generate the three reports. Help is the final layout. It presents helpful information about using and customizing the Books
database.
Records are kept in date order automatically. Buttons enable you to navigate
between the Data Entry screen and the Help screen. With the click of a button, Books can produce three useful on-screen or printed reports that show
your progress throughout the year, and provide the year-end figures you will
need to compute your tax returns.
The heart of Books is the Data Entry screen. When you first open the
Books template, you will see a blank Data Entry screen-no records or
fields. Create a blank record by pressing Command-N or by choosing New
Record from the Edit menu. This is where you enter each expense and income item. The cursor is positioned at the end of the Date field, and the

current date is entered for you automatically (see figure 6.4). As a data entry
example, we will enter an electric bill that has been paid by check.

Figure 6.4 The Data Entry screen for Books.
FileMaker Pro enables you to tab from one field to the next in any layout.
Press the Tab key to move to the Category pop-up field. When you tab to the
Category field, a scrolling list of options appears automatically. In figure 6.5,
the optio ns correspond to the line-item entries on the 1990 Schedule C.
Select an optio n by double-clicking on it, or by highlighting the optio n and
then pressing the Return key. For this example, scroll down and select
Utilities .

NOTE: FileMaker Pro also provides a shortcut for selecting
items fro m pop-up menus. Typing the first letter of a selection, such as "U" for Utilities, scrolls to the first item in the list
that begins with that particular letter.
After you make a cho ice, the cursor moves to the Description field. You
use this line to record notes about the transaction. Type Electric bill , and
then press the Tab key to move to the Receipt? field. This is another pop-up
field and offers "Yes" and "No" as options. Select an option as you did in the
Description field, and then the cursor moves to the Paid To field in the
Expense Item sectio n.
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Figure 6.5 Pop-up menus help speed up data entry and ensure consistency.
Every transaction in Books is either an expense or an income item. You must
fill in either the Expense Item fields or the Income Item fields-not both.
Because this is an expense, the cursor is already in the correct field. Type
People ' s Electric in the Paid To field, and then press the Tab key.
You enter the dollar amount paid in the Amoun t Type 192 . 87 and press the
Tab key. When the cursor enters the Payment Method field, another pop-up
menu appears. You can select from Cash, Check # , Visa, MasterCard,
American Express, and P .0 . #. Select Check # . The cursor then moves to
the Income Item section. Click on the previous field again and edit the
contents so that the entry reads Check #129a Now this record is complete.
Press the Enter key to see the results. The field boxes disappear and the dollar amounts are formatted properly.
The Income Item section of the layout works the same as the Expense Item
section. For each income item, tab past the three expense items Oeaving
them blank) and enter the income data. The Rec'd From field presents a
pop-up menu. You can customize this list by inserting the names of the companies and individuals who pay you most frequently. Instructions for doing
this are provided in the "Customizing Books" section of this chapter. As in all
pop-up list menus, you can accept one of the choices, edit a choice, or type
in an entry from scratch-you are not restricted to the choices offered in the
pop-up menu.
So that you will have data to display in reports, you may want to create
several more records before you continue.
Navigation is also controlled from the Data Entry screen. By clicking on the
buttons at the bottom of the screen, you can create on-screen or printed

reports. When you complete a report, you return to the Data Entry screen
automatically. Information similar to what you are reading now is available in
the Help screen (see figure 6.6). To access Help, click on the Help icon at
the top of the Data Entry screen. When you finish reading, dick on the Data
Entry return arrow at the top of the Help screen.
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Figure 6.6 Detailed use and customization informatio n is available in the
Help screen.

GENERATING REPORTS
No bookkeeping system would be complete without a way to generate useful
reports and summaries. The Books template enables you to create three
different reports and display them on-screen, or direct them to the printer.
To generate a report, click on one of the six buttons at the bottom of the
Data Entry screen. Buttons in the "Preview" row display the report onscreen. Buttons in the "Print" row present the standard Print dialog box, and
then send the report to the printer.
The following are descriptions of the three reports available in Books:

Detail (by Date) is similar to a simple bookkeeping ledger that is
sorted by date. It provides a running total of income and expenses
to date, as well as monthly subtotals.
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Summary (by Category) presents the total amount for each expense
and income category for the year-to-date.
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Detail (by Catego1y) lists each expenditure for the year and is sorted by
tax category. This provides two types of useful informatio n. First, when
used during the business year, it shows how expenses in each category
are accumulating. Second, at tax time, this report will provide the data
you need to finish your IRS Schedule C.

NOTE: Certain items, such as depreciation, insurance, and
travel/entertainment, are not simple deductio ns. The detail provided here will be necessary when determining the amount or
percentage of each category total and whether it will be an allowable deduction or expense.
After running any report, you return to the Data Entry layout automatically,
and the data is sorted co restore it to date order.

CUSTOMIZING BOOKS
The Help layout offers several basic suggestions for customizing Books. If you
want to keep things simple, you may initially want to restrict customizing to
changing value lists associated with the pop-up fields.

Q

Five fields present value lists: Category, Receipt?, Payment Method, Payment
Method 2, and ReceivedFrom. Whatever you enter when defining a value list
is what appears when you tab to that particular field.
Category lists the Schedule C line-item expense categories. You should edit
the value list if the tax categories change or if you decide to break
some of them down for finer detail (Utilities-Elec., Utilities-Gas, and UtilitiesWater, for example). Receipt? is a Yes/No choice. Payment Method and
Payment Method 2 list the types of payments your business accepts and
disperses. ReceivedFrom is currently a dummy field. (It contains no real
values.) As an example of how to change the value List for a pop-up field, you
can modify Receivedfrom by following these steps:
1. Select Define Fields ... from the Select menu. The Define Fields ...
dialog box appears (see figure 6.7).
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Figure 6.7 The Define Fields... dialog box.

2. Scroll using the side scroll bar and highlight the Received.From field.
3. Click on the Options button. The Entry Options for Text Field ...
dialog box appears (see figure 6.8) .
Books

Entry Options rorTeut Field • neceluedfrom•

-.:
1

Auto- enter a unlue that Is

D the

I

-,

Ucr1ru thnt the n eld ualue Is

Cl'cotl on Ool o

D Prohibit modltlcotlon ur auto-enter ed unlues
D Repeating n eld with• mnulmum or
unlues
181 Use n pro- den ned uatue list: [ Edit Unlues .•. )
D look up unlues from a Ole: ( \e t Look1111... J

Ll

100

Figure 6.8 The Entry Options for Text Field ... dialog box.

Getting Organized

The 9-to-; Mac

4. Near the bottom of the Entry Options ... dialog box is the Use a predefined value list: check box. When it is checked fo r a field, a po p-up
menu of values is presented whenever you tab to the field. Click on the
Edit Values ... button at the end of that line to view or modify the
values in the List.
5. In this case, there is a dummy value: "Emer company names here."
Delete this line by highlighting it and typing over it. Enter the
company names of o ne or more of your most important customers,
and press the Return key after each o ne. When the list is satisfactory,
click on OK. The next time you enter an income record, the
ReceivedFrom field will display this list of custo mers.
Using this procedure, you can alter any of the value lists in this database.
You also may want to change the PaidTo field to a pop-up menu that contains a value List of companies to whom you make regular payments.

SPECIAL FEATURE: FILEMAKER SCRIPTS
A script is a set of commands that you can instruct FileMaker to execute.
Scripts can specify a layout to display, a sort order, a Find command, and
a layout to return to when the script has finished. Scripts also can chain to
o ther scripts, performing several scripts automatically in succession. All
buttons in the Books database have FileMaker scripts attached to them.
Every report is generated by a script. Unlike script or macro creation in
o ther programs, such as spreadsheets, FileMaker Pro scripts require no
programming. All you need to do to make a report script, for example, is
design the report until it is exactly as you want it-with the correct sorting
and record selection options-and then define the script by clicking o n the
o ptions in a dialog box (see figure 6.9).
The script that appears in the dialog box is attached to the Preview Detail
(by Date) button on the Data Entry screen. To view the script within
FileMaker, follow these steps:
1. Select Define Scripts ... from the Scripts menu.

2. Highlight the first item in the script list (Detail Report Preview) and
click on the Options button.
The checked boxes tell you that the script performs the following tasks:
• Switch to the Detail Report layout screen.

•

Use all records in the database, rather than a subset based o n a Find
command.

•

Use the same sort criteria that was in effect at the time this script
was created (that is, sort by Date).

•

Display the report onscreen (''Preview'').

•

Return to the Data Entry screen when the script is complete.
Defini tion for Sc ript:
" Det ail Report Preuiew "

0

I ncl ude in m enu

Figure 6 .9 The Preview Detail (by Date) script definitio n.
The final check box instructs the script to run an additional script. In this
case, a script will resto re the data to its original order when the report script
finishes.
Scripting enables you get at the real power of FileMaker Pro. Using a copy
of the Books database, play around with the optio ns and review the discussion in the manual about scripting. After you see how easy it is to make
scripts, you will want to use them often. Suppose, for example, that you
have a database that records purchases by Fortune 500 companies. To
display all purchases over $5,000, issue a Find command, and then sort
the found records by purchase amount. If you needed this information on a
routine basis, just access the Define Scripts ... dialog box and store the collection of settings and options under a script name. If you want to keep the
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script handy, you can add the script to the Scripts menu by checking the
appropriate option in the Define Script ... dialog box. Then, when you want
that informatio n again, simply select that particular script menu item.
You also can use scripts to navigate around the database. If you wanted to
make things easy on the data entry people, for example, create navigation
buttons, such as the buttons in the Books template, that take you from a
data-entry screen to a help screen and then back again.

Tracking Medical Expenses
with RecordHolderPlus
RecordHolderPlus by Software Discoveries is another flat-file database program. For those of you with simple data management needs, the ease with
which you can learn and use RecordHolderPlus makes it a good choice. It
supports a variety of field types (text, number, money, date, yes/no, check
box, picture, table lookup, and radio butto ns) and contains calculation fields.
One feature of RecordHolderPlus should be standard in every database program. Each file you create must be indexed (sorted) on one or more fields.
The field(s) selected determine the order in which records appear. To malce
it easy to quickly move to any record in a database, RecordHolderPlus creates
a Table of Contents based on the indexed fields. Figure 6.10 shows a Table of
Contents window for a medical expense data file indexed on Service Date
and Description. By clicking on any line in the Table of Contents window,
the matching record appears instantly.
The Table of Contents provides a complete list of all records in the database,
sorted according to the indexed fields. The final line in the window displays
the total number of records in the file.

0

You easily can customize data entry screens and repo1ts. You can change
the placement of fields by dragging them into position; modify font types,
sizes, and styles; and dress up screens and reports with graphics. Reports
can have special sections for totals and subtotals, and can calculate averages,
minimums, and ma,ximums. There are also provisio ns for designing and
printing labels, and exporting data to be used with otl1er programs, such as
using customer addresses for a mail merge in a word processing program.

•
1/6/92 - A ffil i eted Physi eel Thernpi:
1/B/92 - A ff il i eted Physi ca1 Thernpi: li!li!
1I 10 /92 - A ffi 1i eted Physi eel Thernp li!i!!
1I1 0/92 - Dervocet
mm
1I1 2/92 - Phoeni x Mutue 1 pre mi um C.... lii!ii
1/13/92 - Dr. Zi rnrnermen (eppt. & x-1 IJ!iii
1I13/92 - Medrol
!i!i!I
:ii-:·
1/22/92 - Dr. Hade
!!!!ii
:1:::1
1/23/92 - Acetomi nophen with codei ;:;;::

Figure 6.10 A Table of Contents window.
Keeping track of medical expenses is something that many of us ignore o r
put off until the last moment. Currently, such expenses must exceed 10 percent of adjusted gross income before one cent is deduccible. Nevertheless, if
someone in your family has an operation late in the year, you will need to
backtrack and get your records together.
The simplest way to track medical expenses is to create a database that you
can use to record expenses as you incur tl1em. Such a database has been
created for you in RecordHolderPlus. As a bonus, che database also enables
you to track insurance reimbursements-whether you have submitted the
claim and the insurance company has responded, and how much of che
charge has been reimbursed. If RecordHolderPlus is not the database program you use, you will find that by reading through this sectio n, you easily
can create the database in your own program.

TRACKING EXPENSES WITH THE

MEDICAL EXPENSES TEMPLATE
The Medical Expenses template enables you to record each
medical expense o n a single screen. It tracks six general types of
expense, insurance submissions and reimbursements, and transportation coses. You can produce a year-to-date report o n demand, and show
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every expense in each category and current totals. At year-end, this report
provides all the information you need for tax compilation. The Data Entry
screen for the Medical Expenses template appears in figure 6.11.
~
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Figure 6.11 The Data Entry screen fo r the Medical Expenses template.
As mentioned previously, you can use the Table of Contents window to move
directly to any record and edit it. RecordHolderPlus does not have a New
Record command. When you want to add another record, you have two
options.

Begin with an <U-isting record and edit as needed-This is us.eful
when many of your expenses are similar. You may, for example, buy
the same prescription every month. Just select an appropriate
record from rhe Table of Contents and make the necessary changes
to the record. When you are through, click o n the Add button to
save it as a new record.
Or

Clear an existing record and enter all data from scratch- To clear a
record, select Clear from the Edit menu, press Command-K, or press
the Clear key on the numeric keypad.

With either method, the original record remains unchanged in the database.
The following steps describe how to enter data for a new medical expense:
1. In the Service Date field, enter the date on which the service was

provided or the expense incurred.
2. For Service Type, click on the radio button that indicates the general
expense type: medical service fee (fees to doctors, dentists, hospitals, and so on); prescription medicines; special items (medical
appliances such as hearing aids, eyeglasses, and crutches); medical
insurance (premiums that you paid, not those paid by your employer); medical travel (trips taken for medical reasons) ; or other
(miscellaneous expenses that don 't fit in any of the other categories).
3. In the Description field, enter a text description of the expense, such
as the drug name, name of the doctor or hospital, description of the
medical test, and so on.
4. Click on the Receipt? check box if you have a canceled check, charge
card slip, or printed bill or receipt.
5. Click on the Submitted? check box if you have submitted the claim to
your insurance company.
6. Click on the Insurance company response check box if you have
received a determination from your insurance carrier.
7. Mileage to and from medical appointments and related travel (a trip
to the pharmacy to pick up a prescription, for example) are currently deductible at 9 cents per mile. If you provided your own
transportation, enter the round trip mileage in the Mileage field. This
is a required field and you are warned if you leave it blank. If no
mileage was incurred for this item, type 0.
8. If you used other transportation, such as a taxi, bus, or airplane,
enter the actual cost of the transportation in the Other transportation
field . This is also a required field. Type 0 if you provided your own
transportation or no transportation was required.
9. Enter the cost of the service or item (regardless of who paid for it)
in the Total charge field. If a doctor's bill was $147.50, for example,
you should enter d1e amount in full, even if the insurance company
paid for part or au of it.
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10. Record the amount the insurance company paid towards the claim in
the Insurance reimbursement field. lfyou did not submit a claim (a
no ncovered expense), type 0.
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11. You can enter additio nal notes about the medical expense in the
Comments field at the bottom of the form.
12. When you finish entering the data, click on the Add button to add the
record to the database. Total transportation, Out-of-pocket, and
Grand Total are calculation fields and are completed for you.
When you hear from the insurance company or begin to receive bills from
the hospital, it is important to update the relevant records. Use the Table
of Contents window to locate the record (the Table of Contents is sorted
by Service Date and Description), make any necessary changes and additio ns, and then click on the Replace button. If you are asked to confirm the
replacement, select OK.

Handling Insurance Reimbursements

fl

With annual or per-incident deductibles, claims treated as
excessive (doctors biJling at rates that are considered "above
the usual or customary charge"), and some insurance payments going to service providers and others to you, it can be
confusing trying to determine the correct figures co enter in
the d atabase. The key is to remember that you are only concerned wid1 the out-of-pocket costs for each medical expense.
Total charge minus Insurance reimbursement must always
equal the dollar amount you personally paid for the incident.
For example, suppose you recently saw a specialist who
charged $200 which you paid at the end of the visit. According
to the insurance company, of that amount, the customary
charge for the service is $160, disallowing $40 of the fee. At
the time, your remaining annual deductible was $ 100. So you
apply the $160 to the deductible of $100 which left a remainder of S60. The insurance company enclosed a check for 80
percent of that amount (S48).
Physician 's fee

$200

Excessive charge

-$40

Subtotal

S160

Remaining annual deductible

-Sl OO

Total

S60

Coverage

80%

Reimbursed to you

S48

For this item, the correct entries in the data record would be:
Total Charge ($200), Insurance reimbursement ($48), Out-ofpocket ($152).
lf the doctor's office had billed the entire fee directly to the
insurance company, these figures would remain the same.
Your doctor would have received the check fo r S48 and you
would be billed the remaining amount of $152.

GENERATING A REPORT
The Medical Expenses template includes a report that lists all year-to-date
medical expenses. The report is divided into separate sections for each
Service Type. Within each service category, expenses are sorted in date
o rder. Each section of the report provides subtotals for the fields. Grand
totals appear at the bottom of the report.
To display the report on-screen, follow these steps:
1. Select Open Format .. . fro m the Report menu. A list of currently
defined report formats appears in a dialog box.

2. Select Report 1 from the report list. The Report 1 design grid appears.
3. Select Page Setup .. . from the Report menu. The Page Setup dialog
box appears.
Select landscape (sideways) orientation. The repo rt will fit only
when you choose this mode.
4. To display the report on-screen, select Preview Print... or Print to
Screen ... fro m the Report menu. (Displaying the report on-screen is
handy when you just want to check totals and subtotals without
wasting paper.) A dialog box that contains record sorting and selectio n
optio ns appears.
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5. Click on OK in the dialog box to display the report. Use the scroll bars
to view any part of the report that doesn 't fit on the screen.
Figure 6.12 displays a typical report.
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Figure 6 .12 A print preview of a Medical Expenses report.

6. When you finish viewing the report, click on the close box in the upper
left corner of the report window.
7. To print the report, select Print ... from the Report menu. Click on OK
in the two dialog boxes that appear.
Sometimes a report may come out wrong. All records in each category may
be the same, for example. To correct the error, select Order ... from the
Report menu. The Specify Fields dialog box will appear. Highlight
S-Service Type in the Sort Fields list box, and then click on the Done bunon.
Selecting S-Service Type groups records according to Service Type and
calculates subtotals for each type of service. After you select Save Format
from the Repor t menu, you can regenerate the corrected report.

CUSTOMIZING MEDICAL EXPENSES
A number of different field types were used in designjng the data entry form.
If you want to create this database in a different program, the following information will be helpful:

Field

Type

Definition

Date of Service

Date

Service Type

Radio buttons

Description

Text

Receipt?

Check box

Submitted?

Check box

Insurance company response

Check box

Mileage

Number

Other transpo rtation

Money

Total transportation

Moneycomputed
field

Total charge

Money

Insurance reimbursement

Money

Out of pocket

Moneycomputed
field

Total charge Insurance
reimburseme nt

Grand Total

Moneycomputed
field

Out of pocket +
Total
transportation

Comments

Text

Table of values

(Mileage *
.09) +Other
Transportation

You can check any of the types and definitions by selecting Structure ... from
the File menu. You also use the Structure ... option to mod ify the values for
the vario us fields. lf you want additional service categories, such as separate
categories for doctors, dentists, and lab tests, for example, follow these steps:
1. Select Structure ... from the File menu. The Structure dialog box
appears.
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2. Select Service Type in the Field list and click on Update Table. This
reveals the List of Values dialog box and lists all the values for Service
Type.
3. Enter the new categories using the standard Macintosh editing procedures and the available buttons to add, replace, and delete categories
as needed.
4. Click on Done to exit the Update Table dialog box.
5. Click on Done to exit the Structure ... dialog box.
6. Select Reformat from the Edit menu. The layout for the data-entry
screen appears with the new service categories already in place.
The service categories can be rearranged by dragging them to new
positions on the layout. Field alignments, fonts, sizes, and styles can
be changed by selecting Field Format... from the Edit menu and
opcions from the Font and Style menus.
7. Click on the Done butcon ac the bottom of the window co save the
changes co che layout.
New service categories are handled in che reporc automatically-no
changes should be necessary.
Another change you may want co make is to display the records in a sort
o rder ocher than the current one. Presently, che records are indexed by Date
of Service and Description. (The field(s) selecced as indices also are used to
arrange data in the Table of Contents window.) Depending on your preferences, you may find it easier to fl ip chrough records if chey are arranged by
Service Type and Date so chat all records fo r prescriptions are gro uped
together. To change the indices, follow these steps:
1. Select Change Index ... from che File menu. The Specify Fields dialog

box appears.
2. Click on the Start over button to clear the Index Fields list. Select the
new fields you want from che fields that appear in the Database Fields
list. For this example, click on Service Type and Date of Service.
3. When you finish, click on Done to creace che new index. The database
and the Table of Contents will be sorced to match the new indices.

You use the report design grid to create or custo mize reports. To access the
report design grid for Report 1 which has already been defined for the Medical Expenses database, select Open Format .. . from the Report menu and
select Report 1. The format fo r the body of the report appears (see figure
6. 13). (To design a new report, you would select New Format fro m the
Report menu.)
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Figure 6.13 The body layout for Report 1.
All info rmation above the radio buttons is used by RecordHoklerPlus as a
header and appears o n each page of output. For Repo rt 1, the field labels
were placed in the header area, alo ng with the report date, page number,
and repo rt title. Below the radio buttons are the names of the fields. Each
is carefully aligned beneath the field label so the columns will line up
properly. With the exceptio n of Description, all fields are right-aligned.
To view the subtotals layout, click on the first Subtotal radio butto n. The
subtotals are fom1atted in Times Bold fo r emphasis. A solid line separates
the subtotaJs from the data in the category above, and a spacer was addtd
below to separate them from the data for the next Service Type (see figu re
6.14).
Subtotals are requested for each Number and Money field. When placing
subtotal and total fields, it is important to align them with the columns of
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data in the Body. The easiest way to do chis is to switch to the Body layout,
note where the edges of each field fall on the ruler, and then return co the
Subtotals or Totals layout and place the fields-resizing as needed.
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Figure 6.14 A separate layout is used for calculating and printing subtotals.
You use the Tools palette to manipulate fields (arrow tool) ; place fields,
labels, and totals o n the page; add special items for the header or footer
(page#, dace, time); and create simple graphics (figure 6.13).
The Totals section was created in exactly the same manner as the Subtotals
section. A heavier line, however, was added above it to indicate the importance of the figures.
To define a total, dick on Total in cl1e Tools palette and drag the field onto
the layout. Next, select the field for which you want co create a subtotal or
total. After you make any necessary formatting changes (modifying the font,
size, or alignment), drag the field into position under the radio buttons.

Panorama II: Phone
Message System
anorama from Pro VUE Development is one of the most advanced,
feature-laden flat-file database programs fo r the Mac. Because o f chis,
it has a steeper learning curve than some o f the simpler databases, such as
RecordHolderPlus, Retriever, and FileMaker Pro. Panorama enables you to
perform the following functions:

P
•

Create custom data-entry forms and reports.

•

Create macros.

• Assign default values to fields.
• Specify input and output patterns for each field.
• Store graphics in special Flash Art files .

Clairvoyance is one of Panorama's most interesting features. It first appeared
in OverVUE, ProVUE Development's first database program for the Mac.
When clairvoyance is set for a field, Panorama attempts to fill in the field for
you by matching the first few characters you type with entries stored in the
database. Typing Pro, for example, may result in ProVUE Development being
entered for you.
ProVUE also offers an optional ZIP code database you can buy for Panorama.
It enables you to identify the city for any ZIP code in the US. This means that
someone operating an order entry database could ask a caller for a ZIP code
and let Panorama fill in the city and state automatically.

Using Phone Messages
In most offices, phone messages usually are recorded on little slips of paper.
If you are well-organized, this system doesn't pose a problem. Realistically,
however, tiny message slips are easily misplaced.
The Phone Messages database enables you to begin automating your office
messaging system. ln additio n to creating normal message slips, the database
stores a record of each call-in case a slip is lost or an employee forgets to
add some numbers to his or her card file.
Each message is recorded on an electronic version of a message
pad-with many amenities. Each call is recorded in the easy-to-use
message entry form (see figure 6.15). The date, time, and record
number are entered for you automatically. You can fill in the For, Category,
and Taken By fields by selecting options from pop-up menus. You can print
records and reports or view them on-screen. You also can organize reports
by record number or sort t11em by employee name.
Normally, Panorama fills in three fields for you automatically whenever you
create a new record: Date, Time, and Record . When you first open the Message Entry window, however, only Record is filled in (as 0000001) . For the
first record only, you must manually type tl1e current date in the Da te field .
The first record in a Panorama database is sacred . It is the basis for all other
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records in the database. Although you can edit the first record, you cannot
de le te it-the d atabase must always contain at lease one record.
~
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Figure 6.15 The Pho ne Messages data e ntry screen.
Afte r you e nter the elate in mm/dd/yy format, such as 09/ 12/92, press the Tab
key twice to move to the For field, and then select the employee who is to
receive the call. The database currently contains a sec of imaginary employee
names. You will learn how to change the list of names in the following section. Selecting an employee invokes the time-stamp feature of the database
automatically, filling in t11e Time field for you.
To complete the record, cab to each field and e nter the appropriate information in t11e following fie lds: From (caller's name), Company, Phone, Ext
(exte nsion, if any) , Category (Please call, Returned call, and so on), Message
(if any), and Taken By (name of the person who took the message).
To create a new message slip for the next call, rurn o n the printer and click
on the Add New Record ico n in the Tool palette (see figure 6.16) . Phone
Messages is programmed to print the current record immediately after you
add a new record. Because you will want a printed copy of each message,
leave the printer on when using t11e database.
After you e nter the first message, subsequent messages will use all of t11e
automatic features designed into the database. When you click on the Add

New Record icon, select the Add New Record command from the Edit
menu, or press Command-£, the current record is printed automatically and
a new blank record appears. The number for the new record and the current
date is entered for you. (The date is taken from the Mac's internal clock.) The
cursor is positioned in the For pop-up menu automatically. After you select
the name of the person who is to receive the message (dick o n the appropri·
ate radio butto n or type the first few characters of the person's last name) ,
the time of the call also is filled in for you.
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Figure 6.16 The var ious tools available in the Message Entry form.
Occasionally, you may need to return to a message to edit it. You may, fo r
example, need to correct an error in the company name or a phone number.
To return to a previous record, page through the records by using d1e up and
down triangles in the Tool palette (first record, last record, next record, and
previous record) . If the database contains many records, you may find it
quicker to use Panorama's Find command. To issue a Find command, select
Find/Select ... fro m the Search menu. Enter the search criteria in the dialog
box that appears (see figure 6. 17).
After you find the correct message, click o n the fields you wanr to ed it and
make the changes. If you made a significant modification, you may want
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co princ a new copy of the message. ]use click on the printer icon in the Tool
palette, or add a new record. Remember, adding a new record aucomatically
prints the current record.
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Figure 6.17 You easily can locate old messages using the Find/Select. ..
command.
Periodically save your changes as you add new records or modify any of che
field definitions or layouts. To be extra safe, you can make Panorama do
some of che work for you using the Save Preferences command. To set Save
Preferences for the database, follow these steps:
1. Select Save As ... from the File menu. Panorama's normal file dialog
box appears (see figure 6.18).
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Figure 6.18 To change your Save Prefe rences, select Save As ... fro m che File
me nu.

2. Click on (either or both) the Automatic Save and Keep Backup
check boxes. The Automatic Saveoption enables you to specify a time
period at which the database will be saved. Keep Backup creates a
second copy of the database for you, and replaces the database
when you perform a new save.
At the end of a session, Panorama prompts you to save any changes made.
Be sure to answer "Yes" if you have added new records.

GENERATING REPORTS
You can create two styles of report in Phone Messages: a call log sorted in
record o rder and a log grouped by employee. After you enter several
messages, you can create either of these reports and display them o nscreen by clicking o n o ne of two buttons ( List sorted by date/timeor List
sorted by employee). Figure 6.19 shows an example ofan employee report.
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Figure 6.19 On-screen reports are created using the Print Preview functio n.
The list sorted by employee option is useful fo r determining if any pho ne
messages have come in for a particular employee. You can view this report on-screen o nly. You can print the normal phone log (List sorted by date/
time) by clicking on the Print phone logbutton. Whenever you print the
report, you are given the option to delete all the old records from the database.
In a large company, Pho ne Messages would contain an enormous number
of records after only a few days of use. Depending on your incoming
pho ne volume, you should clear the database regularly-for example, every
day, week, or month. You can store the printed phone logs in a file folder so
that you can still look up old calls.
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You can clear all records from the database in two ways. First, after clicking
on the Print phone Jog button and printing the log, the Delete records alert
appears (see figure 6.20). To leave the database intact, click on the No button, or press the Rerurn key. To delete all records and begin the database
again, click on the Yes button.
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Figure 6 .20 Clear the database on a regular basis to avoid was ring disk space.
Clicking on the Erase old records button on the message entry screen also
displays the De lete r ecord s alert. Although you can use this option to erase
the records in the database, it is better to clea r the database after you print
the daily, weekly, or monthly report. This ensures a complete paper copy of
the old messages before they disappear.

CUSTOMIZING PHONE MESSAGES
Phone Messages is the most advanced database created thus fa r . As w ith any
database, Phone Messages is made up offields (see figure 6.21). If you have
Panorama, you can examine and change the d efinitio ns by selecting the Design Sheet from the View menu. (To display the View menu, click o n the

tiny menu icon just to the left of the window name in the title bar. The popup menu appears.)
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Figure 6 .21 The field definitions for the Phone Messages database.
The most important columns to note include Type (the field type), Output
Pattern (the way in which data is formatted onscreen and in reports), Range
(characters allowed during input) , Choices (fields with choice lists attached),
Clairvoyance (explained previously), Caps (automatic capitalization), Dups
(whether duplicate entries for the field are allowed) , Default (default fie ld
entries) , and Equation (any formula triggered automatically by moving into
the field) . Following are some important field definitions:

Date-The output pattern for Date is a custom one created especially
for this database. It shows the day of the week followed by the full date.
Record-By designating an output pattern for Record (the Call#) , we
can force leading zeros to appear. This featu re is also useful for
formatting ZIP codes.
Dups-A "No Dup" definition for a field specifies that no two records
can have the same entry for that field . Other than for Record (record
numbers must be unique) there is no reason that the other fields
should not allow duplicates.
Default-Defau lt entries are specified for Date and Record, and are
filled in automatically when a new record is created . Like any other
field, these entries can still be edited . As defaults, the current date is
inserted into the Date field and Record is incremented by one.
After you create preliminary field definitions, you lay out the forms. Phone
Messages consists of two forms: a form for recording messages (Message
Entry) and a form for displaying the call log as a report (Phone Log).

Standard Panorama design techniques were used to create both forms. To
see the design of either of the forms, select the form fro m the View menu
icon, and then click on the top icon in the Tool palette to change from data
access to graphics design mode. Figure 6.22 shows the layout for the pho ne
log report. When you finish viewing the design, select the top icon again to
return to data access mode.
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Figure 6.22 The Phone Log report layout.
Before you begin using the database in your company, you need to modify
the Forand Taken By pop-up men us so that they contain the names of your
employees, rather than the sample names currently in the template. When
working in the Message Entry form, if you position the cursor on either field,
a horizontal or vertical list of names appears. Each name is preceded by a
rad io button. To edit the Forand Taken By pop-up menus, follow these
steps:

Q

1. Click on the View menu icon in the middle of the window title bar,

and select Design Sheetfrom the pop-up menu.
2. To edit the For pop-up menu , double-click on the space where the
Choices column and For field intersect (see figure 6.23). (Because the
full width of the Choices column is not shown, it may appear as
"Choi")
3. The names in the For pop-up menu are alphabetized by the last name.
You enter information in the "last name,_first name" forma t.
Do not use spaces when entering names in pop-up menus. A space
signifies the end ofan entry. Substitu te underline characters(_) for
spaces when typing names. In this list, an underline follows each
comma. Replace the current list with an alphabetized list ofyour
employees.
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Figure 6. 23 On the design screen, double-click o n the Choices (appears as
"Choi") list for the For field to open the list fo r editing.

NOTE: The long string of underlines at the end of the list results in an
extra choice in the pop-up menu. You can use this to record messages
for visiting consultants, temporary employees, and so on.)
4. When you complete the employee list, click outside of the Choices edit
box.
Follow the same procedure to edit the Taken By pop-up menu.
Generally, the Taken By pop-up menu sho uld contain the names of
those who routi nely answer the phones. As with the For list, it is a
good idea to include one extra blank field (a string of underlines)
for those people who occasionally handle the switchboard.
5. Select Save from the File menu to record the changes.
To see a pop-up menu in action, select Message Entry from the View menu
by clicking on the menu icon in the center of the window title bar.
Because you recently replaced the contents of the For and Taken By lists,
you should change the dimensions of the list rectangles so that they display complete lists. You can display any pop-up menu as a horizontal or
vertical list and resize it as needed. In this database, For and Call Type are
vertical lists; Taken By is a horizontal list. To change the shape or orientation of a list, follow these steps:
1. Selecting the Message Entry form from the View menu.

2. Press the Tab key until the cursor is positioned in the For field .
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3. When the pop-up menu appears, position the pointer in the lower
right corner of the list and drag the box to the shape you want. Repeat
this procedure forthe Taken By field.
Although you can paste graphics directly into records, each graphic takes
up memory. To use minimum memory for a graphic, you can store images
as Flash Art. The drawings of the phone, sorted cards, printer, and eraser
were copied into the Flash Art Scrapbook, and then linked to a field in the
Message Entry screen.
To place a Flash Art object on a form , follow these steps:
1. Select the graphic in your graphics program and copy it to the

~

?
</

~

Clipboard by pressing Command-C.
2. Open the database in Panorama, and select Flash Art Scrapbook froi:n
the View menu . Use the Paste command (Command-V) to paste the
graphic into the Flash Art Scrapbook. The Picture Caption dialog box
appears. Enter a name for the graphic, and then click on OK

3. Display the Message Entry screen by selecting it from the View menu.
Click on the icon at the top of the Tool palette to change to Graphic
Design Mode.
4. Select the Flash Art icon (the light bulb) from the Tool palette.
Using the mouse, drag to create a rectangle in which to receive the
art. After you complete the rectangle, the Flash Art dialog box
appears (see figure 6.24).
5. Enter the name of the graphic and surround it with quotation
marks. In the same dialog box, you can optionally crop, center, or
scale the image within the rectangle you have just drawn.
6. To view the new graphic, return to Data Access mode by selecting
the top icon in the tool palette. Because the graphic placeholder is
now a part of the form, the image appears on every record automaticaUy.
As it stands, the Phone Messages database may be adequate for your company. Jfyou want to continue to explore Panorama, you can add or enhance
several functions.
Rather than using Phone Messages to track all incoming calls, you may
want to use it as the basis for a specialized system that you customize for a
single department. Customer Service and Technical Support departments,

for example, can use Phone Messages to track customer calls and keep a
record ofcall-backs and problem resolutio ns.
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Figure 6.24 The Flash Art dialog box enables you to select a picture to
display.
Currently, only two reports are available. Depending on your needs, you may
want to create several specialized reports, assigning them to butto ns or simply displaying them in the Forms list. You can run a repo rt grouped by the
From or Company field, for example, that contains a record count at the end
of each grou ping. This way, you can see whether large portions ofyour calls
are all coming from the same individuals or companies and single them out
for specia.I attention.
The system still depends on paper forms, and forces you to print each message and distribute them by hand. Rather than tiny slips of paper, each
message now takes up a full sheet of letter-sized paper. If your Macs are networked, you have several optio ns for distributing messages over the network,
enabling you to skip the printing altogether. Using the file-sharing capabilities of System 7, for example, the receptionist can capture a screen sho t of
each message using a utility program, such as Snap)ot or Capture, and then
save the message to the appropriate user's disk. lfyou use a electronic mail
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program, you can forwa rd the individual messages and also notify the
recipient as each message is delivered.

Formulas and Macros
The Pho ne Messages database contains one automatic formula. That
formula is responsible for data stamping each record when a message
is taken. The fo rmula is assigned to the For field and is Time
=Time patte r n (Now( ) , ' hh : mm AM/ PM" ) . This formula records the sys tem
time in the Time field. The Timepattern functio n used in the formu la take~
the system time from Now() and formats it as hours, minutes, and AM or PM,
as appropriate.
Seven macros are defined for the database. Click on the View menu ico n and
macros names appear at the bottom of the list. Each macro performs an automatic function or is attached to a button. Beginning a macro name with a
period (as was done here) prevents the macro from being included in the
normal Macro menu .
. Initialize, .NewRecord, and .CloseWindow are special Panorama macros that
are initiated by a Panorama activity, such as: opening a database, creating a
new record, and closing a window, respectively. The macros in the Phone
Message database were defined to do the following:

.Initialize-When you open the database, the Message Entry form
appears automatically.
.NewRecord-When you create a new record, the cu rrent record is
printed, a new record appears, and the cursor moves to the For
field .
.CloseW'indow-Checks the window when you click o n the close box
in any window. If you click o n a window other than the Phone Log
window (the for m that displays the log) , the window simply closes.
If you click o n the Phone Log window, the window closes, the
Message Entry window appears, and the database is sorted by
record numbe r to restore the records to the ir original o rder.

The remain ing fou r macros were created for the buttons on the Message
Entry form. They perform the following functions:

.View Calls by Record Ord-Returns you to the Pho ne Log form and
ini tiates the Print Preview command , enabling you to view the report.

In the Message Entry window, this macro is attached to the List sorted
by date/time button .
.View Calls Sorted by Emp-Sorts the database twice. First, by
employee name (the For field), and then by Date. This macro is
attached to the List sor ted by employee button .
.Print Log-Generates the printed report. le opens the Pho ne Log
form and issues the Print command. When printing is completed, the
window closes and you are asked if you want co delete the old database
records. Ifyou delete the records, the macro creates a new first record
for the database and moves the cursor co the For field. This macro is
attached to the Print phone log button .
.Delete Old Records-Performs the same function as the delete
option that is provided after a report is printed, and is attached co
the Erase old records button. This macro uses the same code co
accomplish the task. You should use this button only after you print
a copy of the old data or decide you do not want a printed copy.

The capability to add macros to a Panorama database makes it possible to
build a system that isolates the user from the actual Panorama program.
This makes Panorama an excellent choice for projects when you do not
expect the person entering data to be familiar with the way in which the
database actually functions.

4th Dimension 2.2.1 : Project
Expense Tracker
n the Macintosh community, when someone mentions a "high-end pro
grammable relational database," many users immediately think of4th
Dimension fromACIUS , Inc. Many Macintosh relatio nal database programs
enable you to create full-blown applications, complete with custom layouts,
menus, and Command-key equivalents. Project Expense Tracker is an application designed in 4th Dimension. It enables you to conveniently collect lists
of project-related expenses and maintain contact information on the companies for whom the projects are being completed.
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Obtaining the 4th Dimension Demo
Yo u must have a copy of 4th Dimensio n to run Project Expense
Tracker . If you d o not own 4th Dimension, ACIUS offers a demonstratio n versio n o f the program that can also be used.
Although it limits the number o f reco rds per file to 50, and the
number o fl ayouts and procedures to 20 and 25, respectively, in
all other ways it is a fully-fu nctional versio n of the program. Not
only will it enable you run and modify the Project Expense
Tracker database included with this book, yo u also can use it to
create your own applications. (If you would like to have the
demo-including sample databases and an 80-page manual,
contact ACIUS at 408-253-DEMO and request the 4th Dimensio n
Test Drive Kit.)

The Project Expense Tracker is an easy-to-use, custo m 4th Dimensio n
application for recording project-related expenses and co mpany contact
info rmation . As a custom application with its own menus and procedures,
it can shield less knowledgeable users from the complexity of maste ring
the underlying d atabase program.
Although custom programming was necessary to create the scri pts and
procedures that make the menu optio ns work, Project Expense Tracker
uses several of 4th Dimensio n's built-in p rocedures to perform other
complex activities, such as record selectio n, navigatio n, editing, so rting,
and p reviewing reports o n-screen.

NOTE: Project Expense Tracker is d esigned to run o n a system
with a 13-inch o r larger colo r mo nito r . Yo u also ca n run it on
standard 9-inch black-and-white systems, bu t you will need to
scroll to view complete records.

Tracking Expenses with
Project Expense Tracker
The first time you open the Project Expense Tracker database, you
are prompted for the name of adata file. Because a data file does
not yet exist, you can create one by accepting the default name and
location that 4th Dimension proposes. Anew file called "Project Expense
Tracker.data" is created for you. Ifyou want to experiment with the database
before you commit important data, go right ahead. When you are ready to
enter real data, return to the Finder and throw away the "Project Expense
Tracker.data" data file. You can create a new data file the next time you run
the application.
When you start the program, a splash screen appears (see figure 6.25). Resize
the window to match your display by clicking on the zoom box in the upper
right corner. If you do not see the zoom box, click on the title bar and drag
the display to the left until the zoom box appears.
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Project Expense Tracker

Figure 6.25 The opening screen and menu options for Project Expense
Tracker.
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All activities are initiated from the splash screen. Project Expense Tracker
works in an un-Mac-like modal manner. Most Mac programs are modeless;
that is, you can do almost anything at any time, including initiating a different
task while you are in the middle of another task. A modal program, on the
other hand, requires you to complete the current activity before you switch
to something else. Whenever you select an activity (by selecting a menu option or pressing a Command-key combination) , you return to the splash
screen when the activity is completed. After you begin an activity, all menu
items are disabled temporarily to keep you from selecting anything else.
Within a particular menu option (New, Edit, or Duplicate) , you can perform
the action as many times as you want, such as editing one or all records.
Project Expense Tracker is composed of two related databases: Projects and
Companies. It is assumed that there is a one-to-one relationship between
each project and a particular company for whom the project is being conducted. You use the Projects database to record up to ten expense items for
each project. The Companies database contains the name and address of the
company for whom the project is being done, the names and phone numbers
ofup to five company contacts, and any general notes you want to make. The
two databases are linked (related) by the Company name fields. Making two
separate databases has a distinct advantage, assuming that you do multiple
projects for the same companies. After you enter company data, you can link
new projects to the old company record-saving you typing time and recordkeeping drudgery.
Because there are two databases, entering a new project is usually a two-part
process. You must start by filling in some minimal information about the
project and, if the project is fora new company, some general data about the

firm.

0

To begin a new project, select New from the Projects menu or press Command-N. The Add Projects screen appears (see figure 6.26). Enter the name
of the company for whom the project is being done. If this is the first project
for that company, you are prompted that there is no matching record in the
Companies database (see figure 6.27) . Click on Create lt to make a new
company record, or Try Again if you think you misspelled the company
name. Clicking on Create It displays a layout screen from the Companies
database.

Figure 6.26 The Add Projects screen is used to start a new project.
File Edit

Projects Companies Reports

Add Pro ec t.s

This rucord

doe~

not oHl st In fll o

·com1rnnlos· .
Whn t do you wont to ll o?

( Creole

It J

Gf19l0l)~
"'
1ry-R~g01n~

00/00IOO
OOI00/00

00/00/00

.

.

~

" '-,

,

~r.·~·#-~~.-\:1 • - ::. ... ··t.:~·:_::::r_:~~··.i-!-~~i.r. ."'.".:.~-.:-->;.. ,.,.-.~. ;-'·!'1,~~

JI

Figure 6.27 When starting a new project, if Project Expense Tracker canno t
locate a record for a company, you can create one.

Ifyou have alreadycompleted a project for the company, you can instruct
Project Exp ense Tracker to search for the company name by using a n "@"
(at) symbol as a wild card character. To search for a ny company name that
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begins with "Micro," for example, you would type: Micro@
. Ifonly one
matching company appears, the Company field and related company information is filled in for you automatically. If two or more potential matches
appear, they are presented so that you can select o ne.
The Add Company screen appears when you create a new company by typing a new company name when starting a project, or by selecting New from
t he Companies menu (see figure 6.28). Fill in as much or as little detail as
you want. The Department and Description columns provide pop-up
menus from which you can choose options. After entering your data, click o n
the Save icon (the normal disk) to save the record, and then you return to
the Add Projects screen. Note that any contact information you enter in the
Company record is visible in the related Projects screen. For your convenience, you can edit o r add contact information on this screen or on the
Company record screen.

Choices for Phone numbers

m

Figure 6.28 Company informatio n is entered using this screen.
Pressing the Tab key moves you from field to field in the Projects and Companies layouts. Some fields in the layouts present pop-up menus. To select an
item, type the first letter or two from its name to move to that particular item,
or move to it using the arrow keys on the keyboard. Press the Ren1rn or Enter
key to accept the cho ice. You also can choose and accept an item simultaneously by clicking on it. To ignore the choices and enter something
different, click o n die Cancel button.

If you already have incurred some expe nses for the project, you can enter
them now. Fo r each expense item, fields are provided for the Date, Expense
Category (the type of expense, such as phone call, duplication, shipping,
and so o n), a Description, and the actual Cost. If you enter anything other
than a no rmal date in any of the ten Date fields, the date you enter is automatically replaced by the current date. The quickest way co use this feature is
to simply press any key, such as a letter o r th e space bar, and then tab out of
the field.

NOTE: The total expenses for the record appears at the botto m
of the Cost column. This figure is updated auto matically after
you save the record .
When you are done entering the project information, click the Save icon. A
new blank project screen will appear. lfyou have another new project you
wish to record, you can d o it on this screen. When you finish entering new
projects, click o n the cancel icon (the d isk with the slash through it) and you
will return co the splash screen.
The flowchart in figure 6.29 summarizes the steps necessary to create a new
project.
Gathering expense and contact information is an ongoing process, so you
need a way to return to the records and update them. Both the Projects and
Companies menus contain Edit options for this purpose. When you select
Edit from either menu, a screen similar co the once in figure 6.30 appears.
To select a record, highlight the record, and then double-click on it. Every
time you exit from a record by clicking on the Trash, Save, or Cancel icon at
the bottom of the record window, you return to the Edit Projects or Edit
Companies screen. Wh en you finish editing, click on the Done button to
return to the splash screen.
The icons at the bottom of the Edit Projects screen represent: go co first
record, go to previous record, go to next record, go to last record , delete
the current record, save the current record, and cancel changes. The two
blank icons are for flipping through pages in multi page records. Because the
present databases contain only single-page records, these two icons are always dimmed.
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Enter a company
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Yes
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Company screen
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Enter project info
and eHpenses
to-date

Click saue
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Yes

Click saue
(disk icon)

No
.I
Click cancel
(slashed disk
icon)

0

Figure 6 .29 The steps for entering a new project.
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Figure 6.30 The Edit Projects and Edit Companies screens present an
alphabetical list of all projects or companies, respectively, from which you can
choose.
For some projects, ten expense lines may not be sufficient. Rather than
creating additional records manually, you can use the Duplicate command
to create a copy of any project record. To duplicate a project record, follow these steps:
1. Select Duplicate from the Projects men u (or press Command-D) . If

only one project record is in the database, you are notified and the
record is duplicated instantly.
2. If mo re than one project record is in the database, you are prompted to
select the correct o ne from the alphabetical project list in the Duplicate
Projects screen.
3. Double-click on the project name and a duplicate project record is
created.
4. Delete or edit the expense items in the new record using the Edit
command from the Project menu.
The new record is identical to the original, except for the project name
which is followed by a dash (-) . If the original record is unnumbered, the
new record is assigned number 2. If the original record is numbered, the
new record is assigned the next highest number. If a project already
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The Company menu contains its own Duplicate command as well. In most
cases, one company record will suffice. If you find you have additional
contacts you need co record, you can use the preceding procedure co
create duplicate company records; however, note that each project record
is linked co only one company record. Be cerrain to link the project
record co the company record with the correct set of contact people.

T

GENERATING REPORTS
Two types of re pores are available: a report for projects and a report for companies. Each prints a simplified version of the data-entry screen, displaying
two to three records per page. To print a report, fo llow these steps:
1. Select Print Projects or Print Companies from the Reports menu.

The Print Projects or Print Companies screen appears.
2. Select the project or company records you want co include in the
report. Pressing and holding down the Shift key select all records
between the first and second record clicked. If you want to select
multiple non-contiguous records, press and hold down the Command key as you click on each record.
3. Click on Done co generate the report. (If you click on Done without
selecting at least one record, you return to the splash screen.)

/J

4. After you respond to the Page Setup ... dialog box, the Print dialog
box appears. Click on OK to begin printing, or click on the Preview on
screen check box to preview the re pore before you print it. If you click
in the Preview on-screen check box, a miniature view of you r report
appears on-screen (see figure 6.31). Clicking o n the Zoom button
enables you to zero in on the detail within the selection rectangle.

QUITTING FROM PRO.JECT EXPENSE TRACKER
When you load or double-click on Project Expense Tracker, 4th Dimension
automatically switches to Runtime mode. When you quit the database application by selecting Quit from the File menu or by pressing Command-Q,

you will be in 4th Dimensio n User mode. Selecting Quit again retu rns you to
the Finder. Alternately, you can remain in User mode and use 4th Dimension
commands to work with the database, or you can select Design from 4th
Dimension's Use menu to make changes to the database structure, layouts,
or procedures.
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Figure 6.31 Preview onscreen displays a miniature view of your report.

Customizing Project Expense Tracker
Within Project Expense Tracker, the o nly part of the template that can be
customized by the user is the contents of the lists fo r the pop-up fields. If
you want to change the list options for a pop-up menu, tab co the field
that contains the pop-up menu and click o n the Modify butto n. An Items in
List dialog box appears (see figure 6.32). Any changes you make in this dialog box are recorded permanently. The dia log box enables you to insert or
append new choices to the list, sort the list alphabetically, or delete unwanted items.
Any other changes you wane to make to Project Expense Tracker must be
made from within the 4th Dimension program. Project Expense Tracker
executes in 4th Dimension's runtime mode. Until you quit from Project Expense Tracker, you do not have access to 40 commands or menus.
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When you do select Quit from Project Expense Tracker's File me nu , you will
be in 4th Dimension in User mode.
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Figure 6.32 Modifying the items in a pop-up menu.
Working within 4th Dimension or the 4th Dimension demo, you can improve
or expand the database in many ways. Without doing any programming at
all, you can make basic changes to field lengths, fonts, and so on. You also
can use the reporting capabilities of 4th Dimension to create your own special reports and to print mailing labels.
Layouts (for the data-entry and report screens) are composed offields and
other objects and are used to set the order in which the fields will be
accessed. The fo nts used in the various layouts are Helvetica, Helvetica
Bold, and Geneva. If any of these fonts or the appropriate sizes are not
installed in your System, you will find out quickly. Some layouts and reports may contain lines that partially overlap each other, for example. To
correct this, just enter 4th Dimension's Design mode and change the
fonts and/or sizes. To edit the fonts, styles, and/or sizes for fields in
Project Expense Tracker, follow these steps:
1. Select Design from the Use menu. You are now in Design mode.

2. Select Layout ... from the Design menu . The Layou t... d ialog box
appears. This is where you select the layout you want to modify.
3. In the Layout... dialog box, the layout list displays only the names o f
the two databases: Projects and Compan ies. Double-click o n both
names to show the names of the layouts-four layouts per database.

4. When you click o n a layout name, a miniature version of the layout
appears in the window to the right of the layouts list (see figu re 6.33).
When you find the layout you want to change, click o n the Open
button. The Layout: Layout name window appears, enabling you to
edit the layout.
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Figure 6.33 To edit a layout, select it from the Layout .. . dialog box.

5. Use the pointer tool to select the field you want to change. You also
can Shift-click to select multiple fields.
6. Use the Foot and Style menus to assign new fo nts, styles, and/or sizes
to the chosen fields. (Note: Regardless of the fo nts in your System, the
field alignments sho uld still be correct.)
7. Click on the layout's close box. Any changes you have made to the
layout are saved automaticall y.
To see your changes in action, select Runtime fro m the Use menu. You are
returned to the splash screen of Project Expense Tracker.
Project Expense Tracker has o nly limited printing capabilities. To create
ad dress labels, the fastes t way is to do so in 4th Dimensio n by following
these steps:
l. Quit from Project Expense Tracker. You will be in 4th Dimension 's

User mode and the Projects window will appear.
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2. Use the size box in the lower right corner of the Projects wi ndow
to shrin k it so that you can also see the List of files window (see
figure 6.34).
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Figure 6.34 The Projects and List of files windows.
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3. Your selection in the List of files windows determines whether you are
working with the Projects o r the Companies database. For label
printing, you need to display the Compa nies records. Click on the
Companies line in the List of files window to display the list of
companies in the database. To ensure that all companies are listed,
select Show All from the Select menu .
If you want to deal with only a subset of the records rather than the
entire Companies database, select Search Editor from the Select
menu. The search ediror enables you to specify record selection
criteria.
4. Select Labels ... from the Reports menu and design your label layout.
Within the dialog box, specify the label d imensions and select the
fields to be included in the labels. A sample layout appears in figu re
6.35. (4th Dimension includes layouts fo r several standard label
sizes. To use any of the existing layouts, click o n the Load button in the
label layout d ialog box.)
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Figure 6.35 Designing a label layout.

Form letter and envelope merges are best handled using 4th Dimension's
Export Data ... command. To create a standard tab-delimited text file in
4th Dimension and use your word-processing program to print the envelopes or mail merge, follow these steps:
1. Quit from Project Expense Tracker. You will be in 4th Dimension's

User mode and the Projects window will appear.
2. Use the size box in the lower right corner of the Projects window to
shrink it so that you can also see the List of files window.
3. Your selection in the List of files windows determines whether you are
working with the Projects or the Companies database. For label
printing, you need to display the Companies records. Click on the
Companies line in the List of files window to display the list of
companies in the database. To e nsure that all companies are listed,
select Show All from the Select me nu.
If you want to deal with only a subset of the records rather than the
entire Companies database, select Search Editor from the Select
menu . The search editor enables you to specify record selection
criteria. If you o nly want to use a subset of the records, select them
using the Search Editor.
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4. Select Export Data ... from the File menu. In the Export Data ... dialog
box that appears, double-click on each field you want to include as part
of the merge (figure 6.36).

EHport doto .••
el Project Trockerf

I

~

I

~

IAddress fil~
~

1::11.,
:::11.
!.:.

L!m:iJ;

soue

)

l(

Concel

l

Q DIF

End of record:

D Use output

(Append

»>)

( Insert

»> )

(

)(

Driu e

End of fie ld:

I
g

Comp•ny
Addrtss t
Addrtss 2
City
St.It
Zjp_Codt

9-to- 5 Moc

Eject

@TeH t

Soue os

Remot•e

)

Q SYLK

EJ

@]
loyout

IQ

Cont.ct 1
Company
Addr..s 1
Addru s 2
City
Sl•tt
Zip Code

___ __________ ______ _______ __IQ

Cont.c t 1
_,.

(

~ (

D Flnol!!!
D Project Tm< l<t.>r
D Project Tra<l<er.tJoto

=

..

D Stuff with

to

,

compression:

..

IFos t

.. ..

....,_....

,

I

Figure 6.36 The Expon Data ... dialog box.
The current settings for file type (Text) and end-of-field/end-of-record
delimiters are correct for creating a normal tab-delimited text file that
can be read by most Mac programs.
5. Name the file in the Save As window. Expon the data by clicking the
Save button.
6. Open the new file in your word processing program, edit it as necessary, and perform the merge.
You can create additional reports from any combination of fields from the
Projects and Companies data files using 4th Dimension's Quick Report
Editor. As an example, figure 6.37 shows a simple report d1at lists d1e total
cost for each project in the database.
To create a basic Quick Report, just drag fields into the report layout.
Reports can be enhanced with manually entered text, sorting, special fonts,
and statistical summaries. You can specify headers and footers in the Page

Setup ... option of the File menu. A sample layout is included on the enclosed disk as Sample Report. To build a report, follow these steps:
1. Select Quick ... from the Report menu.
2. Drag appropriate fields into the layout window o n the right.
Clicking o n the left and right arrows at the top of the Fields window
(top left corner) alternates between showing the Projects and
Companies fields .
3. Click on the Print butcon.
4. When the Print dialog box appears, click on OK to print or click o n the
Preview on screen check box to display a representation of the report
onscreen.
5. When you are satisfied with the report, you can save it for future use
by selecting Save ... or Save As . . . from the File menu .
To reuse a saved report format, select Quick ... from the Report menu, and
then select Open ... from the File menu to load the report.
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Figure 6.37 A 4th Dimension Quick Report.
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Pro ject Expense Tracker's custom menu options are each associated with a
procedure-a small program written in 4th Dimension's programming language. Procedures are the heartofany custom 4D application. Selecting a
menu item o r activating a menu item by pressi ng a Command-key executes a
procedure automatically.
Two menu bars were designed for the program. Menu Bar # 1 is the stand ard menu and contains active menu options . Menu Bar #2 is identical to
Menu Bar #1, but all menu options are disabled. When you select a menu
item from the splash screen, Menu Bar #2 is substituted for Menu Bar #1.
This prevents the user from initiating a second procedure before the cu rrently selected procedure is completed. At the conclusio n of the procedure,
Menu Bar #1 and all menu options are made active again.
The following table displays the eight global procedures linked to the
me nu items. (You can display the links in 4 th Dimensio n by changing to
Design mo de and selecting Menu ... from the Design menu.)

IJ

Menu

Item

Procedure

Description

File

Quit

Built-in procedure

Closes the databases and exits to
4th Dimension.

Projects

New
(Command-N)

NewProject

Opens a new
project record
and creates new
company records,
as needed;
continues to
create new
project records
until instructed to
stop.

Edit
(Command-E)

EditProject

Presents an
alphabetical list
of all projecrs
and enables you
to select projects
to edit.

Menu

Companies

Reports

Item

Procedure

Description

Duplicate
(Command-D)

DupProject

Creates a copy of
the selected
project record.

New

NewCompany

Creates new
company records
until instructed
to stop.

Edit

EditCompany

Presents an
alphabetical list
of all companies
and enables you
to select records
to edit.

Duplicate

DupCompany

Makes a copy of
the selected
company record.

Print Projects
(Command-1)

PrintProj

Generates
onscreen or
printed project
expense reports.

Print Companies PrintCo
(Command-2)

Generates onscreen or printed
company
information
reports.

Ifyou are interested in learning how each procedure actually works, you can
examine che procedures within 4ch Dimension.Justfollowchesesteps:

1. Switch to Design mode by selecting Designfrom the Use menu.
2. Select Procedure .. . from the Design menu. The Procedure .. . dialo~
box appears.
3. Expand the list of global procedures by double-clicking on Global
Procedures or by clicking on the Expand button.
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4. Open a global procedure by double-clicking o n it or by highlighting it
and clicking the Open butto n. The Procedure: procedure name
window appears (see figure 6.38) and shows the text fo r the selected
procedure.
Procedure: NewProject

Ke words
If
Else

End if
Case of

Figure 6.38 The NewProjecc procedure.
Words thac appear boldfaced are 4th Dimension keywords or routines.
Comments are preceded bya' (single prime) symbol. You can write
procedures by typing directly into the scrolling text box in the upper
portion ofthe Procedure window, or you can select keywords, field
names, and routines from the three scrolling lists at the botto m of the
window.
Scripts are mini-procedures associated with particular fields or objects
on the various database layouts, such as buttons and pop-up menus.
"Projects", for example, is the default layout used for creating and editing
project records. Within the Projects layout, every Date field and the Total
Cost field (expense rotal) has a script linked to it. To examine a script in a
particular layout, follow these steps:

1. Enter Design mode by selecting Design from the Use menu .

2. Select Layout ... from the Design menu . The Layout ... dialog box
appears.

3. The layout list displays only the names of the two databases: Projects
and Companies. Double-click on each name to show the names of the
layouts-four Iayou ts per database.
4. Open a layout by double-clicking on it, or by highlighting it and
clicking on the Open button. The selected layout appears (see
figure6.39).

Figure 6.39 This is the "Projects" layout-used for data entry and editing.
;. The presence of an attached script is indicated by a small triangle in
the upper left corner of the field or object. To view a script, doubleclick on the field you want, and then click on the Script button. Figure
6.40 shows the script used to calculate the expense total (Total Cost).
You also can govern when, or if, a script is executed. The Date scripts, for
example, are only activated when the field is modified-and then only if
an illegal date (such as a space or a letter) is entered. If activated, the
scr ipt checks the field for an illegal date and, if one is found, replaces the
contents of the field with the current date.
As you can see, among relational databases, 4th Dimension is a powerhouse. It takes little effort to create attractive layouts and simple reports.
If you are willing to devote the time needed to understand its scripting

Getting Organized

language, you can create custom databases with similar functionality to that
of commercial programs.
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Script: Totol Cost

,.L

Total Cost :=Cost 1+Cost2+Cosl3+Cost4+CostS.Cost6+Cost7+Cost8+Cost'3+Cost 10

...

K!Y_"'ords

IO Projoot ID
If

Else
End if
Cue of
:

M

Projeot Descrfp

m1 Compafl\I
ij'il!1 Date

I
~ Date 2
~ Oat• 3

-+

Routints

(;;: Arrays
F Bool u n

l;;j;r,, Commun;c<>tions
~
ll1'i Compil~r Dfr~ctins iii!\i
~Data Entry
~

I

W Displ ay fog

~

Figure 6 .40. This script calculates the to tal of the ten Cost fields.

Database Desk Accessories
Ithough most database programs are full stand-alone packages, some
database programs function as desk accessori es. HyperDA 11 is a DA
that enables you to browse and enter informatio n into HyperCard stacks.
Retriever ll is a database program that you can run as a desk accessory- for
quick and convenient record-keeping.

A
fl

HyperDA II
HyperCard is the first database to wh ich many users are exposed. HyperCard
clone programs and enhancements are plentiful. Unfortunately, in o rder to
maintain compatibility with new versions ofHyperCard and the HyperTalk
commands that are introduced (HyperTalk is the scripting language for
HyperCard), HyperCard utilities must be updated constantly to maintain
their usefulness. One that is currently up-to-date-supporting HyperCard
2.1- is Hyper DA 11 from Symmetry Software.
HyperDA II is a DA you can use to open, view, and edit or enter text in most
stacks- without running HyperCard. Figure 6.41 shows a stack opened with
Hyper DA. Afull copy ofHyperCard is necessary to create d atabases, but you
can use HyperDA to perform most required casks after the stack (HyperCard
database) is created.

11'1
Bu si ness Cnrtoons Stack
Monsters 2

i------- -- - ---------- ---------------- --------------,
''
'''
''
''
''
'
''
''
'''
'''
''
'
''
''
'
''
''
''
'''
''
''
''
'''
''
''
I_ ____ - - -- - - - - - - - - - - - --- - - - - - - - - - - - - - - - - - - - - - - -- - - - _,

Figure 6.41 A HyperCarcl graphic stack in HyperDA.
HyperDA ll can open stacks in standard size or place them in a resizable
window so that they take up less room on-screen. Although you do not have
access to the higher-level HyperCard functions, such as writing or editing
HyperTalk scripts, you can perform the fo llowing tasks:
• View cards and enter text.
•

Copy selected text and graphics from cards and paste them into
documents of other applications.

• Issue Find commands to search for text strings in a stack.
•

Reveal all hidden buttons on a card.

•

Issue supported HyperTalk commands using the Message Box.

•

Open multiple stacks- each in its own window- up
available memory.

•

Dial the telephone.

•

Print the current card.

to

the limit of

If you already have HyperCard, the advantages ofHyperDA II may not be
immediately apparent. In a nutshell, the advantages are speed and easeof-access. First, HyperCard is slow, even on a souped-up machine-
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particularly when loading. Hyper DA II, on the other hand, is very fast. Second, many programs now offer tutorials written as HyperCard stacks. You
can keep the tutorial o nscreen at the same time as you are learning to use the
product, even when running under the Finder. Third , you don't always need
to use the advanced features ofHyperCard . In fact, unless you are a programmer, the most commo n uses of HyperCard are for browsing informatio nal
stacks and entering data-which Hyper DAII supports nicely.
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Altho ugh HyperDA II can interpret o nly a subset ofHyperTalk commands (in
o rder to keep the utility small), the subset appears to be well-chosen.
HyperDA II includes sample stacks fo r phone dialing and record ing addresses. Another stack presents a version of the program manual. Symmetry
also produces a program called StackRunner! that enables you to make
"double-clickable" applications from HyperCard stacks.

Retriever II
Retriever was the first flat file database written as a desk accessory. Retriever
II by Exodus Sofrware expands the original program and offers two identical
forms : a desk accessory and a standard program. (Because DAs no rmally are
restricted to a single addition in the menu bar, the men us in the two versions
are organized differently.)

fl

If you know how to use a spreadsheet, you will feel right at ho me with
Retriever II. The data area is a grid of rows and columns. Each row represents a record; each column is a field .
You can perform many functions by clicking on icons or special spots in
the database window. The icons in the upper right corner enable you to
jump to a specific record, mark the current record, sort a column, issue a
Find command, dial the phone, print, add a new record , and view the help
screen (see figure 6.42).
Retriever ll supports three types offields: text, numeric, and calculated. Each
database is limited to a single fo nt and po int size, but you can use any font
installed in your System. You can perform the following functions with Retriever ll :
•

Dial phone numbers.

•

Switch among three different sets of marked records.

•

Hide columns.

• Create calculated fields consisting oflists offield names, operators, and
functions.
• Select a default folder and a default start-up file.
• Enter up to 32,000 characters in text fields.
ii

file

Edit rormnt

Goto M ark

Sort

Find

Dini

Re trteuer II

10

Figure 6.42 Retriever's screen uses icons for many commands.

Retriever II has a fine set of import options that enable you to easily receive
data files created in other programs. In addition to creating a new file with
the lmpon command, you also can append data to the current file. A "joined
field" can be created from any pair of imported fields. This is useful for combining multiple address lines into one address, or a first and last name into a
single name. Both importing and exporting functions require a special delimiter to separate the fields and another delimiter to mark the end of each
record. Although most programs support tab-delimited files with records that
end with a Return character, Retriever II enables you to specify any characters
as delimiters.
The capability to combine columns on impon and to reorder current
columns by simply dragging them to new positions makes the program
useful for manipulati ng any data file you need to move between two
programs.
To get you started, Retriever ll includes two dozen sample databases with
useful and interesting information, such as interest, mortgage, and mileage calculators; three unit-conversion databases; an expense report; and
the Macintosh character set.
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Summary
In this chapter, you learned how to get orga nized using da tabases, perform
Schedule C bookkeeping, track medical expenses, use a phone message
system, and use database desk accessories. Specifically, you learned how to
perform the following tasks:
•

Organize information in a database using nuBASE for the Mac,
FoxBASE+/Mac, Double Helix, and HyperCard.

•

Do bookkeeping with Books, a FileMaker Pro database.

•

Track medical expenses using RecordHolderPlus and the Medical
Expenses template.

•

Maintain a phone message system using Panorama II.

•

Track project expenses using 4th Dimension.

•

Open HyperCard stacks using HyperDA II and orga nize information
using Retriever IL

In Chapter 7, "Number Crunching," you will learn how to use spread·
sheets to keep track of b usiness expenses and to create invoices.

Number
Crunching
Spreadsheets were developed as computerized versions ofa bookkeeper's
ledger page. Spreadsheets were actually the first computer program to capture the public's interest and provide a solid business reason for investing in
the new technology. In many ways, VisiCalc, the first spreadsheet program
for personal computers, was responsible for the birth of the micro computer
industry.
Spreadsheet programs have long been considered essential software for
accountants, bookkeepers, and financial personnel. As their popularity grew,
spreadsheets made similar inroads into virtually every job category. When it
comes to handling numbers and making data lists-whether you are doing
the quarterly budget, calculating author royalties, analyzing market research
data, or balancing your personal checkbook-spreadsheets are invaluable.
Some of the reasons for this popularity are discussed in this chapter
and include:
• Capabilities that enable you to perform a wide variety
ofcalculations without mathematical error.
• Tools that enable you to produce attractive and
readable printed reports.
• Macro capabilities for automating routine
tasks.

T
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•

Charting features for presenting numbers in a visual format.

•

Database commands for organizing information.

In the last several years, spreadsheet programs have been infused with
new power in the form of more charting options and spreadsheet publishing features. These features provide even more ways to use spreadsheets
to present information. FoUowing closely on the heels of the word processing program, the spreadsheet is one of the most useful and powerful
applications for any business.

An Introduction
to Spreadsheets
ike ledger paper, an electronic spreadsheet consists of a rectangular
grid of rows and columns used to hold numbers and perform calculations. But that's where the similarity ends. From the very beginning,
spreadsheets offered the capability to perform calculations on long columns and rows of numbers, and to recalculate the formulas automatically
when one or more numbers changed. An error in entering numbers no
longer means that you need to redo the entire page. Instead, you correct the
entry and the computer makes the necessary changes for you.

L

In addition, spreadsheets are more readable than the typical ledger page.
You can format numbers and text to ensure a consistent appearance.
Numbers are entered without any special symbols other than the decimal
point, and a command is used to obtain the desired format. Acurrency format, for example, adds a doUar sign, inserts appropriate commas, and forces
each number to display two decimal places. If you enter the numbers 1 and
1.125, they appear as $1.00 and $1.13. Notice that the computer takes care of
rounding the value for the display. Formats for the currency of other countries, such as £1.00 for the British pound and pence, also are available.
Originally, the term spreadsheet referred to the actual paper used by accountants. In modern times, the term means the program rather than the document. Most programs refer to the documents as worksheets. By tradition,

the rows on a worksheet are numbered and the columns identified by letters.
The 27th column following the one labeled Z is referred to as AA. It is followed by AB and so on. The small boxes where the rows and columns cross
are referred to as cells.
Each cell has a unique identifier composed of the letter that represents the
column followed by the number of the row in which it is located. This letter/
number combination is referred to as a cell's coordinates or the cell address.
In figure 7.1, for example, the highlighted cell C5 is in colum n C and row 5;
F237 would be at the intersection of column F and row 237. The address of
the currently selected cell is generally shown in the upper left corner of the
spreadsheet window.
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Figure 7.1 The arrows point to a cell (CS) and a data range (811:0 12) .
A 1·ange is a rectangular group of cells. In figure 7 .1, the shaded range in the
middle of the spreadsheet is identified as 811:012. When referring to a
range, the two coordinates listed are for the cells in the upper left corner and
the lower right corner of the range. Treating a group of cells as a range enables you to specify formatting commands for several cells simultaneously,
set multiple column widths or row heights, or copy large sections of the
worksheet with a single command rather than copying one cell at a time.
Some programs, such as Excel from Microsoft, enable you to select several
ranges at one time and format all of them with a single command.
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A single cell can hold a number, a word or group of words, or a fo rmula. The
numbers in a worksheet are referred to as data or values, and the words are
usually called text or labels.
The main selling point for spreadsheet programs is their capabiliry to manipulate numbers using/01-mulas. Fo rmulas are created by using cell
addresses and mathematical symbols. They can be as simple as adding the
contents of two cells together, such as Al + A2, or as complex as calculating the potential profit from a series of stock transactio ns.
Calculatio ns also can be performed using the/unclions within the spreadsheet. A function is a special rype of formula that works with a range or series
of numbers. Examples of functions include adding a column o r row of numbers (=SUM) and calculating the terms ofa loan (=PMT) . Functio ns are
generally grouped into categories, such as mathematical, statistical, trigonometric, financial, date/time, and logical. There are also special functio ns fo r
dealing with calculatio ns that involve the values in a database. You can use
functions to:
• Determine the number of days between two dates.
• Compute a linear regressio n.
•

Perform matrix mathematics.

• Test for certain values in cells.
• Concatenate text strings.
• Calculate several rypes ofdepreciatio n.
One of the most important aspects of th e way in which a spreadsheet
works is that formulas are based on re/alive addresses. The term refers to the
fact that fo rmulas and fu nctions are re lated to cells by location rather than
absolute positio n (cell address) . When you copy a fo rmula to a new locatio n,
the cell addresses change to refer to cells that have the same relatio nship to
the new formula. Figure 7.2 shows an example in which the formul a in cell
E3 was copied to E4, E5, E6, and E7. The SUM function in E3 adds th e co ntents ofB3, C3, and 0 3. When the formul a is copied to E4 (one cell lower on
the worksheet) , the new fo rmula references B4, C4, and D4 (each cell address is down o ne row).
If you want a cell add ress to remain the same when you copy a formula,
use an absolute address. An absolute address is indicated by dollar signs in
fro nt of the column and/or row reference. Suppose, for example, that you

have created a worksh eet in wh ich you want to d ivide each e ntry in Bl , B2,
and B3 by a number in cell Al , and place the results in Cl , C2, and C3. Normally, you would write the formula in C1 as = B1/Al a nd the n copy the
formula to cells C2 a nd C3. Because of re lative addressi ng, however, the
formulas in C2 and C3 wou ld be wrong. The d ivisors would be A2 and A3,
respectively, rather than Al .
w
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Figure 7 .2 Formulas are the heart of the worksheet.
The correct approach is to write the fo rmula in Cl as =81 / $A$ 1 and th en
copy th e formula to C2 and C3. This would have the intended result and
generate the new formulas =82 / $A$1 and =83 / $A$1 . When the form ula is
copied into C2 and C3, the relative address (Bl) changes, but the absolute address (SAS!) remains the same.
Because cell coordinates a nd ra nges are d ifficult to reme mber, most
spread sheet p rograms sup port a feature referred to as a range name. Range
na mes are used to ide ntify important cells or ra nges of cells. A range name
can be considered a stand-i n for a cell o r range. Like the cells the name represents, you can use a range name in formu las. Suppose, for example, you have
numbers in cells E9 and El Othat represent:
Total sales for one salesperson (E9)

A percentage on which the commissio n is based (ElO)
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You create a formula in cell Ell that calculates the total commission in dollars. To do this, simply multiply the other two values. Normally, the fo rmula
for calculating th e commission is written as =E9 * E10. However, by assigning range names to these two cells, you can create a fo rmula that is easier to
understand. Using the name Sales for cell E9 and Percent for cell EIO enables
you to write the formu la as =Sales * Percent .
Spreadsheets also excel at enabling you to perfo rm "what if?" analyses.
When creating a sales projection worksheet, you can find out how yo ur botto m line is affected if sales increase by 12 percent and office lease fees
decrease by 3 percent. Simply plug in the new numbers and watch your
totals and other form ulas recalculate instantly. And because you can tie
graphs to the data, o n-screen charts also are updated to reflect the new
figures.
Spreadsheet publishing features are the latest additio ns to the world of
spreadsheets. When examining the on-screen and printed appearance of
many modern spreadsheets, the ledger page analogy-with its hand written
numbers-no longer seems appropriate. With the addition of complex graphics, multiple fonts, and variable row heights and column widths, you now can
print a worksheet and its accompanying charts on a high-resolution printer
and incorporate it into your company's annual report ora brochure-witho ut ever dropping by the art department.
For routine tasks, most spreadsheet programs now contain a macro o r scripting language. You can create macros and scripts two ways. First, many
spreadsheet programs contains a macro recorder that records what you do
and enables you to save it as a macro. Second, you can edit macros you create in the recorder or create them from scratch.
As an example, you can create a simple macro that assigns a specific fo nt,
size, style, and alignment to the contents of a cell. When you want to
reuse that formatting combinatio n, just select the cell or range, and then
execute the macro. Depending on the program, to replay a macro, you press
a Command-key combination, select the macro fro m a menu, o r click on a
butto n to which the macro is attached.
You also can use macros to automate entire procedures, such as sorting
info rmation, selecting a range based on criteria you establish, or generating
and printing a complex report. Some spreadsheet programs even enable you
to create au tomatic macros that execute when you open a particular
worksheet.

Understanding Charts

0

ne of the most striking differences between the original paper-andpencil ledger sheets and the mo dern electronic spreadsheet is the
capability to produce graphs and charts. As spreadsheet programs evolve,
the graphics features are easier to use and provide greater flexibility in the
types of graphs you produce.
Almost from the beginning, spreadsheet programs offered three basic
types of charts- pie charts, line charts, and bar charts. You use a pie chart to
compare parts or percentages ofa whole (see figure 7.3). You also use pie
charts to illustrate how expenses are broken down among categories. To
make a particular slice of a pie chart stand out, it can "explod e" (pull away
from the centerofthe pie) .
•
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Figure 7 .3 You can explode a slice of the pie for emphasis.
More and more spreadsheet programs offer special effects for their charts.
Figure 7.4 shows a three-dimensional column chart from Excel. Although the
information is identical to that ofa normal, two-dimensional column chart,
the impact is much more dramatic.
Afourth type of chart, the stacked bar, is almost as common as the pie, line,
and bar charts. You use a stacked bar charr to compare totals and, within
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each total, show the contribution of each item. You can easily produce other
types ofcharcs, such as area charts, combinatio n charts, high-low c harts, and
scatter plots. Within each chart type, the re is a wide variety of options. Some
of the choices are simply cosme tic. For example, o n a pie chart you can label
slices with names or percentages.
it file Cdlt Gallery Chart rormat M acro Window
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Figure 7 .4 The look of a chart can be as important as the numbers it
represents.
However, othe r options actually change the way the information is presented. Figure 7.5 shows the options fo r line charts in Excel. Options 1
through 5 simply change the design of the chart. However, option 6 performs
a logarithmic transformation ofthe data.
Most spreadsheet programs provide commands for adding tides and descrip·
tions to the chart, formatting the text, and changing colors and patterns used
to display chart components. The current generation of programs also enables you to insert charts within the actual worksheet, add other graphics to
the chart (such as arrows, arcs, and ovals), and create combination graphs in
which one chart type overlays another chart. Combined with desktop publishing techno logy, spreadsheets e nable you to present numerical
information in a way that is far from d1e boring days of paper-and-pencil
accounting.
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Figure 7 .5 The optio.ns for line charts in Excel.

Spreadsheets as Databases
fyou have been to a local computer store lately or picked up a
Macintosh magazine, you know that business programs-particularly major applicatio ns, such as spreadsheets and databases-are expensive. If you
are on a tight budget, you may not be able to afford a high-e nd spreadsheet
and a database. Which should you choose? Which purchase can be .d eferred
until later?

I

If you need number-crunching capability that goes beyond simple totals
and averages, buy the spreadsheet program first. Mose spreadsheets already contain database features, such as the capability co extract records
based o n a criterion, sorting, and database math functions. Bear in mind,
however, that although most leading spreadsheet programs contain d atabase
functions, their ease of use is a far cry from what you will find in most dedicated database programs. Instead, we'll look at how you can create a
quick-and-dirty database in any spreadsheet-whether the spreadsheet program has database features or not.
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All worksheets are composed of rows and columns. All databases are composed offields (a category of information) and records (the information
about a particular person or item in the database). To create a simple database, just treat each row of the worksheet as a record and every column as a
field. Each cell then contains the entry for a field (column) in a particular
record (row).
Worksheets contain many features that make them well-suited to manipulating a simple d atabase. These features include the following:
• A Find command that locates particular records.
•

Built-in mathematical and business functio ns that compute totals,
subtotals, averages, and virtually any other type of calculation you
may need.

•

Text in fields can be concatenated. You can use this feature to join
the data in a First Name and a Last Name field into a single Name
field, for example .

•

Data can be saved as Tab-delimited text files you can use with most
word-processing program merge features to create form letters and
address labels.

Figure 7.6 illustratt:s a simple address database in Excel.
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Figure 7 .6 An address database created in Excel.
As you can see in figure 7.6, the first row of the database consists offield
names that describe the contents of that field . Each of the rows beneath the
field names holds a single complete record. The time required to design such
a database typically is only a few minutes.

If you take the time to learn about your spreadsheet's built-in database commands, you can transform your makeshift database into one that uses the
program's powerful database capabilities. Most major spreadsheet programs
have a database component. As an example , we will look at Microsoft Excel.
The commands in Excel's Data menu enable you to manage database
informatio n.
As in the simple database, the first row of any database contains field names.
After typing the field names, you officially create the database by highlighting
a range for it (including the field names) and selecting the Set Database
command . New records can be added to a database by simply entering them
in the next empty row beneath the field names. As an alternative, you can use
the Form command from the Data menu (see figure 7. 7).
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Figure 7 .7 This Form dialog box enables you to examine and modify
individual database records.
Most of the power of the Data commands lies in its capability to extract subsets of data and to find particular records. To extract a grou p of records
(copying those that meet your criteria to a new spot on the worksheet), follow these steps:
1. After you define the database range using the Set Database command,
copy the field names to a new row o n the worksheet. The new row will
be the start of the criteria range.
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2. Enter one or more selection criteria directly beneath the copied field
names from step 1.
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3. Highlight the field names and criteria row, and select the Set Criteria
y
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command from the Data menu. Together, these two rows make up the
criteria range.
4. Copy the field names to another new row (row 12 in this example).
This row will be the beginning of the extract range.
5. Highlight the field names and several rows beneath them , and then
select the Set Extract command from the Data menu. This is the
extract range.

6. Select Extract.. . from the Data menu or press Command-£. Data that
matches the criteria is copied into the extract range.
Criteria range (A8:K9)
Database range (A 1:K6)

Extract range (A 12:K15)

Figure 7 .8 A worksheet that contains extracted data (sales reps with 1991
sales greater than Sl00,000) .
After you define the database and criteria ranges, you use the Find command
to locate individual records that match the criteria. Rather than copying the

records into an extract range, Excel highlights each record that matches the
criteria. Repeatedly selecting Find fro m the Data me nu will move you fro m
one matching record to the next. You also can use the Form command to
execute simple searches.
You can use the Sort command with any data in the worksheet. Simply highlight the information you want to sort, and then select the command. The
Sort dialog box appears and enables you to specify a o ne-, two-, o r threelevel sort.
These commands provide the basic tools necessary to work with information in a worksheet database. You can sort, search, and extract information
within your worksheet without purchasing an additional program .
If yo u decide to purchase a database program, the work you have completed
in your spreadsheet is no t wasted. Most database programs have strong import o ptio ns for gathering records fro m external files. Using these options,
you can create fields in the database program that are similar to the ones you
have set up in the spreadsheet and import the worksheet data.

Introducing the Excel 3.0:
P/L Template
mong Macintosh spreadsheets, Excel is the front runner. Apple released
a word processing program (MacWrite) and a graphics program
(MacPaint) , but did not release a spreadsheet program . Microsoft moved in
quickly with Excel and captured the majority of the market.

A

Since that time, many pretenders to the spreadsheet th rone have appeared-and then disappeared (or at least faded substantially). At prese nt,
there ar e three major spreadsheets for the Macintosh: Excel, Claris Resolve, and 1-2-3 for the Macintosh. In the race for the ultimate Macintosh
spreadsheet, Excel has a great deal going fo r it. First, it is a mature product. Second, it is a cross-platformproduct-a companio n version runs under
Windows in the IBM environment. Finally, it is well supported by user
groups, the info rmatio n services, and after-market products, such as training
tapes and templates.
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Schedule C Bookkeeping began life as an Excel worksheet. The spreadsheet
version (P/L Template) does not record line item-level detail (you will need
to kee p a ledger fo r that) , but it does perfo rm the following functions:
• Displays mo nthly totals for income and every IRS Schedule C expense
category.
• Tracksdeprcciation.
• Calculates mileage expenses.
• Calculates allowable portions of home office expenses.
• Creates a graph that shows your year-to-date progress.
Excel templates serve the same function as System 7 statio nery
documents. An Excel template consists o f placeholders with formats and formulas. P/LTemplate is a simple worksheet for
recording monthly income and expenses (by Schedule C category). For small
businesses-particularly those o perated out of the home, the P/L Template
can form the basis of a record-keeping system. At t he start of each year, you
simply open the template and save it under a new name , such as P/L 92, P/L
93 , and so on, as a "Normal" Excel worksheet. Fo r the rest of the year, you
co ntinue to work with the new file, rather than the template.

NOTE: If you do not use Excel, the disk also contains a copy of
the template that has bee n saved as an SYLK format file
(P/L.SYLK). Many spreadsheet programs, such as Claris Reso lve,
are capable of reading this version of the template.

Using the P/L Template
The first time you load the P/L Template, you should personalize it. First, if
the spreadsheet does not fill the screen, click on the zoom box. If you cannot
see the zoom box, select Arrange Allfrom the Windowmenu to achieve the
same effect. Next, change the contents o f cell Al and A2 so that they contain
the current year and your name. You can use your Social Security number or
Employer Identifica tio n number, ifyou prefer. Finally, save the worksheet
under a new name as a Normal file rather than a template.

Now you can begin entering data. To make it easier to move around, the
worksheet contains several named ranges that correspond to key areas. To
move to any of them, press Command-G (the Goto ... command) and select
the area to which you want to move from the Goto dialog box. Some named
ranges are single cells; others are ranges. To examine any of the named
ranges, select Define Name ... from the Formula me nu, select a range name
in the Define Name dialog box, and the worksheet range appears.
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Figure 7 .9 Double-click on any named range in the Goto dialog box to move
to chat particular range.
An embedded chart is added at the bottom of the worksheet that begins at
about cell B60. As you e nter figures into the worksheet, the chart changes to

reflect the new monthly income and expense totals automatically. You can
e nter notes in a small section of the worksheet that has been set aside for this
purpose (B50:F58).
Column Acontains Schedule Cexpense categories. The months are arranged
across row 3. Both of these label areas are "frozen" so that you can always tell
what you are entering no matter how you have scrolled the worksheet. Be
sure to change the date in cell A3-Last Update-when you enter new data in
the worksheet.
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You can divide the worksheet into the following key data entry areas:
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Category

Range

Expense items

B4:M27

Income items

B29:M29

Depreciation

A40: H45

Notes

B50:F58

Calculators

Q5:T16

Totals and other summary statistics also are calculated. Rows 29 through
31 display the total income for each month (receipts), total expenses, and
net income, respectively. Rows 33 through 35 show running totals for
income, expenses, and net income. Columns N and 0 show annual expense totals and averages.
Each cell in the Expense Item area (B4:M27) represents the total expenditures fo r one month for that particular expense category. Cell 821, for
example, is the to tal for January repair bills. Each cell in the Expense Item
area is written as a fo rmula and includes all the individual expenditures
for the month. Jf you had three repair bills in the month for S12, S23.75,
and $42.50, the fommla would read: =12+23. 75+42. 5. (Every Excel formula
must begin with an= sign.) As you pay additional expenses d uring the
month, you tack the expenses onto the end of the formula. That way, when
you click on a cell, you can check the formula bar at the top of the screen to
see if you record ed every item for the month.
Row 29 of the worksheet is dedicated to income. Record your mo nthly income in the appropriate cell, following the same fo rmat and procedure that
is used for expense items.
Rather than enter depreciation directly into the expense area, a separate
area is provided for it at the bottom of the sheet (cells A40:H45 as shown
in figure 7.10). The only formulas in the depreciation section of the
worksheet are in column F (Depreciation Remaining). Each cell in F subtracts the 1992 Depreciation and the 1992 Section 179 amounts fro m the
total cost of the item. lf your entries in column D (1992 Depreciation)
require formulas, you must create them.
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Figure 7 .10 The Depreciation area of the P/L Template.

CAUTION: Do not make entries in the depreciation expense
cells of row 9. The Total Depreciation formula in N9 does not
reflect them.
For each depreciable item, you must e nter the following:
Col. A-Item Name or Identification
Col. B-Purchase Date
Col. C-Total Cost
Col. D-Amount to be allocated to depreciation this year
Col. E-Amount to be allocated to Section 179 this year
Col. F-Automatically calculates depreciation remaining after this
year (no entry)
Col. G-Depreciation method used for the item
Col. H-Useful "life" of the item (based on lRS depreciation tables)
The depreciation total (N9) is the sum of this year's depreciation (D46)
and Section 179 expensed tangible property (E46). N9 is divided evenly
among the months in row 9. Because most of us cannot be sure what
depreciation method the IRS will require from one year to the next, you
have several options available to you for handling depreciation during the
year:
• As long as the total is under S10,000, allocate it all to Section 179.
• Make a "best guess" as to the allowable depreciation for the year.
• Assume last year's depreciation methods are still in effect and apply
them to current purchases.
• Leave columns D and E blank until year end (when you have the IRS
instructions in hand).
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The point of making any entries at all in columns D and Eis that without
them, your monthly expense figures will be off-as wi ll total depreciation.
To make it easier to e nter some expense figures, two calculators were
created at Q5 (see figure 7. 11). In the Goto dialog box, they are named Mileage and Expe nseCak. To use either calculator, just enter a number into the
shaded area (blue on color monitors) and transfer the result to the appropri·
ate monthly expense formu la.
/"h'/e~

C8lcul8lor

• •o.0 275
I!!!

Rate per mile

1111Business miles
$12.46 Total amount

b :pense
AllOC8tion
0.142857 Home office ig
Total expense
$30.39 Allo'w'e ble amount

Figure 7 .11 The P/L calculators.
lfyou are tracking the business use ofone or more vehicles, the mileage
calculato r will compute the allowable amount. It multiplies the mileage
rate (27.5 cents) times the mileage figure you enter in cell R8. The Expense
Allocatio n calculator is for those ofyou who maintain a business in the home.
In cell R13, enter the portion ofyour home that is set aside strictly for business. You can base the percentage on the number of rooms used for business
divided by the total rooms in the house (in the template, that is 1/7
or.142857). As an alternative, you can base the figure on the square feet of
the business area divided by the square footage of the entire house. For each
allowable monthly expense, e nte r the total bill in cell Rl 4. The allowable
amount appears in Rl 5.

NOTE: For the current mileage amount you can deduct, see the
IRS 1040 tax booklet.
Neither calculator does anything more than display the results. After you
perform a calculatio n, simply edit the appropriate expense cell and add
the allowable amount to the e nd of the formula. Su ppose, for example,
that the current formu la for June Utilities is =27.5+ 12.97.

If the calculator tells you that $30.39 of your electric bill is allowable, you
then would edit the June Utilities cell so that it reads =27.5 + 12.97 + 30.39.
You can move many of the expense totals in column N directly to Schedule
C. Some totals, however, will require adjustment, such as insurance, interest
payments, rented vehicles and equipment, and travel and entertainment
expenses. Making these adjustments at year end often is more work than
enteri ng the correct figures initially. To determine allowable amo unts, read
the current year's IRS booklets and make the appropriate notations in your
ledger before carrying the allowable portions into the worksheet.
Although P/L Template shows you how your business is doing and produces
the figures needed to complete your an nual Sched ule C, it is no t sufficient to
meet IRS or general business record-keeping requ irements. You must keep a
paper o r electronic ledger that reflects the following:
• The date of each purchase, expense, or income item.
• To who m the amount was paid or from whom it was received.
•

An item descriptio n.

• The dollar amou nt invo lved.
Consider the P/L Template to be an enormous calculator rather than an
excuse for no t keeping adequate records.

Customizing the P/L Template
When adding or changing basic features (new formulas, differe nt headings,
and so o n), it is best to work with the template instead of your current
worksheet.
If you are up to the task, the most obvious improvement you can make to
the template is to link the spreadsheet section to an Excel database. Every
line item and its detail (elate of transaction, tax category, description, and
amount) can be entered in the database as a record and the do llar
amo unt added automatically or by macro to the proper cell in the spreadsheet. For a small business, this approach may even relieve you of the
chore of keeping a paper ledger.
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The template does not use the exact expense categories that Schedule C now
lists. In the last few years, many of the categories have been collapsed into
broaderon es. Rather than lump them into the appropriate categories, P/L
Template lists dues and publications and freight/shipping separately. Ifyo u
want to match che IRS categories exactly, check a currenc Schedule C and
make the necessary changes to the template.

Introducing the Resolve
Invoice Template
!most every business uses invoices. Writing them by hand or using a
typewricer gees the job done, but ic makes record keeping a chore. All
the data entered o n che form also must be recorded in a ledger. The Invoice
cemplace demonstrates that-thanks co che additio n of spreadsheet publishing feacures-current spreadsheet programs are easily up to the task of
ge neracing impressive forms. And by using a spreadsheet's scripcing or macro
language, the information entered into each form can be made available for
further analysis- something chat would be impossible in most forms pro·
grams.

A

Cla ris Resolve is one of che mosc recent Macincosh spreadsheecs to hie the
marker. Based on the cechnology in Informix Software 's Wingz, ic includes a
versatile scripting language, user-programmable buttons and dialog boxes,
shape-drawing tools, variable row heights and column widths, manycharc
types, and full-color suppore. Graphic objeccs, charts, and text boxes can be
placed o n top of che spreadsheet and dragged anywhere you like.
Integrating traditional spreadsheet features with the new draggable, resizable
graphic a nd text objeccs makes Resolve ideal for spreadsheet publishingproducing attractive, high-quality reports char have very little in common with
che single font dot-macrix printouts you may be used co seeing.

Using the Invoice Template
The Invoice templace demonstrates how spreadsheet programs can
perform double duty-printing auractive forms and saving the data
for further analysis. The left side of the worksh eet is a fill-in-the-

blank form for generating invoices. After a new invoice is entered, a simple
click on a button copies the important data to a Resolve d atabase in the same
worksheet. The database can be used to record payments and shows the
remaining balance on each invoice. If you have Resolve, you can open the
Invoice worksheet by double-clicking on it.

NOTE: Seven button scripts have been created for the Invoice
worksheet: Acid_ to_ DB, AddScri pt, Clear_ DB, Go to Database, Go
to Invoice, New_ Invoice, and Print Invoice. These script files
must be kept in the same folder as the Invoice worksheet. Do no t
change any of the file names or portions o f the template may no
lo nger work.
The Invoice worksheet contains two main sections: the invoiceform (cells
B2:G46) shown in figure 7. 12 and the invoice database (cells L4:V505) . Jn
the invoice form area, you enter the data for and print each invoice. Basic
information is copied from each invoice into the database portion of the
spreadsheet using a macro.
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Figure 7 .12 A sample invoice.
The invoice database stores an abbreviated record o feach invoice (see figure
7. 13). As customers make payments, you switch co the database, locate the
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appropriate invoice (they are stored in order of invoice number), a nd e nter
the payment. As each payment is recorded-the database can handle up to
five payme nts per invoice-the balance due is recalculated automatically.
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Figure 7 .13 The database also is where you record payme nts made on the
invoices.
After entering the data in the invoice form, most work will be handled by the
buttons and the scripts attached to them. At the top of the form, you see the
buttons that appear in figure 7. 14. These butto ns above the invoice are responsible for clearing the invoice ofold data, printing, copying data to the
database, and switching to the database screen .
011tab11se •>

Figure 7.14 The Invoice control buttons.
The normal procedure for generating an invoice is as fo llows:
1. Ente r all data for the invoice in the invoice form.
2. Print the invoice.
3. Record the invoice information in the database.
4. Create a new blank invoice.
Clicking o n the Print Invoice button p rints a paper copy of the invoice. It
sets the print range to include o nly celJs 8 2 thro ug h G45, and then prese nts
the standard Printdialog box. If you need multiple copies of each invoice,
you can request them in the Printdia log box.
After the invoice is complete a nd is p rinted, click o n the Add to Database
button to copy the important data from the curre nt invoice into the database (beginning in cell L4). The informa tio n recorde d includes the invoice

number, invoice date, company name, and the invoice total. After the data is
copied, you are given an opportunity to create a new record (see figure
7.15). Clicking on the Yes button in response to the "Create a new
invoice?" prompt means that you do not need to click on the New Invoice
butto n for this particular record.

Creole o new lnuolce?

n

Yes

D

No

Figure 7 .15 Clicking on Yes is equivalent to clicking on the New Invoice
button.
Clicking on the New Invoice button clears the current invoice from the
screen and resets the invoice form to the default values. After the invoice is
cleared, the invoice number (cell B10) is incremented by one. The cursor
moves to the Ship To: section of the new invoice-ready to receive data for
your next invoice.

NOTE: You only need to click on the New Invoice button if
you have not already created a new invoice during the Add to
Database process.
The last button, Database = >, displays the database portion of the
worksheet (cells L4:V505). The database a rea contains only two buttons.
The <=Invoice button shifts the worksheet to redisplay the invoice form .
The Clear Database button deletes all the data from the database. If you
want to start over-perhaps clearing the database at the end of each
month, quarte r, or year-clicking on this button takes you b ack to square
one. If you click on it by mistake, you can recover by selecting Revert to
Saved from Resolve's File menu. This restores the worksheet to the state of
its last Save. You then can check the database to see if any invoice records
were lost.
When you are ready to put Invoice to work, you move from cell to cell
using the arrow keys or the mouse. Invoice fields are where you e nter
data (indicated by italic in figure 7. 16). Blank areas, such as extended
prices and the form totals, contain equations and are filled in for you.
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Figure 7 .16 Only the fields in italic require infonnacion.
First fill in che Sold To: information (cells F4 through F7). The format is
Contact Name, Company Name. Address, and, in a single field , City, Stace,
and ZIP code. Be sure chat che company name is entered in F5, no t in F4. The
information in cell F5 is copied auto matically into the Company field in che
database. If there is no contact person fo r a particular order, stare the information in cell F5 and leave F4 blank. If you forget what is supposed to
appear in each cell, see the o n-screen remi nders in columns I andj .
The invoice number, invoice dace, P.O. number, shipping method, shipping
date, and Salesperson's name/ini tials (B 10through G10) are.filled in for you
with defau lt values. Edit them as needed. Each item is centered within che
field. Now you need to e nter the line items in cells B13 through G39- one
row per item or service. This informatio n is entered like a small database
where each column is a particular field. Those fields identified in bold are
used as the basis for calculatio ns and must be com pieced.

The following is an explanation of the various line item fields .

Qty-A numeric field (numbers only) in which you record the
quantity of a particular item, the number of hours (for service
organizations) , and so on. The entry in this field is multiplied by the
figure entered in Unit Price which gives you the Ext. Price.

Item Number-A field in which you record part numbers or categories. Text of any type (alphabetic or numerical) is allowed.

Description-A field in which you enter a description of the item or
service.

Unit Price-A field in which you enter the cost for each individual
item in the line. Whether you record a quantity of one or 1,000
items on this line, you must enter only the cost of one of the items.
In the case of a service organization, you may enter an ho urly charge
for a particular service here.

Ext. Price (Extended Price)-A field in which the product of Qty and
Unit Price is calculated for you.
There are a few more fields in which you can enter values. Ship/Handling
(G42) is used to record any freight or handling charges for the invoice.
Terms of payment should be entered in 843. If all customers receive the
same terms, yo u can skip this field-the default is entered for you. Comments (Past Due, total of all invoices, and so on) can be entered in cell C43.
Although the text can overflow to the next cell (043) , be sure that it does not
extend into E43 or you wilJ lose the right side of the box that surrounds the
comment.
The next several fields are calculated for you. Sale (G40) is the total for the
Ext. Price column. Sales Tax (G41) multiplies the Sales Tax default (C48)
by the total Sale (G40) using the formula =G40 * SAL ESTAX. If o nly some of
the items are taxable, you must calculate the tax by hand and type in the
correct amount. When a new invoice is created, the original formula is restored to the cell. Total (G43) is the grand total for the invoice and is
calculated for you by adding together Sale, Sales Tax, and Shipping/
Handling.
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When the invoice information is correct (you can check it by selecting Page
Preview .. . from the File menu) , click on the Print Invoice button at the top
of the form. Respond to the Print dialog box by indicating the number of
copies (if mo re than one is needed), and then click on OK.
After you check the printed invoice for accuracy, click on the Add to Database button to copy data from the invo ice into the database. At the end of
the transfer procedure, a dialog box appears and prompts you to create a
new invoice at this time. Click o n Yes, or press the Return key to create a
new record. To leave the current record intact, click on No.
As payments are received, locate the correct record in the database by
selecting Find from the Format menu or press Command-F. The Find dialog
box appears. To locate a specific invoice, click o n the Value button. To
search for a company, type any part of the company name in the Find dialog
box, and then click on the Text button. (If the invoice is recent, you can
locate the record manually by moving to the last record in the database and
visually scanning the records. Click on the Database => butto n to move to
the database, and then press Shift-!.) After you locate the record you want,
enter the payment amounts in the Pay 1 through Pay 5 fields. The Balance
Due field is recalculated for you. If the customer needs a receipt, you must
create one by hand.
When you are ready to create a new invoice, click o n the Invoice => button
to return to the Invoice form, and if necessary, click on the New Invoice
button to clear any previous information.
You can use the Database ... command from the Calculate menu to examine
the d ata in several useful ways. First, you can quickly identify all invoices that
are not completely paid by searching for every Balance Due (V4) that is
greater than zero (0). The Find option in the Database ... dialog box highlights each appropriate record. Or you can extract the same data to another
area of the worksheet. Grau ping these records together in one place makes it
simple to arrange fo r follow-up phone calls, warning letters, or-in some
cases-turning the individual over to a collection agency.

Customizing the Invoice Templat e
As with the other templates, the first step is entering the information about
your company. Open the Invoice worksheet so that you can make changes.
Replace the company name and address by selecting each cell (C4 through

C7) and entering the new information. You also can replace the logo placeholder with your company logo, resizing it as needed to make it fit within
column B. If your logo looks too small, widen column B slightly.
Perhaps the most difficult part of using a spreadsheet program to create a
form is in arranging the data fields and labels so that they are properly
placed, while maintaining appropriate column widths and row heights.
Every time you change a font from normal to bold, for example, you may
need to widen a column to accommodate the new text width . Although
Resolve enables you to place text and graphic objects on a form anywhere
you want, the invoice form is designed, for the most part, without using
these features. This was done to make the template as versatile as possible
(other programs may not support these features) and to demonstrate how
the fo rm could be created in virtually any spreadsheet program that supports
variable row heights and column widths.
Avariety of formats was used for the spreadsheet cells. Dates were formatted
as Dates; monetary values in the Unit Price and Ext. Price columns, as well
as the numeric fields in the database, were formatted as Fixed with two decimal places; and the summary figures at the bottom of the form were
formatted as Currency. All other cells were formatted as General, enabling
you to enter text, numbers, or a combination of the two. Each cell was assigned a specific alignment (left, right, or centered).
Finally, some of the column headers (Qty, Item # , and so on) display as
white type on black. To achieve this effect, fill the cell with black or any other
solid color and use the Format Text Color command to make the text white.
Very few calculations are made in the spreadsheet. If necessary, you can
change these form ulas to match the way you do business. The following
formulas are used :
Cell Coordinates

Formula

G13 .. G39
Extended Price

= 813 * F13
Qty * Unit Price

G40

= SUM(G13 .. G39)
Sum of Ext. Prices

Sale

co11ti1111es
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Cell Coordinates

Formula

G41
Sales Tax
G43
Total
TS ..TSOS
Paid-to-Date

= G40 * SalesTax
Sales * Sales Tax % from cell C48
= SUM (G40 .. G42)
Sales + Sales Tax + Shipping
= SUM(OS ..SS)
Sum of the five payments for each invoice

VS ..V50S
Balance Due

=US· TS
Invoice Total · Paid-to-Date

The default values for the invoice appear in figure 7.17. The defaults are
shown on the worksheet beginning in cell B46. Column B contains the range
names for the defaults and column C holds the actual text and numeric values. Before using Invoice, you should replace the information in column C
with the propervaluesforyourcompany.
CONSTANTS/DEFAULTS
Stertlnv
10000
SelesTex
0.07
3.00
MinShip
TermsOft
Net 30
CustPODft
None
Shi pDfl
UPS Ground
Shi pDtDft
2/20/92
SoldDft
SH

Figure 7 .17 The invoice defaults.

The defaults are stored in the range B46 .. CS4 of the worksheet and are cop·
ied to the proper cells automatically when you click on the New Invoice
button. Each field contains the following default value:
Startlnv (C47)-The number you assign to the first invoice generated
by the system. For each subsequent invoice, this number is increased
automatically by one (1) and copied into cell BlO.

Sa/esTax (C48)-State sales tax in decimal form (enter 0.07 for 7%, for
example) . The information in this cell is used to calculate the tax owed
on the sum of the extended prices in the invoice. If you sell any nontaxable items or services, enter 0.00 in this cell and delete the formula
in cell G42. This enables you to manually enter the tax information for
each invoice, based only on the items that are taxable.
MinShip (C49)-The most common shipping and handling charge. If
you normally do not charge a shipping or handling fee, change the
default to 0.00.
TermsDft (C50)-Normal payment terms in a text string. Keep it
short. If the string is too long, you may need to widen column B.
CustPODft (C51)-Default text for the customer purchase order
number. Because every customer has a different numbering sequence and, in many businesses, only a minority of customers place
orders with a P.O., None or blank is the appropriate default.
ShipDft (C52)-The shipping method. If shipping is not applicable
to most of your sales, enter None or delete the contents of the cell.
ShipDtDft (C53)-Formula that sets the shipping date to match that of
the invoice date. Ifyou want the shipping date to appear blank initially,
delete the formu la in cell C53.
So/dDft (C54)-Default name, initials, or employee identification
number for the salesperson. If every salesperson generates invoices,
each person should enter his or her own number in this cell. If one
central person is responsible for creating all company invoices, you
can replace the cell contents with the most successful salesperson's
name, initials, or ID or leave the cell blank.
The primary reason this template was developed in Resolve is the way in
which the program handles macros, scripts, and buttons. Although
Resolve's Learn feature can be used to record simple macros, complex
scripts must be hand tuned or written almost entirely from scratch. In the
Invoice worksheet, one script is attached to each button. Figure 7 .18 shows
the New Invoice button script.
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Figure 7.18 The New Invoice button script.
The tasks performed by the different button scripts in the worksheet are
described above. To view a particular script in Resolve, select Open Script ...
from the Script menu, o r select the button of interest and choose Button
Script from the Script menu.
If you are willing to do the work, there are several areas in which you can
enhance the template. The most important areas involve the database portion
of the worksheet. You may want to consider the following ideas:

• Add a column to the database to record invoice aging. Using date
arithmetic, you can calculate the number of days between the
current date (NOWO) and the Invoice Date. After this information is
part of the database, you can use the Find and Extract procedures, for
example, to identify invoices more than 90 days overdue.
•

Using Resolve's Learn mode, you can create a script for printing
reports. This becomes more useful when combined with database
commands for extracting particular records.

• You may o nly want to keep unpaid invoices in the database rather
than all the invoices you issue. Using o ther scripts as examples,
create a button that enables you to scan the database for all entries
of zero (0) in the Balance Due column and then delete them. Be sure
the button script also adjusts the pointers to the next open record.

An example of setting field pointers is given in the Add_ to_ DB script:
Name Range (MakeCell(Column() ,Row( )+1)) as " La st lnv ".

• Fields copied into the database ar e sufficient for tracking o nly invoice
payments. They record totals while ignoring the line item information.
If you want to reproduce an entire invoice, you may try changing the
butto n script fo r Add to Database so that aH informatio n fro m the
invoice is recorded. Another butto n in the database could be used to
recreate the original invoice based on an invoice number or the
currently selected record. (Because of memory requirements, however,
adding all this information to the worksheet may be impractical.)
• The Clear Database button script clears the database instantly.
Although the butto n has a hatch pattern on it that makes it stand out
and is far enough away from the other butto n to avo id clicking o n it
accidentally, mistakes still happen. An OK/Cancel dialog boxpatterned after the one used in the Add_to_DBscript-could be added
to the script to offer you a chance to back out of the procedure.
• Resolve supports other types of controls than those illustrated in
Invoice. Rather than use a default to enter the salesperson's name
on the invoice, you can add a pop-up menu to easily select fro m all
salespeople.
•

If the number of services or products you offer is relatively small,
you can improve data entry accuracy by creating another database
that co ntains product codes, descriptions, and prices, and use
Reso lve's Lookup functions to fill in the descriptio ns and prices for
you automatically based on the product codes entered o nto the
invoice.

Lotus 1-2-3 for Macintosh
otus 1-2-3 for Macintosh (from Lotus Development Corporation) has
the look of a contender. Like Excel 3 and Claris Resolve, 1-2-3 enables
you to combine a variety of objects with the worksheet, includi ng color
charts, graphics, text boxes, and macro butto ns. Some of 1-2-3's other
special features include:

L
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3-D charts and graphs

• Tear-off tool palettes
•

Drawingtools

•

Text boxes

•

Graphics you can collapse to icons

•

Cell no tes

•

Database forms for editing o ne record at a time

•

DataLens and Data Access Language (DAL) support for connecting to
external databases

The capability to create 3-D or layered worksheets may be o f particular
interest to you . Using this feature, you can create a separate sales report
for every sales region, for example, and then use the main page of the
worksheet to summarize the regional data. Figure 7 .19 shows a layered
worksheet and the pop-up function menu.
Tools

Window

lnte ntcd statement

199
151

1989

19

'----------~~-' s::,~~=

1909

oo.oox

1

1990

oo.oo•

1

s~

199 1

oo.oo•

1

Figure 7 . 19 A 3-0 worksheet in Lotus 1-2-3 for Macintosh.
Ifyou previously have been intimidated by the macro languages of other
spreadsheet programs, you should experiment with the macro language
ofl-2-3. Figure 7.20shows the 1-2-3 Macro Tran scriptwindow. Every

command you execute is appended auto matically to the text in this window.
If you are not sure of the macro language of a particular command, just perform the action and check the Macro Transcriptwind ow.
~ Macro Transcript ~E

(Scroll-To-Sheet E:A 1}
(Scroll-To-Sheet A:A 1}
(Select- Ronge A:C l }
/( ESC}
(ESC}
(\G}
(Scroll - To-Sheet E:A 1}
{5elect-Ror.ie E:G6}
(Select-Ror.ie E:G6}
(Selec t-Ror.ie E:G7}
(Selec t-Ro nqe E:G 18}
(Select- Ro nqe E:H16}

Qil

:;:~;:·

.

IQj

lli:,

lrL
0

JQ l2!

Figure 7.20 1-2-3's Macro Transcript wi ndow makes writing macros much
easier.
The extensive compatibility between Lotus 1-2-3 and other packages is of
great interest to users of other spreadsheets. It can read files created by
Excel 2.2 and 3.xas well as the IBM-based versions of Lotus 1-2-3. For users
ofother Lotus spreadsheets, traditional menus also are supported.

Personal Training for
Microsoft Excel
hether you are an old hand with Excel or a spreadsheet novice,
learning to use a new version of a spreadsheet program can be a
time-consuming project. Personal Training System has a sho rtcut for you.
They prod uce a 4-volume set of d isks and cassette tapes that will teach
you what you need to know to get quickly u p to speed.

W

The Excel 3 modules include the following:
• Beginning Spreadsheets (entering words, numbers, and percentages;
creating formulas and functions; fo rmatting; printing; making and
using te mplates).
• Intermediate Spreadsheets (absolute references, date arithmetic,
custom formatting, sorting, using IF statements, creating data entry
fo rms).

Nu mber Crunching

• AdvancedSpreadsheets (look-up cables, spreadsheet linking, cell notes,
cell protection, spreadsheet auditing).
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• PowerfulSpreadsheets (style sheets, outlines, linking and consolidating
data, graphic and text objects, and System 7 Publish and Subscribe).
Personal Training Systems also manufactures training modules for dozens of
other Macintosh products.

Summary

I

n this chapter, you learned how to use spreadsheets to keep track of
business expenses. Specifically, you learned how to do the following:
•

Use charts in spreadsheets.

•

Use spreadsheets as databases.

•

Track business income and expenses with Microsoft Excel.

•

Create invoices for products and services using Claris Resolve.

•

Manage business transactions with Lotus 1-2-3 for Macintosh.

•

Speed up learning time with Pt:rsonal Training Systems cassettes.

In Chapter 8, "Strictly Business," you will learn about several programs
more traditionally thought of as business applications, including programs for creating business plans, flow charts, and organizational charts.

Strictly Business
Although word processing, database, and spreadsheet programs have endeared themselves to business users, they also can function as general
purpose programs that are useful in almost any setting. This chapter looks at
a small sample of programs that are mo re traditio nally regarded as business
software.
This chapter begins with a discussio n of programs that create business plans
and organizatio n charts as well as an order-tracking database. The chapter
concludes with a discussion of a topic of interest to everyone: saving money
on your taxes.

Writing a Business Plan
hether you are just starting out in business, o r are getting ready to move on to new fro ntiers, it is important to have a business plan. In addition to being an essential tool for obtaining
funding (whether a bank loan or venture capital), a solid busiy
ness plan is also a road map that can direct your company's
growth. The following are a pair of programs to help you
chart your course and get the money you need.

W
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PlanMaker by POWERSolutions for Business is a HyperCard-based tool fo r
creating business plans. To use d1is program, you must have a copy of
HyperCard installed on your system (included wim PlanMaker). The set of
HyperCard stacks mat make up this program lead you mrough the process of
building a business plan: offering direction and examples, and presenting
crucial issues mat your plan should address.
The program divides the process of writing a plan into two broad areas: the
Wo rkBook and the Financials. The WorkBook is the basis for me text portion
of your plan and is split into nine areas (see figure 8.1). Clicking on any
heading takes you to d1at area of the WorkBook. For each area, suggestions
are provided for me topics mat need to be discussed, as well as tips fo r how
they should be discussed. You are asked a series of key questions-the answers to which will help you describe the history of your business, list
short-term objectives, and generate a plan for the future.
rue
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Go Topics

Sample Plans
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Work b ook

3. ObfecUves

Table of
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c Risks

Go to .•.

I ,.., ......,.
I
I
I

INTRODUCTION
I. EzocuUvo summary

2 . Tbo Compuo y -Pros ont SlluaUo o

I
I
I
I

7 . Marketing Slrot.ogy
/\ Pricing & Proflt.lbtbty
B. Adverttslng & PromoUon
C Publle RetaUons

Figure 8.1 The WorkBook Table of Contents page lists me proposed sections
of me business plan.
As you go mrough the questionnaire, you are free to skip about and ignore
questions mat are not relevant to your business. There is ample space for
jotting no tes-sentence fragments that you may want to incorporate into the
final plan document.

The Financials are your numerical assumptions about sales volume, expenses, equipment needs, and so o n. As you enter numbers, PlanMaker
creates relevant tables and calculates a 12-mond1 proforma, 3-year projected
income statement, cash flow projection, balance sheet, and break-even analysis (see figure 8 .2). Like using a spreadsheet, as your assumptions change,
d1e program recalculates d1e affected tables.
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Figure 8.2 A 12-month proforma table.
After ilie WorkBook informatio n and Financial data are recorded, you move
on to ilie final section of the program: the Narrative. This is where you assemble the pieces of the report. PlanMaker provides a mock word processing
program for iliis purpose, including buttons for adding paragraph indents,
centering text, and repagination. Aliliough you can enter text manually, the
preferred approach is to copy ilie material that you typed into the WorkBook
Notes and Questionnaire sections and use them as the basis for the different
parts of ilie plan. If you are stuck for something to say, you can copy sections
from ilie iliree sample plans included with the p rogram. Samples include
Power DeskTop Publishing (a two-person start-up), Butcher Hollow BBQ (a
small restaurant), and River City Drum (a plastic manufacturing facility) .
PlanMaker contains all ilie components expected in an excellent program.
The manual is first-rate, the HyperCard stack-; are easy to use, and extensive

Strictly Business

instructions are prO\~ded, as well as sage advice fo r constructing a business
plan suitable for people with any level of business experience. Its only sho rt·
coming has nothing to do with the program itself-it has to do with the
environment: HyperCard. Although HyperCard is a suitably flexible programming environment to support this product, speed is not one of its strengths.
Even with a fast Mac, you will experience delays when moving between program modules.

Creating Business Plans
with BizPlanBuilder
Rather than provide a d edicated program for developing business plans,
BizPlanBuilder from JIAN takes the same approach that is used in this book.
It provides a series of templates (word processing and spreadsheet) which
you can use to create your plan. Rather than spending time learning a new
program, you open the templates in programs you already know how to use,
plugging your financial information into the spreadsheets and editing the
word processing documents. The templates are written for Microsoft Word
(or MacWrite) and Excel (SYLK format). Even if you don 't have these specific
programs, chances are good that your particular word processing and sp readsheet programs will be able to read the documents.
Six spreadsheet templates are included: Balance Sheet, Break-Even Analysis,
Budget, Cash Flow Projection, Income Statement, and Source & Use of
Funds. A seventh spreadsheet called Integrated Financials can be used instead and contains all of the information you norma.lly would enter into the
six smaller worksheets. Figure 8.3 shows the Income Statement spreadsheet.
The manual is divided into two parts. In the first, the plan text and spreadsheets are explained. In the second part, the essential points of developing a
business plan are discussed.

0

Flow and Organizational
Charts
sing a flow chart (a symbolic representation of a process) is still one of
the best ways to clearly illustrate the workings of any system. Flow
charts can be used to lay out the routines of a computer program, clarify how

U

management decisions are made, and eve n list the steps in a business presentation. An organizatio nal chart is a special type of flow chart. Rather than
explaining a process, it shows the o rganizational hierarchy. The following
two Mac programs make creating flow and organizatio nal ch ans extre mely
easy.
~
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Figure 8.3 To use any of d1e spreadsheets, you simply replace the dummy
numbers with your own estimates and figures.

Creating Flow Charts with MacFlow
With MacFlow by Mainstay on your Mac, you can toss your flow-charting
symbol te mplates away. After a quick scan dlrough the manual, you will be
able to create perfect flowcharts with symbols linked to othe r charts, comme nt boxes, and docume nts in other programs (see figure 8.4).
You create new symbols on the chart by d ragging dlem from the palette. After
selecting an d placing a symbol, you immediately can begin typing a to.'t label
for it. Connecting two symbols simply requires that you d rag a line from one
to the oth er. Lines can be drawn with o ne, two, or no arrows and can contain
text. To make line-drawing even easier, you can specify that all lines should
be drawn at right angles. Moving any of the symbols causes the lines to be
redrawn automatically-pe rfectly, of course. Clicking o n d1e shadow area of a
symbol can display a comment or launch a file in anothe r program.
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Figure 8.4 A Macf low flow chart.
Macflow charts can include graphics created in other programs. You have
full control over the color of symbols, symbol borders, text, and even the
display itself: the background, scroll bars, title, and so o n. Other helpful
features include the following:
• Text search-and-replace feature.
• Grids for object alignment.
• Adding custom symbols to the palette.
• Multiple fonts, styles, and sizes within a symbol.
• Bezier curves.
• Free-standing text and lines.
• Charts as stationery documents.

0

Macflow's only noticeable limitation is that you can have notes attached to
symbols or launching capabilities, but not both. After a shadow option is set,
it affects all symbols.

Charting With Org Plus
A Jong-time favorite in the PC world, Org Plus from Banner Blue recently was
introduced for the Macintosh. Org Plus was created with one task in mindit's a one-trick pony for creating organizational charts.
Figure 8.5 shows the program in action. Rather than creating each box drawing (as you would have to do in a graphics programs), you simply select the
appropriate position level at the top of the screen (manager, subordinate,
coworker, or assistant), click on its icon the correct number of times (once
for each worker you want to represent), and the program draws and arranges
the boxes.

Figure 8.5 A typical organization chart.

Each chart can include several box styles and box label arrangements, as well
as graphics created in other programs. Boxes can contain names, position
titles, and any o ther information you want-i n any font, point size, and style.
Boxes in each group are resized automatically to match the largest title enclosed by them. In addition to changing the box border and shadow options,
you also can specify different style arrangements for each group of boxes.
Figure 8.6 shows the style options from which you can select.
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Figure 8.6 To set a style for one or a group of positions, select a style from the
Group styles or Assistant styles palette.
Rearranging boxes is done by dragging them individually or as a group to the
new location and indicating the correct relationship, such as subordinate or
coworker. Positions can be eliminated by clicking on the boxes and pressing
the Delete key.
Organizational charts can contain graphics created in other programs, text
strings that show the creation date or chart title, and lines and boxes (created
with the drawing tools) . When printing, there are several functions that will
help you squeeze a chart onto one or a specific number of pages with minimal reformatting.
The following useful features also are included:
•

Varied line thicknesses and styles (solid, dashed, or dotted).

• Select command for simultaneously selecting groups of boxes.

0

•

Capability to hide boxes, branches, and labels.

•

Saving documents in completed form or as stationery.

•

On-line help.

Although Org Plus excels at designing organizational charts, you also can use
it for other charting functions. As an example, you can use it to create a pictorial table of contents that shows the layout and organization of a company
procedure manual. Org Plus is not a program for everyone, but any company
with more than a handful of employees will find it extremely helpful.

Other Business Software

T

he following two programs are in a class by the mselves. Ordertrak by
Database Associates is a sales-order tracking program, useful for any
high-volume manufacturing or sales organization. MaclnTax is an example of
what you can expect in a Macintosh tax preparation program. MaclnTax is
extremely helpful for any owner of a small business who needs assistance
filing his or he r pe rsonal income tax return.

Tracking Orders with Orclertrak
Ordertrak is an order-entry and tracking system written as a FileMaker Pro
database. The entire program is button-driven. (Clicking on any button executes a FileMaker Pro script.) Figure 8. 7 shows the main menu screen. From
this screen, you can jump to the order-entry layout or a tickler file (to remind
you of pending tasks), check on the status of an order, and generate over a
dozen reports and analyses.
~
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Figure 8 .7 Ordertrak's main menu.
Wherever possible, program options are provided as buttons or pop-up
menus. Typing is kept to a minimum. Re ports can be previewed on-screen or
printed. The Manufacturer Analysis Report provides summary informatio n for
specific manufacture rs for the current or previous year (see figure 8.8).
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Figure 8.8 The Manufacturer Analysis Report.
Ordertrak can handle up to thirty manufacturers and an unlimited number of
sales representatives. It can be purchased with or without Ordertrak Aid, an
analysis module.

Preparing Your Tax Return with MaclnTax
Have you noticed that every time the tax code is "simplified" the tax forms
become more complex? Have you reached the point where you just ignore
some deductions because the amount of paperwork necessary to calculate
and claim them costs you more than the potential tax-savings? If so, you are a
candidate for MaclnTax.

0

MaclnTax is an inexpensive program from ChipSoft, Inc. for preparing your
personal Federal tax return. It includes a full complement of forms that you
fill out on-screen (see figure 8.9). If you are not certain which forms to file,
MaclnTax can conduct a simple interview and choose the forms you need
based on your answers.
You can itemize any entry. Rather than just entering a total for medical expenses, you can list separate figures for doctors, prescriptions, and medical
travel, for example, and MadnTax transfers the total to the current line item.
Other figures can be based on IRS worksheets or derived from supplementary schedules (the program supplies both).
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Figure 8.9 MaclnTax forms look like the real thing. Clicking on the Instruct
button d isplays the IRS instructions for the current line.
MacinTax updates its figures automatically as you enter and edit your data. If
you want a quick-and-dirty approximation of your tax liability-without doing the necessary legwork of calculating exact figures-you can enter
estimates of some line items (following any item with an "e" marks it as an
estimate). And although many items are calculated (based on entries made
on other schedules), you also can override any calculated field , if necessary.
When you prepare taxes by hand, you are constantly reminded of the interdependence of the forms. You cannot calculate many of your itemized deductions, for example, until you have calculated your adjusted gross
income-which is based on a host of other forms. With MacinTax, the supporting forms are never more than a double-click or menu selection away.
There is no harm in taking a piecemeal approach, entering data and completing forms in any order that you like. The program keeps track of what
numbers you have entered and bases your tax liabiliry on those figu res alone.
MaclnTax almost makes it fun to do taxes.
Before submitting your return, the program informs you of any items that
may trigger an IRS audit. MaclnTax also provides general suggestions on how
you may be able to save on taxes in coming years.
Although you will not need its blank forms, do not throw out the booklet
that the IRS sent you. You will need it to help clarify some of the more
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complex tax topics, such as depreciation. You should also note that
Macl nTax is tax.preparation software. Its only tax-planning capability is the
option to help you prepare the coming year's estimated tax vouchers.
Each year, rwo versions of Macl nTax are released. The preliminary version
enables you to p repare most of your retu rn. The final version- sent free to
those who bought the p reliminary release- takes into account any lastminute changes in the tax code. For an additional fee, your return can be
filed electronically, speeding any refund that is due.

Summary
his ch apter discussed several programs that create business plans,
flow charts, and organizational charts. You also learned about tracking
orders and preparing Federal income tax returns with a pair of Macintosh
programs. Specifically, you learned about performing the following tasks:

T
•

Creating business plans using PlanMaker and BizPlanBuilder.

•

Creating flow charts and organizational charts, using MacFlow and Org
Plus.

•

Tracking orders using Ordertrak.

•

Preparing your tax return using MacinTax.

In Chapter 9, "Managing Your Time," you will learn how to o rganize your
time using calendar and address-keeping utilities.

Managing Your

Time
Time management is a major responsibility in most jobs. A part of this task is
keeping in touch with the people you need to deal with-customers, supplie rs, and business associates. Other aspects include scheduling meetings or
appointments and maintaining the eternal "to-do" list. With the right software, the Mac can help with your record-keeping, keep you on time with
appointment alarms and reminders, and improve your organization skills.
This chapter provides reviews of several useful utility programs. These tools
can work together to keep you on track in managing both your time and your
contacts. The programs discussed help you perform the following tasks:
• Organize information about the people with whom you correspond
using an Address Book program.
• Create mailing labels or dial the phone using an address
directory.
• Structure tasks into projects and priorities using a
Calendar or "to-do" program.
• Set alarms to remind you ofimportant meetings
or events using a Reminder utility.
• Schedule you r day using an Appointment
utility.

j
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For those of you who spend a significant portion of your workday at the
computer, these tools are far superior to paper-and-pencil equivalents. Eve n
for someone who only uses their computer occasionally, as long as the system is easily available, the investmen t in these tools is well worth the payoff.
The biggest secret is having the discipline to use them regu larly.

Address Book Programs
nless you work in a vacuum, you need a way to track add resses of customers, patients, sales representatives, distributors, or business contacts. You may rely o n a paper-and-pencil desktop rotary file of business
cards. Hand-held electronic address files also are popular. Although they can
be updated more easily and cleanly than rotary files, hand-held systems suffer
several drawbacks. There is often no way to use your add ress info rmation to
print labels o r dial a phone number, the screen may be difficult to read, and
the information cannot be easily shared with other programs. In general, to
get this fu nctionality, the data must eith er reside in a computer or the handheld must have some way of communicating with a computer.

U

If you have never used an address program before, you can get some firsthand experience by trying out the simple Address Book stack that comes with
HyperCard. When you are ready to move o n to something more powerful
and convenient, there are several new address book programs. They can be
roughly classified according to whether they are field-oriented (like a database program) or free-form (like a note pad). Of the address book utilities
discussed in this chapter, the field-oriented programs include MacPho nebook, Dynodex, and Address Book Plus. The free-form programs are IN touch
and QuickDEX IL.

Changing between Programs
For many people, add ress book programs come and go. When you select
one, it is best not to think of it as a life-lo ng commitment. If you find a new
program with a better feature set, you will immediately be faced with the task
of moving your existing address data into the new program .
Exporting and importing are the terms that describe this process. When you
move data out of an old program, you are creating a new file in a particul ar
fo rmat-exporting the data. When you read existing data into a new program, you are importing it-moving the data from your o ld address book
program into the appropriate fields of the new address book program.

Because manufacturers want you to change over to their software, it is important for their program to import a wide variety of data files created by o ther
address book programs. This makes it much easier for you to switch from
your old package to the new o ne. Conversely, few address book programs
will export data directly to other address book formats. The manufacturer
doesn't want to encourage you to switch to someone else's product. However, most programs enable you to export data into several database and
spreadsheet formats. These files can be read by the new program, but require
you co do the necessary clean-up to ensure a reasonably smooth transfer.

Using a Spreadsheet for Conversion
In a situation whe re there is no shared forma t between the two
programs, your best bet is to save o r export your address book
file as tab-delimited text, and then use a spreadsheet to reorganize the data into fields that match those of the new program .
Check your spreadsheet program for text-handling capabilities,
macros, and examples. Microsoft Excel 3.0, for example, includes
a Flat File add-in macro th at adds a Smart Parse command to
the Data menu (described o n page 680 of the Microsoft Excel
User's Guide). Usi ng this command, you can split a column of
data into several new columns by breaking the data at every
space, comma, or other delimiter. This is very useful for splitting
a Name field into First Name and Last Name, or dividing a singleLine City, State, and Zip Code field into three parts.

In the following reviews, carefully note the import and export options offered by each program. Depending o n the choices provided , switching from
one program to another can be accomplished in less than an hour (in the
case of compatible import and export options) or may require the better part
of a day. You will seldom need to retype an entire data file. At least part of
the information will carryover. In general, your biggest problem will be
moving from a free-form address book program to one chat uses fields.

Managing Contacts with MacPhonebook
MacPho nebook from Synex is afixed-field address book that enables you to
store add resses, pho ne numbers, dates, and briefcomments; dial stored
pho ne numbers (assuming you have a modem) ; and print out elaborate
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phone directories and labels. The package includes both a desk accessory
and a program. Either component can be used for data entry, looki ng u p
address records, and dialing the phone, but only the program h as printing
and import/export capabilities. You also must use the program to set preferences and configure the modem for d ialing.
A MacPhonebook syste m can consist ofseveral diffe re nt address books managed by the same program. Before you begin entering data, you can configure the new phonebook by specifying up to eight categories for records (e.g.,
friend, business, service) , and altering the contents of the pop-up me nus for
phone types (office, home, fax) and important dates (meeting, birthday,
a nniversary) . You can create as many phone books as you like with different
fo rmats for each o n e.
For each record , you can include a complete mailing address, up to three
pho ne numbers, an important date, and two lines of comments. However,
the comment field is restricted to 40 characters, so the program isn't suitable
for project tracking. Figure 9. I shows an example of a typical address record.
Radio buttons indicate the categories that apply to the curre nt record .
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Figure 9.1 All data entry is do ne o n screens like this one.
Some of the preferences are forthe entire MacPhonebooksystem. These
settings (and data) are auto matically available to all phonebooks. You can
configure the modem byspecifyinga dialing prefix and/or suffix, your area
code, modem speed, volume, and touch-tone or pulse dialing. There is even
a place to record important personal information, such as credit card numbers and bank accounts.
Importing an existing address file is relatively painless. The supported file
formats for imports and exports are tab-delimited, rerurn-delimited, merge

file, and MacPho nebook. In MacPho nebook, every time you edit a record, you
must verify that you want to save the changes. Because this happens for every
record you change , you should do your major editing before importing an
existing address file, rather than after.
After you create a file to be imported, you can specify the o rder of the fields
and where they sho uld be placed, which ones are to be ignored, and, optionally, a field on which to sort the database. If no sort field is selected, MacPhoneboo k au tomatically sorts on the first field in each record. Unfo rtunately,
the sort field is only used during the import process. After that, records are
always sorted by the first field.
This can lead to a significant problem. Anormal address label is usually writte n as name, company, street, city, state, and ZIP code. For many users, the
co mpany name is the most impo rtant informatio n in the address recordand it may be considerably mo re permanent than the personnel. Because of
this, many peo ple find it easier to sort their address book by company rather
than individ ual. It is possible to import data and organize it in this fashio n.
Unfortunately, whenever you create a new record or edit an existing o ne,
MacPhonebook saves and labels it according to the information e ntered in the
first line of the address-which contains the person's name, not the company
name. The best work-ar ound solutio n is to change the records by putting the
company name on the first line and placing the person's name (Attn: Bill
Jo nes) on the second line.
In addition, because MacPhonebook indexes all records based on the contents
of the first line, if you edit that line, the program assumes that you have created a new record and saves it in additio n to the original record. If you restrict
your editing to o ther parts of the record, MacPho nebook offers you the optio n
of replacing the o rigi nal record with the edited o ne. The o nly o ther problem
with the program is that you should avo id lo ng address lines, as they may be
truncated or over-written during printing.
MacPhonebook provides several ways to list and locate records. Yo u can list
all records, selected categories, or you can base a list o n the results of a search
(a particular area code or state, for example) . To find a specific record, you
can scroll through the alphabetized record index that appears in a window on
every reco rd, use the Go to ... command to search for the closest match in the
first line of each record, o r use the Find ... command to locate a text string
that appears anywhere within a record .
After finding a record, you can dial by first clicking in the appropriate phone
number field and then clicking the telepho ne icon. After the number is
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d ialed , MacPho ne book switches off the mode m automatically so that it
doesn 't interfere with the call.
The View Dates command displays information from the records containing
th e next five dares (based o n the Macintosh clock). Only one dare can be
stored with each record so, unl ess you create a se ries of duplicate reco rds,
you ca nnot use this feature co track your next three schedule d busi ness meetings with XYZ Corporation. When you launch the MacPhonebook program,
the n ext five dares appear automaricaHy.
MacPhonebook's grea test strength is its printing capabilities. If yo u need to
create a phonebook to fit a commercial date book, it is likely that the program
ca n print it in the format you want. MacPhonebook offers seven pre-existing
formats from which you ca n choose. Rathe r than e nabling you to specify your
own field arrangement, font size, a nd page size, MacPhonebook uses a set of
standard formats. The existing formats range from the tiny "Little Black
Book" (2 1/2-inches by 4 1/4-inches) all t he way up to a full-size, 8 1/2-inch by
11-inch directory.
for each printout, you can select the font and font style, as well as a normal
o r condensed fo rmat. Type size is automa tically set for you and canno t be
changed. A tiny preview box e nables you to see how e ach address will print
and shows wh ether some fields wi ll be over-written or truncated. Preferences
fo r each o f the seven print formats can be saved for future use.
Most p ho nebooks are printed double-side d and run as two pri nt jobs.
Mac Pho nebook starts by sizing up th e phone list and calculating how many
pages the job will require. After all the first sides print, a message appears
a nd p rompts you to turn the pages over and reverse the ir order to finish the
printing. MacPhonebooksupporrs most popular printe rs.
MacPhonebookalso includes about 40 labe l formats and supports many
Avery label sizes and layouts, as well as Ro lo dex cards and postcards. You can
design and save custom label formats and, unlike phonebooks, you can
specify all of the font cha racte ristics whe n creating labels. Altho ugh no format
is provided for printing directly o n e nve lopes, it is possible- with a little
expe rimentation-to design o ne. Synex makes a companion program called
MacEnvelope, however, that performs this function.
If you need carry-alo ng phone d irectories o r ma iling labels, MacPhonebook is
a good cho ice. However, the forced sort on the contents o frhe first line a nd
the lack of support fo r envelope printing may leave it short of meeting some
users' needs.

Staying Organized with Dynodex
Dynodex by Po rtfolio Systems is a field-oriented address book program and
desk accessory. It is extremely easy to use, has powerful printing capabilities,
and sports a flexible feature set. Ifyou are dissatisfied with your current
address book program, Dynodex should definitely be considered.
\'V'hen launched, the Dynodex program opens from o ne to three windows
(see figure 9.2). Clockwise from the top left, these are Dynodex's Data Entry, Just Names, and Display windows. The Just Names window serves as
an index for the data file. The Display window shows how data for theselected record wi ll be printed if formatted with the current print layout.
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Figure 9.2 The Dynodex windows enable you to manage the address book.

At a minimum, the Data Entry window must be displayed. The Just Names
window presents a list of all currently selected records, showing the company name, contact person, and phone number. In addition to its
usefulness when tryi ng to quickly fi nd a name or phone number, theJust
Names list also can be used to jump to a record (by clicking on it) or to
mark records for another activity, such as group deletion or creating a special subset. Records can be sorted by up to three fields and appear in that
order in both the Data Entry window and the Just Names list.
Importing and exporting data is fairl y easy. Rather th an support programspecific formats, Dynodex can read and write cab- and comma-delimited

~R
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files only. A field selection box enables you to specify the fields which are
imported and exported, and the order in which they are read or written. If
you already have a free-form address file, you can import the data into
HyperCard 's Addresses stack and then convert it to Dynodex format with
DynoStack, a special stack provided for that purpose.
Within the program, common commands are issued by clicking o n an icon
in the Tool palette. In fact, as with many Macintosh programs, commands
frequently are executed in three ways: clicking on an icon in the palette,
selecting commands from menus, or pressing Command-key combinations.
Dynodex includes both Find and Select procedures to help you locate individual records or create subgroups, respectively. Find requests can search
one or all fields. You also can do a search-and-replace- for each occurrence
or as a global operation. Record selectio ns can be based on the contents of
one or two fields. Records identified during a Select Records ... procedure
also can be marked for further action.
You can save record selection and Find requests that you want to reuse. Each
is append ed to th e Frequent Finds or Frequent Selections pop-up menu.
Dynodex also has a record marking feature you can use when you want to
perform an action on several records simultaneously. You might, fo r example, want to d elete a group of records or send them a mailing. Records
can be marked individually or on the basis of a selectio n criteria. You also can
mark only those records that are no t part of the current selection.
As in most d esk accessory versions of d atabase programs, the Dynodex DA is
a stripped-down versio n of the application. There are no printing, record
selection, or marking options. The DA is well-suited to no rmal data entry and
phone dialing. For mo re advanced o ptions, you must return to the main
program. For a glimpse of the DA and its menu options (see fig ure 9.3) .
Normal data entry features such as date stamping and shorthand keys (you
type a letter or two into a field and the program attempts to fill in the rest of
the entry based o n a list that you have provided) are available.

Like most address book programs, some Dynod ex features can be configured
to work the way you want. Differe nt preferences can be set fo r the program
and the DA. The Preferences menu enables you to specify the following
options:
•

Set up a dialing configuration.

•

Specify a default database to open when the program is launched.

•

Turn on or off auto-save and set a time increment.
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Figure 9.3 The DA version of Dynodex's smart, u ncluttered display.
• Remember window positions.
• Sort a file auto matically at closing.
• Date-stamp note field s.
Other special features include:
• Global search-and-replace.
• Fields can be renamed.
• Search-and-delete duplicate records.
• Scro lling note window that can contain up to 5K of notes.
• Phone d iali ng from any field.
• Auto-capitalization and shorthand keys.
• Save selected records as a new database.
• Sample paper to print several address books.
Dynodex has many of the extensive prin t formatting capabilities of its sister
product, DynoPage. Like DynoPage, Dynodex comes with a variety oflabel,
envelope, address book, and rotary ftle printing layouts. Ifyou need to print
on an unusual si.z e o f paper o r want a layout composed ofa different g ro up
of fields, you can create your own layouts or customize existing o nes.
Although you can issue a no rmal print job with Dynodex, there also is a Print
One command for quickly pumping out a single label o r envelope. You can
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embed a graphic o r logo in the return address section of envelopes, ifyou
like.
You can preview output for the current record just by looking at the Display
window. To preview a larger printout-an address book, for example-there
is a print preview option that shows a reduced view of each page. A magnifying glass tool lets you zoom in on any area of the printout if you want to see
the detail.
In summary, Dynodex is one of the most powerful address book utilities
around. Its record selection, find , sort, mark, and print features clearly set it
apart from the competition. Keep in mind, however, that the real power is in
the program, not the desk accessory. To print even a single envelope, you
must run the program.

Organizing Addresses with
Address Book Plus
Address Book Plus from Power Up Software Corporation is a field-oriented
address book program and desk accessory. The program has two main win·
dows (see figure 9.4). The back window is called the Document Browse
window. Arranged like a spreadsheet or columnar database, it can display
every field of every record o r just selected fields. Its main function is record
selection-either for editing or viewing.
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Figure 9.4 The Address Book Plus windows.

The front window is the Data Entry window. Clicking on a record in the
Document Browse window brings up a Data En try window for that person,
where you can make changes to the information. You can move from field to
field in the Data Entry window by pressing the Tab key or by seleccing a field
with the mouse.
When designing a new address book, you can change field names and set
daca e ntry preferences. By curning off the option to format the Birthday field
as a d ate, you can change it co some thing more useful, such as an AppleLink
o r Federal Express accou nt number field.
The desk accessory is inte nded to be used mainly as a phone dialer, although
you also can add and edit records (see figure 9.5) . Records always appear in a
scrolling list-either in sho rt format (name or company name, city, and the
first two phone numbers fo r each e ntry) or in long format (name, company,
address, all pho ne numbe rs, and profession). Printing and Smart Lists (popup me nus of freque ntly-used choices for a field) are not available in the DA.
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Figure 9 .5 A p ortion of a Contaccs address book shown in long formac.
Within the DA, numbers are dialed by double-clicking on the number you
wane, or by highlighting the number, and then clicking on che Dial button. lo
addition co displaying the record list in several differe nt sort orders, you also
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can select specific records categories to be shown. This makes it easy to select
and call only your field representatives, for instance.
Ifyou already have address book data in another program, Add ress Book Plus
can read its own files (Mac or PC version) and tab-delimited text files. When
importing a text file to create a new address file or merge it with the current
one, Address Book Plus e nables you to specify what fields are read and in
what order . It can eve n h andle some typical clean-up chores for you, such as
reading the first and last names from a single Name field. Similar procedures
are used to export an address file. Supported formats include tab- and
comma-delimited text, as well as data that can be read by a Casio B.O.S.S. or
Sharp Wizard hand-held personal organizer.
Data entry is made easier with a feature called Smart Lists. At its most basic, a
Smart List is a pop-up menu that contains frequently-used choices fo r a field
(Mr., Ms., Mrs., and Dr. for Prefix, for example) . Selecting a choice from a list
saves typing time. The Category and Phone Code fields take Smart Lists a step
further. By pressing the first le tte r of the en try, Address Book Plus fills in the
rest. Ifyou want, you can.assign this capability to other fields too.
Another nice fea ture is the capability to set automatic capitalization for some
fields, such as City or Company. Finally, if you are entering several names
from the same company or city, you can temporarily turn o n "field value
retention" for those fields. Each subsequent record that you e nter will use
the value from the previous record.
Address Book Plus comes with seven basic layouts (address book, envelopes,
InstaBook, labels, mini address book, pho ne list, and rotary file cards) that
can be used to produce printed reports. The program also includes several
libraries ofadditio nal layouts that can be installed. Libraries hold sets of
formats for a speci fic type of printing need such as address books or labels.
There is wide selection of supported formats. For example, forty different
types of rotary file cards are supported.
In addition to printing, layouts can be used to view subsets o f records (only
business contacts, for example) . After selecting a particular group ofrecords
and choosing a layout, you can save th e information as a view. You can create
up to nine predefined views. Each is available as a menu optio n and has a
Command-key so you can switch to it quickly.
Address Book Plus has an extensive help file that will lead you easily through
even the most difficult procedures. As one of the most powerful address
book programs a rou nd , users will be extre mely grateful for this feature.

Getting in Touch with INtouch
INtouch by Advanced Software is a semi-structured address book and phone
dialer DA. Although it does not support fields, each record is split between
two windows (see figure 9 .6). The window on the left is generally the address
window, and phone numbers and notes go on the right. Clicking on the
zoom box in the upper right corner of the Notes window zooms it to cover
the e ntire card.
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Figure 9.6 The arrangement of INtouch information is entirely up to you.
The organization of information between the windows (address on the left
and notes on the right) is more a convention than a requirement, but it does
make using some of the other features of the program easier. Whenever you
print an envelope or label, the text on the left side of the screen is the information that gets printed. The Dial button or Command-0 dials the first
phone number found in the right-hand window or the next one found
searching from the current cursor position within the record. Thus, you can
have multiple phone numbers that can be dialed within the same record.
lf you already have an address file, INtouch can import QuickDEX and tabdelimited text files. The treatment of tab-delimited text files has improved
considerably since the program's initial release. Now you can have INtouch
handle imported text by do ing one of the following:
•

Placing all informatio n in d1e address field (left window).

•

Moving anything after a ZIP code into the Notes field (right window)

• Specifying a number of lines to be placed into the Address field and the
rest into the Notes field.
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When exporcing, the following formats are supporced: 4th Dimension, CAT,
Microsoft File, File Maker, Full Impact, FullWrite, Double Helix II, Excel,
MacWrite, MacWrite II, MORE, Omnis 3 Plus, OverVUE, Panorama, Microsoft
Word, WordPerfect, Microsoft Works, WriteNow, and ASCII text.
INtouch 's lightning-fast search function enables you to quickly find any
record based o n the string of text you have entered. When searching, the
entire record is examined so that you also can base the search on text fo und
in the Notes window (making it a good area to add dates and keywords to
help u niquely identify records).
Because the database is essentially free-form, there is no Sort procedure. The
records are simply stored in the order in which they have been imported and
entered. It is possible to page from record to record, but unless you have
deliberately entered them in a consistent, meaningful fashion, you will seldom use this or the Go To ... feature.
Like most address book programs, you dial numbers through the modem
port, the printer port, or the Mac's speaker . (If the volume has bee n set sufficiently high in the Control Panel, you can dial by placing the mouthpiece of
the p hone close to the Mac's speaker.) You also can set a dialing prefix and
suffix and tell INtouch how to dial long distance calls. The program includes
four user-defined Command-keys that you can set to dial important numbers
o r calling card prefixes.
You should note that although IN touch can print records, labels, and envelopes, it can o nly print o ne document with each Print command. This makes
it excellent for quickly snapping off an envelope, but a bad cho ice if you need
a carry-along address book.

Using QuickDEX II
QuickDEX II from Casady & Gree ne is another free-form d atabase desk accessory. Although it is not designed solely for address files, its ability to dial the
phone and to invoke an envelope printing desk accessory make it worth
considering.
Like the o ther programs discussed here, QuickDEX II is based on a "deck of
cards" metaphor. Each file consists of the cards you have created, and you
can only see one at a time . You navigate among the cards by using the Find
option, by positioning the cursor in the Find text box and pressing the Return key to go to the next card, or pressing Shift-Return to move to the
previous card (see figure 9.7).
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Figure 9.7 Executing a Find command in QuickOEX LI.
QuickOEXcards contain as linle or as much informatio n as you like-limited
only by available me mory. Although bunons are provided for executing o nly
a couple ofcommands (dialing and locating records) , there are few commands to learn: adding a new card, deleting a card, and time-stamping.
Other program options enable you to perform the fo llowing functions:
•

Maintain multiple open QuickOEXJl files.

•

Set a separate fo nt for each card deck.

•

Specifydialingoptions.

•

Date-stampcards.

QuickOEX II also includes a ZIP and area code database called QuickZip that
you can use to look up info rmation on abou t 1,000 U.S. cities.
If you are switching to QuickOEX II from another address boo k program, you
are in for a rude awakening. QuickOEX II has no importing or exporting
capabilities. On import, your choices are to use the Mac's Copy comma nd to
copy each field or record and then paste the result onto a QuickDEX II page
or to simply retype the database. If you d ecide that you want a more traditional address book program, you should look for o ne that can read
QuickDEX II files o r pla n on manipulating a copy of the file in a spreadsheet
to make it easier to import the QuickDEX data into the oth er program.
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Built-in printing options are limited to printing the current card. Like
INtouch, there is no way to print an address book or set of cards other than
one record at a time. Although QuickDEX II cannot print envelopes, selecting
its Print Envelope ... command invokes an envelope-printing DA-ifyou
have o ne. If you don't have an envelope printing DA, you may want to consider Casady & Greene's newest product, Super QuickDEX. lt consists of
QuickDEX II DA, PrintDEX II, and QuickElope DA.
QuickDEX II 's greatest strength also is its greatest weakness. Because it is
free-form, there are no sorting options. (Without fields, sorting makes little
sense.) Fields give order to a database and make consistent entry easy. Witho ut fields, any consistency you achieve is through your own diligence.
On the plus side (and it is a big plus with many die-hard users) , QuickDEX II
is not limited to storing address and phone informatio n. You can use it to
store copies of letters, memos, and faxes (just copy them in your word processing program and paste each one onto a QuickDEX card). You can
dedicate some pages to a To-Do list. You can use it as a note pad or idea
recorder. In fact, rather than thinking ofQuickDEX II as an address-book
program, perhaps it is best to treat it as a note pad with advanced features.

Calendar and To-Do
List Programs
ecause of their limited functio nality, calendar and to-do utilities are
seldom sold as stand-alone programs. You often will find them as a
component in general utility packages, and as shareware or p ublic domain
programs.

B

Event Tracking with Calendar
Sometimes simple is best. The Calendar d esk accessory (part of Fifth Generation System's File Director package) does not have alarms or reminders, but
it does show you a day at a glance, enables you to move no tes from one day
to the next easily, and can print a take-along calendar showing your schedule
for any time period. You navigate within the current month by clicking on
the desired date. You ca n fli p to any mo nth or year by clicking the appropriate squares at the bottom o f the window (see figure 9.8).
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Figure 9.8 In Calendar, days with attached notes are indicated by check marks.
Daily notes are entered in the Notes window on the right side of the screen.
The Notes window scrolls, so you easily can squeeze in your daily schedule
and to-do list notes. The Notes window also supports the Clipboard, so you
can copy information in your word processing program, for example, and
paste it in.
Calendar also enables you to dial phone numbers you type in the Notes
window. The procedure is simple. You can highlight the number, and then
select the Dial command (or press Command-D). Dialing is done through a
modem orthe Mac's speaker, depending on how you have set Preferences.
Phone numbers also can include embedded modem commands that request
tone or pulse dialing or add pauses-to give you time to get an "outside
line," for example.
Some days are more productive than others. ff you have left-over notes or
uncompleted tasks, you can move them all to the next day by selecting the
Move command or pressing Command-M. They are appended automatically
to notes for the next day. The Clearand Archive commands enable you to
eliminate notes. Clear simply erases them; Archive creates an archival text
file from the notes, enabling you to examine them later or use them as the
basis for a report.
Printed calendars can include a single day or a range of dates. The following
options are included:
• Skipping or including "blank" days (dates with no attached notes).
• Printing a line between each day.
• Starting each day on a new page.
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If most ofyour days are organized around tasks rath er than meetings and
appointments, Calendar does the job nicely. It takes o nly a few moments to
set preferences and learn how to navigate and move notes. After that, your
time spent with Calendar is 100 percent productive.

Getting Things Done with To Do!
Some tasks aren't time-oriented at all. Sometimes you simply have a bunch of
stuff you must accomplish-as soon as possible or yesterday. rfyou want to
organize and keep track of those activities, To Do! (a shareware desk accessory written by Andrew Welch) fills the bill (see figure 9 .9). The shareware
fee requested fo r this version is $15.
,-
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Figure 9.9 Clicking o n each Topic displays a related list of Things to Do.
To Do! is completely icon-driven. There are no menu commands or
Command-key equivalents to learn oruse. The screen is divided into two
parts:" Topics" and "Things to Do." Topics are organizing categories. Anything you like can be defined as a topic by clicking on the pencil-and-paper
icon under the Topics window. You can define a particular project o r a class
of work, such as "Reports Due," as topics. Topics are alphabetized
automatically.
After a topic has been created, you can build a related list of activities
(Things to Do) by clicking on the pencil-and-paper icon under the right
window. Each activity must be assigned a prio rity (1, 2, or 3) . When

d isplayed, the activities appear by priority (priority 1 tasks first) and are alphabetized within each prio rity level. As you accomplish tasks and complete
projects, you can replace the priority number with a check mark (marking it
as do ne) or delete the entry.
Notescan be attached to entries in either window-when you create chem o r
later by clicking o n the paper-clip ico n. Altho ugh the notes do no t appear in
the windows, you can examine them by double-clicking o n the appropriate
Topic o r Things to Do item.
The printer and page setup icons enable you to create printed copies of your
lists. You can print a list of all topics and things to do, the items associated
with a selected topic, or selected items. You can optio nally print any attached
notes and choose a fo nt fo r the printout.

Reminder and Appointment
Utilities
nlike simple calendar programs, appointment utilities commercially
marketed as stand-alo ne programs are plentiful. This section discusses
the fea tures of the leading contenders.

U

Remind Yourself with calenDAr
calenDAr by Psybron Systems is a traditional appo intment reminder DA. It
includes a dozen reminder sounds chat can play at the appo inted time and
enables you to record and add your own sounds using the Apple Sound
Manager or Farallo n 's MacRecorder.
Although calenDArcontains a menu, all commo n activities can be executed
by clicking at various spots o n the calendar (see figure 9 .10). To set a reminder, for example, just double-click o n the appropriate date. The cursor
icon in the upper right corner jumps the calendar forward and backward by
month or year.
Clicking on the Finger icon displays all current reminders. Optionally, you
can view o nly reminders set for today, this week, or this mo nth ; just published o r unpublished reminders; those that are sound-o nly (no message) ; or
repeating reminders. Optio n-clicking o n th e Finger icon shows all fede ral
(both U.S. and Canad ian) and religio us ho lidays (includingj ewish) fo r the
current month.
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Figure 9.10 This tiny calendar is the enti re calenDAr display.

The I NIT portion of calenDAr is responsible for checking the system clock to
see if a reminder is due. After the reminder time is reached, a dialog box with
your message appears and the selected reminder sound plays. You can then
dismiss the reminder or click on the Snooze button to force it to replay later.
By default, the clock is checked once each minute. To reduce activity of the
!NIT, you can set it to check every 5, 15, 30, or 60 minutes.
As new reminders are created , you can set them to replay at particular intervals based on minutes, ho urs, days, weeks, or mo nths. You might, fo r
example, want a reminder every four hours to take aspirin or an annual reminder of your boss o r husband's birthday. You also can set reminders to
recur based on a specific day of the month-every second Tuesday, for in·
stance. In addition, each reminder can be preced ed by a warning a certain
amount of time before it is due.

Keeping Track of Time with AlarmsClock
AiarmsClock is one often tools that comes with the Now Utilities 3.0.1 package from Now Software. AiarmsClock is a combination appointment
reminder, clock, and stopwatch for your Mac. After the CDEY is dragged into
your System folder, a digital clock is added to th e right side of your menu

bar. By default, only the time is shown. From within the Control Panel, you
can specify whe ther the clock will display AM/PM, the day, seconds, and a
flashing colo n. You also can select a fon t and color for the clock.
Clicking o n the clock in the menu bar can flip it from displaying the time to
showing the date. An additional click puts it into stopwatch mode- very
handy fo r doing be nch marks. If you don 'tlike wh ere the clock is, you can
drag it to a different spot on the menu bar.
Appoi ntment alarms can be set from the clock or within the CDEV. You can
se t different options for each alarm (see figure 9.1 1). Whe n an alarm goes off,
you can delete it, set it to "snooze", o r reset it to go off again at a specific
time.
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Figure 9.11 Reminders are created and edited on this screen.
In addition to setting the date, time, message, and how the alarms are displayed, you can select a differe nt sound for each one, set it to recur at
specific intervals, and specify a time-out period after which the Mac will dismiss the alarm automatically.
Although AlarmsClock does nor contain all the features ofmajor stand-alone
appointment utilities, it is simple to use and convenie nt.
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Stay on Time with Smart Alarms with
Appointment Diary
Smart Alarms with Appointment Diary by jam Software USA is an INIT/DA
combination for setting reminders and scheduling appointments. As with
similar programs, the JNIT is responsible for tracking the system time a nd
posting alarms as they occu r. The Smart Alarms DA is added to t he Apple
me nu and presents a single screen in which you can add, edit, o r delete
reminders (see figure 9.12). A second DA called Appointments e nables you to
set a daily and weekly schedule, as we ll as record notes and things to do. The
package is ava ilable in two versions: single- and multi-user.
r
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Figure 9 .12 This screen appears whe n you open the Smart Ala rms DA.
When a reminder time is reached, the chosen alarm sound is played along
with a three-line log showing the first warning elate and time, the d ue time,
and the overdue time. For each triggered alarm, you can request a 5-minute
"snooze", specify another prom pr ata chosen time interval, or permanently
dismiss the alarm.
When you set a reminder, you can specify a date and time, whether you want
an advanced warning, whether it is a recurring event, and a sound to use. In
addition to creating normal and recurring alarms, clicking on Goodies enables you to select the following options:

• Snooze tu rns o ff Smart Alarms fo r a specified period o f time.
• Preferences set reminder beeps to continue until you respond to
them; set the number of beeps fo r reminders; or establish a default
time, advanced warn ing, and recurring interval fo r all reminders.
• Applications co nta ins a list of applications in which you do not want
alarms to appear.
• Merge reminders add s another user's alarms to your alarm list.
• Print prints a list of reminders.
• Export text and Import text enables you to exchange d ata.
Setting a standard ti me for reminders with the Preferences me nu optio n can
be very useful. If the majo ri ty of your reminders are o f t he "do this tod ay"
type, rather than "do this at a specific time," you can set the default ti me for
all reminders fo r early in the morning before you normally arrive at wo rk.
That way, you can see the entire day's schedule the mo me nt yo u turn o n
your compu ter.
One special feature of Smart Alarms is the capability to make a reminder
activate a Command-key. In co mbinatio n with a macro program, you can use
this feature to launch a communicati ons program , do a tape backu p, shut
down the system, or anything else that you want to have happen at a time
when you may not be ava ilable.
When the Appointments DA is opened , it presents a two-mo nth appo intme nt
calendar o r the appoi ntments for the current week, depend ing o n which of
th ese views you have set as your Auto Layout You can design an au tomatic
layout fo r every page in the calendar o r for o nly the selected day o f the week.
Figure 9. 13 shows a sample layout fo r those of you who are used to schedu ling hourly appointments and meeti ngs.
ln the mo nt hly view, only appointments and notes fo r the currently selected
day are shown. ln the weekly view, you can see the notes fo r each day o f the
selected week. By clicking o n the name of a month, you also ca n get a mo nthat-a-glance view, similar to a des k blotter calendar. Informa tion in the mo nth
view does not wrap, however, so you are ge nerally better off if you keep your
notes brief. (A two-page display is great when using this feature!)
Other useful features incl ude:
• The co nstant d isplay of the current ti me.
• The capability to resize any d isplay.
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Figure 9.13 The hourly dividers are part ofan Auto Layout added to every page.

•

Case-insensitive Find command.

•

Manual and auto-save.

•

Appointments and notes can be printed for any range of days, weeks,
or months.

•

Diary Migration pro gram is included (for moving a diary into another
computer's diary program, exporting a diary as a text file , compacting a
diary, or archiving a diary) .

Anything you type into an appointment diary can be made into a Smart
Alarm. To do this, follow these general steps:
1. Highlight the entry in the appointme nt diary.

2. Select the Set Reminder.. . command or press Command -R.
3. Make any changes to the settings that are required (an advanced
warning period, for example) and Save the new reminder.

You can create several reminders at the same time by highlighting a block of
entries in an appointment diary. You can make them all one reminde r or
treat them as individual reminders. Communication between the two DAs is
in this direction only-from appointment diary to Smart Alarms. Ifyou enter
an alarm and later decide that you also want it to appear in your appoint·
ment diary, you will have to copy it there or retype it.

Ifyou have the multi-user version of the program, Appointments searches all
connected drives and server volumes for diaries, stopping at the first diary it
finds. Other diaries can be opened using the Open .. . command. The program builds a list of diaries opened during the session and adds them to the
menu bar so that you can easily switch among them.

Schedule Managers

S

chedule managers integrate many of the features of a to-do list program
and an appointment manager. They e nable you to make the most efficient use ofyour time and to monitor the relationship between the tasks you
need to finish and the time available. At their most sophisticated, they can be
used to coordinate the schedules of several people and optimize the use of
available resources.

Scheduling with First Things First
First Things First is an !NIT from Visionary Software that reminds you of
appointments and helps organize your to-do list. After it is installed, a small
clock and calendar icon (about 1" square) appears on the Desktop. Unlike
other objects, this icon maintains its position constantly in front of other
objects, windows, and documents so that it is always visible and accessible.
You can shrink the clock to about one-third its normal size or drag it into
your menu bar if you want to move it off the Desktop.
To set or edit reminders and things to do, double-click on the calendar or
press the hot-key you assigned co the program. By clicking on the Category,
View Range, and View Options pop-up menus (see figure 9.14), you can
determine the specific combination of ite ms that appears on-screen.
When you create a new entry, there are some decisions to make. First, every
entry must either be a reminder or a thing to do. Reminders are accompanied
by an alarm and must be assigned to a specific date and time. Optionally,
reminders may be set to recur at any interval. Things to do, on the other
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hand, are not signaled by alarms, altho ugh they may be assigned a date and
time to help you prioritize them. If you want, you can click on the Remind
Me button when creating a thing to do and First Things First lists it both as
a reminder and a th ing to do.Second , every entry must be associated with a
category, such as Budget Report, Yard Work, o r Meetings. Defining categories
is your responsibil ity. You can have as many as you need to keep your reminders and things to do organized.
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Figure 9.14 This dialog box is used to set, view, and edit reminders and thingsto-do.
Clicking on the calendar icon shown in figu re 9.14 enables you to change the
programs settings and preferences. You can:
•

Select a type of clock/calendar icon (analog or digital) and set display
options.

•

Choose a custom color fo r the reduced clock.

•

Decide whether completed reminders and things to do should be
saved or deleted.

•

Change the hot-key.

•

Pick a sound for reminders and for the optional on-the-ho ur chime.

At first, it may take a little time to get used to the distinction between reminde rs and things to do. It blurs conside rably whe n you realize that you can
assign a time to a thing to do, but that no alarm will sound at that time. In
fact, the most d ifficult part of the program is conceptual. Creating reminders
and things to do is extremely easy. Deciding whether something should be a
reminder or a thing to do is more difficult.

Managing Tasks with
Alarming Events 1.0.3
The Alarming Events DA from CE Software is a n advanced appointment and
to-do list manager. After opening the DA, you can view and enter events fo r
the current day or for the next five days, check a calendar (dates with scheduled eve nts are shown in boldface) , and set program preferences.
Each time you select the DA from the Apple me nu, you first see a miniature
calenda r. Although it normally displays o nly two months, it can be expanded
to show up to several years-de pending o n the size of your screen. The time
and text for the next scheduled reminder, as well as the current time, appear
at the top of the window. A picture can be used to decorate the page, a nd
you can use a different one for each month.
From this view, you can exami ne any date by clicking on it or you can look at
any five-day period by Shift-clicking the range. Each time you select a new
date or five-day range, Alarming Eve nts ope ns a no ther window. When you
want to e nter a new eve nt or edit a n existing one, you begin by selecting the
date from the calendar. This displays the single day view (see figure 9.15).
To complete a n e ntry, follow these general steps:
1. Enter an event subject (35 characters maximum).

2. Select the rype of event: pop-u p alarm, flashing alarm, timed eve nt, or
To Do. (Alarms can only be set fo r the first two eve nt rypes.)
3. If the event has an alarm associated with it, you must set the date and
time by clicking in those areas at the top of the window.
Optionally, you also can enter up to 255 characters of notes about the eve nt,
set an ad vance notificatio n time, specify an estimate of the duration (for a
timed event), or select an interval fo r recurring events. Recurring events also
can be based on a specific number of days before month-end or a specific day
of the week. Other important features enable you to do the following:
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Figure 9 .15 All appointments, remi nders, and things to do are entered in the
single day view.
• Maintain and use multiple appointment books and archives.
• Specify a variety of printing options.
• Import events stored in CaJendarMaker, Smart Alarms, o r text files.
• Set defaults for the event type, duration, advance notification, and
recurring interval fields.
When an event time is reached, a dialog box appears that lists the event subject and notes, and presents a string of icons you use to respond to the
notification. Options include simply closing the dialog box (it appears again
the next time you open the DA), marking the event as completed, postponing
notification for a specified amount of time, opening the DA, archiving the
event (saving it to an archival text file) , or deleting it. Of course, if your
schedule changes, you don 't have to wait until you receive notification to
make the required changes. You can simply open the DA, select the event,
and reschedu le it.

Getting There on Time
with Meeting Maker
Meeting Maker is a network product by ON Technology that enables groups
of individuals to schedule meetings and resources (such as a conference

room, audio/visual equipment, and so o n). Although it functions as a personal organizer-recording your appointments and to-do list, its primary
purpose is to schedule group activities and resolve time conflicts. The product is controlled by an !NIT and is accessed through a desk accessory.
Depending on the number of participants and the level of network traffic, the
program will run on non-dedicated, dedicated, or multiple file servers. To set
it up, one person must act as the administrator, register the users (listing
their names and normal work days and hours) , designate resources, and
distribute the software to each user. The administrator also can mark company holidays in the calendar.

Public groups (lists of individuals that can be invited to meetings en masse
rather than one at a time) can be designated. This feature is particularly useful for handling departmental events or sending a meeting proposal to all
employees.
Proposing a meeting consists of four parts: the proposal (the title of the
meeting and its location); specifying required and optional guests and resources that need to be reserved (a meeting room and equipment) ; selecting
a date and time; and setting an agenda. Meetings can be in scheduled in two
ways. The first is to simply propose a time and ask the desired participants to
respond. The second is called Auto-Pick. With this feature, Meeting Maker
starts with the proposed time for the meeting and displays the first time slot
during work hours that all participants have free. Figure 9.16 shows the
schedule window for a proposed meeting.
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Figure 9.16 Scheduli ng a meeting requires juggling schedules.
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Whe n you attempt to sched ule a meeting, you are shown your own schedule
for the day (in the middle of the window), as well as that of the proposed
participants so you can select the best time. The white blocks represent occupied time slots. Required guests' schedules are shown under the black icon;
optio nal participants are shown under the gray icon. The guests and resou rces are listed on the far right. You can check this window later to see
their respo nses.
After a meeting proposal is sent to the guests, Meeting Maker mo nitors their
responses. If everyone agrees to attend, the program sends you a message to
th at effect and places a check mark in the meeting's time block on all guest's
daily calendars. If anyone declines, Meeti ng Maker will also let you know
that.
Some people have assistants who help manage our schedules. Ifyou want
them to continue in that capacity with Meeting Maker , you can designate
them as proxies. Proxies have full access to your schedule and can make or
accept meeting p ro posals o n your behalf. The o nly schedule items that a
proxy will no t be able to see in your schedule are those that you have marked
as private.
You also can use Meeting Maker as a no rmal calendar program, recording all
planned activiLit:s with it (see figure 9. 17). Doing so is almost mandatory
because other users o n the network are proposing meetings based o n what
they think are your free time slo ts. Fo r each activity you schedule, you can set
a starting time and approximate du ration, give it a title, and record additional
notes abo ut it. You can set it up as a o ne-time or a recurring activity. The title
of the activity can be kept private, and you also can mark it as "flexible"letting other users know that it can be rescheduled if they want to ho ld a
meeting at that time.
Of course, many activities are not related to a specific time slo t. You may have
to make an inventory of computer equipment in your department, fo r example. Rather than placing it o n the calendar, you can add it to your To-Do
list. At a minimum, a To-Do item must have a descriptio n o r name. Yo u also
can set a priority and mark it as personal (that is, unavailable to proxies that
you have named).
Meeting Maker has a flexible set of printing options. Calendars can be
printed to fit most personal planners. When a message arrives fro m another
user or the time for a meeting o r o ther activity is reached, you can be notified
by a message box, a sound, o r bo th .
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Figure 9.17 The calendar and To-Do List show your planned and scheduled
activities for the week.
For companies that have heavy scheduling requ irements, Meeting Maker will
quickly prove itself invaluable. (Just think ... no more running around trying
to find a time when a group of people are all free!) The program is sold in 5and 10-user packs. Each comes with an Administrator's Gu ide, User Gu ides,
and Quick Reference charts.

Summary
eminder, calendar, scheduler, to-do, and address book utilities for the
Mac continue to proliferate. With the batch discussed in this chapterand mo re introduced each month-it's getting harderand harder to come up
with good reasons for being unorganized or arriving late for appoi ntments.
In particular, you learned about the following in this chapter:

R

• Keeping track of addresses using MacPhonebook, Dynodex, Address
Book Plus, IN touch, and QuickDex II.
• Tracking appointments and things to do using Calendar and To Do! .
• Recording reminders using calenDAr, AlarmsClock, and Smart Alarms
with Appointment Diary.
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• Scheduli ng appointme nts and casks using First Things First, Alarming
Events, and Meeting Maker.
In Chapte r 10, "Connectivity", you will learn how co communicate between
Macs and PCs using file transfer software, different ways to share and excha nge data betwee n Mac programs, and about the sp ecial co nnectivity
features of System 7.

Connectivity
No Mac is an island. (Sorry, I couldn't resist.) In most offices, Macs and PCs
must coexist. Because of the supposed complexity of shuttling information
from one type of computer to the other, this coexistence often is an unhappy
one. One solution that many companies resort to is keeping projects on the
two platforms separate. Whichever machine it is created on, it stays on.
However, Apple Computer and the Macintosh development community
understand how important it is that the two machines are able to talk to each
other and work harmoniously. As a result, they have come up with a variety
of options to make this process as painless as possible.
But connectivity means much more than sharing data between Macs and
PCs. Connectivity also implies ways of sharing data and system resources
between Macs and between Mac programs too. In this chapter, we will explore several of the best connectivity solutions including the following:
• Inter-application connectivity involves moving and sharing data
between programs with cut-and-paste, the Scrapbook, Microsoft
linking, integrated programs, and using Save As ... and Export
program options to translate data between different file
formats.
• System 7 connectivity features include File
sharing, program linking, and Publish and
Subscribe.
• Software and hardware solutions for moving
data between different computers: Mac-to-Mac
and PC-to-Mac.
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Although networks also are freque ntly discussed within connectivity, that
topic is left to other books. This chapter foc uses primarily on software and
hardware solutions to the problem of data-sharing on a single Mac and be·
tween computers within the company.

Inter-Application
Connectivity
he n you think of connectivity, sharing data and moving it among
applications usually comes to mind. This sectio n d iscusses the follow·
ing tasks:

W

• Cutting and pasting using the Clipboard.
•

Using tl1e Scrapbook.

• Microsoft "linking."
•

Integrated programs (M icrosoft Works and ClarisWorks) .

• System 7 connectivity features.

Cutting and Pasting
The simplest way to move data be tween programs is to use Macintosh techniques that you are already familia r with : cutting and pasting. Yo u can copy
an Excel chart, for example, and paste it into a budget report you are prepar·
ing in MacWrite II.
To cut and paste a chart, follow these ste ps:
1. Launch Excel and load or create the chart you want to paste into
another docume nt.

2. Select the e ntire chart by selecting Select Chart from the Chart me nu.
3. Copy the chart by selecting Copy from the Edit menu or by pressing
Command-( .
4. Quit Excel and launch MacWrite II.
5. Open or create the budget document, and select Paste fro m the Edit
menu, or press Comma nd-V. (To positio n the graph, you can cente r
the paragraph in which it is located (see figure 10.1].)
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Figure 10.1 An Excel chart pasted into a MacWrite II document.
Cutting and pasting often is the most expedient way to merge different types
of data into a single document. For storing graphics and text that you frequently use, use the Scrapbook.

Using the Scrapbook
The Scrapbook is a DA that stores graphics and text. Like cutting and pasting,
the Scrapbook uses the Clipboard to transfer information into and out of
itself. To add a graphic or text block to the Scrapbook, follow these steps:
1. Select the text or graphic in the program in which it was created.

2. Copy the text o r graphic by selecting Copy from the Edit menu, or by
pressing Command-C.
3. Select the Scrapbook DA from the Apple menu and paste the text or
image into a Scrapbook page by selecting Paste from the Edit menu or
by pressing Command-V. The item is pasted into the Scrapbook.
To retrieve an image o r text from the Scrapbook, follow these steps:
1. Open the Scrapbook and click on the scroll bar arrows to find the
image or text you want.

2. Copy the item by selecting Copy from the Edit menu or by pressing
Command-C.

Connectivity
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3. Open the document in which you want to paste the image or text, and
then position the cursor where you want to paste the item.
4. Paste the image or text by pressing selecting Paste from the Edit menu
or by pressing Command-V.

NOTE: Although copied text appears in the Scrapbook in a
mono-spaced font, the appropriate fonts are restored when the
text is pasted into your document.
The Scrapbook is particularly useful for handling important graphics. Having
a clean copy of your logo in the Scrapbook, for example, makes it simple to
add it co presentations, make letterhead, print custom envelopes, and so on.
As another example, using a hand-scanner, you can scan your signature and
paste it into the Scrapbook (see figure 10.2). When you need to send a
signed document with a fax modem, just paste a copy of the signature at the
bottom of the document. Because it is stored in PICT format, the signature
can be resized as needed.

-0

Scrapbook

2 I 18

PICT

Figure 10.2 A scanned signature within the Scrapbook.

Microsoft Linking
Some programs provide their own method of imer-application communication. Microsoft, for example, devised a feature for Word called "linking." A

section of an Excel worksheet can be linked to a Word document. When you
modify that section of the worksheet, updating the link in Word causes the
changes to be transferred into the Word document.
Think of this as a type of automatic merge. An example of how this
feature works is presented below. To link a section of an Excel 3
worksheet into a Word 4 or 5 document, follow these steps:
1. Launch Excel and create or open the worksheet. For this example, load
the worksheet called Quarterly Sales.

2. Highlight the range Al through E7 (see figure 10.3).

Figure 10.3 Select the worksheet ra nge in Excel.

3. Copy the range by selecting Copy from the Edit menu or by pressing
Command-C.

4. Launch Word 4 or Word 5 and create or open your document. For this
example, load the document ca.lied Sales Memo.

5. In Word 4, position the cursor where you want to place the spreadsheet data (in this case, at the end of the document). Then paste it in
by selecting Paste from the Edit menu or by pressing Command-V. The
Excel data is pasted into the document as a standard Word table. To
create the link, highlight the table in Word 4 and select Paste Link
from the Edit menu.

Connectivity
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Link command; however, the column alignments wou ld be lose.
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If you have Word 5, rather than using the Paste command to create the
table, select the Paste Special .. . command from the Edit menu. Select
Formatted Text (RTF) as the Paste: format and click on the Paste
Link butcon (see figure 10.4). This single command simultaneously
copies the Excel data into the Word document and establishes the link.

T
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Figure 10.4 Word 5's Paste Special. .. dialog box.
After the link is established, the document should look like figure 10.5.
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Figure 10.5 Word 4 adds a non printing file id entification li ne at the top of the
table

to

ind icate it is linked.

To see linking in action, return to Excel and change a fe w numbers in the
worksheet. Then return to Word, highlight the table again, and select Update
Link from Word 4's Edit menu.
If you are using Word 5, select Link Options ... fro m the Edit menu. The
dialog box that appears enables you to specify an update option: Automati·
cally, Manually, or Never; update the link immediately by clicking Update
Now; change the li nk; or open the Excel worksheet. To see if the link is established, click on the Update Now button.

For linking to work, you always muse follow these rules.
•

When creating or updating a link, be sure that Excel and Word are both
ru nning and that che appro priate documents are open (if Excel is nae
ru nning, Word may prompt you for ic).

•

Highlight the entire table in Word when pasting and updating links
(highlighting just pare of the table results in a mish-mash).

•

Remember to update the link in Word each time you want to print a
new copy of the document.

Some other programs o ffer their own version of linking. Multi-Ad Search, a
graphics o rganizing utility, has a feature called ITCH that allows images in its
database to be linked into QuarkXPress documents. Graphics and tex"t that
are p laced rather than copied into a PageMaker d ocument can be upd ated
automatically or manually when the source documents change.

Using Integrated Programs
Integrated p rograms are all-in-one applicatio ns, originally popularized o n the
IBM PC. Rather than buying a separate word processing program, spreadsheet, database, and graphics program-each with its own unique command
structure and interface-you buy a single package that contains all of these
programs. Because the program modules are designed to work like and with
each ocher, there is no need to learn four completely d ifferent programs. And
there is sufficient similarity between modules so that fewer commands and
skills need to be mastered. For these same reasons, integrated programs offer
an easy and inexpensive entry into business computing.
Integrated programs also have another advantage over scand-alone programs-passing, linking, and reusing data tends to be easier, particularly
because many of the programs are designed with this in mind.

Connecrivity
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Although there are now several integrated programs for the Mac (and more
on the way), this discussion foc uses on two of the most popular: Microsoft
Works and ClarisWorks.

WORKING WITH MICROSOFT WORKS
Microsoft Works was the first successful integrated program for the Mac and
was responsible for introducing thousands of users to computing. As such, it
also has the widest support-there are dozens of books and templates available for it. The program contains four modules: word processing,
spreadsheet (with charts), database management, and telecommunications.
Rather than make graphics a separate module, the drawing mode can be
switched off or on by selecting the appropriate command from the Edit
menu. The graphic tools can be used to enhance word processing and
spreadsheet documents. Tools are provided fo r a variety of shapes, lines, and
fill and pen patterns. Draw mode also enables you to create arrows and align
text to follow any straight or curved Line. All other integration between the
modules is handled through cutting and pasting.
Figure 10.6 illustrates many of the program's capabilities. This form letter
contains a graphic letterhead, fields for a mail merge with a customer database, a small portion of a spreadsheet with graphic highlights, and a bar
chart.
Program features of interest include the following:
• Word processing. Linked text columns; spell checking (see figure 10.7);
colored text; text can be made to follow any line shape-straight,
angled, or curved; mail merge; separate formatting for each paragraph.
• Database. Spreadsheet-style lists or custom layouts; computed fields
and functions; field types; split windows; multiple record selection
criteria (AND and OR supported); report generation.
• Spreadsheet. Dozens of built-in functions for math, statistics, date/time,
and finance ; protected cells; cell borders; rows and columns can be
transposed; split windows; charts (2D only) ; cell notes.
• Communications. Each communications settings document can store
numbers for up to eight information services; supports speeds up to
19,200 baud; automatic text capture option.
• Graphics. Arc tool; fill and line patterns; color support; arrows; nudge
graphic by one pixel in any direction using the arrow keys; object
grouping; objects can be frozen so they cannot be selected.
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Figure 10.6 This word processing document illustraces many of the feacures
available in Microsoft Works.
• General. Macros (records keystrokes and mouse clicks); files can be
saved as stacionery; print preview.
The communications module is the weakest component of the program. The
only nontext file transfer prococol supported is XMODEM. And although
spreadsheet cells can each contain any number of styles, only one font is
allowed for the entire spreadsheet.
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Figure 10.7 When adding new words co the spelling dictionary, you can
specify all allowable variants simultaneously.

WORKING WITH CLARISWORKS
ClarisWorks from Claris Corporation is part of a new breed of integrated
software. The integratio n provided in early programs often was in name only.
That is, programs consisted of the typical modules (word processing, data·
base, spreadsheet, and-optionally-graphics and communications).
However, moving data between documents was possible only through the
normal cut-and-paste procedures. Modules essentially were separate programs wich separate cools, features, and procedures.
ClarisWorks, on the o ther hand, allows you co use graphic, spreadsheet, and
word processing tools without having to switch modules. Figure 10.8 shows
a one-page report created entirely in the graphics module. It includes graphic
Lines, linked text boxes (text flows aucomatically fro m one box into the
o ther), a spreadsheet, and a bar chart.
Within a graphics document, for example, you can select the spread sheet tool
and create a new worksheet. As lo ng as the worksheet is selected, the menu
bar changes to provide you with the appropriate commands-to insert formulas, create charts, and so o n. Clicking on the graphics tools again enables
you tO continue creating or modifying graphic elements in the document.
The ClarisWorks modules include word processing, spreadsheet (with
charts), graphics, database, and communications. If you are familiar with
some of Claris' stand-alone programs, you will have a head start on learning
to use ClarisWorks. The word processing program is based on MacWrite, the
database o n FileMaker, and the graphics program on MacDraw.
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Figure 10.8 The graphics and word processing modules enable you to
incorporate elements of the other modules just by selecting the appropriate
cools and creating new frames.
The modules include a solid feature sec:
• Word processing. Separate margin and tab settings for every paragraph;
automatic footnote placement and renumbering; spell checking;
thesaurus; view multiple pages side-by-side; multiple columns; mail
merge.
• Graphics. Scaling by percentages; arrows; arcs; grouped objects; object
alignment comqrnnds; fill and pen patterns and colors; object flipping
and rotation.
• Database. Multiple layouts per database; view as List, custom, or
automatic layout; calculation fields; specify tabbing order; record
selection and searching.
• Spreadsheet. Paste functions; variable column widths and row heights;
multiple fonts and sizes; 3-D charts; cell borders.
• Communications. Save connection sheets for unlimited communication services; capture incoming text; protocol file transfers.
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Several important features are available in most modules and include macro
recording (done by tracking your keystrokes and mouse maneuvers) , viewing
documents in several magnifications, and horizontal and vertical split
windows.
Although not a page layout program, ClarisWorks is suitable for creating
newsletters and ilJustrated reports. Like Microsoft Works, its most noticeable
weakness is in the communications module. Although XMODEM file transfers
are supported, d1ere are no other protocols, such as YMODEM or the popu·
larZMODEM.
The word processing module contains an interesting feature that
isn't normally available in such programs. It's possible to print text
over graphics. Most word processing programs treat graphics as
solid objects dlat must be wrapped around or appear as separate paragraphs.
By placing a PICT graphic of the word DRAFf or CONFIDENTIAL on each
page, you can use your laser printer to effectively rubber stamp each page
with a message.

Draft (see figure 10.9) and Confidential are ClarisWorks word processing
stationery documents. Each contains a single graphic image of the particular
word. To use d1e stationery, simply open one of the documents and enter the
text for your letter, memo, or report.
Because ClarisWorks does not support the concept of a "master page," if your
document runs more than one page, you must copy the image (DRAFf or
CONFIDENTIAL) and place it on all additional pages. To copy a graphic in
ClarisWorks, follow these steps:
1. Select the Graphic tool (the pointer) from the Tool palette. (If the Tool

palette is not visible, click on the Show/Hide Tools icon at the bottom
of the page).
2. Click o n the graphic to select it, and select Copy from the Edit menu
or press Command-C.
3. Move to the page in which you want to insert dle graphic, and select
Paste from the Edit menu or press Command-V.
4. Reposition the graphic as needed by clicking on the center of the
graphic, and then dragging it to the new position.
To print correctly, each graphic must be behind the text. Before printing,
use the graphic tool to select each image and select Move to Back from
the Arrange menu. To return to text mode when you finish manipulating
the graphics, select the Text tool from the palette (the capital 'A').
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Figure 10.9 Because the modes are so tightly integrated, it's possible to add
a graphic be hind a page of text.
The Draft and Confidential graphics were created with the Smart Art I desk
accessory from Adobe. After each image was created, it was exported as a
PICT graphic. The options used for each were as follows:

Draft-Text= Draft; Font= Helvetica-Black; Size = 120 point; Outlining?=
No; Track Kerning

= 10; Text Gray = 10%; Text Angle = 27 degrees.

Confidential-Text = Confidential; Font = Helvetica-Black; Size = 72 point;
Outlining? = No; Track Kerning = O; Text Gray = 10%; Text Angle = 4 5
degrees.

Connectivity

A larger point size and spacing between letters (track kerning) was used for
DRAFf to increase it's size and the amount of space it would take up on the
page. The point size was decreased, kerning eliminated, and the angle increased for CONFIDENTW. to fit on the page.
Again, when using either of the images in a ClarisWorks word processing
document, it is important to place the image behind the text. Postscript
printers, such as the Apple LaserWriter, always print in layers-fro m the back
to the front. Placing the image behind the text tells the printer to first print
the graphic and then print the text over it. If the o rder is reversed (text in
back and graphic in front) , the printer will print all the text first and then
print the graphic over it-obliterating the text beneath.
If you want to change the wording, font, size, rotation, or color of the background images, you will need to create your own in Smart Art or o ne of
several other commercial font styling programs (see Chapter 5, "Making a
Point" for additional information) . The preceding formatting options can be
used as a starting point for re-creating the two images.
This same technique also can be used in ClarisWorks to print any kind of
image behind text. You may, for example, design letterhead or a logo in the
graphics portion of ClarisWorks that prints behind your text. As with the
DRA.IT and CONFIDENTIAL examples, however, be sure that the graphic
uses a light pattern or gray shade to avoid overpowering the text.

PICK A PROGRAM-ANY PROGRAM
Both Microsoft Works and ClarisWorks acco mplish their intended goals. They
are easy to learn and use, and they provide the major functio ns needed by
most business users- all in one comprehensive package. Of the two programs, however, ClarisWorks offers tighter integration and the most power.
And because the database, word processing, and graphics modules are based
o n o ther Claris products (FileMaker, MacWrite, and MacDraw), you will find
it relatively painless to move up to those more powerful programs, if your
needs change.
Microsoft Works, on the other hand, has a huge installed base of contented
users-all of whom are accomplishing their work without a great deal of fuss
or muss. Note, however, that you r choices aren't limited just to these two
packages. Other recently released integrated programs you should also consider include BcagleWorks and Great Works.

File Translation within Mac Programs
As you will see later in this chapter, there are many excellent programs for
converting Mac file formats and for translating between Mac and PC formats.
The simplest type of conversion, however, is already available as an o ption
within many Mac programs that you now own.

Among word processing, spreadsheet, database, and graphics programs, it's
not uncommo n to support multiple file forma ts-either as a Save As or an
Export command. To convert a file to an appropriate PC format, simply save
it using that format in your Mac program, and then transfer it to a DOS disk
using Apple File Exchange, DOS Mounter, MountPC, or AccessPC (these
programs are discussed later in this chapter). You also can move the file to
the PC as an unaltered binary file with one o f the Mac-to-PC transfer pro grams or a standard telecommunications program.
Similarly, you can use the Save As o r Export options to save files in other
Macintosh formats. Yo u may, for example, save a spreadsheet in Text format
so that you can read it into a word processing program or database. You also
can change to a specific format so that a co-worker using Excel, for example,
can o pen a spreadsheet you created with a different spreadsheet program.
Normal
v"Normal
Templat e
Eucel 2.2

IO

SYLK
Teut
CSU
WKS
WKl
WK3
DIF
DBF 2
DBF 3
DBF 4
Teut (Windows)
Teut (O S/2 or DOS)
CSU (Windows)
CSU (OS/ 2 or DO S)

Figure 10.10 Lf you want to save a file in an alternate format, Excel 3.0 offers
these optio ns.
The other factor to be aware of is that many of these same programs are
capable o f loading files in alternate forma ts. In those cases, no conversion is

Connectivity

----The 9-to-5 Mac

T

necessary. just open a MacWrite file with Microsoft Word and the conversion
will happen automatically.

System 7 Connectivity
ystem 7 contains several features designed to enhance data sharing and
inter-application connectivity, including file sharing, program linking,
and publish and subscribe.

S

File Sharing
File sharing enables any or all Macs connected over an AppleTalk network to
act as file servers. Any file, folder, or disk on a Mac that is designated as
shared can be used by any other person on the network. You specify which
users can and cannot have access to your system, as well as the privileges
each is granted.

SEnlNG UP FILE SHARING: THE HOST
To set your Mac up for file sharing, just fo!Jow these steps. (This assumes that
you have a full-rather than a minimal-insta!Jation of System 7. A full installation assures you of having the correct Control Panel devices, Chooser
options, and extensions available.)
1. Turn on AppleTalk by opening the Chooser and clicking on the Active
button.

2. Open the Sharing Setup control panel, identify your system by
completing the Network Identity part of the dialog box, and turn file
sharing on by clicking on the appropriate Start button (see figure
10.11). Starting sharing in this manner indicates that you want to allow
others to use your data files.

NOTE: If you only want to share files on someone else's Mac, you only
need to complete the Network Identity portion of the dialog box. File
sharing does not have to be turned on.
3. To register users and/or groups-giving them access to your system,
open the Users & Groups Control Panel and select New User or
New Group from the File menu. (I'his step is optional.)
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Figure 10.11 To allow files on your system to be shared by others, you must
first turn on file sharing.
4. Next, select the ftles, folders, or disks you want to share by clicking on
them, and then select Sharing .. . from the Finder's File menu. A dialog
box appears (see figure 10.12). Click on the Share this item and its
contents check box. If you want, you can use the middle portion of the
dialog box to set restrictions for groups or individual users.
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Figure 10.12 Use this dialog box to specify group and individual access
privileges for your shared files, folders, and disks.
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SETIING UP FILE SHARING: THE USER (GUEST)
To use someone's shared data, follow these steps:
1. Open the Chooser and select AppleShare . The names of all systems

that have set up file sharing as described above should appear in the
file server window on the right (see figure 10.13). Select the system
you want to connect with and click on the OK button.
~

fife

Cdll

thoour
~

Select a me server.

Figure 10.13 Your first seep as a would-be user is to select AppleShare and
select a file server.
2. To be allowed to link up with the other system, you must log o n as a
guest or a registered user (someone that the owner of the Mac has
defined as registered-see Step 3). Selecting a file server in the
Chooser will display the log-on dialog box automatically.
3. You are prompted co select the disks and folders that you want to use
(figure 10.14). Make your selection and dick on the OK butto n.
Now comes the exciting part. An extra drive will appear on your
Desktop-the one belonging to the user who's system you are sharing.
In this example, the drive is called HD (figure 10.15).
Depending on the access privileges you have, you can load the other user's
documents into your programs, save them to your o r the shared disk, and
delete files on the shared drive. You also can copy the other person's files to
your disk using standard Finder copy procedures.

Fil~

Ed1l
Chuo~ei

Select the Items you won! to use:

Checked Ite ms ( 181) will be opened ot
syst em stortup t i me.

Figure 10.14 Select the item(s) you want to use and click on OK to complete
the log-on procedure.
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Figure 10.15 After you successfully log on, you can open shared files and
drives as though they were your own.

MONITORING AND AD.JUSTING
During a session, the person who has set up file sharing can see who is using
his or her files and can check the level of activity. Opening the File Sh aring
Monitor Control Panel displays the information shown in Figure 10.16.
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File Sharing Monitor
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Idle

Disconnect

Busy

Figure 10.16 The File Sharing Monitor shows who is using your Mac and gives
a graphic indication of how busy your system is.
From this window, yo u can disconnect individual users by highlighting their
names in the Connected Users window and then clicking on the Disconnect button. If you want co disconnect all users, che simplest way is co
reopen the Sharing Setup Control Panel and click on the Stop button.
Whether disconnecting one or all users, you can specify a time delay before
the disconnection takes place-giving users an opportunity co finish their
work.

Program Linking
Program linking allows some programs co exchange data with others on the
network. To invoke program linking, open the File Sharing Control Panel
again, and click on the Start buccon for che feature.
You need co determine which programs you want co link. To do chis, select
chem in the Finder and then select Sharing ... from the File menu. Program
linking isn't supported by all programs. If the program allows linking, you
will see a check box ac the bottom of the resulting dialog box, (see figure
10.17). If not, the check box and it's message are dimmed.
Handling the linking (the data exchange) is the responsibility of the linked
programs. Check their manuals for the appropriate commands and procedures.

Publish and Subscribe
Publish and Subscribe is very similar to che linking feature supported by
many Microsoft programs (see "Microsoft Linking" in this chapter). It allows
documents, text blocks, and graphics to be linked co a master document.

When the linked data is changed, the revised data can be manually or auto·
matically read into the main document.
10 - CanOpener'" 2
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[8J Allow rtm0 t• pr09ram linld"9

Figure 10.17 CanOpener 2 allows remote linking.
Although a feature of the System software, Publish and Subscribe must be
specifically supported by your programs if you want to use it. Publishing an
item makes it available for use by other programs on your Mac, as well as by
other users on the network. The following is an example of how you may use
Publish and Subscribe to create a group report.

PUBLISHING 1-2-3 CHARTS FOR INCLUSION IN
AN ACTA 7 OUTLINE
Some projects require input from several people. Suppose, for example, that
you want to create a budget report that contains expense breakdowns for
every department in the company. The usual way of doing this is to gather
information from each department and then arrange it all in a single master
report. This, of course, would require that each piece of the report be cut
from its original document and then pasted into the master.
As long as the Macs are all on a network and the programs used to create the
pieces of the report all support it, Publish and Subscribe is the ideal mechanism for assembling the data from the department heads. Here's how the
process goes:
1. The project coordinator creates a 1-2-3 spreadsheet template and drafts

instructions for how it should be filled in. The spreadsheet is distributed to each department head.
2. Each department head completes the worksheet and creates a 3-D pie
chart that shows a percentage breakdown for departmental expenses.
3. Each department head selects the 1-2-3 chart and selects Publishing
Create Publisher from 1-2-3's Edit menu. The dialog box shown in
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figure 10.18 appears. Nami ng the edition and clicking Publish makes
the chart available for the Publish and Subscribe p rocess.
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Figure 10.18 Publishing an object or text block requires only that you select
it, select the appropriate Publish option in your application, and create a new
edition for it.
4. Optionally, the creator of the chart can decide how and when the
published edition should be updated (figure 10.19): each time the
document is saved , manually (only when the changes are ready for
viewing by subscribers) , o r right now ("Send Edition Now'').
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Figure 10.19 This 1-2-3 dialog box enables you to specify when new versions
of the published edition should be made available to su bscribers.
5. The project coordinator creates an Acta 7 outline and inserts a header
for each department. After one or more of the charts are created, the

coordinator incorporates them by clicking in the appropriate spot in
the Acta outline and then selecting Subscribe To ... from Acta's Edit
menu (see figu re 10.20).
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Figure 10.20 Here's the published chart fro m the Technical Support Depart·
ment after it is subscribed to in the Acta 7 outline.
You have just seen a simple example of how Publish and Subscribe can help
coordinate a team project. This featu re also can be used by a single Mac to
link data from several documents and different programs into any master
d ocument. After more of the major programs support Publish and Subscribe,
the routine cutting and pasting you currently do to merge different documents will- in some cases-no longer be necessary. It is particularly useful in
linking graphic images with text documents, for example.

Moving Information Between
Computers

T

his sectio n discusses the current crop of connectivity programs-software designed t0 transfer files between machines: PCs and Macs, pairs of
Macs, and between Macs and no n-DOS computers.

Although o rganizing this section accordi ng to what you want to do makes
sense, the capabilities of the programs overlap considerably. This would
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result in much repetitious material being presented. To avoid referring you
to different parts o f this chapter for a discussion of MacLinkPlus/PC, for example, each program is covered separately. At the beginning of each program
section, its basic capabilities and uses are listed so that you easily can tell if
the program is worth further exploration.

Apple File Exchange
Beginning with System 6, Apple included a file translation program with the
System software called Apple File Exchange. Using the SuperDrive (Apple's
high-density floppy drive) , it enables files to be converted from PC to Mac
formats and vice versa. Because the SuperDrive is capable of reading and
writing PC disks (both 720K and 1.44M), File Exchange uses the drive as the
means of moving data between the two machines.
File Exchange comes with a handful of translators. Other programs may provide their own translator files. MacLinkPlus(franslators from DataViz, for
example, comes with a wide variety of File Exchange-compatible translators.

Word for Word/Mac
Word for Word/Mac by Mastersoft is a dedicated program for translating files
from one Mac format to another and between foreign formats (primarily PCs
and Macs). As its name implies, Word for Word/Mac specializes in converting
word-processing fi les. Popular spreadsheets, such as Excel and 1-2-3, are
supported as well. By itself, the program contains no transfer capabilities. To
move files between systems, such as a Mac and a PC, you must transfer them
via modem, Apple File Exchange, or one o f the other programs discussed in
this section.
The program has few o ptions, so it's extremely easy to use. To convert a file,
follow these general steps:
1. Select a pair of "From" and "To" file formats. (Figure 10.21 shows the
supported formats.)
2. Select a source file and a destination folder.
3. Click on the Convert button to perform the translation.
You can select several files to convert simultaneously. However, each file
must use the same set of translation formats. You also can select who le folders for processing-assuming that you need to convert all of the d ocuments
enclosed with in. Refer to figure 10.22 for a peek at the program in action.

Com Form11t
DisployWrite & DCR-RFT
EBCDIC
EHcel 2.1
FullWrite Professional 1.H
lotus 123 1R, 2.D
lotus Manuscript 2.0, 2.1
MocWrite 4.H, 5.0
MocWrite 11 1.0
Moss- I I
Microsoft Word 3.0 Moc
Microsoft Word 3.H, 4.H, 5.H
Microsoft Word 4.0 Mac
Mul tiMote
OfficeWrlter
PFS
Rich TeHt For mot
WordPerfec t 4.1 , 4.2
WordPerfec t 5.0, 5.1
WordPerfec t Moc 1.D
WordStor 3.H thru 6.0
HyWrite Ill

•
••
•
••
•
••
••
••
••

•

RSCll
Com Format
OisployWrite & DCR- RFT
EBCD I C
EHcel 2.1
Lotus 123 1R, 2.D
Lotus Manuscript 2.D, 2. 1
MocWrite 4.H, 5.0
MocWrite 11 I .D
Moss- 11
Microsoft Word 3.0 Moc
Microsoft Word 4.0 Moc
Microsoft Word PC
MultlMote
OfflceWriter
PFS
Rich TeHt Format
WordPerfect 4. 1, 4.2
WordPerfect 5.0, 5. 1
WordPerfect Mac 1.0
WordStar 3.H thru 6.0
HyWrite 11 1

•

••
••
••
••

Figure 10.21 This is the list of currently supported Word for Word/Mac file
translation formats.
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Figure 10.22 Three Macincosh Microsoft Word 4 documents are selected fo r
conversion co XyWrite Ill, a powerful PC word processing program.
You can define a naming co nvention for converted files (normally this is
done automatically by abbreviating the format name and following it with the
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original file name) and also decide how exceptions should be handled. Ex·
ceptions are parts of files that cannot be converted. You can choose to ignore
them, embed three-letter codes in the output document, or create a separate
file which lists the exceptions.
One difficulty you may have with Word for Word/Mac is that no filtering occurs within the file lists. Selecting WordPerfect Mac in one of the lists does
not eliminate all non-WordPerfect files from the list. You must know the
format of every ftle you intend to convert. In many cases, you must also know
the version number of the word processing program that created the file.
This can occasionally be a real problem on the PC side, because the more
popular programs may have four or more supported versions-each one with
a separate translator routine.
Still, if all you really need are a strong set of word processing translators,
Word for Word/Mac is definitely worth considering. lf you are using one of
the newer word processing programs (one for Windows, fo r example), it's a
good idea to check first to see if the current version of Word for Word/Mac
supports it.

Using MacLinkPlus/PC
MacLinkPlus/PC from DataViz, Inc. is an all-around program fo r file transfers
and translations. Files can be moved in any direction between Macs and PCs,
Macs and Sun or NeXI' workstations, or any pair of Macs.
To assure as little information loss between systems as possible, MacLinkPlus/
PC includes several dozen ft.le translators, that enable you to easily convert
between most word processing and spreadsheet formats.

MAKING THE PC AND MAC CONNECTION
Using the supplied serial cable or a pair of modems, you can connect an JBM
PC or compatible co your Macintosh. Separate versions of the MacLinkPlus/PC
program are included for the t\vo machines. After starting the programs, the
first step is to set matching communication parameters (port, baud rate,
method of connection, and so o n). Using the cable, most systems can communicate at speeds of up to 57,600 baud. To get the two systems to link up,
you simply tell one of the programs co connect with the other (or to dial, if
you are using modems). Transfers may be initiated from either program,
regardless of the direction in which the files arc being sent.

After the connection is established, you can begin performing transfers. To
transfer files, follow these general seeps:
1. Select a transfer direction (PC-co-Mac or Mac-co-PC).

2. Select an appropriate pair of translators for converting the file.
3. Select the file you want to transfer.
When selecting a translator, the moment you select a file type from either rhe
Mac or PC list, appropriate matching translators appear in the other list.
Incompatible formats are eliminated automatically (see figure 10.23). A typical transfer is shown in figure 10.24.
:;; File Edl1

Preferences

Log
Cubie to IBM PC

0

Sel ect
Files

Macllnk Mode
MocWrlte II

®

•mmu.uw o

Word (PC)

Macintosh Formats

Remote IDM PC Formots

FromeMaker (MIF 2.0)
FrumeMaker (MIF 3.0)
MacWrlte
Macllfr ile II
Word (for MS- DOS)
Word 3.0
Word 4.0

TIFF (Remote)
Uenturo Publisher (GEM)
Uenturo Publisher (IM6)
Windows Bitmap IBMP)
Word for Windows
WordPerfect (WP6)

[ Clear Selection ]

Figure 10.23 Selecting a pair of translators in MacLinkPI us/PC.

READING FILES WITH DOS MOUNTER
MacLinkPlus/PC also includes a copy of Dayna Communications' CDEV called
DOS Mounter. After it is installed in your System folder, you can insert a
3.5-inch DOS disk into a Mac SuperDrive and its files are treated as any other
normally mounted Mac files. You can use the Macintosh version of Excel or
1-2-3 co read and save DOS versions of spreadsheets directly onto a DOS
floppy disk- without running a transfer program. These files also can be
copied from the Finder, enabling you co move them from the DOS disks o nto
a Mac floppy or hard disk.
In addition co allowing you co mount DOS disks as though they were Mac
disks, DOS Mounter enables you co assign creators and types to DOS files
(see figure 10.25). Because Lotus .\VKS and .WKl files are redefined to be
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1-2-3 for the Macintosh files, double-clicking on them launches the proper
program automatically.
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figure 10.24 This cransfer (controlled from the Mac) takes a Microsoft Word
file fro m the PC, converts it to MacWrite II fo rmat, a nd the n transfers it to the Mac.
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figure 10.25 Reassigning file creators and types with DOS Mounte r.

AND STILL MORE•.•
Other features of note include:
• The capability to link two Macs (by cable or modem) for quick file
transfers.
• Translators are compatible with Claris translators and also can be used
by Apple File Exchange.

• A terminal mode that enables you to connect to other systems that do
not use MacLinkPlus/PC (such as mainframes), acting as a teletype
terminal with fu ll transfer and file translation support.
MacLinkPlus/PC is truly an "everything" file transfer and translation program.
Although it does not enable you to run programs that are on other PCs and
Macs, it does virtually everything else that an office may need in terms of file
exchange. The program is a snap to set up and use. Bear in mind, however,
that many translated files may require some clean-up. Features that exist in
one program (tables, for example) are replaced by a best approximation in
programs that don't offer that feature. Fonts, too, may be changed. DataViz
also offers versions of MaclinkPlus for transferring files between Macs and
Wang VS, Wang OIS, and NBI systems.

File Translations and File Transfers with
Laplink Mac Ill
Laplink Mac Ill from Traveling Software is a speed demon whe n it comes to
file transfers between Macs and PCs, as well as between pairs of Macs. With
the included direct connect cable, you can transfer files between a Mac and a
PC at a rate of 115,000 baud. By purchasing an inexpensive accelerator (approximately S30) from Traveling Software, Mac-to-Mac transfer speed can be
boosted to 750,000 baud!
Transfers between Macs and PCs can be done using the included cable or a
pair of modems. Mac-to-Mac transfers can use the same cable, two modems,
or AppleTalk. Unlike some of the other connectivity programs, Laplink Mac
Ill enables you to transfer entire groups of files at one time, as long as they
are all in the same format.
Laplink is long on features that simplify the transfer process. On the PC side,
you can use the View command to check the contents of any file before you
transmit it and to examine any file received from the Mac. File lists on both
systems can be arranged in several ways to make it simpler to find the files of
interest. Options are provided to display the two file lists as a straight list or a
tree, to select which files should appear and which files should be hidden, to
find and mark files for transfer, and to sore the lists. There also are options
for dealing with duplicate files. You can ask Laplink to confirm all overwrites, or to overwrite with newer files only.
There also are file and folder/directory options that you will find he lpful,
including renaming files, folders, and DOS directories; deleting files; and the
capability to make new folders and directories. Because these operations can
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be performed on either computer from either computer, be sure to get your
co-worker's permission before moving, renaming, or deleting his or her data.
The translation routines provided with LapLink Mac Ill are restricted to word
processing files and are mainly for converting among the most popular PC
formats, rather than from Mac to PC or PC to Mac format. (Given LapLink's
lo ng history as a PC product, this isn't too surprising.) All translations must
be performed by the PC version of the program-either after a Mac file is
received by the PC or before a PC file is transmitted to the Mac. The only
Macintosh file format supported by the translators is MacWrite II . Thus, to
transfer any non-MacWrite file, you must translate the file in its original pro gram by saving it in MacWrite II format, or have a compatible receiving
application on the other system.
If you don't have matching applications on the two systems or do not want to
convert everything on the Mac side to MacWrite format, you may not be delighted with L1pLink's translation capabilities. Other translator programs
discussed in this chapter (Apple File Exchange, MacLinkPlus(franslators, and
Word for Word/Mac) can help you fill in the translation gaps.

NOTE: Although the Mac version of the program doesn't provide
translators, you can assign file creators and types to incoming PC
files so that they are mapped to the proper programs when you
attempt to launch them.
As an example of how L1pLink works, to move a Macintosh Microsoft Word
document to a PC that also is running Word, follow these general steps:
1. Load the d ocument into the Mac version of Word and save it in
MS-DOS Word format.

2. Launch L1pLink and select the file to be transferred. Click on the Copy
button to begin the transfer (see figure 10.26).
3. If the Mac version of LapLink contains a record of the Creator and Type
codes, it attempts to map it to the appropriate PC file type and execute
the transfer. If not, the Mappings ... window appears and prompts you
to indicate the appropriate file type (see figure 10.27).
Mac-to-Mac file transfers also can be performed. This is particularly helpful
when you want to move large numbers of files from one machine to another
without using floppy disks, tapes, or other media as the intermediary.

If you want, you also can set the Connection option to "Self." This displays
your system in both of LapLink Mac Ill 's file lists. This feature enables you to
quickly select files for copying from one directory to another or from one
disk to another (see figure 10.28).
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Figure 10.28 The Mac portion of LapLink also enables you to communicate and copy files freely from one part of your system to another.
One final Mac-to-Mac transfer program is included that is particularly useful
for moving files between a Desktop Mac and a Mac Portable or PowerBook.
The program is called SCSI Disk Link and enables you to transfer files between the systems over a SCSI cable. Essentially, the program makes the
attached portable look like just another hard disk in the SCSI chain. After
connected, you can use the Finder to move files between the systems.

Running a PC from the Mac with RunPC
RunPC fro m Argosy Software enables you to take control of an IBM PC or
compatible from a Mac, running DOS programs in a Mac window. Under
Multifinder or System 7, this means you can run DOS programs in one window (using the PC's processing power) while running Mac programs in other
windows. Other included software enables you to perform batch file transfers
between machines. translate document formats, and mount DOS disks on the
Mac Desktop.
The Mac and PC can be connected by the included serial cable or with modems. Each mach ine has its own version of RunPC software. To start a
session, you execute the PCHOST program on the PC. After configu ring the
program-setting the baud rate, port to use, and so o n-a TSR (Terminate
and Stay Resident program) is loaded into the PC's memory and the PC waits
for the Mac to connect with it.

To make the connection, load RunPC on the Mac and select matching setup
parameters. After the machines are in sync, the connection is made automatically. Speeds of up to 57,600 baud are supported. You also can specify how
PC graphics, boldface, highlighting, inverse and blinking video, and some
keyboard mappings should be interpreted by the Mac. If the screen gets
scrambled, the Mac version of RunPC has an option to redraw the screen.
RunPC gives you a window to whatever is happening on the connected PC.
In figure 10.29, a benchmark program is being run on the PC. The function
and cursor key icons at the top of the window enable you to use the Mac's
mouse to emulate PC keys that you may not have on your Mac keyboard.
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Figure 10.29 Ru nPC in action.

NOTE: You should expect to do some tinkering with parameters
in the Mac program before the machines get on good speaking
terms. Some highlight colors on the PC, for example, will not
show up on the Mac. Low memory situations also can be problematic.
After the machines are connected, any command you type at the DOS prompt
on the Mac screen is carried out by the PC. You can run programs, issue DOS
commands, and even reboot the PC. A "chat mode" can be used by the operators of the two systems to send messages to each od1er.
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RunPC comes with a program called Software Bridge (see figure 10.30) that
enables you to translate files from o ne format to another. It supports a wide
variety of Mac and PC document formats, and the translators are compatible
with Apple file Exchange. The Software Bridge interface makes it easy to
select individual files or groups of files for transfer. The Get Info ... button
provides basic info rmation about any highlighted file. Clicking on the
Select ... button enables you to specify translatio n pairings and the direction
of the translation.
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Figure 10.30 The Software Bridge Document Manager window.
During a session, if you execute the PC's XFER program from a keyboard
(without specifying any parameters o r additional instructions) , Software
Bridge is launched on the Mac automatically. File transfer instructio ns-in
either direction-can then be issued. There also are two XFER commands
d1at enable batches of files to be transmitted without invoking Software
Bridge.
Typing XFER * . WK1 TO REMOTE from the PC's keyboard, for example,
transfers an entire directory ofLotus 1-2-3 spread sheets to the Mac. A similar
command can be used fro m the Mac to transfer a group of files to the PC.
When a PC file is transferred to the Mac or a PC disk is mounted on the Mac's
Desktop, files of unknown types are identified as Software Bridge files.
Double-clicking on one of them causes Software Bridge to attempt to translate the file and d1en launch the appropriate Mac application.

RunPC also includes a CDEV called MountPC. After MountPC is installed,
DOS floppy disks inserted in the Macincosh SuperDrive are mounted on rhe
Desktop automatically. Every file on an inserted disk is identified as a particular type of Macintosh file or, if the file type is unknown, is assigned a generic
Software Bridge "PC" icon. MountPC also enables you to set the creator program and file type for any DOS ftle name extension.
The following are other RunPC program features you may find useful:
•

Printing from PC applications can be directed to a printe r attached to
the PC or co your Mac. If you own a LaserWriter or other PostScript
printe r, selecting that type of printer in your PC program enables the
correct informatio n to be sent to and interpreted by your laser printer.
If the PC program doesn't provide the right type of printer driver but
does support the IBM Proprinter (a common printer) , RunPC contains
an ''Emulate IBM Proprinter" Page Setup ... option that can be used
to interpret the data and send it tO an lmageWriter or LaserWriter.

•

PC data can be copied to the Mac Clipboard eithe r as text, a table, or a
picture, and then pasted into Mac documents.

Mounting DOS Disks with AccessPC
If your main concern is making DOS files easily accessible to your Mac,
AccessPC from Insignia Solutions, Inc. is a solution worth exploring. Like the
MountPC and DOS Mounter CDEVs discussed previously, AccessPC is a Control Panel De vice that enables you to perform the following tasks:
•

Mount DOS disks on the Mac Desktop.

•

Assign a Macintosh creator and file type co each DOS file name
extension.

•

Copy files between Desktop-mounted DOS disks and Mac disks.

•

Double-click on DOS file icons and launch an appropriate Macintosh
program.

The CDEV and other included utilities can do much more. First, AccessPC
optionally can rake over the standard Finder disk formatting command.
When you insert a blank disk or select Erase Disk from the Finder's Special
menu, AccessPC's formatting dialog box appears (see figure 10.31). Sup·
ported formats include low- and high-density 3.5-inch and 5.25-inch MS-DOS
floppy disks. You must have a supported inte rnal or external floppy drive,
such as the Apple SuperDrive (or FDHD); the PLI SuperFloppy 1.4; the
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Kennect Drive 360, 1200, or 2.4 connected by the Rapport Interface; or an
Outbound portable with an FDHD-compatible drive.
nccessPCS MS-DOS Disk l nlllollzollon

T

~
( MS-DOS

Choose rorma t :

I(

Moc

I nrr=c=o=
nc....
el~.

Figure 10.31 Pick a fo rmat: MS-DOS or Macintosh.
Assigning file creators and types is done within the CDEV (see figure 10.32).
AccessPC includes several data files that help you define creators and types
for programs such as MacWrite II and Wingz. Od1er options enable you to
decide which Mac-specific information, if any, is written to DOS disks,
whether AccessPC disk formatting options or d10se of the Mac operating
system should be used, and if DOS hard disks created by SoftPC (a compan·
ion product that emulates a PC on the Mac) can be mounted and
manipulated.
!!D

Con tro l P11nel

Figure 10.32 All AccessPC options are set in the CDEV.
Another CDEV called Multi-Driver adds support for DOS-formatted removable hard disks and magneto-optical cartridges (Bernoulli, Ricoh, SyQuest,
MaxOptix, M.o.s:r., and Sony formats). Multi-Driver replaces your current
removable or cartridge driver and lets you mount Mac or DOS cartridges on
the Desktop.
Media Formatter, an application included with AccessPC, can be used co
test, partition, and format most types of Mac hard disks, SyQuest or Ricoh

cartridges, and magneto-optical cartridges. When fom1atted with this utility,
Multi-Driver adds fast disk caching for the drive and a math speed-up routine.
AccessPC offers a simple elegant solutio n to getting DOS files on the Desktop. You should note, however, that it does not contain file translation
routines. Assigning a creator and type to a DOS file icon only serves to link it
to a Mac application. If the Mac program cannot read DOS files, then you still
won't be able to use the file until it is translated into an acceptable fo rmat. If
translation is required, you must use a translator program, such as Apple File
Exchange, MacLinkPlusf franslators, Word for Word/Mac, or Software Bridge.

Emulating a PC on the Mac
with SoftPC
With RunPC, you can control a PC from your Macintosh. SoftPC from Insignia
Solutions, on the other hand, enables your Mac to become a PC. At this time,
there are two versions o f SoftPC: one fo r the Classic, LC, and Portable, and
another for the SE/30 and Mac II family. Both versions emulate an IBM PCJXT
in CGA mode. A separate EGNAT module changes you r Mac into an 80286
(A1) class machine and adds support for EGA color, an 80287 math
coprocessor, and up to 4M of /JM (Lotus-Intel-Microsoft) expanded memory.
(By the time you read this, SoftFC will have evolved into three versions-all
of them AT compatible.)
Given that you are getting a PC emulated in software-along with support for
common peripherals-SoftPC EGNAT needs RAM and plenty of disk space to
run. A minimum of 3M of RAM is needed; 4M or more if you want to emulate
expanded memory, too.

SETI'ING UP SoftPC
A working copy of MS-DOS 3.3-along with standard DOS utilities-is installed for you o n the Mac automatically. When you start the program, SoftFC
even emulates a normal PC start-up-including the clanking noise of the PC
as it warms up. The first time you run SoftPC, you can set up all the other
options: turning on expanded memory and Microsoft Mouse emulation,
specifying printer emulation, configuring the serial ports, and so on. Under
MultiFinder, SoftFC runs like a normal Mac program. lt has its own movable,
resizable window and a standard menu bar (see figure 10.33).
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Figure 10.33 A standard DOS screen appears in a window on the Mac.
Installing the software creates a minimal C drive that contains a copy of DOS,
AUTOEXEC.BAT, CONFIG.SYS, a mouse driver, and essential utilities. Although MS-DOS floppy disks can be read from a Mac SuperDrive (it becomes
drive A) , SoftPC also emulates a DOS hard disk on one of your Mac's drivt:s
(see figure 10.34). Sizes for the D hard drive can range from 1 to 30M. SoftPC
treats its own folder as the E drive: a shared drive in which Mac and IBM files
can both be stored.

USING THE PORTS
SoftPC uses the two Mac serial ports to emulate the PC COMl: and COM2 :
ports, which means that it's possible to use PC communications programs. (If
one of your po rts is connected co AppleTalk, it is disabled.)
Printing is executed in several ways. SoftPC directly supports two types of
printers: PostScripc and the Epson FX-80. (The next version of SoftPC will
support the more advanced capabilities of the Epson LQ-2500 printer.) If the
PC program you are using has a driver for eid1er of these printers, configuring the PC program and SoftPC's Print Options in this way enables you to
print to most Macintosh printe rs (LaserWriter, lmageWriter, and so on). It's
also possible to print directly from one of the Mac serial pons to an attached
PC printer, if you have the correct serial cable. Finally, you even can create a
normal DOS Print Screen by pressing Fl3 or Command-=.

.

Fiie Edit

Options

I

SoftPC - For Oemons tr11 1ion Purposes Only
Pat h:

jesi SoflPC I

Sub-d i

D IOMB Orlue
C: \DOS

= Grophlcs

fQ

Cl Hord Disk
D PC fonh

.. Sot1rC £&RIAT

(

EJecf

(

Drlue

l
l

(

Creo l e

l

[

concel

l

DIRECT

Path:
Sub-di

1Q
Crent e herd disk celled:

ISt eue's Drlue

I

Path:
Sub-di

Hard Disk Size:

Q
C: \DOS

1 Mbyte 0

4Mbyte

0 15 Mbyte

0 2 Mbyte 0

5 Mbyle

@20 Mbyte

3 Mbyte 0 10 Mbyte

0 30 Mbyte

0

Figure 10.34 When setcing up the emu lated drive D, you need to run FOJSK
and FORMAT-as o n a real PC.
Because most printing goes through the Chooser, you need to instruct
SoftFC on when it should print. You can print 30 seconds after the last character is sent to the printer, or when you quit the PC program.

NOTE: To print to a PostScript printer correctly, you must turn
off background printing.

MOUSING AROUND
SoftFC also enables you to temporarily transform your mo use into a
Microsoft Mouse. Selecting Emulate PC Mouse from the Options menu
instructs the mouse to ignore its no rmal Mac functions. Because PC mice
have a pair of active buttons, the Mac's "=" key must be used to simulate the
right mouse button. If you need to temporarily revert to the Mac mouse, fo r
example to make a menu selection or open a desk accessory, simply press
and hold down the Command key.

OTHER HANDY FEATURES
The Apple Extended Keyboard is a perfect match to the PC 101-key keyboard-there is nothing new for you to learn or memorize. Functio n keys can
be emulated o n the Apple Standard Keyboard by pressing the Command key
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in conjunction with a number key (Command-1 is the equivalent of Fl, fo r
example). A few remapped keys, such as Break, Fl 1, and Fl2, will need to be
memorized.
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Figure 10.35 One Soft PC option allows the Mac mouse co em u lace a Microsoft
Mouse .
lc's possible co copy daca between PC and Mac programs using normal Mac
procedures (all macerial is moved through ch e Clipboard). If yo u are in a PC
program, graphics you highlighc and copy can be pasted into Mac programs
as bitmapped images. Thus, you can copy a 1-2-3.PIC graph from the screen
and paste it into a memo you are writing in MacWrite II. Text also can be
selected in PC programs and copied co a Mac application. All text, however, is
treated as plain-no styles, attributes, color, and so o n. SoftPC includes two
PC screen fonts (PC40 and PC80) you use to format this text in your Mac
programs and restore the proper character spacing. Finally, text can be copied from a Mac document and pasted into a PC program or at a DOS prompt.
Any paste acts as though the text had been entered from the keyboard.
Although all current Macs come with a SuperDrive, a few Mac owners may
no t be satisfied with the capability to deal with o nly 3.5-inch DOS floppy
disks. The SlavePC utility is included and enables you to connect a PC to your
Mac (via the serial ports) and access data disks in any of the PC's 5.25-inch or
3.5-inch floppy drives.
Finder-mountable CD-ROM drives also works with SoftPC as drive E, the
shared Mac/PC volume. However, SoftPC does not supporc MS-DOS

"CD-ROM Extensions" to control the drive directly from PC hardware. Programs that depend on the extensions will not work. To read disks intended
for a PC rather than for a Mac, you may need to acquire a special Mac device
driver from the drive manufacturer.

WHAT'S MISSING?
The only important limitations of SoflPC are lack of support for extended
memory, and graphics are limited to EGA or CGA. The first issue is only important for programs that either support or require extended memory. Many
PC programs, however, can be configured to use expanded memory instead
(supported by SoftPC). The maximum graphics resolution is important
mainly for graphic programs, games, and other programs with exaccing requirements (CAD, for example). Although desktop publishing is much easier
in VGA mode than in EGA, most of the major PC desktop publishing programs still offer EGA support.
Although SoftPC can read DOS disks in the SuperDrive, it does not have any
file transfer or translation capabilities. Other products, such as LapLink Mac
ill and MacLinkPlus, or a pair o f standard telecommunication programs, can
be used for transfers. And there are many utilities that enable you to alter the
file formats.
The new versions of SoftPC will add DOS 5.0 compatibility and Epson LQ2500 emulation, and wiJl include the currently optional SoftNode module
(allows SoftPC to function as a Novell Netware PC node) .

Controlling Another Mac with Carbon
Copy for the Mac
Carbon Copy from Microcom enables you to connect a pair of Macs over
AppleTalk, modems, or a direct serial Link. After connected, you can move
files between the machines quickly in either direction. A second, more interesting use of Carbon Copy is that it allows you to physically control one
machine from the other.
A separate copy of Carbon Copy must be installed on each machine (it checks
for unique serial numbers on each installed copy). After the lNIT and desk
accessory are installed, you start the program by opening the DA (figure
10.36). This window in the desk accessory is used to set the main controls for
Carbon Copy. Preferences also can be set here, including options to start up
in host mode automatically, and security and screen redrawing preferences.
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Figure 10.36 The Carbon Copy DA.
You must set one of the Macs as a potential host. Any host can be logged
onto by simply selecting the host name in the Available Hosts list and clicking on either the Visit or File Xfer... button. The Visit option re-creates the
host's screen in a window on your Mac, complete with menu bar, drive icons,
and trash can (see figure 10.37).
In Visit mode, yo u can directly manipulate the other Mac just as if you were
sitting in front of it. You can run programs and DAs, rearrange the Desktop,
delete files, and use an y attached peripheral (a printer, for example). For all
intents and purposes, it's as though the host is your Mac.

NOTE: The smoothness with which Carbon Copy operates depends largely o n the speed of the host computer. \Vhen the host
is a Mac Plus, fo r example, Visit mode is extremely sluggish. To
pull down a menu by clicking on it may take several seconds for
the response to appear o n-screen. If the host is a llci, on the
other hand, response time is much faster-not full speed, but
closer to normal.
While acting as a host, you still can work normally on your Mac. Separate
cursors appear onscreen-one for the guest and one for the host. Each cursor is a different shade to eliminate possible confusion.
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di sk spoce. Ar e you sure you w ont to
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Figure 10.37 Visit mode.
In Transfer mode, the File Transfer screen appears (see figure 10.38). As a
guest, you easily can move files in either direction. Just select the file you
want to move (only one file can be chosen at a time), select a destinatio n
folder, and click on the Send button. (You may need to close and reopen the
window in which the received file is located before the System recognizes its
file type.)
So why would you want to control someone else's Mac? Here are a few examples:
• You can run programs you don't have-without leaving your desk.
• As a member of the office computer support department, you can
tro ubleshoot for any Mac on the network o r help users at remote sites.

•

lfyou are an instructor, you can monitor students' progress with
computer assignments.

• Two people can work o n the same document at the same time.
Carbon Copy for the Mac contains the following special features:
•

Error detection and correction for any data transferred over a serial
Link (for direct serial connections and modems).

.
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Figure 10.38 File transfers are a breeze with Ca rbo n Copy for the Mac. The
interface is simple to understand and transfers progress quickly.
•

All user preferences are encrypted when saved to disk.

•

Guest privileges can be set for everyone or varied for certain individuals-including the capability to view the host, control the host, retrieve
files, send files, deny access to the System folder, require specific
approval to log on, enable callback (for serial connections), make a
system establish itself automatically as a host at start-up, and instruct
the included Virex INIT to scan all transferred files for viruses.

•

Full screen mode if the host has a larger screen than the guest.

•

Auto scrolling when the host screen does not fit entirely on the guest
screen.

•

Backgrou nd file transfers and optional file compression.

•

When connecting by modem, Carbon Copy provides a pho ne book for
frequently-used numbers and a scripting language for modem control.

Transferring Mac Files Using Modems
Sometimes the files that you or a colleague need are not in the next room.
They may be across town or even on the other side of the country. Sure,
overnight delivery services can get them to you tomorrow, but what happens
when you need them now?
The fastest way to move data over long distances is by telecommunications:
connecting the two systems over a standard telephone line using a pair of
modems and communication programs. This section discusses the equipment and software you will need, and gives you an example of setting up
two-way commu nication.

LEARNING ABOUT MODEMS
Unless you intend to use your modem only to communicate with one other
person or information service, you should select the piece of equipment that
will give you the greatest flexibility for a reasonable price. You may find some
of the following features helpful.
• Hayes compatibility. Simply speaking, this means the modem will
respond appropriately to commands that are intended for a Hayes
modem. Because this is the overwhelming standard among microcomputer modems, you will find that virtually every modem offers this
feature. Because all Mac telecommunications software provides drivers
for Hayes-compatible modems, having this feature assures you of
finding a program you can use.
• Speed (bps) issues. The current speed standard for personal computer
modems is 2400 bits per second (bps). Most information services, such
as GEnie and CompuServe, will enable you to operate at 2400 bps
without additional surcharges. Using higher speeds, if allowed and
supported, is typically more expensive.
Most advertised modems list themselves as being 300, 1200, 2400, or
9600 bps. The higher the bps number (sometimes referred to as
"baud"), the faster the modem can transmit and receive data. However,
when communicating with another modem, transmissions can only
occur at the highest common bps rate. Even if you have a 9600 bps
modem, if your colleague has a 1200 bps unit, you are restricted to
communicating at a maximum speed of 1200 bps. Unless you have
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other uses for the modem, buying a 9600 bps unit may be a waste of
money. Buying one slower than 2400 bps, on the other hand, is
pointless-unless you can get a fantas tic deal on a used or d iscontinued model. Most manufacturers have phased out modem models
slower than 2400 bps.
You are no t restricted to communicating at the modem's highest bps
rate. Most modems also work fine at slower rates, too. A 2400 bps
modem, for example, should also support 1200 and 300 bps.
You should consider the quality of your phone li ne when deciding
which modem to buy. While most standard voice lines will readily
support a 2400 bps modem, 9600 bps modems may require a dedicated data-grade line. If you are unsure, check with your local phone
company.
• MNP (Microcom Networking Protocol). MNP is a modem feature that
provides automatic error control, and in some examples, data compression. Altho ugh software versions of these features also are present in
most communications programs, MNP is a hardware feature built into
some modems. Two modems that support MNP can ignore the errorcorrection protocols in their communications programs and transmit
files to each other the fastest way the software al lows.
It is best to purchase a modem with MNP when you know the
person(s) o n the other end of the phone line also have an MNP
modem.

NOTE: MNP is continually modified. There are many different MNP
levels, offering different features.
• Fax modems. Many modems now have fax capabilities, allowing them
to both transmit data and to send and/or receive faxes. Send-only fax
capability (sometimes referred to as "send-fax") can add less than $50
to the manufactu ring cost of a typical 2400 bps modem. The capability
to send and receive faxes costs a bit more. The advantage of having a
fax modem is that you can send documents created on your Mac
without printing them first, and tl1en carry the output to a fax machine.
Instead, you simply select a fax driver in the Chooser (rather than
selecting your printer), and then issue the word processing or o ther
program's normal Print command. Data printed in this manner can be
sent straight thro ugh your fax modem to any standard fax machine (or
to another fax modem).

When considering a fax modem, be sure to pay attention to che
supported transmission speeds. Normal fax transmissions occur at
9600 bps. If you want your modem to be able to work at the same
speed as a fax machine, look for one that can send and receive faxes at
9600. Less expensive units may only support fax transmissions at 4800
or 2400 bps, or they may offer one rate for sending and a different rate
for receiving. If all you will be using the modem for is receiving faxes,
this won't make much difference. (The decrease in speed is reflected in
the sender's pho ne bills, not yours.) If you intend to send outgoing
faxes, the higher the speed supported by the modem, the smaller your
phone bill.
A few 2400 (data)/9600 (fax) modems also enable you to use the 9600
setting to transmit normal data-not just faxes. This capability, however, is usually restricted to like pairs of modems; that is, both users
must have the same model fax modem. Check the modem specs before
you assume this feature is offered.
•

Internal vs external modems. lf your Mac contains internal Nu Bus slots,
you can use either an internal modem (one that fits into your Mac) or
an external modem (one that connects to your modem port by a serial
cable). At present, the only compelling reason to select an internal
modem is to avoid the clu tter caused by adding yet another external
piece of hardware. Also, internal modems run from the Mac's power
supply; external modems usually require their own separate power
supply. Although internal modems are beginning to make an appearance, they tend to cost substantially more than a comparable external
modem.

• Mac compatibility. In general, a modem is a modem is a modem-as
long as it's an external modem. The significant differences between
external modems that are marketed to Mac users and those marketed
to PC users are the software and cables (if any) that are included. A
modem advertised for Mac users usually is accompanied by Maccompatible software and a cable. If you have a PC modem lying around,
all you need to get up and running is a Mac-compatible cable and a
communications program. Internal modems for PCs and Macs, however, are not interchangeable. The slots in a PC are very different from
those in a Mac, and cards designed for one system cannot be used in
the other.
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LEARNING ABOUT TELECOMMUNICATIONS
SOFTWARE
After selecting a modem, your next task is to choose a telecommunications
program. Many modems come with a program. Altho ugh bundled software
often is very rudimentary, in many cases it is more than sufficient to get you
up and running. As your use of the modem increases, you probably will want
to check o ut some of the more sophisticated programs, such as MicroPhone
II or Hayes Smancom (if you have a genuine Hayes modem rather than a
compatible).
A basic communications program should enable you to perform text and

protocol file transfers (XMODEM, for example) ; support standard settings for
bps, data bits, stop bits, and parity; and e nable you to save different settings
for different communications needs. Settings files can be used to record the
communications parameters and phone numbers for the people and services
with which you want to communicate.
More advanced packages may offer the following features:
• Automated log-on procedures.
•

Macro recording or scripting capability for executing common tasks,
such as logging onto a system, checking for and receiving any waiting
electronic mail, and then logging off.

• Advanced data transfer protocols such as YMODEM and ZMODEM.
• The capability of running your system as a computer '·bulle tin board"allowing users to log-on to your Mac and send or receive data files
without you being present.
As you learn to use the bundled communications software, it quickly becomes apparent what features you need. When you get tired of typing your
password and manually going through the steps of logging onto a bulletin
board or information service, for example, it is time to find a program with
automatic log-on capabilities. When you start to look for a way to automate
an e ntire session, then you should consider a program that contains macro
o r scripting features.

MAKING THE CONNECTION
Afte r you and another user are outfitted with modems and each have a telecommunications program, it's time for a trial run. The following sectio n
shows you the basic steps of setting up and carrying out a two-way

communications session: making the connection, "chatting" with each other,
and transmitting files. MicroPhone ll from Software Ventures is used in the
example, but any communications program will suffice.

SETTING COMMUNICATION PARAMETERS
Initially, the hardest part of getting two computers in sync over a phone line
is ensuring that both are using appropriate communications parameters.
Mismatched parameters result in incoming text overwriting itself on-screen,
abrupt disconnects (sometimes in the middle of d ata transfers) , or failure to
make the connection. Until everything is wo rking smoothly, it's best to perform trial runs with a local colleague rather than someone in another town
or state. (Why add the expense of several long-distance phone calls into the
learning process?)
Assuming that your modem is connected to your Mac and a phone jack, the
first step in the communicatio ns process is setting software parameters for
the two Macs. (Note: If you are using a different program than Micro Phone II,
the precise menu locations and names for these setting will vary.)
1. Start MicroPhone by double-clicking on the program icon. A default
settings ftle called MicroPhone Settings should appear (figure 10.39).
C file Edit Se tllngs

•

P~one

Scripts Transfer

MlcroPhone Sellin s

Figure 10.39 A blank MicroPhone II settings file.
2. Select the Communications .. . option in MicroPhone's Settings menu
(figure 10.40) and set the following parameters:
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Baud rate (also called "BPS'}: Select the highest rate that both
modems support. Normally, this is 1200 or 2400.
Bits p er character (also called "data bits'}: 8
Stop Bits: Auto
Parity: None
Connection port: modem or printer (depending on the Mac po rt co
which you connected the cable of the modem). Programs that don't
offer the option to select a port normally will assume you are using the
modem port.

Other options can be left as is.
~

rue

Edit

Se ltlngs

Phone Scr1p ts Transfer
MlcroPhone Sc ttln 1

Communications Sotttn91

Ouud Ante
0
0
0
0

0

50
75
11 0
134.5
ISO

------------~

0
0
0
0

200
300
450
600
® 1200

Bits per Charncter: [!]
~----~~

0
0
0
0
0

18 00
2000
2 400
3 6 00
4800

0
0
0
0
0

120 0
9600
19,200
3 8,400
5 7,600

Stop Bits: [ § [ ]
Conne ction Port:

Figure 10.40 Only two things are important when setting communication
parameters: (1) Both Macs use matching settings. (2) You settle on a mutually
supported baud rate.
3. Close the Communications Settings dialog box by clicking o n the OK
button and select Terminal ... from the Settings menu. Set Local Echo
to "on" and click on OK again. (Local echo ensures that you can see
the characters that you type, as well as the ones that are coming in over
the phone line from your friend or co-worker.)
4. To complete the set-up process, each of you should now define a new
service in MicroPhone. Select Create Service ... from the Phone menu.
Enter the name and phone number of your colleague, and the dialing

method you are using ("tone" for much tone services or "pulse" for
rotary dial systems).
This completes the setup process. Now you both should turn on your
modems if you haven't already done so.
5. To make the connection, one of you must dial the other's phone
number using the communications program. The person who elects to
be the recipient of the call (it doesn't matter who does this) sho uld
select Wait for Call from the Phone menu.
6. The person who will initiate the call now should select the other
person's name from the Service menu. This causes the modem to dial
the phone number entered earlier. A successful connection will
normally be indicated by the word CONNECT that appears on both
screens.

CHATTING
After con necting, you can type messages to each other. Anything you type is
displayed instantly on the other user's screen. However, there's nothing to
stop you both from typing at the same time, so it's important to take turns.
Otherwise, you will see your characters and the other person's all mLxed
together on the same line:
One way to limit the chat confusion is to be sure to end each line with a
Return or two, signaling that it's the other person's tum. MicroPhone ll provides a feature called a buffered keyboard that makes things simpler. Either
or both of you can select this option from the Edit menu. Type your messages into the buffered keyboard window, (see figure 10.41). What you type
is not sent to the other computer until you press the Return key. When it's
your tum to talk, just press the Return key to send your message.

§[]

Buffered Keyboard

Figure 10.41 You can use the buffered keyboard option to prepare your
message while the other person is typing.
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SENDING FILES
lf all you want to do is chat, skip the modems and communications software
entirely. Just pick up the phone and dial. The meat of telecommunicatio nsand the reason it is discussed in this book-is the capability to move data
over phone lines. Te:>..t files, word processing and spreadsheet files, and even
programs can be sent from one computer to the other. Documents can be
transmitted and received in their original Mac format, enabling the person o n
the other end to read and modify them as soon as they are received.
Although you can send text-only files (one font, only minor formatting) , most
of what you will want to exchange are fully formatted documents. To send a
fu lly formatted document, follow these general steps:
1. Request that the recipient p repare for the transfer. (Although
MicroPhone supports several file transfer protocols, XMODEM is used
for this example.) The designated recipient should select Receive
XMODEM (MacBinary) .. . from the Transfer menu.

2. If you are the sender, wait a few seconds (giving the recipient time
to select the Receive option) , and then select Send XMODEM
(MacBinary) from the Transfer menu. To initiate the file transfer,
select the file you want to send. (For this test, select a small word
processing or spreadsheet file. The smaller the file, the faster the
transfer.)
r

3. A5 the transfer progresses, you will both see an indicator on-screen that
shows the number of bytes that have been transmitted successfully, the
elapsed time, and an estimate of how much longer it will take. When
the transfer is complete, you can chat again, send more files, o r
disconnect.
To end a session, type your go od-byes and then select Hang Up from the
Phone menu. Assuming everything went well, you can use the Save Settings
command in the File menu to save the communications options for future
sessions with that person. They also can serve as the starting configuration
options for other Mac-to-Mac sessions.

COMMUNICATION NOTES
As with anything new you try on your Mac, things seldom go as smoothly as
the preceding task. If you each have different communications programs with
different supported protocols and setting optio ns, many things can go
wrong. Don't be surprised if it takes several attempts before you successfully

make the connection and transmit a file. Following are some other facts and
tips you should know:
•

During a sessio n, ftles can be transferred in either direction. It doesn't
maner who called whom. just follow the preceding procedures.

•

Because smaller files transfer quicker (there are fewer bytes of data to
send), you may consider compressing the file before sending it. Keep
in mind that both users must use the same compression program so
that the recipient can extract and use the compressed files. Otherwise,
the compression program must be able to create self-extracting
a rchives. These are files that, when double-clicked, automatically
extract the compressed programs and data files, restoring the m to their
original form.

•

Depending on the frequency with which you intend to swap files and
the size of those files, you may want to outfit both parties with faster
modems, and possibly data-grade phone lines. Standard phone lines,
although fine for most 2400 bps work, may not be sufficient to reliably
handle 9600 bps transmissions. When dealing with graphics ( rIFF files,
for example), speed is especially important.

•

After you successfully send and receive a several files via XMODEM, it's
time to dig out your communications software manual and explore the
other transfe r protocols. Sending data in larger blocks (lK, for example) will improve transmission speed. YMODEM transfe rs e nable
you to transmit a batch of files using a single command . YMODEM-G
contains the same features as YMODEM, but is faster. Rather than
waiting for an acknowledgment that a data packet has been received,
YMODEM-G simply sends data as quickly as possible- assuming that it
arrived okay. Unfonunately, a single transmission error can kill the
entire transfer; d1at is, d1e file will have to be re-sent in its entirety.
ZMODEM also allows batch file transmission and is very fast. Unlike
YMODEM, ZMODEM retransmits unsuccessful data packets.

• You sho uld also take a look at MicroPhone !l's scripting language.
Using it, you can automate many common communications tasks, such
as waiting for a password prompt from a host system and then instantly
typing the commands necessary to log-on to that system. MicroPhone II
also e nables you to specify log-on and log-off actions. For example,
you can indicate that a message should be sent immediately upon

.
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connection, such as: "You have successfully connected wid1 George
Frede rickson's Mac."
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Summary
n this chapter, you learned how to communicate between Macs and PCs
using file transfer software. In particular, you learned how to perform me
following tasks:

I

•

Transfer data between Mac programs.

•

Combine different types of data using integrated programs.

•

Set up file sharing and program linking.

•

Use Publish and Subscribe in an Acta 7 o utline.

•

Move information between the Mac and PC using Apple File Exchange,
Word for Word/Mac, and MacLinkPlus/PC.

•

Transfer files using LapLink Mac III.

•

Run a PC from a Mac using RunPC.

•

Mount DOS diskettes on the Mac using AccessPC DOSMounter, and
MountPC.

•

Run PC programs o n a Mac using SoftPC.

•

Perform Mac-to-Mac file transfe rs and take control of another Mac
using Carbon Copy for me Mac.

•

Transfer Mac files using modems.

In Chapter 11, you will learn about utilities you can use to make your life
with a computer a bit easier.

More Useful
Utilities
Not all Macintosh software qualifies as a major application program. Rather
than performing an important business function, some programs are designed to make your computing sessions faster, easier, or more efficient. Jn
many cases, these programs, INlTs, and DAs add useful functions to the
Macintosh System software or new features to your favorite business programs. Collectively, these programs are called utilities.
In previous chapters, we covered many utilities that help you get organized
and make better use of your business software- including templates, graphic
tools, and calendar/appointment programs. This chapter discusses the most
important features of dozens of System enbancement utilities. The following
types of utilities are covered:

•
•
•
•
•
•
•
•

File finders for locating lost files .
File recovery tools.
File compression utilities .
Disk optimizers .
Finder enhancements.
Font and DA management tools.
Printing tools .
Macro utilities .

J
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Land of the Lost: Locating
Misplaced Files
ven if you d o an outstanding job of keeping your hard drive o rganized
and your files and folders neatly arranged, sooner o r later you will lose
track of an important file. Six mo nths may pass and you won't recall where
you put that resume you painstakingly created. Or maybe you accidentally
stored the proposal you created last week in the Graphics folder. You can
hunt for the file by manually o pening every folder on your hard disk, or use a
utility to solve this predicament.

E

Locating Files In System 6
System 6 contains a DA called Find File (located in theApple menu) that
enables you to locate lost documents and programs. Find File can search any
disk or directory for file names that contain the word or string of text you
enter. However , you can only search one drive or directory at a time and you
can only base searches on file names. After you select a drive or folder and
enter the text for which you want to search, click on the running man icon in
the upper right corner of the dialog box. Any matches appea r in the scrolling
list box. To display the size, creation date, date of the last modificatio n, and
the location of the file on the drive, just click on the file you want.

Locating Files in System 7
In System 7, the Find File utility has graduated fro m a desk accessory to a
part of the System software. The utility is now located in the File menu of the
desktop as the Find ... and find Again commands. Search capabilities also
have been improved. Find enables you to search any disk or directory fo r file
names that contain the word or text string that you enter, or you can perform
a search based o n other file characteristics.
The basic Find dialog box works much the same as the Find File utility in
System 6. It enables you to search for files only by name. To perform more
elaborate searches, click on the More Choices button to access a d ialog box
that offers more search o ptions. Figure 11. l displays the basic Find dialog
box in System 7.
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Figure 11.1 The basic Find dialog box in System 7.
During a typical search, Find displays the first folder or file name that meets
the search specifications. The folder that contains the found object opens as a
window and the located folder or file name is highlighted. You can display
additional files that match the search criteria by selecting Find Again from
the File menu or by pressing Command-G. lf the file is in a different folder,
the first window closes and the new window opens.
Clicking on the More Choices button in the basic Find dialog box enables
you to perform a search based on file size, kind, label, date created, date
modified, version, comments, or lock status. For example, if you know the
file was created in the last two weeks but cannot remember any part of the
file name, you can search for all files created since that date. You also could
use the results of creation and modification date searches to perform an
incremental backup, selecting only those files created since a particular date
plus those modified since the same date. Figure 11.2 displays the expanded
Find dialog box in which you can specify the additional search options.
If you click on the all at once check box in the expanded Find dialog box,
the entire search is conducted and all matching files are found. The Finder
displays the contents of the selected drive in Name View and highlights all
files and folders that meet the search criteria (see figure 11.3). This option
makes it easy to act on the files as a group, such as deleting or backing up
entire projects.
Although the Find command in System 7 is greatly improved, it still has some
shortcomings. You cannot issue a search based on multiple criteria. For
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example, you cannot look fo r all files that were modified since February 12,
1992 and contain the word "Story" in the file name. Second, you cannot
search for files created by a particular program. For example, it would be
extremely helpful to be able to search for only Microsoft Word documents.
finally, all searches are based on file attributes. You cannot perform a search
based on the contents of a file. For these types of capabilities, you should
consider one of the following commercial programs.
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Finding Files with Locate
Locate is a DA that is part of the MacTools Deluxe utilities package from
Central Point Software. At first glance, it looks like the old System 6 Find File,
but rather than only searching for files by name, you also can search for up to
three keywords contained in the file's text. Combined criteria searches also
are supported. The AND option enables you to search for a file that has a
particular file name and contains a keyword. The OR option enables you to
search for a file that matches the name criterion OR contains a keyword.
Figure 11.4 displays the results of a typical Locate search.
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Figure 11.4 ln addition to showing found files, Locate displays matching text
in contex't.
If you are performing a keyword search, as Locate searches a drive, folder, or
particular area of a disk, the name of each matching file and the matching
text from inside the file are displayed in scrolling list boxes within the
MacTo ols Locate dialog box.
If you prefer, Locate can be instructed to show o nly the path to each file,
rather than its text. As in Find File, any found document can be moved to the
Desktop for easy access. You also can load the document into its appropriate
program by choosing Lau nch Documen t from Locate's menu. Other options
include saving the match list to disk as a tex't file or printing it. Tex't from any
found file also can be copied to the Clipboard and pasted into other documents.
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Because searches can be lengthy, Locate can run in the background if you are
using System 7 or are running MultiFinder in System 6. Locate auromatically
beeps when it finishes a search, so there's no reason to watch its progress
unless you expect the file to be found quickly.

Finding Files with GOfer
GOfer is a desk accessory from Microlytics, Inc. that enables you to search for
files by content. GOfer was the first good program that could perform
searches within the text of files. Version 2.0 is adequate for most such tasks.
Using the dialog box shown in figure 11.5, searches can be Simple (look for
a single word), Boolean (multiple keywords connected with AND , OR ,
NOT), or proximity (find "Mac" or "Macintosh" within 5 lines of "utility"). If
you just want to peek inside a particular file, you can use the Browse function rather than initiating a search. If you are running Multifinder, you can
perform background searches.
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Figure 11.5 GOfer enables you to perform searches based o n content using
this dialog box.
Clicking on the Close/Flex button instructs GOfer ro find text that is similar
to the text you typed. Unfortunately, if you search for "Mac", GOfer also will
locate "mar," "mat," and "man," even though you are probably more interested in catching "Macintosh" and "Macs. "

Other useful options enable you to append selected text to the current contents of the Clipboard, move fo und files to the Desktop (version 2.0 contains
no file launching capabilities), save search instructio ns for later use, and
export chunks of found text.

Finding Files with On Location
If you are short on patience, you may not want to wait for GOfer or Locate to
scan your drives. On Location by ON Technology, Inc. is what you need. It
works by pre-indexing every word and, optionally, every number found in
documents. When you request a keyword or file name search, the results
appear almost immediately.
On Location is a desk accessory activated by an !NIT stored in d1e System
folder. You begin by indexing the drives of your choice. The process is
simple. You just selectCreate Index... from the On Location menu and
select a drive to be indexed. Drives can include volumes you don't normally
keep mounted , such as important floppy disks, SyQuest and Bernoulli cartridges, and CD-ROMs. The indexing process is the slowest part of the
program and can take up to an hour per disk, depending on the size and the
amount of text contained. Because the INIT continually updates the indices
in the background, indexing is generally. a one-time procedure. To store each
index, a file about two percent of the size of the volume indexed is required.
For a 40M drive, the index ft.le is approximately one megabyte.
After you create the necessary indexes, you can perform a search in two ways:
by ft.le name or by keyword. Keyword searches can include multiple words
for which to look and can beAND orQR searches (search for files mat include all of the keywo rds in text or files that contain at least one of the
keywords, respectively). Figure 11.6 displays the results of a one-drive search
for the keywords "Mac" and "utilities."

NOTE: You can search multiple drives simultaneously by pressing and holding the Shift key and then clicking on the drives you
want in the scroll box under the Indexes pop-up menu.
To view the contents of a located file, double-click on its file name in the File
List scroll window. A preview window displays the text-with its actual fonts
whenever possible. Within the preview window, you can move to other occurrences of the found text or perform different searches by clicking the Find
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or Again buttons in the upper left corner of the window. As with the other
advanced file search programs, you also can copy text to the Clipboard and
paste it into other documents.
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Figure 11.6 On Location lists files found by name, size, kind, date last
modified, and the path.
On Location also provides general file-handling capabilities. It enables you to
copy, rename, move, or delete files. You can launch programs or documents
from the File List by highlighting the file and selecting Open Files from the
On Location menu.
If you have large text files, are running on a network, or have huge volumes
attached to your Mac (CD-ROMs, for example), you should consider On Loca·
tion an essential utility. There's no better, faster way to handle searches.

Hard Disk Problems and
File Recovery

M

ost of the time, you are probably a careful computer user. You keep
backups of important data, copy programs to a hard disk or another
floppy disk rather than run the programs from master disks, and you watch
what you throw in the Trash. Still, mistakes and disasters can happen. The
following list describes some ways data can be lost:
• Your hard disk, removable disk, or flo ppy disk develops a few bad
sectors, making one or more files unreadable.
• You throw a folder you thought was empty into the Trash only to find
that it was not quite as empty as you thought.
• You use a template to start a new document and then perform a Save
instead of a Save As ... which destroys the original template.
• You d o a Save As .. . to replace an existing file, but the file name
entered was not the o ne you meant to save over.

If you have the right utility programs (and a bit of luck), none o f these situations need be tragic. Recovery may be possible. Be warned, however, that if
you wait until after a disaster strikes to purchase and install an arsenal of
recovery tools, it may be too late.

The Do's and Don'ts of Recovering Data
\Vhen you format your hard d isk or throw a file in the Trash, the Mac does
not actually erase the files. It merely marks the space that the files occupy as
being available for new files. The next time you save a document or copy data
to the drive, it may end up in the same spot in which your old data resided.
With that in mind, here are a few rules of thumb to follow for what you
should and should not do when attempting to recover lost data.
• As soon as you discover your mistake (reformatting ycur hard disk
drive or trashing important files), make no further changes to the drive.
Cop ying new data to the drive (including recovery software) or
running a disk optimization program may destroy the data you are
attempting to recover. The sooner you discover your error, the better
the odds of recovery.

• Formatting a floppy is not the same as fo rmatting a hard disk drive. In
the case of a floppy, the data really is destroyed-completely and
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forever. If there is any recoverable data on the floppy disk, do not
reformat it. As mentioned above, for matting a hard drive, o n the other
hand, leaves its data intact and is an action from which you can
recover.
• When attempting to resolve a problem with a floppy disk (a file that is
no lo nger readable, for example), work on a copy of the disk rather
d1an the original disk. MacTools Deluxe and 911 Utilities have tools
that enable you to make an exact copy of any floppy disk- whed1er the
data o n it is good or bad.
• If the data recovery software package provides an INIT that records
deleted files or records critical volume information, use them. The
likelihood of recovery is improved significantly by using these types of
INlTs rather d1an using any other recovery methods the software offers.

Permanently Deleting Files
If security is an issue fo r you, many file recovery packages contain
optio ns that enable you to destroy deleted files-over-writing
deleted data with strings of zeros, for example. To ensure a deleted file cannot be recovered, consider buying une of these
programs, such as MacTools Deluxe or 911 Utilities. Remember,
throwing a file in the Trash is not the same as eradicating it.

The capability to yank deleted files out of an emptied Trash can o r unformat
a mistakenly fo rmatted hard disk can be a life-saver. MacTools Deluxe and
911 Utilities can help you with these ugly problems.
Sometimes an important document on a hard disk or floppy can become
damaged, preventing your word processor or page layout program, for example, from opening or saving the file. The Last Resort and CanOpener
utilities are designed to salvage the text contained within a file even when the
file itself cannot be rescued.

Recovering Files with MacTools Deluxe
Central Point Software's MacTools Deluxe provides a pair of utilities for file
recovery-Mirror and Rescue. You can undelete files using either one. Mirror

or Rescue work together to help you recover fro m an accidental format,
restore deleted files, and repair minor or major damage to hard disk
volumes.
Mirror is a CDEV that tracks changes to your hard disk. It is used to create a
Critical Volume Information file about the structure of the hard disk that
Rescue uses to repair damaged volumes. Mirror can also maintain a Delete
Tracking File that records locations of deleted files. This information is sufficient for the utilities to d etermine whether a particular file is recoverable or
whether it has been over-written by new data.
Rescue contains the following three functions:
• Undelete Files offers several methods to locate and restore deleted
data.
• Fix Volumes performs a "hard disk drive check-up" and assists in
recovering after an accidental format.
• Repair Files deals with damaged files and enables you to assign a file
creator and type.
Rather than guessing what you should do to correct a particular problem,
you can click on the help ?icon (see figure 11.7). This general help screen
lists some of the disk and fiJe-related problems you may encounter on the
Mac. Selecting the appropriate sympto m directs you to the steps that you can
take to correct the problem.
Figure 11.8 shows the tests that Rescue performs when evaluating your disks.
Running this series of checks regularly on all your hard disk volumes is excellent for maintaining peace of mind-particularly fo Uowing o ne or more
system bombs or lock-ups. When determining the cause of unusual hard disk
behavior, running this series of Rescue tests is immensely helpful. Rescue
quickly tells you whether there is anything seriously wrong with the volume,
as well as how to correct it.

NOTE: The test for checking bad blocks is very time-consuming.
However, it should be performed periodically to avoid writing
data to a bad sector of the hard disk.
MacTools Deluxe also contains a utility called FileEdit. It verifies an entire
disk or selected files, and reveals invisible files o n any volume. CPS TagFix is
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an JNIT that helps recover files from floppy disk. Finally, MacTools Deluxe
contains a disk optimizer which enables you to unfragment a hard disk drive
and improve its performance. For furthe r discussion about disk optimizing
programs, see the "Disk Optimizers" section of this chapter.
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Recovering Files with 911 Utilities
Like MacTools Deluxe, 911 Utilities is a set of tools that enables you to resurrect damaged and thrown away files and provides solutions for a variety of
disk-related problems.
The heart of 911 Utilities is the 1st Aid I-IFS program. 1st Aid HFS, which is an
acronym for the hierarchical file system used by recent versions of the
Macintosh system, enables you to perform the following casks:
•

Save an archival copy of any disk's volume information (to assist in the
disk restoration process).

•

Distinguish between blank and unreadable disks.

•

Zero-out deleted fi les.

•

Ini tialize disks.

•

Diagnose and recover informatio n from damaged d isks.

•

Make exact sector copies of disks (even damaged disks).

•

Repair damaged boot blocks on any starrup disk.

•

Perform file repairs.

•

Undelete files.

911 Utilities also includes the Complete Undelete CDEV that you use to retrieve discarded files. It maintains a List of files that have been deleted from a
particular hard disk volume, as well as the status of each file.
To undelete a file, you select the CDEV from the list in the Control Panel,
select the drive you want, and click on the Show Deleted Files button. A
scrolling list appears (see figure 11.9). A check mark in front of a file name
indicates that the file is still intact. Clicking o n any file name in the list produces a scatus report that shows what portion of the file, if any, is recoverable. If part of the file still exists, it can be undeleted.
For partially over-written files that contain text, options enable you to extract
only the text or to fill all holes in the file with zeros. To get a better idea of
what the file contains, the PreView button will show you all the text in the
file. Generally, you can expect some files to be whole, some partially intact,
and some irrevocably over-written.
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911 Utilities also provides the following tools:
Sector Collector

Checks disks for bad sectors and marks
che sectors as unusable to prevent
additional data loss.

Cache • Flow (DA and FKey)

Corrects problems with Apple's RAM
Cache and e nables you to flush the cache
manually after every Save.

Minor• Repairs

Enables you to rebu ild a Desktop file
without losing comments you added to
the Ger Info dialog boxes.

Soft•Lock

Enables you to lock a hard disk drive.

Yirex

Checks disks for computer viruses.

The extensive, step-by-step Tmubleshooting Guide that comes with the program may easily be as helpful as the software. 911 Utilities also includes a
folder of sample files with a variety of problems you can use to familiarize
yourself with cro ubleshuuting and n:wvery procedures.

Recovering Text with Last Resort 1.0
Lase Resort is a program that enables you to recover text from damaged ftles,
as well as from files that were never saved co disk. Rather than a file recovery
tool, this CDEV is a keystroke recorder. Each time you start up your Mac, Last
Resort creates a new text file using the date and time che file was opened as

its file name. For the remainder of the computing sessio n, Last Resort records
every letter, number, o r punctuation key you press. At a preset interval (a
certain number of seconds or keystrokes), the information is saved to the file.
If you lose the information on which you are working during that session,
Last Resort enables you to recover your keystrokes by opening the text file in
any word processor.
The program records text you type and p resses of the Backspace (or Delete)
key only. It does no t record cut-and-paste operations, clicks, cursor insertions, or mo use activities. If you write in a perfectly linear fashio n and o nly
use the Delete or Backspace key to cut text, the results of the Last Resort file
will be very similar to the o riginal. Even if you tend to jump around a lo tchanging the locatio n of the insertion point temporarily or using the mouse
to cut and paste text-much o f the original text remains. However, it will be
harder to reconstruct the document.
Backspaces and character deletio ns are represented by a "box" character (1 ) .
The character appears different in different fonts. If you do not see the backspace characters, select the entire document, change the fo nt to Geneva, edit
the te;\1: as needed, and then apply the correct fonts to the edited text. Text in
the Last Resort ftle (which appears in figure 11.10) appears in the order in
which you press the keys. This is not necessarily the o rder in which the text
appears in the real copy.
When you change windows (editing a second docu ment in a word processing
program, switching back to the Finder, o r moving to a different program),
Last Resort embeds the name o f the window into the tex1: file and surrounds
the name with § characters.
lf you are error prone, do not save as o ften as you should, or your Mac is
subject to frequent crashes which result in lost tex1:, Last Resort may be your
best shot at reconstructing the work without needing to rekey the file o r use
an out-dated backup file.

Recovering Text with CanOpener 2
CanOpener 2 is an applicatio n and a DA that is like a safecracker fo r ftles.
Regardless of what a file contains or the program in which it was created,
CanOpener 2 can open the file, display any text or pictures in the file, and
play its sound resources. If you have a damaged file, CanOpener enables you
to open the file and often recover a substantial amount of the text.
After you o pen a file with CanOpener 2 (damaged or not) , you can make a
copy of all text in the file by selecting the numbered Text item in the upper
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window, and selecting Copy from the Edit menu . To copy only a portion of
the text, highlight the text in the view window located in the lower part of
the screen and select Copy (see figure 11.11) .
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Figure 11.10 Last Resort records keystrokes in the order in which they were
pressed.
CanOpener 2 also provides the following useful features:
•

File launching and printing capabilities (System 7 only) .

•

File information (type, creator, size, dates, location, and icon).

•

Search folders for files that contain particular strings of text.

•

Open README files.

•

Read text created in programs you do not have.

•

Clipboard capabilities (copying and pasting) .

•

Storage for text, pictures, and sounds in CanOpener "libraries."
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Figure 11.11 Te>.1: and pictures in files can be examined by double-clicking
on the appropriate item number.

Saving Disk Space with
Compression Tools
o matter how much disk space you have, it never seems to be enough.
As the costs of hard disk storage falls, the size of programs and documents rises. One of the major factors contributing to this space squeeze is the
storage of seldom used programs and archived documents. Even though you
rarely use a particular program or document, you don't want to throw it
away.

N

Unfortunately, the Mac doesn't provide an attic in which to stash these old
treasures. The solution is to shrink the files to a more convenient size. Several software publishers have produced utilities that perform/i/e compression- squeezing files so that they take up less room o n hard disk drives and
floppy disks.
File compression rakes many forms. In the simplest terms, compression utilities look for duplicate information or blank spaces that can be removed. A
simple way to trim a text file, for example, is to locate repeated characters or
patterns of characters. When such a pattern is found, it can be represented by
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a pattern code and a figure for the number of repetitions. For example,
"17 + " can be substituted for a string of 17 plus ( +) signs. Similar approaches
can be used for graphics, such as compressing patterns of on and off pixels
or recording only where colors change.
In addition to a general savings in disk space, compressing files enables you
to:

• Fit files larger than SOOK on a single floppy disk.
• Split large files across several floppy disks.
• Send and receive smaller fi les during telecommunications sessions
(small files take less time to transfer).
• Archive files you seldom use and transfer them to fewer disks.
• Increase data security (some file-compression programs enable you to
encrypt compressed files).
Three of the leading Mac file-compression programs are Stuffle Deluxe
(Aladdin Systems), DiskDoubler (Salient Software, Inc.), and Compact Pro
(Cycles). The first two are commercial programs; the last is shareware and is
available through most information services, user groups, and bulletin
boards.

Compressing Files with Stufflt Deluxe
Stuffle was popularized as a shareware program. After its compression format
gained wide acceptance on the information services, Stufflt Deluxe, which is
a more advanced commercial version, was released.
Stuffle Deluxe enables you to compress and decompress files in many different ways. First, two programs are provided: Stuftlt Deluxe and UnStufflt
Deluxe. The former enables you to compress or decompress individual files,
folders, or groups of files and folders. UnStufflt is a "decompress-only" program that can be given freely to friends and associates so that they can
decompress your "stuffed" files. Two desk accessories are also provided that
perform the same functions.
When you are at the Finder, a Stufflt INIT called Magic Menu adds a menu
item called Magic to the menu bar. You can use the Magic menu to stuff and
unstuff files. It also enables you to stuff and send mail to Microsoft Mail or
QuickMail users.

Finally, if you buy Shortcut (another Aladdin Systems utility) , you can stuff
and unstuff files on the fly-as you open them within programs.
Stuffle is the most feature-laden of the file compression utilities discussed in
this book. Program options include the following:
• Two types of data encryption for added security.
• Decompression capabilities for IBM PC files.
• The capability to split large files across multiple disks.
• Enables you to add comments to an archive.
• Quick procedures for compressing and decompressing files.
• An optio n to create self-unstuffing archives.

• Virus detection.
• Online help.
The Preferen cesdialog box enables you to set Stufflt Deluxe to automatically open any ReadMe file found in an archive during the decompression
process. This makes it easy to document archive contents (see figure 11.12).
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Figure 11 .12 The Preferences dialog box enables you to fine-tune Stuffle
Deluxe.

If the compressed file is in PlCT or TEXT format, you can take a peek at the
contents without first unstuffing the file. Just click on the magnifying glass
icon in a Stuffle archive (see figure 11.13).
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Figure 11.13 The Stufilt Deluxe text and PICT viewers.
Unique to Stufflt is its scripting language. With it, you can perform most
Stufilt operations by executing a script that you have recorded within the
p rogram or have writte n in your word processor. Any procedure that you
routinely perform, such as creating a daily backup of the contents of an important folde r, can be automated with a script. For added convenience, you
can append frequently used scripts to the Stufflt menus a nd assign Command-keys to them.
The only important feature Stufflt Deluxe lacks is the ability co split an
archive across multiple floppy disk. Although you can use the Segment command to perform tl1is task for individual large files, if you command Stufilt to
stuff mo re files tha n can fit o n a floppy disk, the stuffing process simply halts
the mome nt the disk runs out of space.
Aladdin Syste ms has expended great effort co e nsure that Stufflt p rocedures
are available from othe r programs and includes stuffing and unstuffing cools
for the following programs:
•

HyperCarcl XCMDs

•

MicroPhone II scripts

•

Claris XTND

•

QuicKeys 2

Compressing Files with DiskDoubler
DiskDoubler's features are very similar to those of Stuffit Deluxe. You can
compress and decompress files from the DiskDoubler application, from a
special DD menu added to the menu bar, or from within programs (see
figure 11.14).

Help ...

Settings ...
About DD'H...

Figure 11.14 The DiskDoubler DD menu.
All DiskDoubler options are controlled from the Settings menu, including
compression, recompressing, and verification (see figure 11.15).
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Figure 11.15 The DiskDoubler settings.
Whenever possible, a "DD" appears o n the icons of compressed documents
to indicate that the file has been compressed with DiskDoubler. DiskDoubler
aJso enables you to create self-extracting archives.
DiskDoubler's handiest feature is its ability to compress and decompress files
while you are working in another application. You can compress large
graphic or word processing documents, for example, and then from the File
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dialog box, open the compressed files in the program in which you created
them-the files expa nd automatically. When you quit the program, the decompressed files recompress automatically.
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DiskDoubler shares a shortcoming with Stuffle Deluxe. You can split large
files among multiple floppy disks, but you cannot simply split a big folder or
arch ive across floppy disks. If the compressed data does not fit on the destination disk, an error message appears when DiskDoubler runs out of space.

Compressing Files with Compact Pro
Compact Pro is the simplest program of the three compression utilities d iscussed in this book. It provides only two compression methods and runs
only as a program-no DAs, INITs. o r menu bar modifications. And as
shareware, it's also the least expensive-a registered copy of Compact Pro
1.30 costs only S25.
Compact Pro is fast, efficient, and the only one of the three programs that can
create a general archive across multiple disks. On a test folder used to compare the three programs (discussed in the "Head-to-Head Compariso n"
section that follows), Compact Pro's standard compression was the best of
the three programs, chopping a bit more than llK from the next best result.
The bar gauge in figure 11.16 shows Compact Pro 's progress as it compacts
or decompresses files. After the compression is complete, Compact Pro reports the amount of space saved for each file.
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Figure 11.16 You can watch Compact Pro's progress.
Compact Pro also enables you to create self-extracting archives. If you give a
self-extracting archive to a friend or co-worker, the entire contents of the

archive can be extracted without a copy of Compact Pro by double-dicking
on the archive's icon. included with the program is a documentation text file
and a program called Sit->Cpt you can use to convert Stuffle files co Compact
Pro format.

Head-to-Head Comparison
hich file-compression utility should you buy? Knowing the features you
need may make the choice easier. If you require encryption or virus
detection, for example, only Stufflt Deluxe offers these features. If you must
be able to compress and decompress files o n the fly, either OiskDoubler or
the Stuffle Deluxe/Shortcut combination can handle the cask.

W

The degree of acceptance of a particular compression utility by the Macintosh
community is also a factor, especially if you plan co use the program to decompress files you download from information services or if you plan to
upload files for others to use. While DiskDoubler is widely used by commercial developers to distribute large programs, bulletin boards and informatio n
services typically use Stuffle Deluxe or Compact Pro for compression.
Speed and maximization of compressio n are also important. For comparison,
each program was used to compress a folder that contained l.4M o f files. The
included files were an Aldus Freehand EPS file (643K), a PageMaker 4 publication (278K), a Digital Darkroom TIFF file (232K), a MacDraw Pro graphic
(87K), a FileMaker Pro database (65K), a Microsoft Word d ocument (45K), a
PICT screen capture (13K) , and an Excel 3 worksheet (lOK). The chart in
figu re 11.17 illustrates how well the three programs compressed different
files using their most effective compression method (based on compression
percent).
Each program was used to compressed the individual files in the folder,
trying every compression method. Compact Pro and DiskDoubler each compressed the folder by 75%; Stufflt Deluxe reduced the files by 74%. The time
it took to complete this process were: Compact Pro (1 minute 45 seconds),
Stuffle Deluxe (23 minutes 34 seconds) , and DiskDoubler (1 minute 28 seconds). Turning on Disk DiskDoubler's "verification" option increased the
compression time to 1 minute 45 seconds, matching that of Compact Pro.
The advanced methods of Stufflt Deluxe (Best Guess and Better Compression) had enormous difficulty dealing with the Freehand EPS file. Each
method took over 15 minutes to compress the file. Although these methods
improved the compression by about one percent, the trade-off in time wasn't
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worth it-approximately 15 minutes was added ro the compression process.
By comparison, Stufflt's "fast" method achieved a 69% compression of the
folder, but only took 2 minutes and 19 seconds. According to Aladdin Systems, the ne:>..'t version of Stuftlt Deluxe probably will contain only one
compression method, thus eliminating this problem.
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Figure 11.17 This chart d isplays percentage of compression for the three
programs (higher is better) .
If you are more concerned about compacting speed, here's how the fastest
times of the programs compared: Compact Pro (standard compression, 1
minute 45 seconds, 75%) ; Stufilt Deluxe (faster compression, 1minute 49
seconds, 61%); DiskDoubler (method A, 43 seconds, 69%). For raw blinding
speed, DiskDoubler is unbeatable. Even adding file verification to the method
A compression only added 15 seconds to the time.
For users on a budget, and users who don't need to compress or decompress
files while in other programs, Compact Pro is an excellent choice-particularly given the benchmark speed and compression resu lts. If you need to
open compressed files from within other programs, you will need to use
DiskDoubler or the Stuftlt!Shortcut combination.

Disk Optimizers
f you are like many users and have a hard drive attached to your Mac, you
may notice the drive seems to become sluggish over time. This is not
caused by age or overuse; the most likely reason is fragmentation.

I

When a disk is newly formatted, files are placed in contiguous segments of
the disk; that is, the entire file is kept together in a single piece. This continues for as long as there is room on the disk to add new files. Deleting a file,
however, leaves a hole where the original one was located. As you continue
to make changes to the contents of the disk, the operating system is forced to
break some files into pieces in order to find enough room to record the
changes. This causes fragmentation.
Over time-particularly as you get close to filling the disk-you end up with
files scattered in pieces all over the disk. Free disk space also may be scattered around. Because a drive takes longer to find scattered data, your system
slows down.
You have two possible solutions.
You can back up the entire drive (on a file-by-file basis), reformat it, and then
restore the files to the drive. Although this process will eliminate fragmentation, it takes time to do a complete backup and restore and there is always
the possibility that your backup files may not restore properly. (You risk
replacing your readable but fragmented fi les with files that may not be read
at all.)
Or
You can use a disk optimizing program. These programs are designed to
reorganize a hard disk drive, removing fragmentation by piecing files together again and moving the unfragmented files to contiguous sections of the
disk. Two of the most popular programs that enable you to do this are
Optimizer, which is part of the MacTools Deluxe package from Central Point
Software, and Disk.Express II from ALSoft, Inc.

Unfragmenting Disks with Optimizer
Optimizer is a stand-alone program that unfragments files, consolidates free
space (optionally making deleted files unreadable), and checks for bad
blocks. Normally before optimizing a disk, you use Optimizer to analyze the

More Useful Utilities

The 9-to-5 Mac

fragmentation. The top part offigure 11.18 shows a fragmented disk graphically d isplayed by Optimizer.
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Figure 11.18 A hard disk before and after optimizing with Optimizer.
After the analysis is complete, Optimizer tells you how much fragmentation
exists and gives an estimate of how long the optimization procedure will
take. On some systems, the estimates tend to be extremely optimistic-often
only a fractio n of the time it actually takes. As optimization occurs, you can
watch its progress on the disk map. On a color monitor, documents and
applications are represented by different colors. At the end of the nm, the
program log can be printed or saved to disk.
Program options enable you to perform the following tasks:
•

Check for, and avoid, bad blocks.

•

Prioritize applications, placing them where they will be quickly
accessible by the drive's read head.

•

Consolidate free space to the end or middle of the disk.

•

Permanently erase deleted files by replacing their data with a string of
ones, zeros, or a pattern of alternating ones and zeros.

Unfragmenting Disks with DiskExpress II
Disk.Express II takes a different, more sophisticated approach to disk optimization. It is a Control Panel device that optimizes disks continually while your
Mac runs (see figure 11.19). OiskExpress creates a log file that keeps track of
the documents and programs used o n each drive . In the optimization process, Disk.Express arranges the disk's contents so that the most frequently
used files are readily accessible.
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Figure 11.19 The DiskExpress II Contro l Panel.
Buttons in the CDEV enable you to check the current fragmentation status of
any disk, force the immediate optimization of a specific disk, and check the
optimization progress for the disk currently being worked on by Disk.Express
II. Other options concern whether all mounted volumes or just selected ones
are optimized, whether the disk should be verified before each o ptimization,
and whether reads and writes should be verified.
Disk.Express II runs continuously, moving from o ne drive to the next. After
looping thro ugh all mo unted drives, it immediately starts over again with the
first drive in the list. It makes a concerted effort to avoid moving "anchored
files," such as those sometimes used by copy-protected programs.
The program is designed specifically for people who no longer want to concern themselves with fragmentation. Although continuous optimizing may be
overkiU, it gets the job done, keeps the disk permanently optimized, and
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requires no effort o n the user's part. You simply tell DiskExpress what you
want it to do and it will continue until you instruct it to stop.

NOTE: In general, even a packed hard disk doesn't become
seriously fragmented (over 3%) immediately. A once-a-month
manual effort is often enough to smooth things out.

Improving the Finder
lthough most Finder activities are simple to perform, such as copying or
deleting files and launching programs, they frequently take more steps or
require more time than you may want to spend. Opening several layers of
folders just to get to a document or program can be time-consuming and
aggravating.

A

Because of our need to work more efficiently, there has always been a solid
market for utilities that make Finder operations easier and faster to perform.

Improving the Finder with File Director
File Director from Fifth Generation Systems contains three main components: File Director (a program and document organizer), DiskTools
(performs Finder-related activities and several special functions), and
QuickLaunch (a program and document lau ncher). Also included are several
useful DAs: a calendar, two calculators, and a phone pad and dialer.
File Director's primary functio n is that of an organizer, providing an alternate
Desktop for the Mac. It consists of 16 pages, each with 42 slots into which
programs, desk accessories, and documents can be arranged. Each page can
be organized in any manner tl1at makes sense for your needs. You may, for
example, organize your applications in one group by program type and your
documents in separate groups by project (see figure 11.20).
After you assign an item to a slot, just click on that application, DA, or document to open it. When you quit from a program, you instantly return to File
Director.
Any program that creates its own files can have documents associated with it.
Clicking on the note pad that follows a program name enables you to view
the names of any files you linked to that application, and enables you to

launch the documents directly rather than just running the program and then
opening the documents.

Figure 11 .20 You can o rganize File Director pages the way you want.
DiskTools is an icon-driven Finder alternative you select from the Apple
menu or invoke by pressing Command-Shift-D. All Finder activities can be
performed from DiskTools, as well as several other useful functions (discussed below) . Just select one or more files, click on the appropriate icon,
and review t11e information presented or respond to the dialog boxes (see
figure 11.21).
In order, the icons represent d isk information; file information; make a new
folder; delete, rename, move, copy, or find files; compute file sizes; provide
system information; and invo ke Quick.Launch (a program and document
launcher) . Most DiskTools activities are accomplished by choosing one or
more files and clicking o n an icon-no dragging required! To move a file, for
example, just select the file, click on the Move icon, and choose a destination
folder. After the file is copied to the destination, the original copy is deleted
automatically.
Based on the results of a search, files also can be marked and treated as a
group. Search criteria can include: a file name, the creation o r modification
date, the creator or fi le type (to be included or excluded) , file size, and icon
color. You can search selected drives or all drives simultaneously. When the
search is complete, you can mark all the group members using a single
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command, and then treat them collectively, such as moving or copying all of
them to other disks.
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Figure 11.21 The DiskTools window.
The sole function of the QuickLaunch INIT is to make it easy to launch programs without returning to the Finder. You can invoke Quickl.aunch by
pressing Command-Shift-Q or clicking on the Quick.L-.unch rocket icon in
DiskTools.
When the QuickLaunch window appears, you see a scrolling list (see figure
11.22). Menu options enable you to add applicatio ns, documenc names, and
dividers to a launch list. After you add a program o r document to the list, you
can launch the item by double-clicki ng on it, or by highlighting it and then
pressing the Return key. You also can select items using the arrow keys or
by pressing the first letter in the document or the program name. lf your
Mac has sufficient memory, you can select seve ral items and launch them
simultaneously.
Organization of the QuickLaunch list is e ntirely up to you. You can add labeled dividers, for example, to. arrange the list by project or program type.
Although QuickLaunch is a simple utility, it can save an hour or more of
folder-sifting each week.
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Figure 11 .22 The Quicklaunch list makes starting applications simple.

Improving the Finder with DiskTop
The DiskTop DA by CE Software performs essentially the same functions as
DiskTools. You can use it to copy and move files, create folders, delete files,
and launch programs and documents. The three components of the utility
are DiskTop, DT Launcher, and DiskTop Find (see figure 11.23). All are accessible from within DiskTop and also are separate items in the Apple menu.
You can define special hot-keys to display any o f the three utilities from the
Finder or while you are in a program.
To execute most DiskTop options, just select o ne or more files and folders,
click on a button, and read or respond to the dialog box that appears. The
options provide all of the functionality of the standard Finder. When you use
DiskTop, you can manage files and folders, and restart or shut down your
Mac. Useful additions include the capability to calculate the total size of a
selected group of ftles and folders, an improved Get Info ... command, displaying the path to a chosen ftle or folder, and the capability to set AppleTalk
access privileges.
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Figure 11.23 The DiskTop window.
The DiskTo p Get Info ... command displays the same information available
from the Finder command, but with a greater degree of control. You can add
a special set of comments (called CE Comments) that remain anached to the
file even after rebuilding the Desktop. (Comments added directly to a Finder
Get Info window are normally deleted when the Desktop is re built.) You can
set the user level to normal or technical. In the laner case, you also can view
and alter the type and creator fo r each file, as welJ as change file attributes
(Locked, Invisible, Bundle, and so o n).
The DiskTop Find command e nables you to locate files and folders rapidly
based on their name, creation or modification date, file type, creator, or size.
You can launch any file that appears in a DiskTop or Find window by doubleclicking on that file. You also can swap the "found list" for the DiskTop list
that curre ntly appears. You can use Find and DiskTop togetl1er, for example,
to locate and reorganize every Microsoft Word document on your drives, or
ro make a copy of every file modified in the past 24 hours. Find is available as
a button within DiskTop a nd also is presenred as a separate DA in the Apple
menu.
DT Launch is the final piece of the program. As in QuickLaunch, you decide
which programs and documents are to be included in the lau nch list, and

you can change them as often as necessary. Selecting OT Launch from the
Apple menu, or pressing Command-Shift-A from the Finder or from within
another program displays the list of all installed applications and files (see
figure 11.24) .
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Figure 11 .24 DT Launch provides fast program and document access.
You can select any program or document from this list and open it immediately. In addition to using OT Launch to launch programs, the same function
is available by double-clicking on any file in a normal DiskTop directory list.

Improving the Finder with Shortcut
Shortcut is a Control Panel device from Aladdin Systems that modifies standard File dialog boxes so that when you open or save a file, powerful new
options are presented . In System 6, for example, when the File dialog box
appears, you need to click on the Drive button to change drives and click on
the pop-up folder menu to move from one folder to another. If you have
multiple drives and layers of folders, the process becomes tiring quickly.
After you install Shortcut, click on the drive icon in any File dialog box to
display the Shortcut pop-up menu (see figure 11.25). You can quickly change
to a specific drive-rather than just the following drive in the finder chainby selecting it from the menu or by pressing a special Command-key
combination.
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Figure 11.25 The Shortcut pop-up menu.
Two of Shortcut's most useful functions are the Go to Folder and Open File
com mands-used co select folders and files from among those recently
opened. Shortcut keeps track of the last five folders and files you accessed,
and adds their names to menu lists automatically. Frequently used files and
folde rs also can be added to the lists manually.
For users who don 't like moving between windows, noth ing is more annoying than jumping back to the Finder to deal with mundane file tasks.
Shortcut enables you to perform most of these functions o n the fly from its
pop-up menu. Options include re naming, deleting, and "shredding" files;
creating new folde rs; and displaying Get Info dialog boxes for files and folde rs. The speedy Fast Find command enables you to locate a file o r folde r.
You can search by file name, creation date, o r modification date.
Shortcut comes with two "viewers" chat enable you co view text or PICT files
(see figure 11.26). After you open a text file, for example, you can assign a
new fo nt to that file a nd copy selected parts to the Clipboard.
The View command is extre mely useful whe n dealing with PICT files and
enables you to view fi les before placing them in a deskcop publishing program. The PICT viewer also includes a marquee tool with which you can
select all or a part of a graphic, copy it to the Clipboard, and then paste it
into another drawing or docume nt.

Figure 11.26 The Shortcut viewers handle text and graphics.
Shortcut has a special relationship with Aladdin Systems' file compression
utility, Stufflt Deluxe. If both Stufflt and Shortcut are installed, you can use
Shortcut menu commands to save o r open files in any of the Stufflt compression formats. Yo u also can use the Fast Find ... command to peek inside a
Stufflt archive for a lost file. If Stufflt is present, normal Save dialogs boxes
are altered automatically to provide a Stuffit option (see figure 11.27).
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Figure 11 .27 Stuffl t Deluxe enables you to compress files from every Save
d ialog box.
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The new option ("Stuff with compression:") is added at the bottom of every
Save dialog box and enables you co compress a file as it is saved. You can use
any one of Stuffit Deluxe's compression methods by selecting the method
from the pop-up menu.
Shortcut was not designed to perform all Finder activities-just those related
co loading, saving, and deleting files. But it goes a long way towards making
this process painless. And if you already own and use Stuffle Deluxe, the
productivity gained by marrying the two products should be more than
enough to justify buying Shortcut.

NOTE: When run under System 7, a few new programs (most
notably Microsoft Word 5 and Excel 3) use a new type of File
dialog box that effectively bypasses Shortcut.

Improving the Finder with POWERicons
In the Desktop File menu, System Ts Make Alias o ption provides an extremely useful function for creating icons linked to programs or documents
located elsewhere on the disk. And recently, several programs and DAs have
included d1eir own special "launch" programs-icons that, when doubleclicked, find and launch the creating application automatically wherever it is
o n your disk. Examples of these programs are File Director, KaleidaGraph,
DocuComp, and Quickletter. POWERicons from Magic Software provides
these capabilities for any program or document run under System 6. With
POWERicons, you can create icons that open or print one or more documents or launch a particular program.
POWERicons is controlled from a single dialog box (see figure 11.28). You
use the menu bar only to quit the program.
When creating a new icon, you select the applicatio n, choose.a worki ng d irectory (the directory the program should offer as a default when loading or
saving files) , name the ico n, and then determine whetl1er the program or
document should be represented by a POWERicons ico n or display the
application's icon. Optionally, you ca n link one or more files to the icon by
adding them to the Attached Documents list. You can specify if each attached document should be printed or just opened when the icon is
do uble-clicked. Spend five minutes with the manual and you will know everything you need to make your own launch and print icons.
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Figure 11.28 The POWER icons dialog box.
Each icon you creace is tiny- caking u p only 5K of disk space. From a scorage
standpoint, there is little harm in scattering POWERicons all over your disk.
Like any other file, you can place POWERicons anywhe re ic is conve nient fo r
you. You can arrange che icons along the bottom of your screen, for example,
or coss che icons in a project folder co make them easy co find.
POWERicons is great for helping novices, trainees, and business associates
get work done on an unfamiliar computer. lf a series of spreadsheets must be
printed at the end of each week, create a POWERicon that automatically
opens and prints the appropriate files. If you need co be away, anyone in the
office can generate the reports for you by simply clicking on the icon.
Bear in mind that POWERicons is not a program subscicuce. If che associated
program is not on your disk, the icon will not work. Similarly, you cannot use
the icon to open DAs or run macros. You also sho uld note that after you
create a POWERicon, you cannot edit ic. If you wan t to change the icon in any
way, including the appearance, documents attached, and so on, you must
creace a new icon.

Improving the Finder with Tiles
)use as DiskTop and DiskTools share the same market, you might consider
Tiles to be POWERicons on steroids. Each icon you create with Tiles represents one of three things: a program, a document, or a QuicKeys 2 macro.
Program tiles launch programs, document tiles launch documents, and
QuicKeys tiles execute QuicKeys 2 macros.
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Yo u can create tiles ma nually o r aucomatically. The easiest way to get started
is to use Tiles in auto-create mode. As lo ng as Tiles is running, auco-create
instructs it co keep track of the programs you run and che documents you
o pen and instantly create a new tile fo r each program or d ocume nt. Because
Tiles must be running in the background for the auto-create fea ture to work,
you must start Tiles before you ope n an applicatio n.
Tiles are arranged in palettes. There is a separate pale tte for all programs a nd
o ne for every set o f program docume nts. Clicking on a n application tile and
selecting Open ... from the File me nu displays all the docu ments you recently opened in that particular program. Double-clicking on any d ocument
launches the program in which the document was created. You use the contro l bar across the top to activate masc Tiles functions (see figu re 11.29).

Figure 11.29 Tiles pale ttes enable you to launch programs and docume nts.
To keep the palettes from becoming over-crowded, you can specify the
maximum numbe r of ciles and how long seldom-used tiles should be retained. If the maximum number o r time-limit is exceeded , the oldest tiles are
deleted automatically. In addition, if you do not use a tile within the time
period you have specified, that tile is discarded. Like POWER icons, if you
find it more convenient, you can move tiles to the Desktop.

le is not necessary to let Tiles do all the work. If you want more control over

the tiles that are created, you can choose the documents and applications
individually, or you can tell Tiles to create new riles for all applications or
documents contained in a particular folder.
Although much of your everyday work consists of one-shot affairs, such as a
memo to a co-worker, you can group some computer accivities together as a
unit. To create an annual report, for example, you may pull together information from a word processing docu ment, a spreadsheet, and a graphic
program. Tiles supports groupings of this sort and labels chem projects. A
project consists of any group of related files you want to use together. Defining a set of files as a project tile enables you to open all the fi les with a click
of the mouse.
Other Tiles options enable you to customize the appearance of tiles. You can
place tile names on or beneath riles, import icons fo r tile faces or design your
own, display or hide the control bars, and view tiles as icons, small icons, or
a list (see figure 11.30).
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Figure 11.30 The Import option enables you to import file icons or pictures
to be used as tile symbols.
You also can manage the appearance of the Desktop by stacking tile windows
and issuing clean up commands. You can perform many file functions, such
as copy, rename, move, or delete, by manipulating tiles associated with individual files. You also can pin tiles to a palette to keep the tiles from being
deleted.
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System Resource
Management Tools
hi rd-party software vendors have developed a special category o f utilities
that improve the way the Mac hand les system resources, such as fonts,
desk accessories, and sounds. The four utilities discussed in this section are
Adobe Type Re union, Adobe Typ e Manager, Suitcase II, and Masterjuggler.

T

Organizing Font Menus with
Adobe Type Reunion
Whe n you pull down the Font menu in a word processing, spreadsheet, or
other program, the list is sorted alphaberically by font name. lf you install
many fonts, the font list can become unwieldy. In parricular, you may have
several fonts wirhin rhe same type family (see figu re 11.31). If you install
variants of the Times family, for example, rhe Font me nu may list fou r individual fonts: Times, Times Bold, Times Italic, and Times Bold Italic. Their
actual names are Times, B Times Bold , I Times Italic, and BI Times Boldltalic,
respective ly. Because they are alphabetized, the names of the individual
Times typefaces wi ll be scarrered throughout the font list rather than displayed together.
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Figure 11.31 Inscalling a type family can add many names to the font menu.

In some programs, such as Microsoft Wo rd, you can remove the additional
fonts from the program's font list. Unfortu nately, this solution only works
within the sp ecific program and you must pe rform this task fo r each font.
Within each type family, Adobe Type Re union regroups typefaces so that they
appear together in the Font menu. Only family names are listed in the font
list. To access the fonts within a family, select the type family name with the
mouse and a pop-up menu of styles appears (see figure 11.32).
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Figure 11 .32 The pop-u p menu displays all the installed fonts for each type
family.
Adobe Type Reunion is simple to use. Just place the !NIT in the System
folder. You do not need to run any special programs or configure options.
Just toss in the !NIT and forget about it.
Adobe Type Re union creates submenus for aJJ bitmapped fonts that have
more than one instalied style and are written in the PostScript language.
Adobe Type Re union works with aJmost every Macin tosh application. However, it does not affect font lists that appear in dialog boxes.

Managing Fonts with
Adobe Type Manager
Adobe Type Manager (ATM) uses font outline files to improve the on-screen
display and print quaJity of PostScript fonts on bitmapped printers. It pro-
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vides the same functionality to PostScript fonts as does TrueType technology.
Without ATM, to get a good-looking font rendering on-screen, you must
install that particular font size in your System folde r.
After you install ATM, you only need a single bitmapped font size installed for
each typeface you inte nd to use. ATM is capable of generating on-screen fonts
in any size, as long as the appropriate outline file is available-you no longer
need to install all the various sizes of fonts for each screen font. If ATM finds
an existing bit-mapped screen font in the proper size, that screen font is used
rather than ATM. Figure 11.33 illustrates the appearance of a 72 point font
with ATM and without ATM.

Adobe Type
Manager

Adobe Type
Manager
Figure 11.33 Helvetica Bold with ATM (top) and without ATM (botto m)
installed .
In addition to reducing the amount of space devoted to screen fonts on your
hard disk, the other major benefit is when you print to a non-PostScript
printer. Histo rically, PostScript printers, such as the Apple LaserWriter HNT,
have always been capable of producing smooth printed type at any size by
using outline fonts to generate the characters. Non-PostScript printers, such
as the ImageWriter, could not use o utline fonts. Instead, characters were
generated directly from the installed bitmapped screen fonts. If you did not
install a particular fon t size, characters printed in that size appeared jaggedjust as they did o n-screen. With ATM, non-PostScript printers gain access to
the o utline font files, enabling them to print smooth characters in any size.
The ATM CDEV enables you to set the size of the f ont cache-an amount of
RAM set aside for ATM to do its work. The default size is 96K; however, if you
use multiple fonts per document, Adobe recomme nds you reset the cache to
about 50K per font. Wh en counting fonts, each typeface counts as an individual font. For example, News Gothic Regular, Oblique (Italic), Bold, and
Bold Oblique count as four fonts. Other typestyles such as outline, shadow,
and strikethru do not affect this total.

ATM is shipped with the outline and bit-map ped files fo r the Helvetica,
Times, Courier, and Symbol fonts. It also comes with a utility called Font
Porter you can use to install bitmapped screen fo nts if you are using System
6. For System 7 users, ATM also works with TrueType fon ts. Note that if you
use True Type a nd PostScript versions of the same fo nt in a document, the
TrueType font takes precede nce.

Managing Fonts. DAs. Sounds, and
FKeys with Suitcase II
In System 6, you normally use Apple's Font/DA Mover to install screen fonts
and desk accessories directly into the System ft.le. However, you may run into
two proble ms:
• You are limited to a maximum of 15 desk accessories and 500 fo nts.
• Adding large numbers of screen fonts in various sizes can make your
System file swell u ncontrollably.
Every d ay, more wonde rful utilities seem to appear-and many of them are
desk accessories. As far as many users are concerned, 15 DAs aren't nearly
e nough . Apple agrees and has dealt with this pro ble m in Syste m 7. However,
if you are using System 6, Suitcase II enables you to access as many fon ts and
DAs as you want. The secret is to leave tl1e fonts a nd DAs in the ir o riginal files
(called suitcases). Rather than install the fo nts and DAs into your System file,
you tell Suitcase II which font and DA suitcases you want to o pen automatically at start-up. The normal default opens a maximum of twelve suitcases,
but you can raise the limit. Each font or DA suitcase is capable of containing a
maximum of 500 fo nts or 52 DAs.
The new fonts and DAs will be available each time you restart the Mac. lf you
use Suitcase ll, 20, 30, o r more DAs is no proble m. Figure 11.34 shows what
an expanded DA list looks like. If you have more DAs than can fit o n your
screen, you can scroll the list, and then select the o ne you want.
In additio n to sp ecifying DA and font suitcases to open at start-up, Suitcase 11
also enables you to ope n DAs on the fly during a normal computing sessio n.
You can access DAs without installing the m-either in the Syste m or for use
with Suitcase II. You also can organize the Apple menu and move any d esk
accessory to the top to make it easier to find. This is particularly useful for
important DAs, such as the Chooser and Control Pane l.

More Useful Utilities
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Figure 11.34 Suitcase II expands the Apple menu.
Suitcase II has several utilities and options for dealing with fon ts. You can
view an example of any installed font- in any size and style by clicking on the
Show button in Suitcase II. Suitcase II also tells you whether printing will be
done with the bit-mapped font or a PostScript version (see figure 11.35).
Font Harmony, another useful Suitcase II utility, can resolve font ID conflicts
(every font used on the Mac is identified by a number) and can merge members of font families together. Font & Sound Valet compresses fonts and
sound resources and unpacks them automatically as they are needed.
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Figure 11.35 Suitcase II's Show option makes it easy to examine fonts.
Suitcase II also enables you to do the following:
•

Play any installed alert sound such as boing, simple beep, monkey, and
so o n.

•

Manage FKeys (Command-Shift-1 through Command-Shift-0) by letting
you re name, renumber, or invoke the m from the Suitcase II window.

•

Inspect the contents of unopened suitcases.

•

Use the actual fonts to display fo nt names in any program's Font menu.

Managing Fonts, DAs, Sounds, and
FKeys with Master.Juggler
Like Suitcase II, Masterjuggler fro m ALSoft is a utility that enables you to
move beyond the limits of the number of fo nts and DAs you can install under
System 6 by specifying the suitcase files you want to open on start-up. In fact,
if you look at the two p rograms side by side, you will see that they have very
similar capabilities.
You can use Masterjuggler and its various utilities for the following tasks:
•

Load fo nts and DAs from suitcases automatically du ring start-up o r on
the fly during a computing sessio n.

•

Resolve font, DA, sound, and FKey name o r numbering conflicts.

•

Combine fo nts into families to shorten Font me nu lists.

•

Handle System sounds and FKeys.

•

Heset the number of simultaneous open files the Mac allows.

More Useful Utilities
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After you install Masterjuggler by dragging the file into the System folder,
Masterjuggler adds itself to the Apple menu. \Xlhen you select MasterJuggler
from d1e DA list, d1e MasterJuggler pop-up menu appears with ten options:
MasterJuggler, Application Lis~ DA Lis~ Font Lis~ FKey Lis~ Sound Lis~
FontShow, HotSounds, KeyChains, and ResContlicts. A hot key can be
assigned to each option so they can be invoked without opening the Apple
menu.
The ten options provide the following functions:
•

MasterJuggler enables you to open, close, or view the contents of font
and DA suitcases.

• The Application List displays the currently open applications (under
MultiFinder) and enables you to switch amo ng them, restart or shut
down the Mac, or launch a different application.
• The DA List shows the currently installed DAs and allows any of them
to be opened from the keyboard-no mouse-handling required.
•

Font List displays the names of all installed fonts using the actual font
face and any of nine styles.

• Fkey List shows all installed FKeys and enables you to select them by
name.
• Sound List can play any installed System alert sound or select one to
replace the standard beep.
•

FontShow, which is an expanded version of Font List, can display a
sample text string; display the text string in seven different sizes;
display only bitmapped, oudine, or both types of fonts; and print font
samples (see figure 11.36).

•

HotSounds is used to assign sounds to vario us system activities, such
as system start-up, restart, and disk insertion or ejection. To play any of
the sounds, hold down the Option key while clicking on the name of
the sound you want to hear. You can assign a specific sound, no sound,
or a random sound from the set of installed sound resources for each
activity (see figure 11.37).

•

KeyChains enables you to create a sound or an applicatio n chain. A
sound chain consists of o ne or more sounds that you want to playeither once or continuously. Application chains consist of several
programs you want to launch as a group.
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Figure 11.36 FontShow displays every fo nt in its own typeface and enables
you to enter your own sample text string.
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Figure 11.37 HotSounds is used to play and assign sou nds to system
activities.
•

ResConflicts is used to identify font, DA, sound, and FKey name and
ID conflicts.

Masterjuggler also includes the following utilities:
•

Foot/DA Utility which merges fonts into famil ies, changes fo nts into
NFNTs (New Fonts), and renumbers or renames fo nts and DAs.

•

FKey/Sound Mover which enables you to move sound resources and
FKeys among files, as well as rename and renumber these resources.

More Usefu l Utilities

•

Set File Count which enables you to change the maximum number of
open files allowed by the System.

•

Resource Resolver which resolves font and sound ID number conflicts
automatically.

•

Sound Converter which manages sound fi les; converting between
formats and renaming, renumbering, playing, or removing sound
resources.
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Like Suitcase II, MasterJuggler performs its fo nt- and DA-handling duties
transparently. The Masterjuggler disk includes several public domain fonts,
DAs, and sounds.

Printing Tools
pple System software includes drivers for standard printing, plus
Backgro under for background printing o n lasers. If you want to do anything else with your printer, there are several utilities that offer special
capabilities beyond that of the System software.

A

Printing with DynoPage
If you keep up with PC printer introductions, you may have noticed that
several Hewlett-Packard Laserj ets now feature duplex (two-sided) printing.
PostScript printers generally do not provide o ne-pass duplex printing. You
must turn the paper over and feed it thro ugh a second time. For this to work,
however, your Macintosh program must enable you to print the even- and
odd-numbered pages separately. Only a few Macintosh applications- most
notably desktop publishing programs-will let you do this. If you want to
add this capability to almost every Mac program, you need DynoPage from
Portfolio Systems.
Dyno Page works by intercepting no rmal print requests and reformatting and
repaginating the output as desired. The package consists of a special printer
driver, a CDEV, an FKey, and a series of layout templates. Whenever you
select a program's Page Layout.. . command, after the normal dialog has
been dismissed, DynoPage displays its own dialog box. A scroll box in the
dialog box enables you to select any DynoPage layout templates that are
stored in your System folder. A text description of each layout is p rovided.
Other options allow you to print single- or double-sid ed , leave space for

binder holes, and specify the size of the printout (full-size, a percentage
reduction, or reduce as needed to match the original pagination).
When you next issue the Print command, DynoPage takes over the data
handling and prints the job using the most recently selected template. In the
case of double-sided printing, DynoPage displays an alert box instructing you
to reinsert the paper when tl1e first half of the job has been completed.
Templates are provided for printing between 1 and 16 pages on each side of
the paper. Popular paper sizes such as U.S. Letter, Legal, and A4 are supported. If you use a Day-Timer, Day Runner, or another personal organizer,
you will find DynoPage parcicularly helpful. DynoPage ships with a set of
Instant Address Book Paper (DynoDex #106) that is pre-punched, serrated,
and ready for use in your laser printer.
DynoPage's strong points are the ease with which you can do double-sided
printing, and print address books and personal organizers. Its only significant
weakness is that, although it can print two pages per side of paper, it cannot
print a simple "fold-it-in-half" booklet. (Note: The current version of
DynoPage is not compatible with SuperLaserSpool) .

Print Spooling with SuperlaserSpool
If you have used Backgrounder (part of Apple's System software) you are
already familiar with the concept of spooling. Instead of feeding the data
directly to the printer, a spooling program merely captures the entire print
job and saves it co disk. Then, as the printer is ready for more data, the
spooler sends it along. The advantage of using a spooler is that your computer isn't tied up while you print. Instead of printing everything in the
foreground (forcing you to watch an interminable Print dialog until the
entire job is finished) , you can go about your computing while the printing is
handled in the background.

NOTE: Even with Background Printing selected in the
Chooser dialog, many programs still print in the foregrounddesktoppublishing, fo rms design, and graphics programs often
do, for example. SuperLaserSpool quickly spools them all so you
can get on with your work.
There are two pieces co Fifth Generatio n System's SuperLaserSpool: an !NIT
and Laser Queue, a desk accessory. Laser Queue is used to configure and

More Useful Utilities

The 9-to-5 Mac

control the operation of SuperLaserSpool (see figure 11.38) . Options enable
you to perform the following tasks:
• Set the location of the spool ftles.
• Change the order of or delete print jobs that are in the queue.
• Route jobs to different printers.
• Pause printing.
• Preview documents before they are sent to the printer.
• Change the amount of RAM allocated to the print buffer.
• Specify the level of network prioricy.

Supt rl~strSpool

v2.02

Cop!Jr loM 198 7-1990
Andi.J tlus:s and Nick G.tult

. Microsoft Word•Product lnde•I
2. PngeMaker 4.2•Uoyoger• 2
3. PngeMaker 4.2•Uoynger• I

18] Use dragging to change queue order
S tatus -----------~

ufff' : l1c1, documtnt: Microsoft 'W'Of'd-eProduc:t lndt• I , shtus:
Pf'oc+Uing job

Figure 11 .38 Each document in the queue is numbered. As jobs are printed,
messages appear in the status window to let you know what is happening.
Fifth Generation Systems also makes a similar product for direct-connect
ImageWriters called SuperSpool. lf you want to reduce non-productive computing time-time that is spent waiting for a DTP or graphics program to
finish printing-you should consider SuperLaserSpool or SuperSpool.

Automating with Macros
aero utilities enable you to take common activities, such as making one
or a series of menu selectio ns, and perform them by pressing a single
Command-key. As work- and time-savers, macro programs are unbeatable.

M

A macro is a series of keystrokes, menu selections, and/or mouse actions that
can be initiated by a single user action (usually pressi ng an assigned key

combination or selecting an item from a macro menu). Some macros can
execute automatically based on the time on the system clock or the number
of minutes since start-up. A macro can consist of as little as a single mouse
click or menu selection or be as complex as launching one or several programs, completing a series of actions, and then quitting to the Finder. Macros
can perform tasks within programs, between programs (transferring information between two applications, for example) , or at the Finder Desktop.
Macro programs typically p rovide a recorder or watch me feature. To create
simple macros, the recorder is turned o n and the user steps through the
actions that the macro is inte nded to perform. Changing a text string in your
word processor from its current font to Helvetica, for instance, would only
require selecting the text and choosing Helvetica from the Font menu. By
selecting the text before turning o n the macro recorder, you can create a
general macro that-on playback- will only affect the currently selected text.
Depending on the macro utility being used, more complex macros may involve some programming with the macro or scripting language or, at least,
may require some e diting (inserting a pause for a specific period of time, for
instance). Spreadsheet macros, for example, are seldo m based solely on
recorded actions.
Many major programs now include macro capabilities. Spreadsheets almost
always have a macro or scripting language. High-end communication and
backup programs frequently offer this feature, too. Word processing programs are also fertile territory for macro programs. WordPerfect has the
feature built-in. Microsoft Word 4 included AutoMac lli, a standalone macro
utility that can also be used with other programs.
We have already discussed the macro and scripting capabilities of several
programs. In this chapter, we will look at standalone macro utilities. Even if
you have never used a macro program, if you have ever had System 6 installed o n your Mac, you 've seen Macro Maker-a simple macro recorder.
(Macro Maker was included as a part of the Syste m software, but has now
been abando ned by Apple with the release of System 7.)
Today, the most significant standalo ne macro programs are QuicKeys 2 (CE
Software) and Tempo II (Affinity Microsystems Ltd.). We will examine tl1e
former so you can see the many ways in which macros can increase your
productivity. Although the comments will refer to QuicKeys 2, you will find
most of the information applicable to other macro utilities, too.

More Useful Utilities
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QuicKeys 2 is composed of CDEVs, IN!Ts, and a desk accessory. Whether a
mo use click or movement, menu selectio n, or text entry, each action can be
stored in QuicKeys 2 as a QuicKey. Every macro consists of one or more
QuicKeys and can be initiated with a single user-designated keystroke, by
selecting it from the QuicKeys menu, or be made to occur at a particular time
or number of minutes after system start-up. To create a macro, follow these
steps:
1. Open the QuicKeys 2 desk accessory or CDEV.
2. Select ''Record one QuicKey," ''Record Sequence ," or ''Record Real
Time ."

3. Perform the action or actions that you want QuicKeys 2 to record.
4. Select Stop Recording ... from the QuicKeys 2 menu.
5. Specify a name for the macro, a keystroke to activate it, and whether
you want it to appear in the QuicKeys 2 menu.
Every macro is either assigned to the specific program which you were using
at the time or can be a universal macro, available from within any program.
Macros that invoke desk accessories, for example, are normally universal
macros. Because each group of program-specific macros are kept separate
from other program-specific macros, you can use identical keystrokes in two
programs to produce slightly (or extremely) different results. For instance,
Control-Option-Command-B might be used to change selected text to Adobe
Garamond Bold within PageMaker, but changes text to Times Bold in Write
Now.
When you select the QuicKeys 2 ... option from the QuicKeys pop-up menu,
a screen similar to the one in fig ure 11.39 appears. By clicking or Shift-clicking on icons at the bottom of the window and selecting particular keysets,
you can restrict the list to specific QuicKey subsets.
Most QuicKeys are recorded as a sequence. \X'hen played back, they execute
as fast as the Mac can handle them. For some time-sensitive applications and
when creating on-screen demos and training materials (showing the steps to
do a mail merge, for instance), QuicKeys 2 can record in real time. When
activated, real time QuicKeys will execute at the same speed as when they
were recorded.
QuicKeys also includes several extensions- small programs that provide new
functions. Two of the most useful extensions are Choosy (select Chooser

devices without opening the Chooser), and Panels (work with CDEVs without opening the Control Panel). Some programs from other manufacturers
(Stuffle Deluxe, for example) include their own QuicKeys 2 e>..'tensions.
2.1
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Figure 11 .39 This dialog box enables you to manage QuicKeys by viewing,
editing, loading, listing, and printing them.

More Macro Ideas
The following are some ways that QuicKeys 2 can save you time, mouse manipulation, and aggravation.
•

Program launcher. Why hunt through dozens of folders for your
favorite programs or a particular document? You can use the File
QuicKey to Launch any program or document. The QuicKeys 2 manual
suggests that you assign a different program to each function key.
You can take this a step further and automate your actions in the
program after it is launched. You can, for example, use Virex to check
every new disk for viruses.

•

Font selector. Although every word processing and page layout
program contains a Style menu and associated Command-keys, what if
your system contains real boldface and italic versions of installed fonts?
To specify the Helvetica Bold font (rather than the Helvetica font with
the bold style applied to it), you must select the font from the Font
menu. Record One QuicKey or a Menu/DA QuicKey works great for
selecting particular fonts. If you have many fonts, assigning QuicKeys to
the fonts you use the most can save a lot of needless menu pulling.

More Useful Utilities
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Instant access to essential DAs. QuicKeys 2 also can be used as a
desk accessory launcher. Rather than sorting through a list of thirty DAs
dozens of times each day, you can create a QuicKey to display your
calendar, the Control Panel, or an address/phone number database.

• Selecting Chooser devices. If you have two primers (or a primer and
a fax-modem), you can create two QuicKeys: one for each device,
followed by a Page Setup ... command so that the current document
will be fo rmatted and paginated correctly.
• Timed activities. Not all communication and backup programs
support timed activities. You can use QuicKeys 2 to launch your
communications program at a particular time, connect with an information service, download a new messages, and then Jog-off. You can
add a repeat function to make this happen at d1e same time every day.
You also can use the same type of macro to perform a daily timed
incremental backup of an important disk drive.
• Sequences. As you use your favorite programs, you will probably
no tice that you repeat certain sequences over and over. When creating
a document, you may find that you use a particular phrase over and
over. Rather than typing the phrase at each occurrence, just use a
QuicKeys macro.

Macro Tips
If you give some thought before creating a large amount of macros, you will
spend less time editing them later. The following suggestions may help when
creating several macros.
• QuicKeys 2 can maintain separate keysets for each program that you
use. Don't be afraid to reuse the same key combinations. Just make
sure not to duplicate the keystrokes in the Universal Keyset or used by
the current program.
•

Be as co nsistent as possible when assigning key combinations-or
devise a strategy for keeping them straight in your head. To avoid a
conflict with most programs, all of my key combinatio ns are ControlOption-Command, plus a single letter key. If you have an Apple
Extended keyboard, it is an easy combination co press. Od1er possibilities include a letter plus the Control key or a function key (Fl through
Fl2).

• Whenever possible, use a mnemonic letter for each macro, such as
Control-Option-Command-B for boldface.
• Don't create more macros than you can remember.
•

Not all macros need to be permanent. Make temporary macros to
tackle the task at hand, and when you see no further use for the macros
just dele te them.

Summary
n this chapter, you learned about utilities you can use to make your life
with a computer a bit easier. In specific, you learned about the following
tasks:

I

• Locating files using the Locate, GOfer, and On Location utilities.
• Recovering data with MacTools Deluxe, 911 Utilities, Last Resort, and
CanOpener.
• Saving disk space and compressing files with Stufflt Deluxe,
DiskDoubler, and Compact Pro.
• Optimizing your hard disks using Optimizer and Disk Express.
• Improving Find er capabilities using File Director, DiskTop, Shortcut,
POWERicons, and Tiles.
• Managing fonts and DAs with Adobe Type Reunion, Adobe Type
Manager, Suitcase II, and Master]uggler.
• Printing with DynoPage and SuperLaserSpool.
• Automating tasks with QuicKeys 2 macros.
In Chapter 12, "Protecting Your Investme nt", you will learn how to protect
your hardware using several special techniques and programs.

More Useful Utilities

Protecting Your
Investment
Like most business users, you have a substantial investment in your Mac-the
cost of the equipment, software, and perhaps what is more important, the
value of the data that you have painstakingly entered into spreadsheets, word
processing documents, databases, and accounting programs. When you work
with computers, there are simple inexpensive steps you can take to guard
against data loss and equipment damage.
This chapter describes measures you can take to protect your investment.
Some procedures deal with the proper way to use your equipment. Others
are hardware modifications that can prolong the life of your equipment.
The suite of software products every computer user should own is
also discussed. ln this chapter, you will learn how to:

T

• Protect hardware with products, such as static
guards, surge protectors, and uninterruptable
power supplies.
• Use screen savers to protect your monitor.
• Back up your data.

/
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•

Protect your entire system using virus detection.

•

Handle hardware repairs.

Hardware Solutions
When operating a Mac, you can protect your data and prolong the life of your
equipment. Getting into the habit of adhering tO the following guidelines can
help you avoid many of the simplest and most common p;oblems.

Protecting Hardware with AntiStatic
Sprays, Strips. and Mats
Static electricity and magnetic fields can be lethal to the data on your Mac. A
sufficient dose of either can destroy the floppy disk in your hand or the hard
disk drive on your desk. Even the static electricity you generate when walking
across carpet in cold and dry weather, or the magnetic field that surrounds a
telephone can be enough to destroy data.
If seasonal static is a problem for you, there are several effective solutions.
You can use anti-static sprays, static discharge strips, or anti-static floor mats.
Spray anti-static sprays on the floor surrounding a computer or workstation.
Static discharge strips and anti-static mats both use grounding cords to elimi·
nate static. To discharge static in your body, all you need tO do is much the
strip or mat before you touch your Mac or handle disks.
Data is stared magnetically on floppy disks and hard disk drives. Magnetic
fields can do as much damage tO your disks as can static electricity. Moving a
disk in and out of a magnetic field can erase the info rmation on the disk. The
same guidelines you use to take care of a good cassette tape also apply to
hard disks and floppy disks. In addition, there are some special concerns in
an office environment. To avoid magnetic problems:
•

Do not use magnets to hold floppy disks to the side of your filing
cabinet or desk. (I realize this one sounds silly, but it has happened!)

•

Give away your magnetic paper clip holder or move it away from your
computer.

•

Keep hard disk drives and floppy disks away from most electronic
devices, including telephones. Power supplies, such as the o ne in your
Mac, also contain magnets. In the Mac Plus, for example, the power
supply is located in the left side of the case. This is why you sho uld
never place a hard d isk drive to the left of a Mac Plus, but it is o kay to
put it beneath or on the right side o f it.

Using a Surge Suppressor
Most likely, you have heard about electrical surges. After a power failure,
currents can come rushing up the utility lines and into the circuits of your
home or o ffice. Use a power strip that contains surge-suppressing capabilities
to protect your computer hardware inexpensively.
As with o ther electronic devices, look for a power strip with a UL (Underwriters' Laboratory) seal. Power strips sold as surge protectors have different
capabilities. Inexpensive surge protectors frequently protect against surges
between the hot and neutral wires only. Be sure the power strip you purchase also protects against common mode transients-surges between hot
and ground and between neutral and ground. Sales brochures and catalogs
often call this three-line protection.

Using a UPS
If the area in which you live or work is subject to frequent brown-outs or
extreme power surges, you should consider buying a UPS (Uninterruptable
Power Supply). In simple terms, a UPS is a giant battery. If the electric current disappears suddenly or drops below an acceptable level, the UPS
immediately kicks o n, providing your Mac and peripherals with several minutes of power-enough to ensure that you can save all open documents and
shut down without losing data.
Better UPS equipment also supplies line conditioning. This feature cuts out
the peaks and valleys in electrical output, and ensures that the Mac receives
only "clean" electricity. Although small fluctuations in line voltage may not
crash your Mac, the fluctuations reduce the life span of the system. A UPS
with line conditioning also eliminates surges- anything short of a direct
lightning strike, that is.
At what point do you need to buy a UPS? A decent UPS can cost anywhere
from three hundred to several thousand dollars, depending o n the features

Protecting Your Investment

The 9·to·S Mac

offered, the number of watts for which it is rated, and the length of time it
can provide backup power. For home use, a UPS is seldom warranted, but
certain situations merit the investment. Prior to starting work on this book, a
series of surges destroyed the motherboard of my Mac llci and the power
supply for my fax modem. It became obvious that a UPS with line conditioning would pay for itself in an area where summer is a season of brown-outs
followed by devastating surges.
Before purchasing a UPS, take a few minutes to add up the power requirements of the devices you want to protect. At a minimum, you should protect
the Mac and the hard drives. If the equipment manuals don't list the power
requirements, and many do not, you may need to contact the manufacturers
for the information. Be sure to buy a UPS that is powerful enough to handle
those devices and a bit more (for future expansion). If you get a UPS with
sufficient power, you can connect your monitor(s) as well.
Do not include laser printers in the calculation. The power demands for a
laser are far beyond the demands for other computer equipment. According
to its manual, an Apple LaserWriter IINT, for example, can draw up to 900
watts. The cost of a UPS that would protect o nly this printer is about Sl,000.
Furthermore, it is not necessary to include a printer on a UPS. If the power
fails and your data is protected, all you lose when your printer fails is timenot data. You can reprint the document when the power returns.
Given the cost of recreating information stored on your system, protecting
your hard disk drives from power surges is a necessity. Get a good surge
protector for each system.

Screen Savers
Have you ever walked past a Mac monitor and noticed a shadowy image onscreen? This phenomenon is called bum-in. It occurs when a single
unchanging image appears on-screen for a long period of time. Burn-in does
not make the monitor unusable, but it is unsightly and distracting.
One way to avoid burn-in is to make a habit of turning down the brightness
whenever you will be away from your Mac for an extended period of time. A
simpler solution is tO get a screen saver program. To prevent burn-in, screen
savers place constantly changing patterns on-screen.

If you belong to a computer club or have access to an information service,
such as CompuServe or GEnie, you have access to several free or inexpensive
screen saver programs. lf you would rather stick with commercial products,
two excellent packages to consider are After Dark and Pyro!

Protecting Your Screen with After Dark
After Dark is the premier Macintosh screen saver program. It is a combination
of a Control Panel document and an INIT file that becomes part of the system
at startup. Rather than offer only a single screen saving pattern, After Dark
includes more than thirty different displays. The Control Panel presents a
scrolling list of all installed modules (see figure 12.1). After Dark enables you
to set options, such as volume level, speed, and so on, and then view each
screen saver before selecting the one you want to use.

==~~rn
1 modul•
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~

Complttt Un. •.
3,3,3

Figure 12.1 The After Dark Control Panel.
You also can set other optio ns, such as automatic turn-on time, sleep and no
sleep corners, password protection, and SystemIQ Activity Monitor (it refrains After Dark from activating when you are printing, sending or receiving
data over a modem, or there is disk or CPU activity beyond a certain level).
Screen savers range fro m the classic After Dark flying toaster (shown in figure
12.2) to an aquarium of fis h. In addition, the standard version of After Dark
provides two special modules for those of you who are easily bored. Randomizer enables you to select a list of modules that cycle through at random
whenever After Dark is invoked. MultiModule lets you select a set of modu les
that will appear on-screen simultaneously.

Protecting Your Investment

The 9-to-5 Mac

Figure 12.2 After Dark's Flying Toasters are almost a trademark.
If you find that the original thirty modules are n't enough, Berkeley Systems
sells more modules called More After Dark. Volume 1 offers another 25 cute,
inte resting, and spectacular displays-including alien landscapes, Mandelbrot
drawings, waddling ducks in a confetti factory, an arcade game, a new set of
aquatic life to add to After Dark's Fish! module, and the diagnosis portion of
Virex, the popular anti-virus program. There's also Boris the Cat, a tiny kinen
that chases a butterfly around the screen, scratches itself, and meows!
Most After Dark modules run in color or black-and-white; however, the
screens are more interesting in color. After Dark also supports multiple
monitors, including mixtures of color and black-and-white. Additional userprogrammed modules can be downloaded from bulletin boards and
information services. If you have programming experience, the After Dark
manual even provides instructions for creating your own modules.

Protecting Your Screen with Pyro!
Pyro! is designed similarly to After Dark. Pyro! contains fewer modules (thirteen in total) , but offers more configuration options (see figure 12.3). In
addition to the Sleep corners and automatic-timer activation, you can start
Pyro! by pressing a function key or by selecting Sleep from the Special
menu.
Each time you invoke Pyro! , it displays one of its modules. You can designate
modules as primary or seconda.ry. If memory is available and the underlying
screen activity is minimal, the primary modu le will appear. If circumstances
change, Pyro! switches instantly to a secondary module. Each module also
contains a setting called Persistence you can use to fine-tune the primary/
secondary switching process.
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Figure 12.3 Pyro!'s Control Panel.
One of the most inre resting modules is Aquarium (see figure 12.4). Rather
than just swimming back and fort h, the fish occasionally turn toward the
fronr of the screen and stare at you, and if two fish collide, o ne eats the
other!

Figure 12.4 The Pyro! Aquarium.
Pyro! also offers a password option, support for color or black-and-white
displays and multiple monitors, and instructions for programming your own
modules.
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Uncovering Microsoft Word's
Secret Screen Saver
You may nor realize it, bur if you own Word 4 or 5, you already have a screen
saver! From Word 5, select Commands ... from the Tools menu. To see what
Word's screen saver can do, select Screen Test from che scroll window.
(Press S to jump the first command that begins with che letter S.) Click o n
Screen Test, and chen click o n the Do It button in che upper right corner of
che dialog box (see figure 12.5). The screen fills wich a constantly changing
pattern. To scop the screen or change the display optio ns, click che mouse
button once. To stop viewing the patterns, click the mouse button o n the
screen. and then click o n Cancel
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Figure 12.5 Word 5's Commands ... d ialog box.
Although nor designed as a screen saver, Screen Test still does the job; however, you will experience the following shortcomings:
• You muse be running Word.
• You muse be in an open document.
• Screen Tesc only runs on the current screen. If you use cwo monitors,
the second monitor will nor be affected.
To use Screen Test o n a regular basis, you need to add it to one o f the \'(ford
menus. To add Screen Test (or any other Word command) to a Word menu,
follow these seeps:

1. Select Commands ... from the Tools menu. The Commands ... dialog
box appears.

2. Press S to jump to the section of commands that begin with the letter S,
and then click on Screen Test.
3. From the Menu pop-up menu, select the menu to which you want to
add Screen Test. You can add it to the Tools menu, for example.
4. Click on the Add button next to the Menu pop-up. The command is
added to the menu you chose and will now be accessible by selecting it
from that menu.
5. If you also want to assign a Command-key that you can use to invoke
Screen Test, click o n the Add ... button next to the Keys wi ndow. You
are prompted to press the key-combination you want.
6. Click d1e Close button to close the dialog box.

Virus Protection
And then there are viruses. A computer virus is a destructive computer program or routine that is capable of copying itself into other files and disks.
Most viruses work by attaching themselves to the code of other executable
programs (as many of them as possible). This is what enables them to replicate. Some viruses attack the System file, or the invisible Desktop file that
records the file and folder organization for each of your drives. Any unlocked
floppy disks you slip into a drive also may be susceptible to viruses. Moving
an infected floppy disk to someone else's Mac is one of the most prevalent
means of spreading viruses.
There are many types of viruses. Some cause system crashes or can damage
the progranls to which they become attached. Some are referred to as Trojan
Horses. A Trojan Horse is a program with a seemingly real purpose-just Like
any other application. Behind its avowed purpose is a second purpose-that
of being a virus launcher. When you run the program, a portion of its code
executes and completes whatever damage it was designed to do. Unlike other
viruses, Trojan Horses do not infect other programs. You must run the original program to cause damage.
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Following are some simple steps you can take to prevent your Mac from
becoming infected:
1. Accept software from reliable sources only. Be wary of software
provided by friends or downloaded from bulletin board systems. Even
disks purchased fro m dealers or direct from the manufacturer can be
infected.
2. Lock all disks before inserting them into your disk drive. A locked disk
(one with an open write-protect hole in the upper right-hand corner)
cannot be written to by the Mac. Although it will not keep the contents
of that disk from infecting your hard disk drive, it will prevent the data
and programs o n the floppy disk from being altered by a virus.
3. Allow no one but yourself to use your Macintosh. A few companies
offer hardware locks that insert directly into a floppy drive. Without a
key (or a crowbar), no one will be able to add a virus-infected program
co your system. In some companies, however, this may be impractical
or impossible.
4. Buy and use an anti-virus program.
Anti-virus programs offer two additional approaches to dealing with viruses:
detection and eradication. Detection routi nes frequently can be set to auto·
matically scan any new disk that is inserted into a drive or to check each
program as you launch it. The eradication part of an anti-virus program at·
tempts to eliminate the virus code from each infected program.
For an anti-virus program to retain its usefulness, you will need to obtain
regular updates for the program. As new viruses surface, th e program must
be told how to identify the virus and correct it. Although some companies
may distribute updates through information services, such as CompuServe
and GEnie, corporate users will find it simpler to take the manufacturer up
on its subscription service. For a set fee and period of time, you are sent each
update as it is released.

Preventing Viruses with Virex
Virex from Microcom is a two-part anti-virus utility-a program and a CDEV/
INIT that installs in the system folder. The Virex program is used to diagnose
and to optionally repair selected volumes. In Expert Mode, you can enter
information about new viruses as they are discovered and calculate a
checksum figure for every application on your hard disk. You can compare

future record scans with the originals, and Virex points out any programs
that have been suspiciously altered. The Virex main screen appears in figure
12.6. Selecting Expert Mode from the Options menu adds additional icons
to the screen and greatly expands the options the program provides.
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Figure 12.6 The main screen of the Virex program.
The INIT primarily is used for virus prevention. You can configure it from the
Control Panel to scan every disk you insert during a computing sessio n and
to check every application as it is launched. Other setting options include:
•

File repair.

•

Password requirements to change the INJT settings.

• Temporary disabling of floppy-disk checks.
• Automatic scanning at system start-up or shut-down.
The Virex program and INIT are easy to use regardless of your level of computer experience. To run the program, just select the drives (volumes) you
want to scan, and then click on the Diagnose button. Purchasers of the program are entitled to one free update. The current price for the an nual update
service is $75.

Preventing Viruses with Rival
Rival from Microseeds Publishing resides in your System folder. lt checks
start-up documents automatically when you boot the Mac and files and applications as you open them. Rival displays an icon during start-up and

•

431

Procecting Your lnvesanent

The 9-to-5 Mac

surrounds the Apple icon in the Finder w ith a box when the file or program
is loaded properly.
By checking files and applications as you use them, Rival prevents viruses
from spreading. When a virus is detected, you can eliminate it (Repair) or
temporarily disable it (Stun) . Within the Control Panel, you can instruct Rival
to perform a general check of specific volumes, folders, or files, or to scan all
inserted floppy disks (see figure 12.17).

=o

Control Panel

~~

Key board

C"'
ur_r-'en;..;.t.;..;.
fi1;..;.e_ _-ll-T'-'-o.;.:ta_6

1--'I

I

IQ]

!l!\!J o 1nterna1 HD
!;!!!! o SyOuest S

~;~~j~

E'-'-rr..:.:or..:.-i
~

i..::I

~

D Databases

..,,,. DDTP/WP

:::

Jii!i: oGraphics
Monitor s
···;

lO

Mouse

-

~

'14
332

to

iiil!l
!ii,'. ~1o=p.=n==;:;111===c1=os=e=::;ij:;:l1=ns=ta:::11=:;;-ij;;::IEJ=.e=ct:=:::::;:ij

~ ~~ ~

~_ _ --.....i..:~

Riv•l

# ~ ..§:

!Analyze

1.1 .B - ~1989-91 Fred • nd JMD

ij

CJ

Figure 12.7 You can configure Rival from the Control Panel.
One feature that sets Rival apart from its competitors is the capability to notify you of subversive instructions to erase or format a disk; that is, any format
command not issued from the Finder's Erase Disk menu option.
Like Virex, Rival is simple to use, offers on-line help, and is supported by an
update program. Vaccines, which are instructions for fighting new viruses,
are available from the publisher for $60 for six updates. You also can download vaccines from popular information services, such as CompuServe, at no
expense.

Hardware Repairs
Besides following the prudent hardware and software practices described in
this chapter, you need to give some thought to what you are going to do
when the worst occurs- a piece of equipment fails.

Unless your company is very large, it makes little economic sense to employ a
full-time technician to handle equipment repairs. However, it may be a good
idea to keep a small inventory of replacement parts on hand. Components,
such as monitors, a mouse, keyboards, and external hard disks, easily can be
swapped out as the need arises. The defective item then can be taken co a
repair service or returned to the manufacturer for repair. This can eliminate
the down-time normally associated with equipment failures.
Another option is co buy a service contract. A service contract is insurance fo r
your computer hardware. lf a printer stops working o r a hard drive heads
south, the service company will repair or replace the item within a specified
time period. When shopping fo r a service company, you should look for the
following things:

Reliability and quality of service- How soon can you expect the repair
person to arrive after you call? How long do repairs usually take? Do the
service personnel try to diagnose the problem, or simply begin swapping
parts-hoping to hit the right one? For most businesses, the time wasted in
guessing at a solution negates the value of the service contract. To check on
quality, ask for several references-preferably of companies that are similar in
size and in a similar industry.

Loaner Policy-Resides correcting the problem, it is important to minimize
down-time-the length of time you will not be able to use your equipment
or access your data. If the company needs to take your system to the sho p,
will they give you a loaner in the meantime? A o ne- o r two-day repair job can
screech into weeks if the necessary parts cannot be located.
Price-Most companies charge you an annual fee based on the value of the
equipment included in the contract. Prepare an inventory of equipment and
submit ic to several repair services fo r competitive bids. If possible, request
an itemized quote. You may find that a company is attaching a very high price
to a small set of items they prefer not to cover. With line item quotes, you can
consider excluding those items from the contract.
Remember, a service contract is insurance. And like insurance, if you have a
good year, you lose because you never take advantage of the service for
which are paying. In a bad year, a service contract will seem like the best
investment you ever made. Most service companies and Apple dealers accept
walk-in traffic. However, without a service contract you may have less leverage in ensuring that repairs are done quickly and in receiving loaner
equipment.
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Summary
In this chapter you learned how to protect your system. In particular, you
learned about the following:
•

Protecting your hardware using sprays, magnetic strips, and magnetic
mats.

•

Protecting your equipment from power surges.

•

Protecting your mo nitor screen from burn-out using screen saver
programs.

•

Protecting your d ata and applications from dreaded computer viruses
using virus preventio n programs.

•

Preparing yourself for hardware failu res.

The appendices following this chapter provide extra information that will
enable you to set up your business using the Mac.

·The System 7
Advantage
System 7 is Apple's newest release of its operating system. The operating
system is responsible for the "look-and-feel" of the compute r system and for
the various resources available to programs. No single application is as important as the operating system; it underlies every program and utility on the
Macintosh. For lo ng-term users, System 7 offers a variety of improveme nts
without sacrificing the traditional advantages. System 7 contains no surprises,
but many new features. Some aspects of System 7 discussed in this chapter
include:
• Elegant featu res for improving the appearance of and organizing
the Desktop.
• Multi-tasking features that enable you to work with
more than one application at a time.
• Balloon help.
• Aliases for easier program, document, and
folder access.

/
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An improved System folder that simplifies the installation of system
resources, such as fonts, DAs, and Control Panel devices.

• Virtual memory.

Hardware Requirements
Before you get too excited about System 7 and the wondrous possibilities
that it can open for you, there are several hardware requirements that your
Mac may not currently meet. Owners of older Macs may have to crack open
their wallets and purses before switching to System 7.
First, Macs older than the Macintosh Plus won't be able to use System 7 at all
unless they have been upgraded to Pluses. If you do have a Plus or higher, it
must have at least 2M of RAM (memory). Most users should consider 2.SM of
RAM the bare minimum. This allows you to comfortably run a single small
application. If you intend to use high-end graphic or desktop publishing
programs, however, you will be happier with 4M to 8M of RAM.
Second, your Mac must have a hard disk or an Apple SuperDrive. Although it
is possible to squeeze much of System 7 onto a single high-density floppy
with System 7's Installer program, you will be much happier with a hard disk
since it can hold all of System Ts resources.
With the hardware requirements out of the way, continue reading to see
what System 7 offers.

The Best System 7 Features
The most important features of an operating system are the features you use
every day. When a major system upgrade is introduced, it must strike a balance between new features and users' old, familiar ways of doing things.
System 7 does an excellent job in this regard. Rather than considering System
7 a replacement for System 6, it's better to think of System 7 as an extension
o f System 6. This section reviews some of the most significant changes you
will encounter during your daily work with System 7.

Looking Good
The most noticeable change in the interface of System 7 is the "look." Many
standard elements have been revamped to present a more attractive appearai:ice. Window elements, such as the zoom and close boxes, now have a
three-dimensional look. It's much easier to understand the process of dragging a scroll box, for example, when the element on-screen appears as if it is
actually solid.
If a monitor is only able to display four or less shades of gray (black and
white is two shades), System 7 uses the System 6 style windows. However, if
the monitor can handle more than four shades, System 7 uses the new style
of windows. All the System 7 features are available with the plainer box too,
but the new look is more appealing and easier on the eyes.

Displaying Files and Folders
One of the most striking changes in System 7 is the way in which file and
folder information is presented. As with previous versions of the System, you
can display the contents of a Desktop window three different ways-with
icons, small icons, or as text lists. In System 7, you have greater control over
the way file and folder information appears.
The new Views control panel enables you to select fonts for labels on the
Desktop, set the character size, and organize the Desktop (see figure A. l).
The font settings are applied to the entire Desktop. The organizational settings, such as Staggered and Snap to Grid, are applied to every new
window and also used when you select Clean Up from the Special menu.
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Figure A.1 The Views dialog box enables you to customize the display of files
and folders.
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You also can use the Control Panel to select information that appears on the
text list, such as by size, labels, and so o n. These views are particularly useful
when attempting to locate a group of files, or when you forget a file name.
Perhaps the most useful viewing feature is that you no longer need to open a
new window to view the contents of a folder, as shown in figure A.2.
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Figure A.2 This By Name view displays several levels of folders.
To display the file contents of a folder, click on the triangle that appears to
the left of the file name. The triangle points down and the file names are
listed under the folder. lf the triangle points to the folder name, the folder is
closed.
Another change in System 7 now enables you to edit the icon for any file or
folder-even adding color. Although editing ico ns was always available to
individuals willing to try their hand at programming with a utility such as
ResEdit from Apple Computer, System 7 makes the process simple and
straightforward. With this feature, you can customize the Desktop, creating
an environment that is tailored with symbols meaningful to you.
To change an icon fo r a file or folder, you create the icon in a graphics program, copy it, and then paste it into the file or folder's Get Info dialog. The
Get Info dialog box provides summary information about the selected object
(file, folder or disk) and enables you to change that information. To display
the Get Info dialog box, select the file or folder, and press Command-I.

To change an icon, follow these general steps:
L Open your graphics program and design the icon.
2. When you finish designing and editing, select the icon image with the
Marquee tool if you are running a Pa.int program, or the pointer tool if
you are running a Draw program. Press Command-C to copy the new
graphic to the Clipboard.
3. Select Finder from the Application menu or simply click in an empty
area of the Desktop.
4. Click on the icon of the ftle or folder you want to replace.
5. Select Get Info from the File menu. The Get lnfo dialog box appears.
6. Click on the icon that ~ppears in the upper left area of the dialog box,
and select Paste from the Edit menu.
7. Click on the close box to close the Get Info ... dialog box. The new
icon appears in place of the old one.

NOTE: lf you prefer to edit an existing icon rather than create
an entirely new one, you can copy an icon by selecting the icon
for a ftk ur folder on the Desktop. Press Command-I to make the
file or folder's Get Info box appear. Click once on the icon to
select it, and then press Command-C to copy the icon to the
Clipboard. Finally, in the graphics program, paste the image of
the icon into the drawing area by pressing Command-V. Edit as
necessary to create the new icon.
If you later decide you want to revert to the original icon, perform a Get Info
on the file or folder again, click on the icon once in the Get Info dialog box,
and press the Delete key.

Multi-Tasking and Moving
among Applications
\Vhen running System 6, if your Mac had enough memory, you could operate
under MultiFinder and have several programs open and running at the same
time. This is referred to as multitasking. For Macs with limited memory, you
can switch off MultiFinder and run under the Finder, enabling you to execute
only one program at a time. In System 7, MultiFinder is no longer just an
option-it is a permanent part of System 7.
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In System 6, you can switch among open applications by clicking on the
small application icon in the upper right-hand corner of the screen. Each
click cycles from the current application ro the next program in line. System
7 has taken this approach a step further. Clicking the tiny application icon
now presents an application menu (see figure A.3).
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Figure A.3 The Application menu is a new feature of System 7.
When you open an application, the icon and name appear under the Appli·
cation menu at the far right side of the menu bar. The Application menu is
designed ro provide easier access to multiple applications by enabling you to
hide application windows, move between applications, and move to the
Finder rapidly just by making the appropriate menu choice.
Often the Desktop becomes cluttered with open windows generated by the
numero us applications and DAs you are running concurrently. System 7
clears away the clutter without closing down applications or windows using
the Hide command. The Hide commands are located in the Application
menu. You can hide the current application or all other applications.
Selecting the Hide Others command causes any windows o n the Desktop
that are not associated with the current applicatio n to disappear. lf you hide
the current applicatio n, the current window disappears and the icon dims on
the finder menu. To redisplay a hidden windo w, select the name of the
application o r the Show All command from the Application menu.

Folder windows on the Desktop also contain a new navigation feature. If you
press and hold down the Command key while you click on the name of any
open folder window on the cicle bar, a pop-up hierarchical menu appears
(see figure A.4). Selecting any folder from the menu causes that folder's window to open.

Figure A.4 Pressing and holding down the Command key and clicking on an
open folder produces a pop-up menu.

Getting Balloon Help
The Balloon Help menu appears co the left of the Application menu icon
and is represented by a balloon icon. For the first time, System 7 contains a
feature that provides an integrated help system for all applications. Help is
provided as tbought balloons that contain information about the object over
which the cursor is positioned (you do not need to click the mouse co display
the Help balloon). Figure A.5 shows an example of the type of information
available through Balloon Help.
Balloon Help is not available in all applications, but as more programs are
revised to meet the requirements of System 7, the way you obtain help information within a program will become mo re consistent. le is already available
for all aspects of the Desktop and dialog boxes created by the System.
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Figure A.5 Balloon help provides a guide co identifying the purpose and
function of objects.

Emptying the Trash
The Trash can icon is a storage area for items you mark for deletion. Files and
folders remain in the Trash until you select Empty Trash from the Special
menu.

Q

When you drag items to the Trash, the icon changes from an empty to a full
(bulging) Trash can. To display items in the Trash, double-click on the Trash
can icon. A window appears and lists the items marked for deletion. You can
still manipulate the files that are in the Trash until you empty the Trash. After
you select Empty Trash from the Special menu, the files you placed in the
Trash are deleted.
Before System 7, the trash was emptied when you shut down the Mac,
opened programs, or selected Empty Trash from the Special menu. In
System 7, items are permanently deleted o nly when you execute the Empty
Trash command. With this new approach, you can clean up your Desktop
and store files in the Trash until you are certain you don't need them anymore.
As a protection against inadvertently throwing away the wrong files or folders, the Empty Trash command is routinely followed by a prompt asking if
you are sure tlrnt you want to delete the contents of the Trash. As in System
6, if you press and hold down the Option key when you select the Empty

Trash command, the Trash is emptied without presenting the "Are you
sure ... " prompt. lntermediate and advanced Mac users may want to avoid
this prompt completely (panicularly after seeing it a couple of hundred
times). You can turn off the "Are you sure you want to permanently remove it?" prompt by following these steps:
1. Click once on the Trash can icon to select it.

2. Press Command-I o r select Get Info ... from the File menu.
3. Click on the Warn before emptying check box to toggle off the
option.

Copying in the Background
Another new feature in System 7 is the capacity to copy an item to a disk in
the background. You can copy files, folders, and floppy disks by dragging the
informatio n to a new disk (or another locatio n on the same disk if you press
and hold down the Option key while dragging) or by selecting Duplicate
from the File menu. When the copy process begins, the Copy d ialog box
appears. After you begin the copying process, you can switch to another
applicatio n to continue your work while the system completes the copy.
However, you may notice a diffe rence in the performance of your system
during a background copy procedure. The system may seem jerky and awkward to handle.

Launching Programs from Files
Within most enviro nments, loading a document into an application requires
two steps-opening the applicatio n, and then opening the document. On the
Mac, as long as the applicatio n used to create the document is currently
available, you can perform this action in a single step by just double-clicking
the document. This is possible because every document has an associated
creator (tl1e application that created it) and every application recognizes the
documents it creates.
In System 7, it is possible to use a document to open an application other
than the application in which the document was created. This is accomplished using the drag-and-drop method. Rather than double-clicking on the
document icon to open it, drag the document icon on top of the application
icon. This causes the application to star t and the document to be loaded as
the active file. All of this is accomplished by the o perating system.
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NOTE: For the drag-and-drop method to work, the application
must be able to read documents of the type dropped on the
application icon. Although Microsoft Word, for example, can read
files created by Nisus, an accouncing program documenc dragging onto the Word icon would be ignored.

Creating and Using Aliases
Aliases, icons that represent programs or documents stored somewhere else
on the system, open an entirely new way of organizing your stored information. Using an alias, it is now possible for a single file to be in two (or more)
places simultaneously.

><

To simplify identification, alias names are shown in italic. To create an alias,
simply select the original file or program icon at the Desktop and select
Make Alias from the File menu. As with any other file, you are free co rename aliases.
A common use for aliases is to add programs o r documents to the Apple
menu. In System 7, you can place any type of file (including a document) on
the Apple menu. To do this, place the original file or an alias into the Apple
Menu Items folder inside the System folder. The entry on the Apple menu
appears in regular type and displays the name and icon associated with the
file (see figure A.6). Selecting the alias launches the program or document
the alias represents. To remove an alias (or any other item) from the Apple
menu, open d1e Apple Menu Items folder, and then drag the item out of the
folder to the Desktop.
You also can use aliases when working with the new Startup folder. The
items you store in the Startup folder open automatically when the system
first starts. (The equivalent procedure in System 6 is to select items and then
choose Set Startup from the Special menu.)
Because aliases take up little disk space (lK is typical), you can make as many
as you need. When the Apple menu becomes cluttered, you may create a
folder that contains nothing but aliases for your most frequently used applications or documents.

Figure A.6 You now can lau nch programs and documents from the Apple
menu.

NOTE: You also can create aliases of folders. Double-clicking o n
a folder alias displays the contents of the original folder.

Inside the System Folder
In previous versions (System 6 and earlier), the System folder contained two
main files-the System and Finder. The System file contained all of the system resources, such as screen fonts, sou nds, and DAs. Other files in the
System folder included device drivers, such as those used fo r communicating
with a printer, and support files for programs and desk accessories. !NIT
files- small programs that loaded automatically during system startup and
were used co perform specific tasks-and CDEVs (Control Panel d evices)
were also stored in the System folde r. You could access CDEVs by selecting
the Control Panel desk accessory in the Apple menu.
Control Panel documents are no longer managed by a single program, but
are scored in the Contro l Panel folder. An alias for this folder is placed in the
Apple menu automatically. Selecting the Contro l Panel DA opens the Control Panel folder and displays the available CDEVs. You can activate any
System 7 CDEV by do uble-clicking o n it.
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Desk accessories also are now independent programs, no longer stored as
par t of the System folder, but placed within the Apple Menu folder as individual icons. This removes any barriers associated with DA size or complexity.
Now you can add major applications, such as Word 5, to the Apple menu.
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!NIT ftles are organized within the Extension folder. Some older IN!Ts still

require placement on the main level with the System file. Preference files
also are similar and must be placed in the Preferences folder or on the
main level.
One of the most impressive changes in System 7 is the elimination of the
Font/DA Mover utility. Previously, this utility was necessary to install DAs and
fonts in the System. Font/DA Mover is replaced by a sophisticated automatic
installation routine.
You can move resources by dragging them outside the System wi ndow. When
not stored in the System file, resources are stored and treated as individual
document ftles. In addition, System 7 provides mechanisms for previewing
and editing resources. Double-click on the System file and it displays all of its
resources, such as fonts and sounds, as individual documents. If you doubleclick on any of the sound ftles, the Mac plays the sound for you. Doubleclicking on a font file displays one or more samples of the selected font, (see
figure A. 7).
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Figure A.7 Fonts are much easier to work with in System 7.

Despite the greater complexity of the System folder, installing new system
resources is significantly easier. Simply drag the icons on top of the Syste m
folder-the operating system takes over and places them in the appropriate
locations.

Connectivity Features
One of System Ts biggest advan ces is in the area of data sharing. If you have
an AppleTalk/LocalTalk network, you can readily access files and programs
on other user's hard disks, using the m as if they were your own. File sharing
and program linking, as well as Publish and Subscribe (a feature for dynamic
data exchange), are discussed in depth in Chapte r 10, "Connectivity."

Virtual Memory: Increasing Memory
without Buying New Chips
Not every Mac has megabytes of memory to spare. But if you have some unused sp ace on your hard disk and a Mac with a PMMU (Paged Memory
Management Unit chip), you can tell the Mac to use the hard disk space as
extra memory! (PMMU-equipped Macs include the SE/30, most Mac II models, and the newer Macs.)
Because virtual memory uses your relatively slow hard disk rathe r than blazing fast RAM, speed can be a proble m. However, virtual memory is just the
thing for those occasions when you absolutely must open a program or two
mo re than can fit in your Mac's memory.
As with every o ther major System software revision, most Mac users will eventually follow Apple's lead and install System 7 on their machines. Although
minor incompatibilities and the need to e nhance their Mac with add itional
RAM will initially trouble some users, d1is is a small price to pay for the substantially increased functionality offered by System 7.
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Backup Basics
When Steve Jobs engineered the Macintosh computer, the guiding philosophy was that it should be like an appliance-simple to use and immediately
productive. But even appliances, no maner how well-made, have components that eventually wear out or break down. If your CD player breaks
down, your CD collection will still be intact. A hard drive failure, on Lhe
other hand, can instantly wipe out mounds of critical business data.
The excuses for not using a backup program or routinely performing backups are fairly predictable. "Backing up is a bother.", "This is an expensive
piece of machinery. I never expected it to break down.", or "I didn't tl1ink
this would happen to me." are some of tl1e more familiar excuses.
The point is tl1at you should expect your hard disk to break clown. You
should expect to throw the wrong folder or file into the Trash-at
least once in awhile. You should expect a critical floppy disk or
hard disk drive to mysteriously become unreadable, accompanied by a prompt asking if you wane to initialize
(erase) it. Keeping current and archival backups can
eliminate most data loss.

N

Need more convincing? Would you buy a $250,000
house, but skip the annual insurance payment? Of
course not! Everyone realizes that houses can be
burglarized or catch fire. Although such events are
unlikely, insu rance is a small price to pay to protect your investment. Similarly, backing up your

/
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data is a small investment-both in time and money-to protect your intellectual property. Whether you use floppy disks, tapes, removable cartridges,
or erasable optical disks, you should design a backup schedule and stick to it.
The best way to prepare for a disk drive failure is to keep extra copies of your
data. Decide ahead of time which data you can afford to lose. You can restore
programs, for example, from the master disks. Keep multiple copies of anything else, and, if possible, store the copies in another location. Storing dual
copies of data o n the same hard disk drive does not help if the drive fails or
the controller goes up in smoke. Similarly, storing the backu p copy next to
your computer will not help if the office goes up in smoke. If you don't have
another secure spot to store at least one set of backups, check "Computer
Security" in the Yellow Pages. If you are located in a metropolitan area, you
probably will find several firms who specialize in off-site data storage.

Backup Schedules
There are two main types ofbackups-/ul/ and incremental. A full backup, as
its name implies, is a complete backup of a disk drive. Everything on the
disk is duplicated in the backup. Your first backup should be a full
backup. An incremental backup copies only 1hose files you have modified
or created since the last backup. If you perform a fu ll backup on Monday,
for example, followed by daily incremental backups for the rest of the
work week, the current state of your hard drive could be replicated by
restoring all the backups performed that week. When restoring data, you
should replace older versions of files with the newer versions. (Some
backup programs do this automacically.)
How often should you back up your drives? It is a good idea co gee into the
routine of doing a daily backup. Depending on the amount of work you perform on your Mac, the following is a schedule you should find easy to live wid1:
1. On Monday, perform a full backup using one tape, SyQuest car-

tridge, or set of floppy disks for each drive. Label the media "A" or
" 1." (If you are using floppy disks, be sure to label each disk, too.)

2. At the end of each of the next four days (Tuesday through Friday),
perform an incremental backup of each drive. This adds only those
files you have newly created or modified since the last backup.
3. The next week, repeat steps 1 and 2 with a new tape, cartridge, or
set of disks. Label the media "B" or "2."

4. On the following Monday, reformat media set A (or 1) and repeat
this sequence- beginning with step 1.
This procedure rotates two backup sets. In addition to being able to
recover from a drive crash (by restoring the current week's full backup
plus the incremental backups) , you also will be able to replace lost,
damaged, or inadvertently altered files from the previous week.
For a small business, this approach probably will suffice. For added
security, however, you may want to make a few changes. Rather than
rotating the backup sets this way, you may want to create a new backup
set every week for four weeks, and then rotate them on a monthly
basis. This way, you can recover data as far back as the previous month.
At the end of the month, you can put the most recent backup set in
storage or make another full backup for that purpose. For an accounting or programming department, this may turn out to be an excellent
investment. You never know when you will need to reexamine
accounting files from the beginning of the year, or want to reuse or
change a piece of code written six months ago.

NOTE: If you find you are not able to keep up with the preceding backup procedure, remember that occasional backups are
better than no backups. A good rule of thumb is to back up when
you have data you can't afford to lose.
Nothing says you must back up everything. If you just completed a major part
of a project, you can make a backup of just that file by copying it to a separate disk. When you finish the project, create a disk that contains all the
associated document files. Although this is not as sophisticated as the preceding schedule, your most important data will still be protected. If everything
fits on a single floppy disk, you can even use a macro program, such as
Tempo or QuicKeys 2, to automate the procedure.

Selecting a Backup Medium
Your choice of medium (generally floppy disks or tape) will depend on the
size of your hard disk drive(s), your budget, and the amount of automation
you require. If you are new to backup procedures and have not selected a
backup medium, you may find the following information helpful.

Backup Basics

Backing Up with Floppy Disks
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When purchased in bulk or from a mail-order house, BOOK floppy disks (also
referred to as floppies) cost $5 to S7 for a box of te n. To de te rmine the ap·
proximate number of floppies you will need to back up a hard disk drive,
click on the disk icon and select the Get Info command from the File menu
(see figure 11.6). For a full backup, divide the amount listed as "o n disk"
(usually reported in kilobytes or K) by 800. This yields the starting number of
floppy disks (see figure 8.1).
You will probably find floppy disks to be sufficient when backing up 20M to
40M hard disk drives. Floppy disks are relatively inexpensive and require no
additional hardware. However, you may find that swapping disks, rapid
growth in disk sets, and the time it takes to back up using floppy disks
becomes old quickly.
Info
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Figure B.1 Backing up this drive would require 92 SOOK floppy disks.
If you have a SuperDrive, you also can use the highe r capacity I.4M floppy
disks. These disks can be significantly more expensive when compared to
BOOK disks; however, you will use fewer of them. For a filled 20M hard
disk, for example, it cakes about 25 SOOK floppy disks to perform a full
backup, but only 15 high-de nsity disks.
When buying floppy disks for the preceding backup schedule, double the
number of boxes you originally calculated, and then add a couple more
boxes for increme ntal backups. (Remember, you will be making two backup
sets.) You can keep the total number of floppy disks you use down by
performing full backups more frequently. The drawback to performing
full backups is the time required versus the time it takes to perform
quicker incremental backups.

Because backup software is faster and often scores files more efficiencly than
a Finder copy, choosing the right program can make using floppy disks co
back up small hard disks more manageable. As the amount of daca on your
hard drive moves above 40M, backing up on floppy disks becomes a cimeconsuming chore. And many times, when something becomes a chore, you
do ic less often.

Backing Up with Tape Drives
When you gee tired of swapping floppies, ic's cime to chink about buying a
tape drive. You will find tape drives to be more efficient and less cumbersome for backing up 40M and larger hard drives. Backups require little or no
cape swapping, and ic is possible co perform unattended backups. Tape cartridges are relatively inexpensive. However, it pays co shop arounddepending on the capacity, che manufacturer, and whether they are preformatted, some tapes cost more than others.
Backups are a breeze when you use a high-speed tape drive. As lo ng as the
capacity of the cape drive exceeds che capacity of your largest hard drive
volume (plus an extra 20 percent or so for incremental backups), you can
pop in a tape cartridge, launch your backup program, and that's ic. When
che backup is complete, jusc remove the tape and get back to business.

TIP: Many backup programs can run in the background, making ic unnecessary for you co scop working.
On the basis of scorage capacity, cape is a bargain when compared co flo ppy
disks. My cape drive, for example, uses DC2120 capes ..Each tape can sco re
120M of data, and the cosc per tape is between S18 and S35, depending o n
where you buy them and whether the tapes are pre-formatted. Even inexpensive SOOK disks cosc about S6 per box. Because it takes 15 boxes of floppy
disks co equal the capacity of one DC2120 cape, the equivalent cosc for floppy
disks could run about $90-chree co four times more expensive.
Be sure chac che capacity of the cape drive is larger chan che capacity of your
largest hard disk drive. If you partitioned your drive, make sure chac che
capacity of the cape drive is larger chan che largest partition. Parcicioning
your hard disk drive serves several purposes. First, backups will not require more than one cape for each parcicion. As long as each volume or
partition fies on a single cape, you still can aucomate the procedure and
perform unaccended backups. Second, buying a cape drive wich a higher
capacity than your hard disk drive is critical if you want co be able co
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perform incremental backups to the same tape. Third, as your system
grows, you will invariably buy larger hard disks. Giving yourself some
leeway in this fashion will leave you better prepared for future expansion.
Options for tape-backup programs also tend to be more flexible than fo r
floppy-disk programs. It is possible, fo r example, to set most tape programs
to perform a backup automatically at a particular time each day. If you use
your Mac for business purposes or you are in charge of a network, you may
want to instruct the program to back up at the end of the business day or late
at night. Just make sure you put a tape in the drive before you leave the office.

NOTE: Although most users focus on drives with a capacity
of ISOM or less, if you are a network manager, you also may want
to take a peek at the new DAT drives. The cost per tape is only
slightly more and storage capacity typically ranges from 1 to 2
gigabytes.
Another option to consider is rf!'movable hard disks. If you are backing
up a 40 to SOM hard drive, removable hard disks may be more suitable to
your needs. Although cartridges can be expensive (44M SyQuest cartridges currently go for between $65 and SlOO each), tlley have numerous
advantages. First, because Bernoulli and SyQuest drives are Ftndermountable, they easily can serve as a replacement for any drive that you
are backing up. That is, you can run programs and load data directly from
them-unlike tape. Second, unlike floppy disks, they often are almost as
fast as a normal fixed hard disk drive. When not used as a target fo r a
backup, you can use them as a regular drive-for storing data and running programs-without suffering a tremendous loss in speed.

As backup targets, however, their size may be something of a limitation. If
you have large volumes or partitions which you need to back up, 40M or SOM
cartridges are small when compared to a standard tape or DAT cartridge. You
still can use removable hard disk drives to back up huge volumes, but you
will run into the same problems that occur with floppy disks: multiple disks
per backup set (with the unavoidable swapping) and rapidly mounting costs
(to perform a single full backup of a 120M drive would take three 44M
SyQuest cartridges for a minimum cost of about S200). However, if your
primary drives are small or you have a backup program that can compress
data as it backs up, a removable cartridge drive may be a good choice.

Disk Mirroring
Even if you make backups at the end of each day, what happens to today's
work if your drive fails at 3 p.m.? Unless you printed it, it's gone. For critical
data, you also may want to consider a solution called mirroring. Mirroring
uses a second hard disk drive to make continuous backups of a primary hard
disk. The second or "twin" drive is always identical to the main drive. When a
file is added, changed, or deleted from the main drive, the same action is
perfo rmed automatically on the twin drive. lf the primary drive fails, you can
replace it with the twin drive. A few minutes of work, and you are up and
running again.
Golden Triangle offers two products for mirroring: Twinlt, a software-only
solution, and DiskTwin, a NuBus card and software package. Twinlt works
o n any Mac from the Plus or Classic on up, but only protects a single drive.
You can configure DiskTwin to protect multiple drives (including network
drives), but it requires a Mac SE/30 or Mac LI series computer. With either
package, you need to buy an additional drive to serve as the twin. It must
be the same size or larger than the drive you want to protect.
The NuBus card included with DiskTwin creates a second SCSI port for the
Mac (for more information on SCSI ports, see Appendix C, "The SCSI
Connection"). Each twin drive is connected in series to the card rather
than to the Mac's built-in SCSI port. The twin drives then are paired with
drives at the same SCSI address on the normal port. The product also
includes an option to have a single twin drive protect multiple primary
drives. You may, for example, use a 200M twin drive to simultaneously
mirror three drives (as long as their total capacity does not exceed that of
the twin). DiskTwin has an option that is particularly useful if you are
mirroring a network hard disk drive-you can set the twin drive co cake
over automatically if the primary drive fails.
Mirroring is not a substitute for backups. If you are considering ic, you
should treat mirroring as a supplement to normal backups. Mirroring does
not protect you from throwing away the wrong ftles, for example, nor can it
avoid the damage caused by computer viruses. Any mistake you make o r
problem you have on the primary drive is repeated instantly o n tl1e twin.
Still, mirroring is an excellent approach for businesses that cannot afford
down-time.
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Backup Software
Although you may be convinced of the importance o f making regular backups, doing so often is like trying to keep a New Year's resolution. It's
time-consuming, inconvenient, and for some, it may be confusing. But with
the right backup program, much of the pain and virtually al1 the confusion
can be eliminated. This section discusses several current backup programseach designed to make the job as easy as possible.
You also can archive manualJy, using the Finder to copy the files to a disk, a
Bernoulli cartridge, or a removable hard disk. As an alternative, you could do
something as simple as making a month-end tape backup and storing it. But
what about critical files that change over time, such as a departmental expenses spreadsheet, or those for which you need permanent copies, such as
database templates? The easiest way to handle these circumstances is by
selecting and using a good backup program.
Most backup programs can be divided into two types: standard (suitable for
backing up to any Finder-mountable device) and archival (suitable for backing up to almost any device, including those that are not accessible from
the Finder). Standard backup programs generally perform only full and
incremental backups and only to Finder-accessible devices, such as floppy
disks, removable hard disks and cartridges, and other types of hard disks.
Many user backup requirements are met by this type of program. Read on for
info rmation about DiskFit Pro and Redux, examples of standard backup
programs.

Backing Up with Redux and DiskFit Pro
Redux and DiskFit Pro have identical backup p hilos.ophies and very similar features. Although DiskFit backups are readable and copyable from the
Finder, files backed up by RedtLx can be restored painlessly- you are
prompted for the specific disks that you need to insert. Both programs are
easy to use. As long as you are backing up to a Finder-mountable vo lume and
you don't require archiving capabilities, they are both excellent choices.

BACKING UP WITH DISKFIT PRO 1.0
Disk.Fit Pro from Dantz Development is one of the simplest backup programs
you will find. It can back up data to any type of Finder-mountable disk, including floppy disks, SyQuest and Bernoulli cartridges, erasable optical disk
drives, and ocher hard drives.

The guiding philosophy of DiskFit Pro is that you should use a minimum
number of disks for each backup set. This is crucial when you perform routine incremental backups. Where other programs store multiple copies of
each file (resulting in a rapid increase in the number of disks required),
DiskFit Pro stores only the most current version of each file. If you modify an
old file on your hard disk drive, the older copy is removed from your backup
set and replaced by the newer version. If you delete a file from your hard
disk, that file also is deleted from your backup set, making room for more
new files to be added. This process keeps your backup set from expanding
quickly. Your backup set always is an exact match of the current state of your
hard disk. You also can elect to exclude particular file types from a backup,
skipping all PageMaker and MacDraw files, for example.
When you first back up a drive, you can elect to back up everything, o nly
documents, only programs, only the System folder, or only a single file. To
save time, you may want to deal only with documents because you can always
restore programs fro m their original disks. You also can decide whether to
include the entire disk, one folder, or a selected set of files and folders .
DiskFit Pro enables you to define subvolumes on any drive (see figure
8.2). A subvolume is any folder you want to treat as an entire backup
source. You may, for example, store all accou nting files in one folder on
your hard disk. Defining that folder as a subvolume enables you to easily
create a backup set that consists only of that folder.
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Figure B.2 A defined subvolume with DiskFit Pro.
As long as you don't need copies of all the generations of each file, DiskFit
Pro's approach works well. After your first full backup, incremental backups
move quickly. You are prompted to insert only those disks that contain files
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that have been changed o r deleted from the hard disk. New files are placed
on additional disks or squeezed into available space on the original backup
disks.
Backups can eithe r be normal or duplicates. A normal backup arranges files
so that they are packed as tightly as possible on your backup disks. Files are
scattered across the disks as needed. A duplicate backup, on the othe r hand,
maintains th e original folde r hierarchy. The backup is an exact duplicate of
what is on the hard disk.
Other useful program features include:
•

Verification chat each back-up file is a perfect copy.

•

Scanning of backup disks co check fo r damage.

•

Faster copying (bypassing the normal Macintosh HFS copy procedure
in favor ofDiskFic Pro's proprietary copy routine).

•

Automatic formatting of blank floppy disks you use in a backup.

•

Chimes and alerts that you can pose on a daily basis to remind you to
back up.

•

Network support.

•

Support for System 7 aliases (making it easier co locate files in a backup
sec).

Retrievi ng files from a backup sec is equally simple. Because DiskFic Pro
scores each file in its o riginal Finder-readable form, all you need to d o is drag
the copy from your backup disk onto your hard disk. If the file was split
across two disks, DiskFit Pro can rejoin the pieces. If you have trouble finding
the files you wane co restore, the program creates backup reports chat tell you
on which disk each file can be found. If you wane to restore a complete
backup sec, the program will do it for you, coo.
If you haven't progressed co tape backups, DiskFit Pro is an important program to consider. If you don't need multiple copies of each file and are
mainly concerned with backups of the current state of your drive(s) , you
will find DiskFic Pro's approach a winner.

BACKING UP WITH REDUX 1.63
Redux from Microseeds Publishing shares DiskFit Pro's parsimonious backup
philosophy. Only files that still exist on the source disk are kept in the

backup set, and only the most current version of each file is retai ned. This
keeps the number of disks in the backup set to a minimum.
Redux can perform a complete backup of any disk, backups of selected files
and folders, and incremental backups. Unlike Disk.Fit Pro, normal backups
made with Redux are written in a proprietary format. As a result, to restore
all or part of a backup, you must use Redux. If the files you are backing up fit
on a single destination disk (floppy disk, removable cartridge, or hard disk
drive), you can specify that files be kept in their original formats. Like a
Disk.Fit backup, files stored with this method can be read directly from the
backup disks and restored without using Redux.
Redux includes a number of special options to make your work easier. While
you are in the program you can perform Finder-type activities, such as erasing disks, viewing disk contents (the directory structure of a backup set or
any potential source disk), and trashing files from the backup disk or any
other mounted disk. \Vhen examining a file list, you can display everything,
only files that are already part of the backup set, only changed files, only
folders, or only unchecked files. They can be sorted by folder, file name,
date, or size. Redux includes on-line help if you need assistance with the
program. On subsequent backups, Redux displays only the files that have
changed. This gives you the opportunity to deselect any files you don 't want
to add to the backup set (see figure B.3).
'
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Figure B.3 Redux displays the files that have been changed since the last
backup.
Power User preferences offer still more options. If you want to perform a
selective backup, use these options. They enable you to turn off some safety
features (no confirmation on trashing items, for example) , set new target
disks to be erased automatically, and create a progress report automatically
and save it to disk after each backup.
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Redux contains its own scripting language. Scripts are created by Redux as
you perform accions and choose program options. Although you can edit
and write your own scripts, most users find it unnecessary.
Unless you use the Copy backup option, all restores must be done from
within Redux. In addition to restoring selected files or performing a complete restore, Reclux enables you to specify advanced resto re options in the
Special Restore dialog box (see figure B.4).

OK
Wh e t typ e of specialized Restore would you like?

Cancel

@ Stondord Res tore

Restore all files thot ore checked.

O Restore Olffere nces

Restore oll files thot houe changed
or are missing from the hard disk.

O Re store New er

Replace old uerslons of fil es on the
hard disk.

O Re store Missing Files

Restore oll files thot ore not on t he
hord disk.
Repl ace old uerslons of Illes on t he
hard disk, and r es tore all mes that
ore not on the hord disk.

O Rest or e Newer and Missing

Figure B.4 Reclux's Special Restore dialog.
A separate program called Redux Restore also is included in this package.
It serves two purposes. First, if you want to make a special start-up floppy
disk for restoring backups (a good precaution in case your hard drive
fails) , Redux Restore is small enough to leave room fo r a System folder. Second, although not in the public domain, you are free to distribute the
program to others. If you want to send a Redux backup set to one of your
branch offices, you also can send Redux Restore, enabling the receiver to
extract and use the files.

Archival Backups
Archival backup programs, such as Retrospect and FastBack II, can back up
data to almost any device, including most proprietary-format tape drives. If
you are not satisfied with the speed or capabilities of the software that comes
with your tape drive, these two programs are your best bets. In addition to
full and incremental backups, Retrospect and FastBack II also can archive
data, compressing files so that they take up less space on the target media

and optionally removing them from the source drive. Users with large hard
disk drives and file servers-or anyone who wants to archive data as well as
simply make a backup copy- will find the fearures of Retrospect and
FastBack ll attractive.

Archiving with FastBack II 2.50
FastBack from Fifth Generation Systems has long proclaimed itself the king
of floppy-based backup programs. With FastBack II, it has become a true
archiving program and now supports virtually all backup media. Depending
on the complexity of your backup needs and your level of software sophistication, you can choose from three different interfaces: short menus, full
menus, and FastBack Express. Using FastBack Express is the simplest way to
perform backups. You just select a backu p source, a target, and the type of
backup you want from the FastBack Express dialog box (see figure B.5).
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Figure B.5 The FastBack Express dialog box.
ln addition to full and incremental backups, FastBack LI also performs
differential backups and full copy backups. A full copy backup is identical
to a full backup, but does not reset the backup date for each file it copies.
This is useful if you simply want a copy of the disk contents separate from
your normal backups. A differential backup contains a copy of every file
you have added or changed since th e last fu ll backup. To restore a hard
disk drive, you only need the most recent full backup and the most recent
differential backup. If you were performing incremental backups instead,
you would need the full backup plus every incremental backup. The program restores the most recent versio n of each file automatically in the
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combined backup sets. FastBack II also supports advanced file selection
procedures, including by folder, file name, creatio n date, modification
date, creator, file type, color, or file-size range.
FastBack II can perform data compression, archiving, error correction
(useful for ensuring the accuracy of backups to floppy drives), write verification, compare a backup to its source, and maintain backup history files
(see figure B.6). Although encryption is not a feature, you can passwordprotect backups. The program also can print backup media labels and has
a complete set of tape-handling options (format, erase, rewind, and so
on). When running under MultiFinder, you can set FastBack II so that it,
or other programs, has priority.
~
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Figure B.6 The Backup Options dialog box enables you to save program
options to disk as named settings files.

TIP: If FastBack has the highest priority, it can run quickly in
the backgrou nd, but foreground programs will run slowly.
If you are running FastBack in the foreground, you can view the backup
progress as it happens (see figure B.7).
To speed up option selectio n, you can save setups and add macros. You can
record macros automatically by simply tracking your actions and menu
choices, o r you can write them using the program's extensive macro language. Macros also can be combined with timed backups to automate the
process.
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Figure B.7 The Backup Progress dialog box enables you to watch the
backup process.

Archiving with Retrospect 1.3
Retrospect, another product of Dan12 Development, is an icon-driven backup
program. Regardless of whether you are doing a routine backup or are
archiving files, the operation is accomplished by using the four icons that
appear at the top of the screen in figure B.8. Retrospect has· dozens of
power-user options but does an excellent job of keeping them out of your
way. Beginning a full backup or an incremental backup never takes more
than a few moments and a couple of mouse dicks. Then all you need to
do is sit back, insert new target media when prompted, and wait for the
backup to finish .
Retrospect's four icons control the following features:
Source

Enables you to select the source drive from all drives
connected to your Mac.

Archive

Enables you to select a named backup set for that
particular drive. If this is the first time you are backing
up the drive, this is when you will create the backup set
and select the type of media to use, such as tape or
removable cartridges. Retrospect scans all anached
devices and lists only the archive types your system
supports.
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Select

Enables you to select the files and folders that you want
to include in the backup. If this is the first full backup
of the drive, all files are selected for you automatically.
If this is a subsequent (incremental) backup, all newly
created and changed files are already marked for you.
Files can also be chosen manually, if you wish.

Options

Enables you to turn on verification or compression, or
enter comments (if it is a normal backup). If it is an
archival backup, you can elect to delete archived files
fro m the source disk. Ten additional archive options
are available for users who want greater control.
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Figure B.8 Retrospect icons appear at the top of the screen.
Files can be restored to a source disk in two ways. Selecting Restore executes
a complete restore. This option is most useful when there have been problems with a drive or you suspect the files on the drive are fragmented. During
a complete restore, the most recent version of every file in the backup sec is
copied to the hard disk. You can restore a select group of files using the
Retrieve option. After specifying the archive and the destination disk, the
Select window appears (see figure B.9) and displays in hierarchical fashion
the contents from each of your backup sessions.
You can select files manually by scanning through and clicking on the fi les
you want to retrieve, or by specifying selection criteria. Standard file selectors
include all files, o nly applications, only documents, only the System folder,
graphics files, files modified in the last week, and files that have not changed
in two months, six mo nths, o r o ne year. The latter "unchanged" criteria are
excellent for identifying files you may want to move to an archive. Custom

selectors can combine these and other criteria, enabling you to make more
complex search requests.
Retrleuln
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Figure 8.9 When you click the Select icon, a list of all fi les in the backup sets
appears.
Other Retrospect features include designating certain source folders as
subvolumes, <leleting files from any mo unted disk, file compression, file
encryption, verifying the integrity o f an archive, comparing an archived file to
its source, duplicating an archive, and scripting.

Scripting with Retrospect
\Vhenever you perform a backup, archive, restore, or retrieve, Retrospect
keeps track of the options you selected and records them automatically in a
script (a list of backup or restore optio ns). Each time you perform a backup,
a general script named Backup, for example, is created and stored in the
Action menu. The selected source and target drives, selection criteria, and
o ptio ns chosen are all written into the script. Unless you tell it o the1w ise, the
next time you run Retrospect, it will replay the Backup script, setting all
optio ns the way you had them last. If you only have o ne hard drive and
always use the same options, this simplifies the backup process greatly. Because you may have different backup and restore preferences fo r different
hard drives, Retrospect enables you to create and save named scripts that
can be replayed as needed.
If you have multiple hard drives or special backup requirements that go beyond standard full and incremental backups, you can use Retrospect scripts
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to completely automate the backup process. You can make a script for each
backup procedure you routinely perform.

Master scripts enable you

execute o ne or several other scripts. Because
you can only launch and execute master scripts from the Finder, you must
create two scripts: a standard backup script for the drive and a master script
that executes the backup script.
tO

The following task shows how to make a master script that will perform an
incremental backup for one of your hard disks. The result is a Finderlaunchable icon that performs all the steps of the backup for you
automatically. A double-click is all it takes!
To create a master script, follow these steps:
1. Launch Retrospect and select Scripts .. . from the Config menu. The

Scripts dialog box appears (see figure B.10).
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Figure B.10 The Scripts dialog box.
2. Click on the New button.
3. A prompt appears and asks you what type of script you want ro create.
(First, create the standard backup script.)
Select "For Backup." This creates a new script named "Untitled" and
returns you to the Scripts dialog box.
4. Enter a nan1e for the script in the text box, such as " Internal HD
incremental."
5. Click on the Rename button to make the name permanent.
6. Double-click on the new script name, or highlight the name and click
on the Modify button to define the steps for the script. The normal
Backup dialog box appears.

7. Specify the source volume, the target archive, selection criteria, and
other options as usual by clicking on the icons or the Next button.
The default is an incremental backup and assumes that you already
have done a full backup and created a usable archive file. If an appropriate archive does not exist already, you can make one by clicking on
the Create New .. . button in the Archive window.

NOTE: After you select the options you want from the Options
window, close the window wid10ut clicking the Execute Now button.
8. To create the master script, select New again from the Scripts window,
click on the Master Script radio button, and click the OK button. Now
give the Master Script a name just as you did the first script.
9. Double-click on the master script name, or highlight the name and
click on the Modify button. A script selection window appears with the
name of the newly created script in the tide bar. Highlight the name of
the backup script you created previously, and then click on the Save
Document ... button.
This completes the creation of your master script.
Now you can quit from Retrospect. At the Finder, you should see a new icon
for the master script. To test the script, make sure your target media is ready
and then double-click on the icon. The entire incremental backup should
take place as you watch. When the backup is complete, Retrospect quits
automatically. To change what Retrospect does after finishing a master script,
you can set the Auto-execute options in the Preferences dialog box to shutdown when complete, stay in Retrospect, or quit Retrospect.
After you test your new procedure, you may want to make similar scripts for
your other drives. If you want to take things a step further, you can explore
the option of making timed backups by referring to "Using the Calendar" in
the Scripts chapter of the Retrospect manual.
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The SCSI
Connection
One of the many advantages of having a Mac is the ease with which you can
connect external hard disks and other devices to it. Every Mac contains a SCSI
(Small Computer System Interface) port built into the back panel. (SCSI is
pronounced "skuzzy.") The SCSI port enables you to connect as many as
seven external devices in a series or chain, such as hard disk drives, tape
drives, and scanners. For Macs equipped with an internal hard disk drive, you
only can connect six devices to the SCSI port. (The internal hard disk drive
counts towards the total of seven.)
Although all connections are made to the external SCSI port, you must
still attend to three important issues: the connecting cable, SCSI
ID numbers, and proper termination. After you understand
how these factors affect the set-up, you will be able to add
new peripherals in a minimum amount of time.
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Understanding SCSI Cables
here are three standard SCSI cable configurations: 25-to-50, 50-to-50,
and 25-to-25. The numbers refer to the number of pins or connectors
o n each end of the cable. The standard connector on the back of a
Macintosh computer is a 25-pin connector. Normally, you use a 25-to-50
cable to connect the first SCSI device to the Mac. Before you purchase a
SCSI device, find out what type of connector it uses. Your best bet is to purchase the correct cable at the time you purchase the SCSI device.

T

NOTE: Because it has a rectangular 30-pin SCSI port, the new
Macintosh PowerBook computers require a special HD-30 SCSI
cable to connect to the first SCSI device.
Because manufacturers often assume that their device will be the first external device you will hook up, most drives are shipped with a 25-to-50 pin
cable-which is suitable only for the first device in the chain. The 25-pin end
plugs into the SCSI port of the Mac and the 50-pin end connects to the ~'ter
nal device. If this is your second or third SCSI device, on the other hand, the
25-to-50 pin cable often is useless to you.
Because most drives are equipped with two 50-pin ports, you usually need a
50-to-50 pin cable to connect two external SCSI devices. Some SCSI devices
are equipped with two built-in 25-pin ports rather than the more common
50-pin port. To connect a SCSI device that contains two built-in 25-pin ports
to the Mac, you will need a 25-to-25 pin cable, or a 25-to-50 pin cable to
hook it to another SCSI device. An accommodating dealer o r mail-order
house may be willing to swap the cable they normally ship with their SCSI
device for the cable you need.

NOTE: Not all devices contain two SCSI ports. If a device is
equipped with one port, it must be the last device in the chain.
To avoid serup complications, do not purchase a device that
contains o nly o ne SCSI port.

Setting SCSI ID Numbers
very device connected in a SCSI chain must contain a unique 10 number. The ID number identifies the device to the operating system and
must be between 0 and 7. ID 7 is reserved for the Mac itself. Internal hard
disk drives normally use ID 0. That leaves 1 through 6 for any other SCSI
devices you want to add. Having two devices set for the same ID can cause
serious problems. It doesn't matter which number you use for an external
SCSI device, as long as there aren't any duplicates.

E

Setting an ID for a device usually is done by turning a dial, clicking on a button, or arranging DIP switches on the back of the device. When adding a new
device to the SCSI chain, just select an unused number. Normally, you don't
need to turn around the devices to check the ID numbers. Most SCSI devices
provide a program (either a stand-alone utility or a Control Panel document)
that displays this information for you. Advanced programs, such as
DiskMaker, show the assigned ID numbers and which device is associated
with each number (see figure C. l) . Less complicated programs may show
only the IDs in use-not which specific drive is associated with each ID.
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Figure C.1 A DiskMaker list of SCSI ID numbers in use and their associated
devices.
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Before you buy a SCSI device, make sure that it does not contain a p ermanent ID number; that is, one that you cannot change. Two devices
permanently set for ID 3, for example, are unusable together.

N

Terminating SCSI Devices

T

ermination is the most confusing part of hooking up SCSI peripherals.
The easiest way to understand how termination works is to picture a
lawn sprinkle r system that has several sprinklers running from the same
water fa uce t. The faucet is the Mac and tl1e sprinklers are tl1e SCSI devices. The last sprinkle r in the chain must not have an open pipe leading
away from it. Lf it did, you could not control the water flow. Most of the
water would simply run out of the open e nd . As in the sprinkler analogy,
you must "cap" the last device in a SCSI chain. This "capping" or "closing
off' is referred to as termination. You must terminate the first and last
device in a SCSI chai n. Additional termination can result in data loss or
damage to the SCSI port. The diagram in figure C.2 shows proper termination for a Mac system with one or more external SCSI devices. It is
assumed that the Mac has an internal hard disk tlrnt is already terminated.
The internal hard disk is considered the first device in the chain. Figure
C.3 shows correct termination for Macs without an internal hard disk.

Terminated

No Termination No Termination

Terminated

Figure C.2 Proper SCSI termination for syste ms with an internal hard disk.

Terminated

Terminated

No Termination

Terminated

Figure C.3 Proper SCSI termination for systems without an internal hard disk.
You can accomplish termination in o ne of two ways: internally (using a
set of su pplied terminating resistors) or externally (using a SCSI cable
terminator). Many drive manufac turers ship SCSI devices that are terminated internally. All tem1inating resistors look similar, but they may be
several d ifferent colors such as reel, blue, yellow, o r black.

If the device you p urch ased or are going to purchase is the only external
SCSI device you have, you do not have a problem. Because you know it is
the last device in the chain, you must te rminate it. If the device you purchased is not self-te rminating (in othe r words, does no t have internal
terminato r resistors), you will need to purchase a cable terminator. This
is a small connector that fits directly into the SCSI port or at the end of
the cable that wiU be attached to the device requiring termination.
Assuming that you have an internaJ hard disk drive (which is always terminated) , you now have two devices-both of which are te rminated. The
internaJ drive is the first device and the external device is the last d evice. If
you add more devices, acid the m to the middle of the chain and without
terminators.
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NOTE: Problems can arise when SCSI devices are already internally terminated. If the device is to be added to the middle of
your SCSI chain, you or your dealer will need to open the drive
and use a pair of needle-nose pliers to remove the terminating
resistors. Some drive manufacturers make this easy for you by
covering the terminating resistors with a small access panel. To
reach the resistors on other drives, you sometimes need to take
the drive case apart. (See your peripheral manual for the location
of terminating resistors in your new external SCSI device.) If you
are squeamish about messing with the innards of a new hard disk
drive, ask the dealer or mail-order house to remove the terminating resistors for you. When you receive the drive, however, it is a
good idea to check their work to make sure the resistors really
are gone.

Troubleshooting
Topics
Problems with the Macintosh can be divided into three main categorieshardware, system software, and applications. Application problems relate to a
specific piece of software and are best dealt with by examining the software's
manual or by calling technical support. Hardware problems are actual physical problems with your equipment. They ofcen are very simple in nature and
can be dealt with by a little experimentation. In the worst case, hardware
problems may require a trip to the computer repair shop o r the replacement
of an expensive piece of equipment. System software problems are most
commo n on systems that serve a variety of functions and where the software
is constantly changing. This appendix details a few simple steps that you can
take to remedy many of the most commo n problems.

Hardware
Troubleshooting

A

ltl1ough we like to th ink of our computer as
infallible and truly deserving of our awe and
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wonder, things do go wrong. Sometimes the problems are with the physical
hardware rather than the programs. Here are some things to try before contacting your dealer or the manufacturer.

Step 1: Try It Again
Many problems are temporary "glitches"; one-time errors that quickly go
away by themselves. When something goes wrong-a hard disk that doesn't
appear on the desktop, a modem that will not d ial, or a misprinted page from
your printer-before you panic you should always try it again. In many cases,
the problem simply disappears. Chalk it up to bad luck, unfortunate timing,
or gremlins, and then get on wid1 your work.

Step 2: Head for the Power Switch
Hardware-related problems that don't immediately fix themselves on the
second try are best tackled by reaching for d1e on/off switch. Turning a device
off and back on is often the simplest way to reset it. You can safely turn the
power off and on for a monitor or any device hooked up to one of the Mac's
serial ports, such as a modem or printer. SCSI devices, however, require
special handling when trying mis approach. To reset a problematic SCSI
device, such as an external hard disk, me best approach is to shut down me
Mac. Select Shut Down from me Finder's Special menu. Then rum off the
power, wait at least fifteen seconds, and rum it on again. Remember, when
performing d1e Shut Down routine, you need to rum off all of your equipment in the proper order (use Shut Down, rum off me power switch, and
d1en rum off any SCSI devices). For more information about trouble-shooting
SCSI devices, see Appendix C and Chapter 12, "Protecting Your Investment."

Step 3: Check the Power Cords
and Cables
If the device has no power (no lights or no ise are coming from it) , make sure
the power cable is firmly attached to the device and securely plugged into an
outlet. You also can try a different power cable. Cords and cables can wear
out or short out.
If the problem persists after cycling the power off and on and the recalcitrant
device is getting power (as evidenced by no ise, indicator lights, and so on) ,
make sure all connecting cables are firmly attached-power cords, SCSI

cables, and serial cables. If you have spare cables (or know an associate or a
friendly dealer who will lend you one) , try swapping your suspect cable for
one that is known to be good.
The situation is a bit more complex if you have more than one SCSI device.
To check for a bad SCSI cable, disconnect all external SCSI drives except o ne,
attach an external terminator to it (if the device is not terminated internally),
and try again. Continue adding devices (always moving the external terminator to the last device in the chain) until you get a failure. By methodically
swapping cables and devices, you should be able to determine which cable, if
any, isn't working properly. In addition, the order of devices in the SCSI
chain can sometimes make a difference. Try rearranging them.
Before removing or reconnecting cables, you should always turn off the
equipment. Failure to do so can cause serious damage to the Mac or the
peripheral.

Step 4: Diagnostics
If the device came with any diagnostic software, now is the time to run it.
Hard disks, for example, typically are sold with a program that can test for
bad sectors (areas of the hard disk that can no longer hold data) and can
update the driver software. Some devices even have their own error checking
and reporting scheme. Modems and laser printers generally have panel lights
that indicate their current srarus. Some hard disks, for example, blink the
drive light in a Morse cocle-rype pattern whenever there is a hardware problem. Although these lights may not mean anything to you, the pattern can be
easily interpreted by the manufacturer's technical suppo rt people.
Finally, be sure to record any error messages that appear o n the Mac's
screen. They may state or give a clue to the type of hardware problem.

Step 5: Pick Up the Phone
When the simple stuff fails, it's time to call in the experts. If the device is still
under warranty, call your d ealer. If not, call the manufacn1rer. At a minimum,
be prepared to give the device's model number, the model of Macintosh
to wh ich it is connected, and the versio n of the System and Finder you are
using.

Troubleshooting Topics

The 9-to-5 Mac

Troubleshooting the
System Folder
nfortunately, there are many reasons why some programs occasionally act up o r crash. Many of the most common reasons have little to
do with the actual program and are a result of problems with the System file
or items in your System folder. If several applications begin acting strangely,
the problem is probably in your System folde r. If the problem is limited to a
single program, try replacing the program file with a new copy from your
original disk. If that does not clear up the problem, the next step is to check
out the System folder. The following section details things you should do to
make sure your System folder is in the best possible shape.

U

Step 1: Use Only One System Folder
If you let other people use your Mac or are a little careless about the way that
you install new software, you can end up with multiple System folders on the
same hard disk drive. If the Mac tries to use the System resources from both
folders during the same computing sessio n, crashes and system errors often
follow. The simplest way to detect multiple System folders-other than hunting for them manually- is to use System 6's Find File DA, Sym:m T s find
command, or a similar utility to look for all files named "System" or "Finder."
Throw any extra System folders into the trash.

Step 2: Rebuilding the Desktop
Occasionally, some Desktop operations beco me extremely slow. Some windows may be very slow to open or icons may appear one at a time. Each
volume attached to your Mac contains an invisible file called "Desktop." The
Desktop file maintains a list of all files on the drive, as well as d1eir positions within their folders. Unfortunately, the Mac System software does a
poor job of purging the Desktop file of old information. Periodically, it is
a good idea to rebuild the Desktop files, compressing them so that they
only contain current file information. Once every month or two should be
sufficient.
To rebuild the Desktop, reboot the Mac while holding down the Command
and Option keys. You are prompted to rebuild the Desktop of your start-up
hard disk. If you have add itional hard disks, you will be asked if you wish to
rebuild the Desktops of those drives as well.

There are two side-effeccs of rebuilding the desktop that you should know
about. First, any commencs you typed into program and file Get Info boxes
are erased. If this is a problem, some programs, such as 911 Utilities, provide
an alternate way of rebuilding the Desktop while keeping comments intact.
Second, some document icons may lose their distinctive appearance and
revert to blank pages. To restore the icons, you can run the creating program
and load the files, or you can drag the creating program into the same folder
as the files and then run one of them.

Step 3: Check for INIT Conflicts
Those wonderful lNITs (called extensions in System 7) may be the cause of
your troubles. lNITs are special programs that, when placed in your System
folde r, run automatically each time you start up your Mac. (The IBM equivalents are referred to as "terminate and stay resident" programs or TSRs.)
INITs are constantly running in the background. Some hardware devices
depend on INITs to make them work. Because they normally send and receive in the background and must monitor the modem port for incoming
faxes, fax-modems, for example, are often controlled by an INIT. In general,
any functions that must be at your immediate beck and call-regardless of
what program you are running or what else you may be doing-are governed by INITs. Examples can include macro programs, appointment
alarms, virus checkers, screen savers, and utilities that modify the Mac's
menu bar, or provide special "hot keys."
More and more essential utilities are being written as lNITs. Because INITs
do their thing in the background, some of the other programs that you run
may not be doing a great job of checking for INIT activity. (And some INITs
may not be doing an adequate job of notifying programs that they are
around.) One possible consequence is an JNIT/program conflict. This is a
fai.rly common problem with screen savers, for example. When a program
thinks that it is the only application on-screen, you can end up with a real
mess when a screen saver suddenly kicks in. INITs also can conflict with each
other. This is a frequent source of unpredictable system crashes and normal
Mac functions that suddenly go haywire.

If you suspect that an INIT is the cause of your current troubles, follow these
steps:
1. Temporarily move all INITs o ut of your System folder and reboot, or
start your Mac from a System disk that does not contain any INITs.

Troubleshooting Topics

(If you're not sure which files are INITs, open the System folder and
choose By Kind from the Finder's View menu. INITs are listed as
Startup documents in System 6 and System extensions in System 7. You
also may want to move any non-Apple Control Panel documents
(CDEVs) to the Desktop at the same time. Apple-suppfied CDEVs
include Color, General, Keyboard, Labels, Memory, Monitors, Mouse,
Sound, and Scartup Device, and Views.)
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2. Repeat the process in which the error first occurred. If you cannot
make the problem recur after removing the INITs, it's likely that one
of them was the troublemaker. To find out which !NIT was the
problem, put the INITs back into the System folde r one at a timerebooting after each one is added- and see when the symptoms
reappear. If the problem recurs, you have identified the offender. To
verify this, add back all of the INITs except the suspected troublemaker. If the problem doesn't return, give the INIT manufacturer a call
to see if a fix is available or in the works.
3. Make sure that no pair of INITs performs the same function. Having
two appointment reminder INITs, two modem INITs, and so o n, is
asking for trouble. Both could conceivably grab for the same system
resource at the same time, causing a spectacular crash. Remove one
of them from your System folder, reboor, and see if the problem
disappears.
4. After experimenting with your System folder, you may want to rebuild
the Desktop. The files in your System folder frequently are accessed
and it never hurts to be sure that they can be easily located by the
System.
5. Sometimes the order in which INITs load is the problem. Since INITs
load alphabetically, you can alter the loading o rder by renaming them.
Resolving !NIT conflicts can be e>.1remely time consuming-particularly if
you are running a dozen or mo re of them. A better way to do the testing is to
use an INIT manager utility. INITPicker from Rival Software is one of the
most widely used. It enables you to do the following:
•

Temporarily disable some lNITs.

•

Create !NIT sets that can be selectively loaded.

•

Change the loading order.

Also, on a crash at startup, INITPicker will attempt to determine which !NIT
caused the problem and will disable it on the next boot.

Othe r comme rcial !NIT handlers are available , as well as s hareware and public domain utilities. In the latter group, you may look for a helpful document
file called rNITinfo, which lists hundreds of known and suspected INIT in·
compatibilities.

Step 4: Replace the System File
This is the most drastic solution, but sho uld solve most proble ms. After a
system crash, the System file may be corrupted; that is, it may contain some
e rroneous o r "garbage" data. When getting rid of your INITs fails to correct
the problem and your System begins crashing mo re o ften than usual, the
cause may be a corrupt System file. The solutio n is to replace it with a clean
copy using the Installer program that came with your System software. Some
experts recommend you routinely replace the System file every mo nth or
so-just to be o n the safe side.
Occasionally all you need to replace is the Finde r fi le. Although less common,
the Finde r also can become corrupte d. To correct this, boot your Mac from a
flo ppy disk and drag a good copy of the Finder into the System folder on the
hard disk. Be sure that the version number of the two Finders are identical
(select Get Info from the File menu to check versio n numbers). Mixing and
matching System software is a no-no.

Special Problems in
System 6
unning under MultiFinder, sometimes you will see a dialog box with
the "Application unexpectedly quit" message. Whatever program you
were just running has suddenly given up the ghost and has unceremonio usly d umped you back at the Desktop. Any changes that you made to the
data file you were working on are now gone. Although the file is probably
intact, it is only as current as your last Save.

R

In most cases, this problem is caused by running out of application memory.
You can fix it by simply increasing th e memory available to the program. To
do this, return to the Finder, click o n the program icon once to select it, and
select Get Info fro m the File menu. At the bo ttom of the window will be the
text "Application Memory Size (K) :" followed by a box with a number in
it. Type in a larger number, close the box, and try runn ing the program
again.
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The Info box presents two figures: the minimum amount of memory required to run the program and the amount you are willing to allocate to
it. Start by increasing the available memory by 25 to 50 percent. If you
have loads of memory to spare-select About the Finder .. . from the Apple
menu and check the figure given for "Largest Unused Block"- you may
even try doubling the program's memory allocatio n to see if that makes a
difference.
Every program, DA, INIT, and so on, requires memory to run. One special
area of memory is called the System heap. And when you run o ut of heap
space, some programs can explode in your face like a trick cigar; that is, a
System crash frequently follows. Running out of heap space is one of the
most significant problems that can befall a user of System 6--System 7 takes
care of the issue for you.
To determine if you have heap space troubles, return to the Desktop and
selectAbout the Finder ... from the Apple menu. The About the Finder .. .
dialog box shows how much memory is currently in use and allocated to
each program that is running. The black area of each bar is memory that is
being used; the light area represents the remaining memory that is available
to the program. Immediately after starting your Mac, between 20 and 30
percent of the bar for System should be unused (showing a light pattern). If
the entire bar is black (or close to it) , you are a prime candidate for heap·
related problems.
There are several commercial and shareware utilities for increasing the
size of the heap. Now Utilities includes one called StartUp Manager. Several packages from CE Software provide one known as Heapfixer. One of
the easiest to use is a shareware CDEV called Heap Tools.
When you select Heap Tools from the Contro l Panel, you can see how
much free space is in the heap. (Note that the amount of free heap space is
dynamic-it changes throughout your computing session. If you keep the
About the Finder... box open as you run other programs, you will notice
that some programs make bigger grabs for the heap than others, for example.) With Heap Tools, you can compact or purge unneeded resources
from the heap during your computing session. Changing the setting for
the amount of free initial heap space requires you to reboot before it
takes effect.
If you don't own or have access to any of these heap utilities, your only other
option for freeing up heap space is to pare down your system. Remove any
unessential DAs, IN!Ts, Control Panel devices, and fonts. Then reboot and
select About the Finder ... again to see the impact your changes have made.
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4th Dimension-ACIUS, Inc., 408/252-4444
911 Utilities-Microcom, 919/490-1277

A
AccessPC-Insignia Solutions, Inc., 415/694-7600; 800/848-7677
Acra 7- Symmetry Software Corporation, 602/991-0572
Address Book Plus-Power Up Software Corporation,
4151345-5900; 800/851-2917
Adobe Illustrator-Adobe Systems, Inc., 415/961-4400
Adobe Photoshop-Adobe Systems, Inc., 415/961-4400
Adobe Type Manager (ATM)-Adobe Systems, Inc. ,
415/961-4400
Adobe Type Reunion-Adobe Systems, Inc.,
415/961-4400
After Dark/More After Dark-Berkeley Systems,
510/540-5535

Alarming Events-CE Software, Inc., 515/224-1995; 800/523-7638
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Aldus PageMaker-Aldus Corporation, 206/622-5500; 8001333-2538
Aldus Personal Press-Aldus Corporation, 206/622-5500; 800/333-2538

B
BizPlanBuilder-JIAN, Tools for Sales, 415/941-9191; 8001346-5426

c
CalenDAr-Psybron Systems, Inc., 30413404260; 800/8664260
CanOpener 2-Abbott Systems, 800/552-9157
Capture-Mainstay, 818/991-6540
Carbon Copy for the Mac-Microcom, 800/822-8224
Checklist 2-ElseWare Corporation, 206/547-9623
Cheshire-Abbott Systems, 9141747-4171; 800/552-9157
Citadel-Microcom, 919/490-1277
Claris Resolve-Claris Corporation, 408/727-8227; 800/628-2100
ClarisWorks-Claris Corporation, 408/727-8227; 800/628-2100
ClickArt Business Cartoons, ClickArt EPS Business Art, ClickArt Color Graphics for Presentations-I/Maker Company, 415/962-0195
Compact Pro-shareware product available through user groups, bulletin
boards, and infom1ation services; if these sources are inconvenient, a copy
can be ordered directly from : Cyclos, P.O. Box 31417, San Francisco, CA
94131-04 17

D
DataShaper-ElseWare Corporation, 206/547-9623
DeltaGraph- DeltaPoint, Inc. , 408/648-4000; 8001367-4334
Digital Darkroom-Aldus Corporation, 206/622-5500; 800/333-2538
DiskDoubler-Salient Software, Inc., 415/321-5375
Disk.Express-Al.Soft, Inc. , 713/353-4090

DiskFit Pro-Dantz Development, 415/849-0293
DiskTop-CE Software, Inc., 515/224-1995; 800/523-7638
DiskTwin- Golden Triangle, 619/279-2100
DocuComp-Advancecl Software, 408/733-0745
Double Helix-Odesta Corporation, 708/498-5615; 8001334-6041
Dynodex- Portfo lio Systems, lnc., 914/876-7744
DynoPage- Portfolio Systems, Inc., 914/876-7744

E
Effects Specialist- Postcraft International, Inc., 805/257-1797

F
FastBack Il-Fifth Generation Systems, 504/291-7221; 800/873-4384
Fast Forms- Power Up Software Corporation, 4151345-5900; 800/851-2917
File Director- Fifth Generation Systems, 504/291-7221; 800/873-4384
FileMaker Pro-Claris Corporation, 4081727-8227; 800/628-2100
First Things First-Visionary Software, 503/246-6200; 800/522-5939
FlexForms Business Templates- Formula, Inc., 7071763-9944
FrameMaker- Frame Technology Corporation, 408/433-3311; 800/U4-FRAME
ext. 965

Freehand- Aldus Corporation, 206/622-5500; 800/333-2538
FoxBASE+/Mac-Fox Software, Inc., 419/874-0162

G
Gallery Effects-Aldus Corporation, 206/622-5500; 800/333-2538
GOfer- Microlyrics, Inc., 716/248-9150; 800/828-6293
Gram • ma • tik Mac-Reference Software International, 415/541-0222;
800/872-9933
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HyperCard- Claris Corporation, 4081727-8227; 800/628-2100
HyperDA II-Symmetry Software Corporation, 602/991-0572

I
Image Grabber- Sabastian Software, 206/861-0602
Info rmed Designer/Manager-Shana Corporatio n, 403/463-3330
INITPicker-Microseeds Publishing, 813/882-8635
Instant Update-ON Technology, Inc., 617/876-0900 ext. 606; 800/926-5530
lnto uch-Advanced Software, 4081733-0745

.1-L
KaleidaGraph-Synergy Software, 2151779-0522
Laplink Mac III-Traveling Software, Inc., 206/483-8088; 8001366-6045
Last Resort-Working Software, 408/423-5696; 800/229-9675
Legal LetterWorks-Round Lake Publishing, Inc., 203/431-9696
LetterWorks-Round Lake Publishing, Inc., 203/431-9696
Letter Writer Plus-Power Up Software Corporation, 415/345-5900;
800/851-2917
Lotus 1-2-3 for Macintosh-Lotus Development Corporation, 800ffRADEUP

M
MacEnvelope-Synex, 718/499-6293; 800/447-9639
MacFlow-Mainstay, 818/991-6540
MaclnTax-ChipSoft, Inc., 800/257-9888
MacLabe!Pro-Avery Dennison, 818/915-3851; 800/541-5507
MacLinkPlus/PC-DataViz, Inc., 203/268-0030; 8001733-0030
MacPaint-Claris Corporation, 4081727-8227; 800/628-2100
MacPhonebook-Synex, 718/499-6293; 800/447-9639

MacWrite II-Claris Corporation, 4081727-8227; 800/628-2100
Magic-MacroMind • Paracomp, 415/442-0200
MasterJuggler-ALSoft, Inc., 713/353-4090
Meeting Make r-ON Technology, Inc., 617/876-0900 ext. 606; 8001926-5530
MicroPhone II-Software Ventures, 1nc., 415/644-3232
Microsoft Word-Microsoft Corporation, 206/936-8080
Microsoft Works-Microsoft Corporation, 2061936-8080
Multi-Ad Creator-Multi-Ad Services, Inc.; 800/447-1950

N
Nisus-Paragon Concepts, Inc., 619/481-1477; 800/922-2993
Now Utilities-Now Software, 503/274-2800; 800/522-5939
nuBASE for the Mac-New Era Software Group, 305/2 55-5586

0
On Location- ON Technology, Inc., 617/876-0900 ext. 606; 800/926-5530
Ordertrak-Database Associates, 617/449-8387
Org Plus for Macintosh-Banner Blue, 415/794-6850

p
Panorama- ProVUE Development, 714/892-8199
Personal Training for Microsoft Excel 3.0-Personal Training Systems,
800/fEACH-99
Persuasion-Aldus Corporation, 206/622-5500; 8001333-2538
PlanMa.ker-POWERSolutions for Business, 314/241-0023
POWERicons-Magic Software, Inc., 402/291-0670; 8001342-6243
PowerPoint-Microsoft Corporation, 2061936-8080
Printer's Apprentice Layouts: PageMa.ker Templaces-Postcraft International, Inc., 805/257-1797
Pyro!-Fifth Generation Systems, 504/291-7221; 800/873-4384
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QuarkXPress- Quark, Inc., 8001788-7835
QuickDEX II-Casady & Greene, inc. , 408/484-9228
QuicKeys 2- CE Sofhvare, Inc., 515/224-1995; 800/523-7638
Quickletter-Working Software, 408/423-5696; 800/229-9675

R
RagTime 3-MacVONK USA, 408/973-7100; 800/875-9632
RecordHolderPlus-Sofhvare Discoveries, 203/644-3232
Redux-Microseeds Publishing, 813/882-8635
Retriever II-Exodus Sofhvare, 513/522-0011
Retrospect-Dantz Development, 415/849-0293
RightWriter-Que Software, 317/573-2500; 800/992-0244
Rival-Microseeds Publishing, 813/882-8635
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RunPC- Argosy Sofhvare, 212/274-1199

s
Sales LetterWorks- Round Lake Publishing, Inc., 203/431-9696
Sensible Grammar- Sensible Sofhvare, Inc., 3131774-72 15; 8001394-4669
Shortcut-Aladdin Systems, Inc., 408/685-9175
Smart Alarms with Appointment Diary- Jam Software USA, 415/663-1041
Smart Art-Adobe Systems, Inc. , 415/961-4400
SmartForm Designer/Assistant-Claris Corporation, 4081727-8227;
800/628-2100
SnapJot- Wildflower Software, 708/916-9360
SoftPC/EGA-lnsignia Solutions, Inc., 415/694-7600; 800/848-7677
Software Bridge/Mac-Argosy Software, 212/27 4-1199
Studio/I , /8, and 132-Electronic Arts, 800/245-4525
Srufflt Deluxe-Aladdin Systems, Inc., 408/685-9175

Suitcase Il-Fifth Generation Systems, 504/291-7221 ; 800/873-4384
SuperLaserSpooVSuperSpool-Fifth Generation Systems, 504/291-7221;
800/873-4384
SuperPaint 3-Aldus Corporation, 206/622-5500; 8001.333-2538

T
Taste-DeltaPoint, Inc., 408/648-4000; 8001.367-4334
Thunder 7-Baseline Publishing, 901/682-9676; 800/926-9676
Tiles-CE Software, Inc. , 515/224-1995 ; 800/523-7638
To Do!-shareware product available through user groups, bulletin boards,
and information services
Twinlt-Golden Triangle, 619/279-2100

U-V
Ventura Publisher-Ventura Software, 619/673-0172 ; 800/822-8221
Virex-Microcom, Inc., 919/490-1277

W-Z
Word for Word/Mac-Mastersoft, 602/277-0900
WordPerfect-WordPerfect Corporation, 801/228-5026
WriteNow-T/Maker Company, 4151962-0195
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Symbols
("Application unexpectedly quit")
message, troubleshooting, 481
("box") character (0 ), 379
("DD") file compressed with
DiskDoubler, 385
1-2-3 spreadsheet publishing in
Acta 7 outlines, 331-333
1st Aid HFS (hierarchical file
system), 377
4th Dimension database program,
Project Expense Tracker
application, 207-227
customizing, 217-227
generating reports, 216
quitting, 216-217
911 Utilities, 377
tools, 378

A
absolute addresses, spreadsheets,
236-237
AccessPC, 345-347
Media Formatter, 346
Acta 7 outlines, 1-2-3 spreadsheets,
publishing, 331-333
Acta 7 outlining program, 52-53
address book DAs
Address Book Plus, 288-290
Dynodex, 285-288
INcouch, 291-292
QuickDEX II, 292-294
Address Book Plus
address book DA,
288-290
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Address Book Plus address book
programs, 280, 288-290
address book programs, 280
Address Book Plus, 288-290
Dynodex, 285-288
MacPhonebook, 281-284
address databases, 45
addresses, cell, 235
addressing envelo pes, 94-106
Adobe fo nts, 152
Adobe lllustrator PostScript drawing program, 137
Adobe Photoshop image processing
program, 138-139
Adobe Type Manager (ATM) fonts,
37, 405-407
Adobe Type Reunion, 404-405
After Dark screen saver, 425-426
MultiMo dule, 425
Randomizer, 425
Alarming Events appointments and
to-do list DA, 305-306
AlarmsClock appointment and
reminder DA, 298-299
Aldus Freehand Postscript drawing
program, 137
Aldus PageMaker, see PageMaker
Aldus Personal Press desktop
publishing program, 146
Aldus Persuasion desktop
presentation program, 151
aliases, creating in Syste m 7
operating system, 444-445
analyses, "what if?", 238
anti-static techniques, 422
anti-virus programs
Rival, 431-432
Virex, 430-431
Apple File Exchange, 334
application chains, 410

applications, 10-12
databases, 166
Media Formatter, 346
prioritizing, 390
Project Expense Tracker,
207-208, 227
Projects related database,
210-216
see also programs, software
appointment and reminder DAs,
cale nDAr, 297-298
appointment and reminder INIT/
DA, Smart Alarms with Appointment Diary, 300-303
appointment and reminder utility,
AlarmsClock, 298-299
appointments
Alarming Events DA, 305-306
First Things First INIT, 303-305
Meeting Maker program,
306-309
archival backups, 456
archives, creating self-extracting,
386
archiving files , 460-467
ATM, see Adobe Type Manager
auto-create mode of Tiles, 402
auto-incrementing field in
fo rms, 128
award certifica tes, 29-32

B
backups
archival, 456
differential, 462
duplicates, 458
floppy diskettes, 452
full , 450-451
full copy, 462

incremental, 450-451
medium
floppy diskettes, 452
tape, 452
tape drives, 453-454
nonnal, 458
software, 456-460
standard, 456
templates, 18
Balloon Help, System 7 operating
system, 441-442
bar charts, 239
baud rate, setting, 360
billing fonns, 112
bitmapped images, 139
bits per character, setting, 360
bits per second (bps) , 355
Bitscream fonts, 152
BizPlanBuilder program, 270
blocks, bad, checking, 375, 390
boilerplate text, using in
documents, 41, 47
Books database templates, 176-179
customizing, 180-182
generating reports, 179-180
Boolean fields, 129
Boolean logic, 169
booting Macintosh, 11
bps (bits per second) , 355
bug fixes, 12
bugs in software, 20-23
burn-in, eliminating with screen
savers, 424
business
letters, 44-48
memos, see memos
plans, writing, 267-270
presentations, see presentations
programs, 267

c
cable tenninator, 473
cables, Small Computer System
Interface (SCSI), 470
calculation fields, 168
CalenDAr appointment and
reminder DA, 297-298
Calendar appointment and
re minder DA, 294-296
CanOpener 2 (text recovery) DA,
379-381
Capture screen capture CDEV,
162-163
Capture Viewer utility in
Capture, 163
capturing screens
for presentations, 159
with Capture, 162-163
with Image Grabber, 160-162
with SnapJot, 160
Carbon Copy, 351-354
CDEVs, 10
version numbers, 14
cell addresses, 235
absolute and relative, 236-237
cells, range, 235
certificates
award, 29-32
Manager of the Month, 31
ornate, 32
paper for printing, 32
see also awards
chains
application, 410
sound, 410
charts, 239-241
creating flow with MacFlow,
271-272
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creating organizational with
OrgPlus, 273-274
flow and organizational,
270-271
using in presentations, 155-157
chatting, 361
checlcing
bad blocks, 375, 390
gram mar, 44, 48-52
speUing, 44, 55-57, 148
Checklist 1.0 and 2, 149
checklists, managing publications,
149-150
Cheshire program, creating charts
and graphs, 155-157
Chooser desk accessory, 10
clairvoyance, 195
Claris Resolve, see Resolve
ClarisWorks, 320-324
ClickArt Color Graphics for
Presentations, 140-141
ClickArt EPS Business Art, 140-142
ClickArt Image Po rtfolios,
bitmapped clip art versio ns, 140
cliclcing mouse, 8
clip art
commercial, 140-1 42
electronic, 140
e nvelopes, 96
traditional, 140
clock for Macintosh, AlarmsClock,
298-299
collecting fo rms, 113
collection, creating in Double
Helix, 173
comma-delimited, identification of
fields in data documents, 64
commercial clip art, 140-142
common mode transients, 423

communication parame ters,
setting, 359-361
communications, ClarisWorks, 321
Compact Pro files, compressing,
382, 386-387
Companies database, 210-216
generating reports, 216
company logo, 142
cleaning up scanned image,
144-146
scanning, 142-143
compari ng ClarisWorks with
Microsoft Works, 324
file-compression utilities,
387-388
Compatibility Checker, 15
compressing files, 381-382
with Compact Pro, 386-387
with DiskDoubler, 385, 386
with Srufflt Deluxe, 382-385
compression tools, saving disk
space, 381-386
computer viruses, 23-24, 429-430
computerizing pre-printed forms,
117
computers, data transferring,
333-364
conditioning, line, 423
connecting
IBM with Macintosh, 336-338
Macintosh, 351
connection pon , setting, 360
connectivity, 311
inter-application, 311-325
System 7 operating system,
326-333, 447
te mplates, 493
contents of files, viewing, 371
Control Panel devices, see CDEVs

converting files, 334
to Macintosh format, 334
to PC format, 325, 334
word-processing, 334
Copying titles with System 7
operating system, 443
creators, assigning to DOS
files, 338
customizing
Books database templates,
180-182
Invoice template, Resolve,
258-263
Medical Expenses template,
191-194
P/L Template, 251-252
Phone Messages database,
200-205
Project Expense Tracker database, 217-222
Shipping Request form, 123-124
SmartForm forms, 119-120
Work Order form, 127-132
cutting data, 312-313
CYMK (cyan, yellow, magenta,
black), 154

D
data
bits, 143
cutting, 312-313
exporting, 280-282
Dynodex, 285
INtouch, 292
QuickDEX II, 293
Smart Alarms with Appoint·
ment Diary !NIT/DA, 301
files, 10
storing, 8

importing, 280-282
Address Book Plus, 290
Dynodex, 285
!Ntouch, 291
MacPhonebook, 282-283
QuickDEX II, 293
Smart Alarms with Appoint·
ment Diary JNIT/DA, 301
pasting, 312-313
programs for importing,
DataShaper, 150
protecting, 422
recovering, 373-374
spreadsheets, 235
transferring, between
computers, 333-364
data documents
identifying fields, 64-65
mail me rges, 63-93
DATA statements in mail
merges, 70
database manage ment, Microsoft
Works, 318
database programs, see databases
databases, 165, 171, 242
4th Dimension, Project Expense
Tracker application, 207-227
address, 45
advantages, 169-170
ClarisWorks, 321
creating in spreadsheets,
241-245
manipulation features, 242
DAs, 228
HyperDA II, 228-230
QuickDEX II , 292-294
Retriever ll, 230-231
Double Helix, 173-175
FileMaker Pro, 175-180
Books te mplate, 176-179
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creating a merge fiJe, 65-66
customizing Books te mplate,
180-182
generating reports with
Books template, 179
scripts, 182-184
flat-file, 175, 184, 194
FoxBASE + /Mac, 171-173
functions
indexing and sorting, 169
HyperCard, 175, 228
mail merges, 64-66
nuBASE for Mac, 171
Panorama, 194-195
Phone Messages, 195-199
customizing, 200-205
formulas and macros,
206-207
generating reports, 199-200
RecordHolderPlus, 184-185
Medical Expenses
template, 185-194
relational, 207
Retriever 11, 230, 231
templates, 494
DataShaper data importing
program, 150
date, current, program automatically inserting, 34-35
date fields, 122
date stamping, 34-35
dBASE language, FoxBASE+/Mac's
compatiblity with, 171
dBASE Mac, see nuBASE for Mac
decompressing files with Unstufflt
Deluxe, 382
default settings for fields in
forms, 111
defining subvolumes, 457

dele ting
fi1es, 398
p ermanently,374
fonts, 405
DeltaGraph program, creating
graphs, 157-158
designing
layout for publications, 147-149
software, 21
DesignStudio desktop publishing
programs, 148
desk accessories (DAs)
access macros, 418
address book
Address Book Plus, 288-290
Dynodex, 285-288
INtouch, 291-292
QuickDEX 11, 292-294
Alarming Events (appointme nts
and to -do list), 305-306
calenDAr (reminder and
appointment), 297-298
Calendar, 294-296
CanOpener 2 (text recovery) ,
379-381
Chooser, 10
databases, 228
free-form, 292
HyperDA II, 228-230
QuickDEX ll, 292-294
Retriever 11, 230-231
DiskTop, 395-397
e nvelo pes and labels, 101-105
Find File (System 6), 366
GOfer (file search), 370
in combinition with INIT, Smart
Alarms with Appointment
Diary, 300-303
INto uch (phone dialer),
291, 292

Locate (file search), 369-370
managing
with Masterjuggler, 409-412
with Suitcase II, 407-409
On Location (file search),

371-372
Scrapbook, 313-314
Smart Art, 152-154
To Do!, 296-297
version numbers, 14
Desktop, 6
troubleshooting, 478
desktop presentation programs,

150-151
desktop publishing (DTP) pro-

grams, 146-147
managing publications, 149-150
using templates, 147-149
detection, anti-virus programs, 430
dictionaries, 56-57
differential backups, 462
Digital Darkroom image processing
program, 138-139
disk drives
backups, 450
ejecting, 9
floppy, 8
backups, 452
formatting, 374
unmounting from Desktop, 9
hard, see disks, hard
disk mirroring, 455
disk optimizer p rograms, 376,

389-392
disk space, saving with
compression tools, 381-386
DiskDoubler
files, compressing, 382, 385-386
diskettes, see disks

Disk.Express II, disks,
unfragme nting, 391-392
DiskFit Pro backup program,

456-457
disks

9-to-5 Mac, 491-495
DOS, mounting on Macintosh
Desktop, 345-351
fragmentation, 389
hard, 8
formatting, 374
partitioning, 453
removable, 454
storage capacity, 10
troubleshooting, 476
unfragmenting, 376
unmounting from Desktop, 9
mounting on Desktop, 8
protecting from magnetic
fields, 422
unfragmenting, 389-390
with Disk.Express II, 391-392
DiskTools (icon-driven finder alternative) , 393
DiskTop desk accessory, 395-397
display-o nly fields in forms, 126
displaying
files and folders, System
operating system, 437-439
DocuComp, comparing wordprocessing documents, text files,
or program Listings, 53-55
documents, 10, 46
checking grammar, 48-52
comparing with DocuComp,

53-55
creating te mplates, 29
data, 63-94
ide ntifying fields, 64-65
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fax transminal forms, 35-38
letterheads, 38-41
linking with speadsheets,

315-317
MacWrite II, Award template,

29-32
memos, 32-35
Microsoft Word, transferring to
personal computer (PC), 340
opening, 8
outlining, 52-53
previewing, 31
spreadsheet, see worksheets,

234
style sheets, 42-44
using boilerplate text, 41, 47
see also len ers
DOS
cartridges, mounting o n
desktop, 346
disks, mounting on Macintosh
Desktop, 345-351
files creators and types, 338
'
DOS Mounter, 337
dots per inch (dpi), 143
Double Helix database program,

173-175
double-clicking mouse, 8
down-time of computer, 433
drag-and-drop method , 443
dragging mouse, 8
draw programs, 136
Postscript, 136-137
drives, Finder-mountable, 454
duplex printing, 412
duplicate backups, 458
Dynodex address book program,

280-288
DynoPage, 412-413

E
Effects Specialist type effect
program, 154-155
ejecting disks, 9
electronic clip art, 140
eliminating
burn-in with screen savers, 424
static, 422
Encapsulated Postscript files
see EPS files
envelopes
printing, 94-96
with Envelope Merge (Word) ,

96-98
programs and desk accessories,

101-106
templates, 94-98
EPS files, 137
EPS format, 143
Epson FX-80 printer, 348
eradication, anti-virus
programs, 430
e rasing files, 391
Excel spreadsheet program, 64,

155, 239-243
linking spreadsheets, 315-317
P/L Template, 245-251
customizing, 251-252
training module, 265
excessives, 50
exiting, see quitting
expanded memory, 351
Lotus-Intel-Microsoft (LIM), 347
expenses, tracking, 207-227
exporting data, 280-282
Dynodex, 285
lNtouch, 292
QuickDEX 11, 293
Smart Alarms w ith Appoint·
me nt lNIT/DA, 301

e;\"tensions (JNITs), 10
in QuicKeys 2. 416
version numbers, 14

F
FastBack II, 461-462
Fast Forms program, 116, 120-124
fax
Fax Form template, 36
capabilities with modems,
356-357
modems,selecting fonts, 37-38
transmittal te mplates, 35-38
faxi ng Macintosh d ocuments, 37
Federal rax return, preparing with
MaclnTax, 276-278
field types, 167
field-oriented address book programs, 280
fields, 167
databases, 242
identifying in data documents,
63-65
in forms, 118, 123-132
auto-incrementing, 128
Boolean, 129
dare, 122
defaulr senings, 111
display-only, 126
number, 121
picture, 112
table, 130
setting order of, 66
file compression, 381-382
programs, 382
utilities, compari ng, 387-388
File Director, Finder, improving,
392-394

file locarion programs, 369-372
FileEdir utility, 375
FileMaker Pro database program,
175, 180
Books te mplate, 176-179
cusromizing, 180-182
generaring re ports, 179
mail merges, 65-66
scripts, 182-184
files
archiving, 460-467
compressing
with Compact Pro, 386-387
with DiskOou bler, 385-386
with Srufflt Deluxe, 382-385
contents, viewing, 371
converting, 334
to Mac formars, 334
to PC format, 325, 334
word-processing, 334
data, 10
decompressing wich UnStufflr
De luxe, 382
deleting, 398
permane ntly, 374
displaying System 7 operating
system, 437-439
DOS
creators, 338
types, 338
EPS, 137
erasing, 391
loading, 325
locating, 396
by conte nt, 370
by keywords, 3 71
by name, 371
in System 6, 366
in Syste m 7, 366-368
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misplaced, 366-372
with On Location, 371, 372
locking, 17-18
MacTools Deluxe (file recovery)
program, 374-375
moving, 393
preference, 446
protocol, 358
read-only, 18
recovery programs, 373, 380
renaming, 398
saving, 325
setting, 358
sharing, 326-330
adjusting, 329-330
monitoring, 329-330
("shredding"), 398
stationery, 17
stationery pad, 18
template, 16-17
TIFF, 136-137
transferring, 337-341, 352-363
with modems, 355-364
types, 11
undeleting, 375-378
fiJters, "plug-in", 139-140
Find File (System 6) desk accessory,

366
Find (System 7) command, 366-367
Finder
alternatives, DiskTools, 393
improving with, 392-403
DiskTop, 395-397
File Director, 392-394
POWERicons, 400-401
Shortcut, 397-400
Tiles, 401-403
Finder-mountable drives, 454
finding, see locating

First Things First appointments and
to-do list INIT, 303-305
fixed-field address book
program, 281
FKeys
managing with Master]uggler,

409-412
managing with Suitcase II,

407-409
flat-file databases, 165-184, 194
FlexForm Business Templates:
General Business-Volume 1,
112-113
Inventory/Stock-Keeping
Edition-Volume II, 113-114
flow charts, 270-271
creating with MacFlow, 271-272
folders
displaying, System 7 operating
system, 437-439
locating, 396
font selector macros, 417
fonts
Adobe Type Manager (ATM), 37
deleting, 405
managing with
Adobe Type Manager,

405-407
Adobe Type Reunion,

404-405
Master]uggler, 409-412
Suitcase II, 407-409
PostScript, improving, 405
proprietary names, 152
selecting for fax transmissions,

37-38
TrueType, 37
types, serif and sans serif, 152
using for presentations, 151-152

form letters, mail merges, 62-94
formats, graphic files
EPS, 143
PICT, 143
PICT and PICT2, 136
TIFF, 143
formatting
floppy disks, 374
hard disks, 374
pictures, 168
forms
billing, 112
default settings for fields, 111
electronic, SmartForm
program, 112
fields, 118, 123, 127-132
Boolean, 129
table, 130
FlexForm Business Templates:
Inventory/Stock-Keeping
Edition--Volume II, 113-114
non-printing layer, FastForms,
116
PageMaker, 114-115
picture fields, 112
pre-printed, 115-116
computerizing, 117
printing layer, FastForms, 116
programs, 110
FlexForms Business Templates, 112-115
SmartForm, 117-120
scanning pre-printed, 115
selling, 113
Shipping Request, 120-122
customizing, 123-124
templates, 111-132, 494
Work Order, 125-127
customizing, 127-132

formulas, 237
creating, 237-238
Phone Messages database,
206-207
spreadsheets, 236
FoxBASE+/Mac database program,
171-173
fragmentation of disks, 389
FrameMaker desktop publishing
program, 146
free-form address book
programs, 280
free-form database desk
accessories, 292
full backups, 450-451
full copy backups, 462
functions
search/replace, 57
spreadsheets, 236

G
Gallery Effects, "plug-in" filters,
139-140
glossaries, user-definable, 57
GOfer (file search) desk accessory,
370
grammar-checking programs, 44,
48-52
Gram0 ma0 tik Mac, 44, 51-52
graphics
ClarisWorks, 321-322
in presentations, 151-163
Microsoft Works, 318
programs, 136-137, 142-146
image processing, 138, 139
selecting, 137-139
spreadsheets, 240
storing, 313-314
using in letterheads, 41
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graphs, using in presentatio ns,
155-159
grounding cords, 422

H
hand-outs, 151
hard disks
re moving from Desktop, 9
storage capacity, IO
see also disks
hardware
problems, 23
protecting, 422-423
repairing, 432-433
service companies, 433
require me nts, System 7
operating syste m, 436
u·o ubleshooting, 475-477
Hayes compatibility, 355
hierarchical file system, 3 77
high resolution images, 138
HyperCard, 15
database program, 15, 175, 228
stacks, 269
HyperDA 11 DA database, 228-230

I
IBM, connecting with Macintosh,
336-338
icons, 8
dragging to Trash, 9
modifying, 439
identification (ID) numbers, Small
Computer System Interface
(SCSI), 471
Image Grabber screen capture
program, 160-162
image processing programs
Adobe Photoshop, 138-139

Digital Darkroom, 138-139
images, bitmapped, 139
scanned, cleaning up, 144-146
importing data, 280-282
Address Book Plus, 290
Dynodex,285
INtouch, 291
MacPhonebook, 282-283
QuickDEX II, 293
Smart Alarms with Appointment
Diary, 301
improving Finder, 392-403
DiskTop, 395-397
File Director, 392-394
Postscript fonts, 405
POWERicons, 400-401
Shortcut, 397-400
Tiles, 401-403
income taxes, preparing Federal tax
return with MaclnTax, 276-278
incompatibility, 21
increasing memory, 481
incremental backups, 450-451
indexing, 169
Informed Designer program ,
124-132
!NIT/program conflict, 479
INITs, 10
combined with DAs, Smart
Alarms with Appointment
Diary, 300-303
First Things First appointments
and to-do list, 303-305
version numbers, 14
ink-jet printers, 32
installing software, 22
Instant Update work group
software, 58-59
instruction booklet,.Macintosh,
19-20

integrated programs, 317-324
inter-application connectivity,
311-325
interactive mode, 51
IN touch
address book
DA, 102-103, 280, 291-292
invoice
database, 253
form, 253
Invoice template, Resolve, 252-263
invoices, mail merges, 63
IRS Schedule C, Books
template, 176

K
KaleidaGraph program, creating
graphs, 158-159
key fields, 169
KeyChains, 410

L
labels, 101
INtouch DA, 102-103
MacEnvelope program, 105-106
Macl..abelPro program, 103-105
printing, 98-101
programs and DAs, 101-106
spreadsheets, 236
templates, 98-106
landscape
form, 125
mode, 31
languages, dBASE, FoxBASE+/Mac's
compatiblity with, 171
scripting, see macros
LapLink Mac Ill, 339-342
laser printers, 32

Last Resort 1.0 (recover text)
program, 378-379
launching, see opening
layout design, 147-149
Legal LetterWorks, 44-48
Letter Writer Plus, 44-48
letterheads, templates, 38-41
letters
business, 44-48
form, 77-94
mail merges, 62-76
see also documents
LetterWorks, 44-48
LIM (Lotus-Intel-Microsoft
expanded me mory, 347
line charts, 239
line conditioning, 423
Linking
Excel worksheets and Word
documents, 315-317
Microsoft, 314-317
Multi-Ad Search utility, 317
program, 330-331
worksheets, documents,
315-317
lists
To Do! DA, 296-297
templates on 9-to-5 Mac disk,
538-539
loading files, 325
Locate (file search) desk accessory,
369-370
locating
files, 396
by content, 370
by keywords, 371
by name, 371
folders, 396
in System 6, 366
in System 7, 366-368
misplaced, 366-372

The 9-to-5 Mac

with On Location, 371-372
locking files, 17-18
logic, Boolean, 169
logos, company, 142
cleaning up scanned image,

144-146
for envelope return
addresses, 96
scanning, 142-143
Lotus 1-2-3 for Macintosh
spreadsheet program, 155,

263-265
Lotus-Intel-Microsoft (LIM)
expanded memory, 347

M
MacDraw Pro, 136
MacEnvelope, envelopes and
labels, 105-106
MacFlow program, 271-272
MaclnTax program, preparing
Federal tax return, 276-278
Macintosh
booting, 11
cartridges, mounting on desktop, 346
.c onnecting, 351
with IBM PC, 336-338
faxing with modem, 3 7
files, transferring, 339-341
with modems, 355-364
hardware problems, 23
instruction booklet, 19-20
models, 15
operating systems, 15
personal computers (PC),
executing, 342-343
product index, 483-489
restarting, 11

serial ports, 348
shutting down, 11
software
guidelines, 19-20
templates, 538-539
Starting, 6-11
system software, selecting, 15-16
training modules, 265-266
Macintosh-to-Macintosh transfers,

339-340
MacLabelPro, 103-105
MacLinkPlus/PC, 336-338
DOS Mounter, 337
features, 338-339
MacPaint, 136
MacPhonebook address book
program, 280-284
macros, 418
("watch me") feature, 415
creating, 414-419
desk accessories (DAs) access,

418
font selector, 417
Lotus 1-2-3 for Macintosh, 264
Phone Messages database,

206-207
program launcher, 417
recorder, 415
selecting Chooser devices, 418
sequences, 418
spreadshee ts, 238
timed activities, 418
universal, 416
MacTools Deluxe ftle recovery
program, 374-375
disk optimizer, 376
utilities
Mirror, 375-376
Rescu, 375-376

MacWrite II
Award template, 29-32
mail merges, 81, 83
Magic desktop presentation
program, 151
magnetic fields, disk damage, 422
mail merges, 47-48, 62-76, 81
conditional statements, 77-79,
83,86
DATA statement, 70
MacWrite, 83
Nisus, 93-94
primary file, 88
Print Merge command, 71-73
secondary file, 88
Taste, 84, 86-87
WordPerfect 2.0, 87-93
WriteNow, 83-84
managing
desk accessories (DAs) with
Masterjuggler, 409-412
Suitcase II, 407, 409
FKeys with
MasterJuggler, 409-412
Suitcase II, 407, 409
fonts with
Adobe Type Manager,
405-407
Adobe Type Reunion,
404-405
Masterjuggler, 409-412
Suitcase II, 407-409
publications with checklists, 149
sounds with
Masterjuggler, 409-412
Suitcase II, 407-409
manipulating databases in spreadsheets, 242
master scripts, 466

MasterJuggler DA, 409-412
Media Formatter application, 346
Medical Expenses template,
185-189
customizing, 191-194
generating reports, 189-190
Meeting Maker appointments and
to-do list program, 306-309
memory, IO
expanded,351
Lotus-Intel-Microsoft
(LIM), 347
increasing, 481
virtual, 447
memos, 46
templates, 32-35
menu bar, 6
merge fields, 69
merge form, 63-73
Microcom Networking Protocol
(MNP), 356
Microsoft Excel, see Excel
spreadsheet program
Microsoft linking, 314-317
Microsoft PowerPoint desktop
presentation program, 151
Microsoft Windows, 19
Microsoft Word
documents, transferring to
personal computer (PC), 340
Envelope Merge, 96-98
mail merges, 69
producing labels, 98-101
screen saver, 428-429
see also, Microsoft Word 4 and 5
Microsoft Word 4
date stamping, 34-35
Letterhead 1 template, 39
Letterhead 2 template, 39
Memo Template, 33
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Microsoft Word 5, 12
mail merges, 67
te mplates, 17
Microsoft Works
comparing with ClarisWorkS,
324
database management, 318
graphics, 318
integrated program, 318-320
spreadsheets, 318
telecommunications, 318
word processing, 318
Mirror (file recovery) utility,
375-376
mirroring disks, 455
miscellaneous forms, 113
misplaced files, locating, 366-372
MNP (Microcom Networking
Protocol), 356
modal manner in programs, 209
modeless programs, 209
models of Macintosh, 15
modems
configuring for dialing with
address book programs,
282-295
fax, 37
capabilities, 356-357
selecting fonts, 37-38
Hayes compatibility, 355
Macintosh, transferring files,
355-364
Microcom Networking Protocol
(MN P), 356
speed (bpi) issues, 356
troubleshooting, 476
modes
interactive, 51
Tiles auto-create, 402
modifying icons, 439

More After Dark screen saver, 426
mounting disks on Desktop, 8
mouse, 7, 8
drag-and-drop, 443
SoftPC program, transforming to
Microsoft Mouse, 349-350
moving
files, 393
windows, 8
Multi-Ad Creator desktop publishing program, 146
Multi-Ad Search utilities, linking,
317
MultiFinder, 15
multitasking, System 7 operating
system, 439-441

N
newsletters, creating, 322
Nisus, mail merges, 93-94
non-printing layer of forms
Fast Forms, 116
normal backups, 458
nuBASE for Mac database
program, 171
number fields, 121

0
On Location
file search DA, 3 71-3 72
locating files, 371-372
opening programs, 8, 394
operating systems, 6, 10
selecting, 15
System 6 , 15
System 7, 15, 435-447
features, 15
Optimizer, 389, 390

optimizers, disk, 389-392
Ordertrak sales orde r-tracking
program, 275-276
Org Plus program, 273-274
organizational charts, 270-271
creating with Org Plus, 273-274
orie ntation, page, landscape mo de,
31

p
P/L Template for spreadsheets,
245-251
customizing, 25 1-252
page-layout programs,
spell-checkers, 55-57
Paged Memory Manageme nt Unit
(PMMU) chip, 447
PageMaker forms, 114-115
Template option, 17
paint programs, 136, 139
Panorama database program,
194-195
Pho ne Messages, 195-199
custo mizing, 200-205
formulas and macros,
206-207
generating re ports, 199-200
parameters, communication,
setting, 359-361
parity setting, 360
partitioning hard disks, 453
pasting data, 312-313
personal computers (PC)
executing from Macintosh,
342-343
files, transferring, 339-341
pe rsonal dictionaries, 56
Personal Training Systems training
modules for Maintosh products,
265-266

p hone dialer DAs, 282-285
Phone Messages database, 195- 199
customizing, 200-205
formulas and macros, 206-207
generating reports, 199-200
photographs, scanning, 138
PICT format, 136, 143
PICT viewer, 398
PICT2 format, 136
picture fields in forms, 112
pie charts, 239
PlanMaker program, 268-270
· plans for businesses, 267-270
PMMU (Paged Memory Management Un it) chip, 447
pointing with mouse, 7
po rts, serial, 348
PostScript drawing programs,
136-137
Postscript fonts, improving, 405
PostScript printer, 348
power, protecting, 423-424
POWERicons, Finder, improving,
400-401
pre-printed forms, 115-116
computerizing, 117
prefere nce files, 446
presentations
preparing with desktop presentation programs, 150-151
using
charts and graphs, 155-157
fonts, 151-152
graphs, 157-159
screen captures, 159-163
text effects, 151-155
preventing viruses, 430-432
primary file, mail merges, 88
Print Merge command, 71-73
print spooling, 413-414
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printers
printers, selecting, 10
Epxon FX-80, 348
ink-jet, 32
laser, 32
PostScript, 348
Printer's Apprentice Layouts,
templates, 148
printing, 412-413
duplex, 412
envelopes, 95-96
with Envelope Merge (Word),
96-98
in ClarisWorks, 322-324
labels, 98-101
printing layer of forms,
Fast Forms, 116
printing tools, 412-416
prioritizing applications, 390
product index for Macintosh,
483-489
production forms, 113
Program launcher macros, 417
program linking, 330-331
program listings, comparing with
DocuComp, 53-55
programming in Double He lix, 173
programming e rrors, 20-23
fixing, 12
programs, 10
address book, 280
Address Book Plus, 288-290
Dynodex, 285-288
MacPhonebook, 281-284
anti-virus
detection, 430
eradication, 430
Rival, 431-432
Virex, 430-431

backup
DiskFit Pro, 456-457
Redux, 456, 460
BizPlanBuilder, 270
business, 267
creating charts and graphs,
Cheshire, 155-157
creating graphs
DeltaGraph, 157-158
KaleidaGraph, 158-159
data importing, DataShaper, 150
database, 171
4th Dimension, 207-227
Double Helix, 173-175
FileMaker Pro, 175-184
FoxBASE+ /Mac, 171-173
HyperCard, 175, 228
mail merges, 65-66
nuBASE for Mac, 171
Panorama, 194-207
RecordHolderPlus, 184-194
Retriever II, 230-231
desktop presentation, 150·151
desktop publishing (DTP),
146-147
managing publications,
149-150
using templates, 147-149
disk optimizer, 389-392
draw, 136
electronic forms, SmartForm,
112
e nvelopes, 101
e nvelopes and labels,
MacEnvelope, 105-106
Fast Forms, 116
file location, 369·3 72
file recovery, 374-375
1st Aid HFS, 377

file-compression, 382
fixed-field address book, 281
flow and organizational charts,
270-271
flow charts, 271-272
for Macintosh, guidelines, 19-20
forms, 110
Fast Forms, 120-124
FlexForm Business
Templates, 112-115
Informed Designer, 125-132
SmartForm, 117-120
grammar-checking, 48-52
graphics, 136-146
image processing, 138-139
selecting, 13 7-139
Informed Designe r, 124
integrated, 317-324
labels, 101
Last Resort 1.0 (text recovery)
program, 378-379
launching, 394
Syste m 7 operating
system, 443
MacFlow, 271-272
MaclnTax, preparing Federal tax
return, 276-278
MacTools Deluxe, 374-375
Meeting Maker appointments
and to-do list, 306-309
modal, 209
modeless, 209
opening, 8
Org Plus, 273-274
organizational charts, 273-274
outlining, 52-53
page-layout, spell checkers,
55-57
paint, 136-139
PlanMaker, 268-270

Postscript draw, 136-137
revisions, types, 12
sales order-tracking, Ordertrak,
275-276
screen capture, 159-162
capture, 162-163
Image Grabber, 160-162
SnapJot, 160
software, 12
checking compatibility with
System 7, 15
upgrading, 14
version numbers, 12-14
spreadsheet, 155
see also spreadsheets
spreadsheet publishing
Lotus 1-2-3 for Macintosh,
263-265
Resolve, 252-263
storing, 8
text recovery, 378-381
type effects, Effects Specialist,
154-155
word-processing, 30-41, 146
addressing envelopes, 94-96
comparison to typewriters,
27-28
envelopes, 96-98
labels, 98-101
mail merges, 63-94
style sheets, 42-44
tools, 44-59
writing business plans, 267-270
see also applications and
software
Project Expe nse Tracker
application
4th Dimension database,
207-208, 227
customizing, 217-227
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Projects related database,
210-213, 215. 216
quitting, 216-217
projects, labeling in Tiles, 403
Projects database, 210-216
generating reports, 216
proofreading, 148
protecting
data, 422
disks from magnetic fields, 422
hardware, 422-423
power, 423-424
protocol files, 358
proxies, 308
public grou ps, 307
publications, managing with
Checklist, 149-150
Publish and Subscribe, 330-333
publishing
1-2-3 spreadsheets in Acta 7
outlines, 331-333
features of spreadsheets, 238
purchasing forms, 113
Pyro! screen saver, 426-427
modules, primary and
secondary, 426

Q
QuarkXPress desktop publishing
program, 146-148
quick-and-dirty databases,
creating, 241
QuickDEX II address book
program, 280
QuickDEX II database DA, 292-294
storage capabilities, 294
QuicKeys 2, 416-417
extensions, 416
QuickLetter, 44

quitting Project Expense Tracker
database, 216-217

R
RagTime 3 desktop publishing
program, 146
RAM (Random-Access Memory),
9-10
range names, spreadsheets, 23 7
range of cells, 235
read-only files, 18
Ready,Set,Go! desktop publishing
program, 148
receiving forms, 113
RecordHolderPlus database,
184-185
Medical Expenses template,
185-189
customizing, 191-194
generating reports, 189-190
records, 166
data documents, 63
databases, 242
recovering
data, 373-374
files, 3 73-380
text, 378-381
Redux backup program, 456, 460
relational databases, 165, 207
relative addresses, spreadsheets,
236
reminder and appointment DAs,
calenDAr, 297-298
reminder and appointment INIT/
DA, Smart Alarms with Appointment Diary, 300-303
reminder and appointment utility,
AlarmsClock, 298-299
re movable hard disks, 454

renaming files, 398
repairing hardware, 432-433
reports generating, 179-180
in Phone Messages database,
199-200
in Project Expense Tracker,
216
with Medical expenses
template, 189-190
Rescue (file recovery) utility,
375-376
Resolve spreadsheet publishing
program, 155, 252-263
restarting Macintosh, 11
Retriever 11 DA database, 230-231
Retriever II database program,
230-231
retrieving files, see recovering files
Retrospect, 463-464
scripting, 465-467
revisions of programs, types, 12
RightWriter, 44-48
Rival anti-virus program, 431-432
Rolodex-style DAs, 45
RunPC program, 342-345
("chat mode") , 343
features, 345
sessions, starting, 343
Software Bridge, 344

s
sales programs
order entry, Ordertrak, 275-276
tracking, Ordertrak, 275-276
Sales LetterWorks, 44, 48
sans serif type, 152
saving
disk space with compression
tools, 381-386

files, 325
scanning
company logos, 142-143
cleaning up image, 144-146
forms, 115
photographs, 138
television screens, 138
Schedule C, see IRS Schedule C
Scrapbook desk accessory, 313-314
screen capture, 159-163
screen savers, 424-429
After Dark, 425-426
eliminating burn-in, 424
Microsoft Word, 428-429
More After Dark, 426
Pyro! , 426-427
Screen Test, adding to menu, 428
screens, capturing for use in
presentations, 159-163
scripting, 465-467
master, 466
scripting language, see macros
scripts
FileMaker Pro database
program, 182-184
Project Expense Tracker database, 226
SCSI (Small Computer System
Interface), 469
cables, 470
device, troubleshooting, 476
identification (ID) numbers, 471
terminating, 472-473
SCSI Disk Link, 342
search/replace function, 57
searching records
Boolean logic, 169
database function, 169
secondary file, mail merges, 88

selecting
objects, 8
records, database function, 169
telecommunications
software, 358
text, 8
self-extracting archives
creating, 386
selling forms, 113
Sensible Grammar, 44-50
sequences, macros, 418
serif type, 152
service contracts, hardware
repair, 433
setting
baud rate, 360
bits per character, 360
communication parameters,
359-361
connection port, 360
files, 358
parity, 360
stop bits, 360
sharing files, 326-330
adjusting, 329-330
monitoring, 329-330
Shipping Request form, 120-122
customizing, 123-124
Shortcut
Finder, improving, 397-400
options, 398
("shredding") files, 398
shutting down Macintosh, 11
slides, 151
Small Computer System Interface
(SCSI), see SCSI (Small Computer
System Interface)
Smart Alarms with Appointment
Diary appointment and reminder
!NIT/DA, 300-303

Smart Art desk accessory, 152-154
SmartForm program, 112, 116-120
SnapJot screen capture
program, 160
SoftPC program, 347-351
executing, 347-349
features, 349-351
mouse, transforming to
Microsoft Mouse, 349-350
printers
Epson FX-80, 348
Postscript, 348
serial ports, 348
software
backups, 456-460
bugs, 20-23
checking compatibility with
System 7, 15
design decisions, 21
installing, 22
Macintosh, 491-495
guidelines, 19-20
system
checking compatibility with
programs, 15
selecting, 15-16
telecommunications, selecting,
358
upgrading, 14
version numbers, 12-14
work group, Instant Update,
58-59
see also applications and
programs
Software Bridge, 344
sorting, database function, 168
sound chain, 410
sounds, managing with
Masterjuggler, 409-412
Suitcase ll, 407-409

speadsheets, documents, linking,
315-317
specialized dictionaries, 57
specifying tiles, 402
speed (bpi) issues, 356
spelling, checking, 44, 55-57, 148
spooling, 413-414
spreadsheet programs
see spreadsheets
spreadsheet publishing programs
Lotus 1-2-3 for Macintosh,
263-265
Resolve, 252-263
spreadsheets, 155, 233-234, 270
cell addresses, 235
cells, 235
charts, 239-241
ClarisWorks, 321
creating databases in, 241-245
manipulation features, 242
data, 235
Excel,
linking, 315-317
P/L Template, 245-252
formulas, 236
functions, 236
Lotus 1-2-3 for Macintosh,
263-265
macros, 238
mail merges, 64
Microsoft Works, 318
publishing features, 238
range names, 237
range of cells, 235
Resolve, 252-263
templates, 494
training modules, 265
values, 235
VisiCalc, 233
worksheets, 234

see also spreadsheet publishing
programs
stacked bar chart, 239
stacks, HyperCard, 228-269
standard backups, 456
starting Macintosh, 6-11
Statement of Account template,
117-119
customizing, 119-120
statements
conditional, 83
conditional in mail merges,
77-79, 86
mail merges, 63
static
discharge strips, 422
eliminating, 422
stationery
files, 17
pads, 18
Stationery Pad, 37
stock-keeping forms, 113
stop bits, setting, 360
stopwatch for Macintosh,
AlarmsClock, 298-299
storage capacity, 10
storing graphics and text, 313-314
Studio/1 paint program, 136
Studio/8 paint program, 136
Studio/32 paint program, 136
Stufllt Deluxe program, 382
files, compressing, 382-385
style sheets, 42-44
subvolumes, defining, 457
Suitcase II, managing
desk accessories (DAs), 407-409
FKeys, 407- 409
fonts, 407- 409
sounds, 407- 409
suitcases, 407
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SuperLaserSpool, 413-414
SuperPaint 3, 139
system
resource management mols,
404-412
software
checking compatibility, 15
selecting, 15-16
System 6
files, locating, 366
operating system, 6, 10, 15
troubleshooting, 481-482
Syste m 7 operating system, 6, 10,
15, 435-447
aliases, creating, 444-445
applicatio ns, 439-441
background copying, 443
Balloon Help, 441-442
connectivity, 326-333, 447
features, 15
files
displaying, 437-439
locating, 366-368
folders, displaying, 437-439
hardware requirements, 436
icons, modifying, 439
multitasking, 439-441
programs, launching, 443
System folder, 445-447
trash, emptying, 442
virtual memory, 447
syste m enhancement utilities, 365
System Folder, 10
System 7 operating system,
445-447
troubleshooting, 478-481
System heap, troubleshooting, 482

T
tab-delimited identification of fields
in data documents, 64-65
table field, 130
Tag Image File Format files,

see TIFF
tape drives, backups, 453-454
Taste, mail merges, 84-87
telecommunications
Microsoft Works, 318
software, selecting, 358
telephone messages,
see phone messages
television screens, scanning, 138
Template option, PageMaker, 17
templates, 3, 96, 148
9-to-5 Mac disk
backup copies, 18
BizPlanBuilder, 270
connectivity, 493
database, 494
Books, 176-182
Medical Expenses, 185-194
desktop publishing programs
(DTP) , 147-149
envelope, 94-97
Excel's P/L Template, 246-251
customizing, 251-252
fax transmittal forms, 35-38
files, 16-17
FlexForm Business Templates:
Volume I, 112-113
forms, 111-120, 494
Invoice, 252-263
label, 98-101
lenerheads, 38-41
MacWrite II, Award template,
29-32
mail merges, 68-69, 73, 76-77,
81-92

memos, 32-35
Microsoft Word 5, 17
PageMaker, 17
spreadsheets, 538
using boilerplate text, 41
word-processing, 29-41, 538-539
terminating Small Computer
System Interface (SCSI), 472-473
text
effects
SmartArt, 152-154
using for presentations, 151
files, comparing with
DocuComp, 53-55
recovery programs, 378-381
selecting, 8
spreadsheets, 236
storing, 313-314
thesauruses, 44, 56
three-dimensional column
chart, 239
three-line protection., 423
Thunder 7 spell-checking CDEV,
56-57
TIFF Converter utility in
Capture, 163
TIFF files, 136-137
TIFF format, 143
Tiles
auto-create mode, 402
Finder, improving, 401-403
projects, labeling, 403
tiles, 402
timed activities, macros, 418
timed grab, 161
To Do! DA, 296-297
to-do lists
Alarming Events DA, 305-306
First Things First INIT, 303-305

Meeting Maker program,
306-309
tools
compression, 381-386
printing, 412-416
word-processing programs,
44-59
tracking
events with Calendar DA,
294-296
expenses, 207-227
sales with Ordertrak, 275-276
traditional clip art, 140
training modules for Maintosh
products, 265-266
transferring
data between computers,
333-364
files, 337-363
Macintosh-to-Macintosh,
339-340
transients, common mode, 423
transparencies, 151
Trash,9
emptying, System 7 operating
system, 442
Trojan Horses virus, 429
troubleshooting, 477
("Application unexpectedly
quit") message, 481
Desktop, 478
hard disks, invisible, 476
hardware, 475-477
modems, 476
pages, misprinted , 476
SCSI device, 476
System 6 operating system,
481-482
System folder, 478-481
System heap, 482

The 9·t0·5 Mac

TrueType fonts, 37
Tune Ups, 16
type effects programs, Effects
Specialist, 154-155
types, assigning to DOS files, 338
types of fonts, 152
typewriters, comparison to wordprocessing programs, 27-28

u
UL (Underwriters' Laboratory)
seal, 423
undeleting files, 375-378
u nfragmenting
disks, 389-390
disks with DiskExpress II,
391-392
hard disks, 376
Uninterruptable Power Supply
(UPS) , 423-424
universal macros, 416
UnStufilt Deluxe (file decompression) program, 382
upgrading software programs, 14
UPS, see Uninterruptable Power
Supply (UPS)
user-definable glossaries, 57
utilities, 365
file-compression, comparing,
387-388
FileEdit, 375
Find File (System 7), 366-367
Mirror (file recovery) , 375-376
reminder and appointment,
AlarmsClock, 298-299
Rescue (file recovery) , 375-376
system enhancement, 365
utilities, see also programs,
applications, software

v
vaccines, virus protection, 432
values, spreadsheets, 235
Ventura Publisher desktop
publishing program, 146
version numbers, software, 12
locating, 12-14
viewing file contents, 3 71
views in databases, 173
Virex anti-virus program, 430-431
virtual memory, System 7 operating
system, 447
virus launcher, 429
viruses, 429-430
computer, 23-24
detection, 430
down-time of computer, 433
eradication, 430
preventing, 430-432
vaccines, 432
Trojan Horses, 429
VisiCalc spreadsheet program, 233

w
"what if?" analyses, 238
What You See Is What You Get, see
WYSIWYG
windows, moving, 8
Word for Word/Mac, 334-336
files, converting, 335
word-processing
programs, 146
addressing envelopes, 94-96
ClarisWorks, 320
comparison to typewriters,
27-28
envelopes, 96-98
labels, 98-101
mail merges, 63-94

Microsoft Works, 318
tools, 44-59
style sheets, 42, 44
templates, 29-41, 494-495
WordPerfect 2.0, mail merges,
87-93
work group software, Instant
Update, 58-59
Work Order form, 125-132
worksheets, 234
WriteNow mail merges, 83-84
WYSIWYG displays, 135

r---------------------------------,
Scientists, Engineers, and Researchers...
Get numerical data from your printed charts!

If you have a Macintosh™ and a Payroll to meet.
you are only missing one thing ... SCHEDULEMAKER™
ScheduleMaker 4.0 runs on a Macintosh Computer with a Hard Drive, at least 1 meg of RAM memory
and requires a Macintosh compatible printer. From worker database, to worksheets and within minutes
you have a balanced, cost effective schedule. Retail cost of ScheduleMaker 4.0 is $395.00.
With this coupon, you receive a 25% discount. Your Cost: $296.25

Send this coupon along with a check to:

Visa MasterCard orders (ref coupon code): Call (504) 756-2322
For Full Running DEMO ($35.00): Call (504) 756·2322
Demo cost applies to purchase of program, non refundable.

Craig Systems, Inc.

16717 Monitor Avenue
Baton Rouge, LA 70817
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Completed Schedule

.Ready~t,Go! Special Oller Order Fonn
Ready,Set,Go! can handle all phases of the publishing process, from concepts and thumbnails, through
roughs and comps, right to typography, color separations and mechanicals-all controlled by you at your
Macintosh! Take advantage now of this Incredible offer: Order'Ready,Set,Gol with this coupon for
just $225 (regular price $395). SAVE $1701
YES! I want to order Ready,Set,Gol at the special price of $225 -shipping included(regular price $395).
__ Check/Money Order
MasterCard
__ Visa
Card Number: _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ Expires: _ _ _ __
Signature _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ Telephone: _ _ _ _ _ _ _ __
Ship To Name: _ _ _ _ _ _ _ _ _ _ _~---------------Address: _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ __

OFFER VALID UNTIL JUNE 1, 1993. NYS RESIDENTS PLEASE ADD SALES TAX. RETURN COUPON TO:

Manhattan Graphics Corp., 250 E. Hartsdale Avenue, Hartsdale, NY 10530

GUARANTEED

to get 'your project done on time
and on budget!!!
Save $120.00 off the regular price of a 2-day
seminar at an MPI location. Normally $600.00
per student, now just $480.00!

Project Management Seminar

NAME: _ _ _ _ _ _ _ _ _ _ __

COMPANY NAME: _____________
ADDRESS:-----------CITY: _ _ _ _ _ _ _ _ _ _ __
STATE: _ _ _ _ _ _ ZIP: _ _ __

PHONE: - - - - - - - - - - - - - offer expires June I. 1993

• 2-day course from the world's leading
experts in Project Management
• Learn "hands on" how you can use
your computer and MPI software
to get projects done on time and on
budget everytime or your money back!!

Send your registration fee of $480.00 along with
this completed coupon and we11 reserve a seat for
you in our next seminar.
MICRO PLANNING INTERNA TI ON AL

3801 E. Florida Avenue, Ste. 605 Denver, CO 80210

CALL NOW: (303) 757-2216

$50.00 SAVINGS!
This coupon good for a $50.00 discount with the
purchase of MICRO PLANNER KeyPlan 2.0.
List Price: $249.00
NAME:·------------"--VISA/AMEX/MC #: - - - - - - SIGNATURE: _ _ _ _ _ _EXP:_

ADDRESS:
CITY:
_ _---------~
_ _ _ _ _ _ _ _ __
STATE:._ _ _ _ _ _ ZIP: _ _ __
PHONE: _ _ _ _ _ _ _ _ _ __
offer expires June I, 1993

Call now to Older your copy of MICRO PLANNER

KeyPlan for just $199.00 (plus $10.00 S&H). Or
send this coupon with your check or credit card# to:
MICRO PLANNING INTERNATIONAL

3801 E. Florida Avenue, Ste. 605 Denver, CO 80210

$140.00 SAVINGS!
This coupon good for a $140.00 discount with the
purchase of MICRO PLANNER Manager.
List Price: $695.00
NAME:. _ _ _ _ _ _ _ _ _ _ __

PLANNER

,~

KeyPlan

The perfect feasibility/proposal writing tool!
Project Management at its easiest.

m

• A planning tool that works like you
think! Enter your plan in OUTLINE
fonnat, adding detail as necessary
• View your project 4 additional ways:
Plan View (network diagram)
Bar Plan View (timeline)
Graph View (pie charts, line graphs)
List View (list tasks, target dates, etc.)
• System 7.0 compatible
ORDER NOW: (303) 757-2216

~~~~~c

PLANNER
~Manager
=>
Everything you need to complete
projects on time and on budget.

VISA/AMEX/MC #: - - - - - - SIGNATURE: _ _ _ _ _ _EXP._

The ultimate in power and ease of use for
project management.

CITY: -_
-STATE:
______ZIP:
___

• Manager's unique desktop makes it
easy to organize complex or multiple
projects

ADDRESS: _ _ _ _ _ _ _ _ __

PHONE: ~---------~
offer expires June I, 1993

Call now to order your copy of MICRO PLANNER
Manager for just $555.00 (plus $10.00 S&H). That's
a $140.00 sa~! Or send this coupon with your
check or credit card# to:

•Data entry from PERT, Gantt,
Outliner or Table fonnats
• Customize reports and symbols to
meet your specific requrrements

MICRO PLANNING INTERNATIONAL

3801 E. Florida Avenue, Ste. 605 Denver, CO 80210

ORDER NOW: (303) 757-2216

Only $59
Add $3 shl, CA Res add 7.75% tax
International orders call for piicing.

~f!lane

List $99

Name:

The Affordable Spreadsheet with
power, speed, versatility and simplicity.

Address:

City: _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ __
State:

ZIP:

MacUser' s Highest Ratlngl

Phone:
------------------~

Please charge my

D

O

VISA

+ Simple to use.

MasterCard

------------------Expiralion Date: _ _ _ _ _ _ _ _ __ __ _ __

+
+
+

Signature: - - - - - - - - - - - - - - - - -

+

Card#:

Mall to:

NIGHT DIAMONDS SOFTWARE
P.O. BOX 1608 • Huntinglon Beach, CA 92647

First time spreadsheet
users find BiPlane easy to use.
On-line help makes learning easy.
Creating impressive reports is a snap.
102 built-in functions provide versatile and
powerful tools.
System 7 compatible.

Order direct! Call (714) 842·2492
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Free Information Packet.
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If you've bttn waiting for a painc program 1ha1 combines U1< raw
beauty of fine-art technique with the efficiency of tl1c compmcr,
mccc Fractal Design Painter"'.

To~•

Painccr simulucs che tools and ccxrmcs of narur.i.I media. Wich
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saturated bleed of fch markers and the nubby richness ofcharcoal.
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Painter also hdps you 2chievc • v>riety of artistic dli.-cts by offering
you an assortment of p•pcr textures. From fine grain 10 rough, from
h:ilf..tonc 10 canvas, Painter offers surf.ices that r<::ict 10 drawing and
painting tools much like p.1pcr rt."Octs to paint.

Use Painrer for cr<::iting background< and rexmrcs fur all your pre'
scnration applications and 3-D modeling sofrwarc. With Painter.
even a photographic image can be made imo a Van Gogh or a lush
w:uercolor. Just imagine the possibilities...
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The Macintosh Problem Solver
Send in this coupon and

SAVE 25°/o
off the retail price of Help!™

Help!n• is the only Macintosh software utility
which uses artificial intelligence to pinpoint
system configuration problems and help you
solve them . With Help! you can improve the
efficiency of your Maci ntosh and avoid
disastrous system crashes. Help! detects
conflicts, incompatibilities, improperly installed
files, environmental problems, damaged files
and duplicate files - and tells you exactly how
to fix them!

To receive Helpl at a 25% discount off tha retail price of $149.00, send $111.75 plus $5.00 shipping to:

Teknosys, Inc.

3923 Coconut Palm Drive, #11 1, Tampa, FL 33619
Phone: (800) 873-3494

Get Strunk & White's The Elements of Style, Electronic Edition

for only

$19.95!

(with this coupon plus $450 shipping and handling in the U.S.)

Coupon expin.'S 6/1/93

Microlytics

$40
Value!

Reviewer's have called Strunk and White's Tire Elements of
Style " ... the best book of its kind" and raved, 'The work
remains unparalleled. direct, correct. and delightful."
Now The Elements of Style is available for your Macintosh.
Part of Microlytics' INFODESK series , The Elements of Style
provides a concise reference tool for crisp. succinct and
powerful wri ting. It's an easy-to-access, educational reference
work for the rules and principles of correct English usage.

A

Mai I this coupon to:
Microlytics
Two Tobey Village Office Park
Pittsford. NY 14534
Attn: Customer Suppon/Salcs
Questions? Please call: l-80CJ.828·6293
(Canada and NY State, call: 7 I6·248-9 150)

Get a $25 rebate

when you purchase
Graph Master!

(Retails for$295.00)
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Return 1his coupon with your GraphMaster registration
Vernon Gooden
card comple1ed to:
VBS lnc.
380 Interstate North Parkway
Suite 190
Atlanta, GA 30339

Call 404-956-0325 for your nearest retailer. Offer expires June 1, 1993.

Do you want to manage your time and people better? GeoQuery can help you do just that by taking critical
infonnation about your business-lists of clients, prospects, personnel, facilities...anything-and automatically creating maps showing information on your Macintosh screen.
CeoQuery sells for just $395. Order direct and receive a FREE
stale atlas. Just call 1-800-541--0181 to order. Be sure to
mention this coupon lo receive your FREE state atlas. Or, fill
out the coupon below and send to: CcoQuery Corporation,
P.O. Box 206, Naperville, IL 60.566-0206.
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How This Book
Was Created
This book was created entirely on a computer. Several programs were
invaluable in the process of writing and designing this book. The text was
written and edited using Microsoft Word. The book outline was kept upto-date in Acta 7; recordkeeping was performed in FileMaker Pro and
lntouch; all screen shots were taken with Snapjot; and graphics were
created with Excel 3.0, SmarcArt, and SuperPaint 3.0. Pages were laid out
using Aldus PageMaker and the index was created via PageMaker. The
cover was designed using Adobe PhotoShop and QuarkXPress; icons and
other images were created using Adobe Illustrator and Aldus Freehand.
The classy logos appearing in illustrations throughout the book are
examples of ClickArt, courtesy of I/Maker.

The 9-to-5 Mac

Using The
9-to-5 Disk
The 9-to-5 Disk contains all the templates d iscussed in The 9-to-5 Mac. In
most cases, templates are accompanied by o ne or more files that let you put
your templates co use instantly. After making a backup copy of your disk, feel
free to move the files to other disks and folders on your hard disk.

What's on The 9-to-5 Disk
our disk contains 121 items. These items are arranged in five folders
by subject matter (i.e., Connectivity Templates, Database Templates,
Forms Templates, Spreadsheet Templates, and Word Processing). These
subject folders contain all the templates that are discussed in Tbe 9-to-5 Mac.

Y

The following is a list of what's on the disk:

Connectivity Templates
The ClarisWorks templates folder contains "Confidential" and "Draft." A
second folder called Microsoft Link template contains a "Quarterly Sales"
Microsoft Word document and a "Sales Memo" Excel document.

Database Templates
The Medical Expenses templates folder holds the document "Medical Expenses." The Phone Message template folder holds two documents "Phone

Messages" and "Phone Msg Art." Another folder is the Schedule C template
which holds a FileMaker Pro document entitled "Books."

Forms Templates
The Shipping Request template folder contains the document "Shipping
Request." The Statement template folder holds one document, "Statement."
Another folder is entitled the Work Order template which holds a document
entitled "Work Order. "

Spreadsheet Templates
The Invoice System template folder holds the following document files:
"AddScript•Add to DB•Clear DB•Go to lnvoice•Invoice•New Invoice•Print
Invoice." The P/L template f folder includes two Microsoft Excel documents:
"P/L Template" and "P/L SYLK."

Word Processing Templates
This subject folder holds six folders which contain the majority of templates
and document files found on the disk. These folders and their contents are
listed below:
The Envelope & Label template folder holds the following folders: Avery
4146 template folder, contains "Avery 4146" (a Word document), and "Label
Data" (an Excel document)• Envelope Merge template folder contains two
Word documents, "Basic Merge Data" and "Envelope Merge."•Envelope
template folder holds four documents, "Envelope (MacWrite II), Envelope
(Word), Envelope (WordPerfect)," and "Envelope (WriteNow)."•The Shipping Label template folder contains "Basic Merge Excel Text (Microsoft
Excel)," and "Shipping 5164 (Avery)."
Another folder is the Mail Merge templates folder. This folder includes: The
Advanced Merge template which contains "Advanced Merge" a Microsoft
Word document and "Advanced Merge Data" an Excel document.• A Basic
Merge template folder holds four Microsoft Word documents: "Basic Merge,
Basic Merge Data, Data Doc. Template (\Vord)," and "Data Doc. TemplateTABS."•The Intermed. Merge template folder holds four more Microsoft
Word documents: "A, B, Intermediate Merge," and "Intermediate Merge 2."
The Other Word Processors folder holds five folders containing files for five
word processing programs. MacWrite II folder contains four documents:

Using the 9-to-5 Disk

The 9-to-5 Mac

"Advanced Merge Data" (Excel) , "Advanced Merge-MW," "Basic Merge Excel
Text," and "Basic Merge-MW." •The Nisus folder ho lds "Advanced Merge
Data-N, Advanced Merge-N, AN, Basic Merge Data-N, Basic Merge-N, BN,"
and "Intermediate Merge-N."•The Taste folde r contains six documents:
"Advanced Merge Data 2, Advanced Taste 1, Advanced Taste 2, Advanced
Taste 3, Basic Merge-Taste," and "Taste Data l."•The WordPe1fe ct folder
contains the following nine docume nts: "Adv. Merge 1-\VP, Adv. Merge 2-WP,
Adv. Merge 3-WP, Advanced Merge Data-WP, Basic Merge Data-WP, Intermediate Merge-WP, Negative, Neutral," and "Positive." •The \VriteNow folder
include the following e ight documents: "A, Advanced Merge, Advanced Merge
Data, B, Basic Merge Excel Text, Basic Merge-WN, Intermediate Me rge 2," and
"Intermediate Merge-WN."
The Word Process. Templates folder includes an Award template folder
which holds "Award template (MacWrite)." •Fax template folder holding a
"Fax template (Word)" docume nt. •The Letter templates folder holds three
Microsoft Word d ocuments, "Letterhead 1 (Word 5), Letterhead 1 (Word),"
and "Le tte rhead 2 (Word)." •The Memo templates folder holds two Microsoft
Word documents: "Memo te mplate (Tabs)" and "Memo template (Word)."

....,_._ .........
What's on 1be 9-to-5 Dtsk
Conncctivily Tcmpla1cs • Oaiabase
Tcmpla1cs • Fonns Tcmpla1cs • Sprcadshee1
Templa1es • Word Processing Templa1es
For a descrip1ive lis1ing of disk
con1cn1s, sec "Using The 9-10-5
Disk," p . 539.
To order more Hayden Boob call:
1-800-438-5331
ISBN: 0-672-48515-X

THE 9 ·to·Q MAC®

The Complet.e Resource t.o
Getting Business Done on the M

This is not your father's Macintosh. Yes, it's still the same machine that
religiously cranked out camera-ready art and the tool that ignited a
desktop publishing revolution. But now-it's changed. Faster and more
powerful, the Mac has become The 9-to-5 Mac!
Complete with a disk packed with timesaving document, spreadsheet,
and database templates, this book is your resource for getting down to
business. Image seems to be everything nowadays. Now-you can turn
to the Mac to make your business documents look splendid. All your
solutions are spelled out in clear terms along with dependable examples.
From word processing, mail merge operations, and impressive business
presentations to database management and number crunching, you'll
learn both the science and the common sense of business computing.
Make your life easier on the Mac by discovering what System 7 does for
you. Really. Move on to power-trip topics such as data security, disk
performance, and networking. Lean and meaty chapters on these
unfamiliar topics all add up to help you re..tch Macintosh success. Plus,
a special troubleshooting section helps right your wrongs, and a product
index makes your Mac complete. Just like this book.
Get to work on your Mac with The 9-to-5 Mac!

'ftte 9.fo·5 Mac shows you how to:
Work with words and your word processor
Compose your own customized business forms
Make charts and graphs for business
presentations
Build streamlined, organized databases
and accurate spreadsheets
Protect your equipment, software,
anddata

485
I SBN 0-672-4851 5900(

Save over $2,100 on valuable Mac software,
hardware, and other stuff
9 780672 48 5152

...
...

$29.95 US/$37.95 C

